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Notice Every effort has been made to ensure that the information in this guide is complete and accurate at the time of 
printing. Information, however, is subject to change. See Appendix A, “Customer Support Information,” in 
System Programming for important information. 

Your Responsibility for 
Your System’s Security

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized party—for example, 
persons other than your company’s employees, agents, subcontractors, or persons working on your 
company’s behalf. Note that there may be a risk of toll fraud associated with your telecommunications system, 
and, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

You and your System Manager are responsible for the security of your system, such as programming and 
configuring your equipment to prevent unauthorized use. The System Manager is also responsible for reading 
all installation, instruction, and system administration documents provided with this product in order to fully 
understand the features that can introduce risk of toll fraud and the steps that can be taken to reduce that risk. 
Lucent Technologies does not warrant that this product is immune from or will prevent unauthorized use of 
common-carrier telecommunication services or facilities accessed through or connected to it. Lucent 
Technologies will not be responsible for any charges that result from such unauthorized use. For important 
information regarding your system and toll fraud, see Appendix A, “Customer Support Information,” in System 
Programming.

Federal Communica-
tions Commission State-
ment

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference, in which case the user will be required to correct the interference 
at their own expense. For further FCC information, see Appendix A, “Customer Support Information,” in 
System Programming.

Canadian Department of 
Communications (DOC) 
Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the radio 
interference regulations of the Canadian Department of Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux
appareils numériques de la classe A préscrites dans le réglement sur le brouillage radioélectrique édicté par 
le
ministère des Communications du Canada.

Year 2000 Compliance The MERLIN MAGIX Integrated System is certified to be Year 2000 compliant. Additional information on this 
certification, and other issues regarding Year 2000 compliance, is available online at 
http://www.lucent.com/enterprise/sig/yr2000.

Trademarks 5ESS, AUDIX, CONVERSANT, CentreVu, DEFINITY, Magic On Hold, MERLIN, MERLIN LEGEND, MERLIN 
Mail, PARTNER, PassageWay, MLX-10, MLX-20L, MLX-28D, MLS-6, MLS-12, MLS-12D, MLS-18D, 
MLS-34D, SYSTIMAX, TransTalk, and Voice Power are registered trademarks and 4ESS, Intuity, Lucent 
Technologies, MERLIN MAGIX, and Prologix are trademarks of Lucent Technologies in the US and other 
countries.

Acculink, ACCUNET, MEGACOM, MulitiQuest, MLX-5, MLX-5D, MLX-16DP, MLX-10D, MLX-10DP, and 
NetPROTECT are registered trademarks of AT&T.

Microsoft, Windows, Windows NT, and MS-DOS are registered trademarks of Microsoft Corporation.

ProComm and ProComm Plus are registered trademarks of DataStorm Technologies, Inc.

Supra, Supra NC, StarSet, and Mirage are registered trademarks of Plantronics, Inc.

UNIX is a registered trademark of UNIX System Laboratories, Inc.

PagePac is a registered trademark and Powermate and Zonemate are trademarks of DRACON, a division of 
Harris Corporation.

Okidata is a registered trademark of Okidata Corporation.

Pipeline is a trademark of Ascend Communications, Inc.

Intel and Pentium are registered trademarks of Intel Corporation.

Apple and Macintosh are registered trademarks of Apple Computer, Inc.

IBM is a registered trademark of International Business Machines, Inc.

Novell and NetWare are registered trademarks of Novell Corporation.

CLASS is a servicemark of Bellcore.

Copyright © 1999, Lucent Technologies Document 555-710-111
All Rights Reserved Comcode 108522293
Printed in USAs Issue 1
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Ordering Information

For more information about Lucent Technologies documents, refer to the section entitled “Related 
Documents” in “About This Guide” in System Programming.

Support Telephone Number
In the continental US, Lucent Technologies provides a toll-free customer helpline 24 hours a day. Call the 
Lucent Technologies Helpline at 1 800 628-2888 or your Lucent Technologies authorized dealer if you need 
assistance when installing, programming, or using your system. Outside the continental US, contact your local 
Lucent Technologies authorized representative.

Network Engineering Group
For assistance in designing a private network, call the Network Engineering Group at 1 888 297-4700.

Lucent Technologies Corporate Security
Whether or not immediate support is required, all toll fraud incidents involving Lucent Technologies products 
or services should be reported to Lucent Technologies Corporate Security at 1 800 821-8235. In addition to 
recording the incident, Lucent Technologies Corporate Security is available for consultation on security 
issues, investigation support, referral to law enforcement agencies, and educational programs.

Lucent Technologies Fraud Intervention
If you suspect you are being victimized by toll fraud and you need technical support or assistance, call BCS 
National Service Assistance Center at 1 800 628-2888.

Warranty
Lucent Technologies provides a limited warranty on this product. Refer to “Limited Warranty and Limitation of 
Liability” in Appendix A, “Customer Support Information,” of System Programming.

 

Call: BCS Publications Center
Voice 1 800 457-1235 International Voice 317 322-6791
Fax 1 800 457-1764 International Fax 317 322-6699

Write: BCS Publications Center
2855 North Franklin Road
Indianapolis, IN 46219-1385

Order: Document No. 555-710-111
Comcode: 108522293
Issue 1, October 1999



IMPORTANT SAFETY INSTRUCTIONS

The exclamation point in an equilateral triangle is intended to alert the user to 
the presence of important operating and maintenance (servicing) instructions in 
the literature accompanying the product.

To reduce the risk of fire, electrical shock, and injury to persons, follow these basic safety precautions 
when installing telephone equipment:

■ Read and understand all instructions.

■ Follow all warnings and instructions marked on or packed with the product.

■ Never install telephone wiring during a lightning storm.

■ Never install a telephone jack in a wet location unless the jack is specifically designed for wet 
locations.

■ Never touch uninsulated telephone wires or terminals unless the telephone wiring has been 
disconnected at the network interface.

■ Use caution when installing or modifying telephone lines.

■ Use only Lucent Technologies-manufactured MERLIN MAGIX Integrated System circuit 
modules, carrier assemblies, and power units in the MERLIN MAGIX Integrated System control 
unit.

■ Use only Lucent Technologies-recommended/approved MERLIN MAGIX Integrated System 
accessories.

■ If equipment connected to the MLX telephone modules (008 MLX, 408 GS/LS-MLX, 408 
GS/LS-ID-MLX, and 016 MLX) or the ETR telephone module (016 ETR) is to be used for 
in-range out-of-building (IROB) applications, IROB protectors are required.

■ Do not install this product near water—for example, in a wet basement location.

■ Do not overload wall outlets, as this can result in the risk of fire or electrical shock.

■ The MERLIN MAGIX Integrated System is equipped with a 3-wire grounding-type plug with a 
third (grounding) pin. This plug will fit only into a grounding-type power outlet. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact an electrician to replace the 
obsolete outlet. Do not defeat the safety purpose of the grounding plug.

■ The MERLIN MAGIX Integrated System requires a supplementary ground.

■ Do not attach the power supply cord to building surfaces. Do not allow anything to rest on the 
power cord. Do not locate this product where the cord will be abused by persons walking on it.

■ Slots and openings in the module housings are provided for ventilation. To protect this equipment 
from overheating, do not block these openings.

■ Never push objects of any kind into this product through module openings or expansion slots, as 
they may touch dangerous voltage points or short out parts, which could result in a risk of fire or 
electrical shock. Never spill liquid of any kind on this product.



■ Unplug the product from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not 
use cleaners or aerosol cleaners.

■ Auxiliary equipment includes answering machines, alerts, modems, and fax machines. To 
connect one of these devices, you must first have a Multi-Function Module (MFM).

■ Do not operate telephones if chemical gas leakage is suspected in the area. Use telephones 
located in some other safe area to report the trouble.

■ To eliminate the risk of personal injury due to electrical shock, DO NOT attempt to install or 
remove an MFM from your MLX telephone. Opening or removing the module cover of your 
telephone may expose you to dangerous voltages.

■ ONLY an authorized technician or dealer representative shall install, set options, or repair an 
MFM.

SAVE THESE INSTRUCTIONS

WARNING:
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About This Guide 0

The power and versatility of the MERLIN MAGIX Integrated System is due in part to its many 
options and features. These options and features have been recorded on system planning forms 
and initially programmed at the time of installation. Changes in use patterns, the addition of new 
equipment, or a change in operating mode may necessitate additional system programming.

Intended Audience 0

This guide is intended for System Managers—those personnel who plan, program, maintain, and 
manage the system. It is also intended for qualified support personnel who are responsible for 
installation and initial system programming.

How to Use This Guide 0

This guide contains all the programming procedures you need to enable your system to function at 
peak efficiency. Refer to the following documents for additional information:

■ Feature Reference describes features in detail and any feature interaction.

■ System Planning describes the System Planning Forms and their use.

‘‘Related Documents,” later in this section, provides a complete list of system documentation, 
together with ordering information.

In the USA only, Lucent Technologies provides a toll-free customer Helpline 24 hours a day. Call 
the Helpline at 1 800 628-2888 (consultation charges may apply), or contact your Lucent 
Technologies representative if you need assistance when installing, programming, or using your 
system.

Outside the USA, if you need assistance when installing, programming, or using your system, 
contact your Lucent Technologies authorized representative.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

About This Guide 
xxiiTerms and Conventions Used 

Terms and Conventions Used 0

The terms described here are used in preference to other, equally acceptable terms for describing 
communications systems.

Lines, Trunks, and Facilities 0

Facility is a general term that designates a communications path between a telephone system and 
the telephone company central office. Technically, a trunk connects a switch to a switch—for 
example, the MERLIN MAGIX Integrated System to the central office. Technically, a line is a loop-
start facility or a communications path that does not connect switches—for example, an intercom 
line or a Centrex line. In actual usage, however, the terms line and trunk are often applied 
interchangeably. In this guide, we use line/trunk and lines/trunks to refer to facilities in general. 
Specifically, we refer to digital facilities. We also use specific terms such as Personal Line, ground-
start trunk, Direct Inward Dialing (DID) trunk, and so on. When you talk to personnel at your local 
telephone company central office, ask them which terms they use for the specific facilities they 
connect to your system. 

Some older terms have been replaced with newer terms, as follows:

Old Term New Term

trunk module line/trunk module

trunk jack line/trunk jack

station extension

station jack extension jack

analog data station modem data workstation

digital data station terminal adapter workstation

7500B data station ISDN terminal adapter data workstation

analog voice and analog data station analog voice and modem data workstation

digital voice and analog data station MLX voice and modem data workstation

analog data-only station modem data-only workstation

digital data-only station terminal adapter data-only workstation

7500B data-only station ISDN terminal adapter data-only workstation

digital voice and digital data station MLX voice and terminal adapter workstation

MLX voice and 7500B data station MLX voice and ISDN terminal adapter data workstation
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Typographical Conventions 0

Certain type fonts and styles act as visual cues to help you rapidly understand the information 
presented:

Product Safety Advisories 0

Throughout these documents, hazardous situations are indicated by an exclamation point inside a 
triangle and the word CAUTION or WARNING.

WARNING:

Warning indicates the presence of a hazard that could cause death or severe personal injury 
if the hazard is not avoided.

CAUTION:
Caution indicates the presence of a hazard that could cause minor personal injury or 
property damage if the hazard is not avoided.

Security 0

Certain features of the system can be protected by passwords to prevent unauthorized users from 
abusing the system. You should assign passwords wherever possible and limit distribution of such 
passwords to three or fewer people.

Nondisplaying authorization codes and telephone numbers provide another layer of security. For 
more information, see Appendix A, ‘‘Customer Support Information.”

Throughout this guide, toll fraud security hazards are indicated by an exclamation point inside a 
triangle and the words SECURITY ALERT.

Convention Example
Italics or bold indicate emphasis. It is very important that you follow these steps.

WARNING:

Do not remove modules from the 
carrier without following proper 
procedures.

Italics also set off special terms. The part of the headset that fits over one or both 
ears is called a headpiece.

Plain constant-width type indicates text 
that appears on the telephone display or PC 
screen, as well as characters you dial at the 
telephone or type at the PC.

Choose Ext Prog from the display screen. 

To activate Call Waiting, dial *11.
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SECURITY ALERT:
Security Alert indicates the presence of a toll fraud security hazard. Toll fraud is the 
unauthorized use of your telecommunications system, or use by an unauthorized party (e.g., 
persons other than your company’s employees, agents, subcontractors, or persons working 
on your company’s behalf). Be sure to read “Security of Your System: Preventing Toll Fraud: 
in Appendix A, “Customer Support Information” and “Your Responsibility for Your System’s 
Security” in the “Copyright and Legal Notices” section at the beginning of this document.

Related Documents 0

The documents listed in the following table are part of the MERLIN MAGIX documentation set. 
Within the continental United States, contact the Lucent Technologies BCS Publications Center by 
calling 1 800 457-1235.

Document No. Title

System Documents: 

555-710-100 Customer Documentation Package: 

Consists of paper versions of the System Manager’s Quick 
Reference, the Feature Reference, and System 
Programming 

555-710-110 Feature Reference 

555-710-111 System Programming 

555-670-112 MERLIN LEGEND® Communications System, Release 
7.0, System Planning

555-710-112 System Planning Supplement

555-710-113 System Planning Forms 

555-710-119 System Manager’s Quick Reference 

555-610-150 MERLIN LEGEND® Communications System, Release 
6.1, Network Reference 

555-710-800 Customer Reference CD-ROM: 

Consists of the System Manager’s Quick Reference, the 
Feature Reference, System Programming, and the 
Network Reference 
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Telephone User Support: 

555-710-123
(U.S. English)

4400/4400D Telephone User’s Guide 

555-710-123FRC 
(Canadian French)

4400/4400D Telephone User’s Guide 

555-710-127 
(U.S. English)

4406D+, 4412D+, 4424D+, and 4424LD+ Telephone 
User’s Guide 

555-710-127FRC 
(Canadian French)

4406D+, 4412D+, 4424D+, and 4424LD+ Telephone 
User’s Guide 

555-660-122 MLX Display Telephone User’s Guide 

555-630-150 MLX- 5D®, MLX-10D ®and MLX-10DP® Display 
Telephone Tray Cards (5 cards)

555-630-152 MLX-28D® and MLX-20L® Telephone Tray Cards (5 cards)

555-660-124 MLX-5® and MLX-10® Nondisplay Telephone User’s Guide 

555-630-151 MLX-5® and MLX-10® Nondisplay Telephone Tray Cards 
(6 cards)

555-630-155 MLX-16DP® Display Telephone Tray Cards (5 cards)

555-670-151 MLS and ETR Telephone Tray Cards 

555-670-152 MLS and ETR Telephone Tray Cards (16 cards)

555-660-126 Single-Line Telephones User’s Guide 

555-660-138 MDC and MDW Telephones User's Guide 

System Operator Support: 

555-710-134 Digital Direct LIne Console Operator’s Guide 

555-710-136 Digital Queued Call Console Operator’s Guide 

Miscellaneous User Support: 

555-661-130 Calling Group Supervisor and Service Observer User 
Guide 

555-650-105 Data and Video Reference 

Documentation for Qualified Technicians: 

555-661-140 MERLIN LEGEND® Communications System, Release 
6.1, Installation, SPM, Maintenance and Troubleshooting

555-710-142 Installation, SPM, Maintenance and Troubleshooting 
Supplement 

Document No. Title



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

About This Guide 
xxviHow to Comment on This Guide 

How to Comment on This Guide 0

We welcome your comments, both positive and negative. Please use the feedback form on the 
next page to let us know how we can continue to serve you. If the feedback form is missing, write 
directly to:

Documentation Manager
Lucent Technologies
211 Mount Airy Road, Room 2W-330
Basking Ridge, NJ 07920

555-710-116 Pocket Reference 

Toll Fraud Security: 

555-025-600 BCS Products Security Handbook 

Document No. Title
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1Programming Basics 1

Overview 1

This chapter presents the information you need to master before you begin the programming 
procedures covered in Chapter 3, ‘‘Programming Procedures.” It covers the following subjects:

■ An introduction to system programming basics

■ How to use the system programming console

■ How the programming screens and keys work

■ How to interpret and use the programming procedures

■ How to enter and exit system programming

■ Which system components require idle states for programming
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Introduction to System Programming 1

The MERLIN MAGIXTM Integrated System offers easy-to-use, menu-driven software for system 
programming. After your system is installed, use this software to accommodate your company’s 
changing needs for such enhancements and modifications as upgraded lines, additional modules, 
and new extension programming. 

Planning Forms 1

Before you begin to program or modify your system, you should familiarize yourself with the 
system planning forms. Initially, system planning forms are used to plan your system and program 
your system during installation. After installation, they remain a source for all programming 
information on your system database. The information ranges from the system time and date to 
specific equipment configurations and feature programming. 

Each planning form is either required or optional:

■ Required forms are necessary to program the system.

■ Optional forms are needed only if the System Manager included the features or options shown 
on the forms.

Before you begin to program or modify your system, review the Control Unit Diagram on system 
planning Form 1 to identify the module types installed in the system’s control unit. Use this 
information to program or modify lines and trunks and assign or reassign lines to extensions. 
Check the physical control unit to verify that the modules are placed in the slots identified on the 
diagram. Correct the diagram on Form 1 if there are any discrepancies.

Before you make any changes to your system, be sure to do the following:

■ Mark any system modifications or changes on the appropriate planning form. Keep your 
planning forms up-to-date. 

■ Check the Feature Reference for possible feature interactions.

■ Program the system or the system component during the appropriate idle state. See ‘‘Idle 
States’’ on page 1-22.

Types of Programming 1

The three types of programming available for the system are:

■ System Programming. This type of programming enables the System Manager to program 
features that affect all or most system users, and requires one of the following:

— A system programming console which is a 4424LD+ or MLX-20L telephone connected to 
one of the first five jacks of the first TDL or MLX module in the control unit.
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— A PC with Windows System Programming and Maintenance (WinSPM) software. WinSPM 
provides two interfaces for system programming—Quick Access and Standard SPM 
Mode. Quick Access provides a graphical user interface (GUI) for those tasks most 
commonly performed by the System Manager (for example, adding or deleting members 
of groups, perform system inventories, create reports, administering multiple systems, 
making station labels appear on display telephones, and more). Pictorial representations 
of system components, such as modules and their vintages, and the creation of a 4400-
Series or MLX telephone button labels are available with WinSPM. 

The Standard SPM Mode interface provides an emulation display of the system 
programming console. It allows basic SPM programming of the MERLIN MAGIX system 
and supports SPM programming for options not included in the GUI.

The PC should be connected to the lower port (labeled ADMIN) on the processor module. 
A PC with a modem can perform system programming remotely through the public 
network, or by connecting to a tip/ring extension jack (016 (T/R), 016 ETR programmed for 
T/R operation, or 008 OPT module) on the system. A built-in modem in the processor 
allows the PC and the system to communicate.

■ Extension Programming. This type of programming enables individual extension users and 
system operators (except for Queued Call Console operators) to change their extension 
features to meet individual needs. For details about extension programming, see the 
appropriate user and operator guides.

■ Centralized Telephone Programming. This type of programming enables the System 
Manager to program any feature that can be programmed by individual extension users or 
system operators. Some features can be programmed only in centralized telephone 
programming. Centralized telephone programming can be done on the programming console 
or on a PC with the WinSPM software. See Chapter 4, ‘‘Centralized Telephone Programming.”
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System Programming Console 1

The system programming console is a 4424LD+ or MLX-20L telephone connected to the system 
programming jack. When you begin system programming on a new system for the first time, the 
console must be connected to the first jack on the first 412 LS-ID-TDL or 024 TDL module if you 
are using a 4424 LD+ telephone, or to the first jack on the first 008 MLX module, 016 MLX module, 
or 408 GS/LS-ID-MLX module if you are using an MLX-20L telephone. The first jack on the first 
TDL or MLX module is factory set as the system programming jack and as an operator position. 
When you program for the first time, you can change the system programming jack to any one of 
the first five jacks on the first 412 LS-ID-TDL module or 024 TDL module, or on the first 008 MLX 
module or 408 GS/LS-ID-MLX module. This allows you to program without interfering with the 
operator’s call handling.

You can also have one or two Direct Station Selectors (DSSs) connected to the system 
programming console. Each DSS adds 50 extension buttons to the console, which facilitates 
assigning features to extensions. The DSS for the 4424LD+ console is the DSS 4450.

A 4424LD+ telephone is shown in Figure 1-1. An MLX-20L telephone is shown in Figure 1-2. 

Figure 1-1. 4424LD+ Telephone
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Figure 1-2. MLX-20L Telephone

Console Components 1

Table 1-1 describes the components that make up the 4424LD+ or MLX-20L Console. Refer to 
Figure 1-1 and Figure 1-2 for the location of the components. Table 1-2 describes the components 
that make up the DSS.

Table 1-1. 4424LD+ and MLX-20L Console Components

Component Function

Desk Stand
(not shown) 

An adjustable stand on the console and the DSS allows a 20- or 30-degree 
viewing angle (optional on the 4424LD+ telephone).

Button Labeling 
Cards 

Cards labeled with the number or feature assigned to each line button.

Contrast Control
(not shown) 

A sliding control at the top of the console, used to brighten or dim the display 
screen.
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Fixed Feature 
Buttons 

4424LD+ telephone fixed display buttons for most-used features: 

Spkr (Speaker) for turning the speakerphone on and off.

Mute for turning the speakerphone’s microphone and, if applicable, the 
headset’s microphone on and off.

Trnsfr (Transfer) for sending a call to another telephone.

Conf for adding a line or extension to a conference call.

Redial for redialing the last number dialed from the telephone.

Hold for putting a call on hold.

MLX-20L telephone fixed display buttons for most-used features:

Feature for viewing the Feature screen and selecting features.

HFAI (Hands-Free Answer on Intercom) for answering voice-announced 
calls without the handset.

Mute for turning the speakerphone’s microphone on and off.

Speaker for talking on a call through the speakerphone without lifting the 
handset.

Transfer for sending a call to another telephone.

Conf for adding a line or extension to a conference call.

Drop for disconnecting an extension or line from a conference call.

Hold for putting a call on hold.

Dialpad Number pad for dialing telephone numbers.

Direct Station 
Selector (DSS)
(not shown) 

A device that adds extension buttons and other buttons to the console. See 
Table 1-2.

Display Buttons Four fixed display buttons and 10 unlabeled buttons used to view the 
different screens and select names, features, and options from the display 
screen. See ‘‘Console Buttons’’ on page 1-8.

Display Screen Screen with a 7-line by 24-character display area that shows call 
information, features, prompts, date, and time.

Handset The hand-held part of the console you pick up, talk into, and listen from.

LEDs (Light-Emitting Diodes) The lights on the console that assist in checking 
feature status.

Line Buttons Buttons to make and receive calls; unlabeled buttons are programmable for 
one-step feature use. The 4424LD+ has 24 line buttons, and the MLX-20L 
has 20 line buttons.

Message Light A red light that signals a waiting message.

Table 1-1. 4424LD+ and MLX-20L Console Components — Continued

Component Function
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User Cards and 
Tray (MLX-20 
only)

A slide-out drawer with erasable cards for noting telephone numbers and 
feature codes.

Volume Control A button for adjusting the volume of speaker, handset, headset, and ringer.

Table 1-2. Direct Station Selector (DSS) Components

Component Function

Covers Removable plastic covers to protect the designation cards. The top cover 
protects the 50 DSS button labels. The lower cover fits over the fixed 
buttons.

DSS Designation 
Cards 

Cards for labeling the extension or feature assigned to each button.

DSS Buttons Fifty buttons used for one-touch dialing of co-workers’ extensions to make 
or transfer calls. DSS buttons are also used to page co-workers over 
speakerphones, to park calls, and to handle outside calls.

Fixed Buttons Ten additional buttons, including Message Status, Direct Voice Mail (MLX 
DSS only), and three Page buttons. The five remaining buttons on the first 
DSS are not used. If a second DSS is connected to the console, the 10 
buttons at the bottom of the second DSS are not used.

Fixed Message Status button used with fixed Page buttons to see which 
telephones have Message Lights on.

Fixed Page Buttons are three buttons used to select the pages of 
extensions that the 50 DSS buttons represent.

LEDs (Light-
Emitting Diodes) 

The lights that assist in checking feature status.

Table 1-1. 4424LD+ and MLX-20L Console Components — Continued

Component Function



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Basics 
1-8System Programming Console 

1

Console Buttons 1

Use the 14 buttons located on either side of the 4424LD+ or MLX-20L console display area for 
system programming. These buttons are arranged in two columns of seven buttons, as shown in 
Figure 1-3 and Figure 1-4. On the 4424LD+ console, three of the four fixed display buttons have 
different labels than those on the MLX-20L console, although the same functionality is provided 
(see ‘‘Fixed Display Buttons” that follows).

Figure 1-3. 4424LD+ Display Buttons and Main Menu

Figure 1-4. MLX-20L Display Buttons and Main Menu

Fixed Display Buttons 1

The top two buttons in each column have the same labels and functions regardless of the screen 
display. This type of button is called a fixed display button. Table 1-3 describes the functions of the 
fixed display buttons for the 4424LD+ and MLX-20L consoles.
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Unlabeled Display Buttons 1

Use the five unlabeled display buttons on each side of the screen to select commands, options, or 
items on the screen. The functions of these buttons vary, based on the option you select.

If you are using WinSPM for system programming, the simulated 4424DL+ or MLX-20L console 
screen on your PC screen shows the function keys that correspond to the console screen 
selections. For example, to save an entry, you select Enter on the console or click � in the 
emulation display on your PC. See Chapter 2, ‘‘Programming with WinSPM,” for details about 
using function keys and additional information about WinSPM.

Console Overlay 1

The programmable line buttons are on the main part of the console. There are 24 line buttons on 
the 4424 LD+; however, the four buttons on the top row are not used during system programming.

The MLX-20 console has 20 line buttons, but you can use the console overlay to program up to 28 
line buttons on any extension through centralized telephone programming. Select Page 1 to 
access line buttons 1 through 20 and Page 2 to access line buttons 21 to 34. The top line of 
numbers next to each line button on the console overlay represents line buttons. See Figure 1-5 
and Figure 1-6 that follow.

Appendix E shows the button diagrams for the telephones used in the system. Refer to this 
appendix when programming buttons for other telephones.

Table 1-3. Fixed Display Buttons

MLX-20L 
Buttons

4424LD+ 
Buttons Function

Home Exit Return to normal call handling mode after you finish programming. 

Menu Menu Display the Main menu shown in Figure 1-3.

More Display more items when a menu is continued on more than one 
screen, indicated by an angle bracket (>) on the upper right of the 
screen.

Inspct (Inspect) View a list of lines or extensions on which a feature is 
programmed or the settings for a feature. On the 4424LD+ console, an 
Inspect button must be programmed (programming code *778).

Return to the previous screen; indicated by an angle bracket (<) on the 
upper right of the screen. The MLX-20L does not have an equivalent 
button.
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When labels or filenames are entered, the letters A through F are displayed on the console screen. 
Additional letters can be entered by using line buttons 1 through 20 to represent letters G through 
Z. These letters are also displayed on the top line of the console overlay.

Figure 1-5. 4424LD+ System Programming Console Overlay
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Figure 1-6. MLX-20L System Programming Console Overlay

The Top Sys Prog labeled function shown on the console overlay in Figure 1-6 does not appear on 
the 4424LD+ console overlay. The 4424LD+ does not provide a fixed HFAI (Hands Free Answer 
on Intercom) button for this feature; however, the HFAI feature can be programmed onto a line 
button on the 4424LD+ telephone and then used for system programming.

When programming lines/trunks, you can select a block of 20 lines/trunks as shown in Figure 1-7, 
and toggle the green or red LED associated with each line button on the console to program each 
line/trunk. The bottom line of numbers next to each line button on the console overlay represents 
the twenty lines/trunks associated with each line button (see Figure 1-6).

Figure 1-7. Selecting a Block of Lines/Trunks
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Console and DSS Lights 1

The red and green lights (LEDs) next to each of the 20 line buttons on the 4424LD+ and MLX-20L 
console show the status of the line/trunk options. LEDs on the DSS show the status of features 
programmed on extensions. See Appendix C, ‘‘LED Displays,” for more information.

Console Lights 1

The green and red LEDs next to each button on the console display the status of the line/trunk 
option that is being programmed. For example, when you select Pools from the Lines Trunks 
menu, the red LED is off if the selected line is not in a pool and on if the line is in a pool. Appendix 
C, ‘‘LED Displays,” provides a table that shows the default LED status for line/trunk options.

DSS Lights 1

The lights on the DSS (if one is attached to the console) show the status of features being 
programmed on the extensions. When you select a feature from a menu, the red LED next to the 
DSS button is on, off, or flashing, depending on whether the feature is already programmed on the 
corresponding extension. For example, when you select Toll Restrict from the Restrictions 
menu, the red LED next to the DSS button lights for each toll-restricted extension. Appendix C, 
‘‘LED Displays” provides a table that shows the default DSS status of LEDs for system features.

Programming Procedures 1

The programming procedures provide step-by-step instructions for programming the system. This 
section details how to make the best use of the programming procedures.

Procedure Organization 1

The programming procedures in Chapter 3, ‘‘Programming Procedures,” are organized into logical 
groups. The programming procedures associated with a specific aspect of the system are grouped 
together under one heading. For example, to assign network services for PRI, you would go to the 
section titled ‘‘PRI Facilities’’ and then locate the network services procedure. For quick reference, 
see ‘‘System Programming Hierarchy’’ on page 1-19 for a list of procedures based on the menu 
hierarchy in Appendix B. It traces the menu path for a specific function.
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Procedure Contents 1

Each procedure begins with a general description of the feature, followed by a summary of 
programming information that includes the items listed below:

Programming Screens 1

There are three types of system programming screens:

■ Information Screens. To view what is currently programmed on the system.

■ Menu selection screens. To select options from a menu.

■ Data entry screens. To enter values or to identify a specific extension or line/trunk you want 
to program.

Figure 1-8 shows a sample information screen. When you select Sys Program from the Main 
menu screen (shown in Figure 1-3 on page 1-8), the screen shown in Figure 1-8 appears with 
system setup information.

Programmable by Indicates who has permission to use the procedure.

Mode Specifies which system mode supports the procedure: Key, Hybrid/PBX, 
Behind Switch, or a combination.

Idle condition Specifies the idle state required before the procedure can be performed.

Planning form Indicates the planning forms that provide information for the procedure.

Factory setting Shows the factory settings, if any, for equipment or features affected by 
the procedure.

Valid entries Specifies the characters, numbers, or values accepted during data entry.

Inspect Specifies whether or not the feature status can be verified using the 
Inspect feature.

Copy option Indicates whether or not the feature can be copied to another system 
component once it has been programmed.

Console Procedure Provides a summary of the procedure steps using the system console.

PC Procedure Provides a summary of the procedure steps using WinSPM.
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Figure 1-8. Information Screen

You cannot make changes on an information screen. Select Back (or click � in the PC emulation 
display) to continue to the next screen in the procedure. 

Figure 1-9 shows a sample menu selection screen.

 

Figure 1-9. Menu Selection Screen

A menu selection screen prompts you to select one of the available options. The screen title is the 
first line on all screens. The second line contains a system prompt or instruction. The remaining 
lines of text vary, based on the selected option.

An angle bracket (>) appears in the upper right corner of menu selection screens that have 
additional option screens. Press  or More (or click � in the PC emulation display) to see the 
additional screens; continue to press or click these buttons to move through the screens and 
return to the original screen. Figure 1-10 shows a sample data entry screen.

System Set-up Your system information appears in
Review and Exit place of the x’s. 
Size: xxxx

Type: xxxx

Operator: xxxx xxxx xxxx xxxx 
xxxx xxxx

Back

System Programming:  > Screen title and More indicator (>)
Make a Selection Prompt
System Extensions Options List
SysRenumber Options

Operator Tables

LinesTrunks AuxEquip

Back NightSrvce
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Figure 1-10. Data Entry Screen

A data entry screen prompts you to enter specific data or to make specific choices. Data to be 
entered will be displayed with n’s in the text. When n’s appear on the data entry screen they 
indicate data currently programmed for the feature. An exception is the slot/port number which is 
displayed as sspp to distinguish the 2-digit slot number from the 2-digit port number. Slot is the 
slot number in the carrier and port is the port number on the module. 

Many screens show data entered on a previous screen, such as an extension or trunk number. 
Within the programming procedures, this type of variable information is shown with x’s.

When information to be entered varies in the number of digits required (for example, a telephone 
number that can range from 7 to 20 digits), the data may be displayed as an uppercase X or N. 

Data entry screens may also contain menu selections. Instead of entering data from the dialpad, 
you select options on the screen, such as Yes or No, to enable or disable a feature. To select this 
type of option, press either the unlabeled display button next to the option name, or the function 
key that corresponds to the option name. Then your selection is highlighted. To program or save 
the highlighted selection, press the unlabeled display button next to Enter (or click � in the PC 
emulation display).

Assign Lines/Trunks: Selected Option
Enter extension Prompt

Data Entry Area

Backspace

Back Enter

The slot/port numbering for adjunct ports on MLX modules begins at 21. The slot/port 
numbering for adjunct ports on TDL modules begins at 25. For example, on an MLX 
module in slot 1 of the carrier, to access adjunct port 710, you would enter 0121 as the 
slot/port number (01 indicates slot 1 on the carrier) while on a TDL module in slot 1 of the 
carrier, to access adjunct port 710, you would enter 0125.
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Verifying Data Entry 1

You can use the Inspect feature to view the entries you save.

The Inspect button is fixed on an MLX-20L. To use the Inspect feature on a 4424LD+ telephone, 
you must program a line button with the Inspect feature (refer to Feature Reference for 
programming the Inspect button. 

An example of how to use the Inspect feature begins with Figure 1-11. The figure shows a data 
entry screen with the adjunct extension number of an MLX port.

Figure 1-11. Inspect Example

After you enter and save 7108, you can enter and save another extension; the extensions you 
enter appear one at a time in the screen, as you enter and save them. However, if you press the 
Inspect button (� in the PC emulation display), all extension numbers that you have 
programmed in this data entry screen appear. For example, if you entered 7108, 7109, and 7110, 
when you press the Inspect button, all the extension numbers appear as shown in the sample 
Inspect screen in Figure 1-12.

Figure 1-12. Sample Inspect Screen

Whenever you want to return to the previous screen, select Back (� in the PC emulation 
display).

2B Data\Video: > Selected Option
Enter adjunct extension
number of an MLX port

Prompt

7108 Extension Entered
            Delete

Backspace

Back Enter

2B Data\Video:    >

7108  7109 7110 Inspect Data Displayed

Back



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Basics 
1-17Programming Procedures 

1

The Inspect feature also allows you to check a value that has already been programmed for a 
feature. This is helpful when you are changing or modifying features. You can also use it when you 
program sequential extensions or lines to verify the last number programmed. See the Feature 
Reference for details about the Inspect feature.

Saving Entries and Moving among Screens 1

At the bottom of each screen, one or more screen keys may appear representing functions that 
allow you to change your entry, save your entry, or return to a previous screen. Various 
combinations of these screen keys appear on each programming screen. Figure 1-13 shows the 
QCC Priority screen with a typical display of screen keys.

Figure 1-13. Screen Keys

The PC keys that correspond to the screen key selections are shown here for quick reference. 
These PC keys do not appear on the console display screen. Table 1-4 contains details on the use 
of the screen keys. 

QCC Priority x: x = QCC Priority entered in earlier step
Enter line/trunk number

 xxx xxx = line/trunk number (801–880)
Delete 
 

� Backspace Next � 
� Back Enter � 

Table 1-4. Screen Keys

Display PC Key Function

BackSpace � or  
> 

Change your entry. Select Backspace (click � or > in the 
PC emulation display) to correct your entry. Each time you select 
Backspace or click �, the screen cursor moves backward to 
erase one character at a time.

Enter � or 
1 

Save your entry. Typically, you select Enter (click � or 1 
in the PC emulation display) to complete a procedure and save the 
information. Occasionally, you must select Exit (click � in the 
PC emulation display) and return to a previous screen after you 
use Enter. If the entry is not valid, the system may beep and/or 
display an error message and does not save the entry.

Delete 
 Delete a current entry. Select Delete (click 
 in the PC 
emulation display).
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Using Enter 1

Pressing Enter to save your entry produces one of the following results:

■ The next screen in the procedure appears.

■ The screen does not change and you can enter another extension or line/trunk. In most of 
these cases, Delete is also an option. Enter is used either to assign the extension to a 
group or to assign a feature to the extension. Delete is used to remove the extension from a 
group or to remove the feature from the extension.

■ The procedure is complete and you return to a previous screen.

Using Next 1

When you program a feature that applies to a sequence of extensions, lines/trunks, or groups, the 
screen key Next appears on the console display. Next (� in the PC emulation display) permits 
you to save your current entry and display the next number in the sequence. You can continue to 
press Next until you finish programming the entire sequence. When the last number in the 
sequence displays on the screen, press Enter (� in the PC emulation display) to save the final 

Next � Program sequentially numbered items. If you are programming 
a group of sequentially numbered extensions, lines, or trunks, you 
may optionally select Next (click � in the PC emulation display). 
This saves your entry and automatically provides the number of 
the next extension or trunk in the sequence. Typically, you remain 
at the same screen until you select Next. In a few cases, you may 
return to an earlier screen in the procedure. 

Back � Return to the previous screen. Select Back (click � in the PC 
emulation display) when you complete a procedure, to move up 
one screen in the menu hierarchy. (Appendix B provides a 
reference to the entire System Programming menu hierarchy.)

Exit a screen without changes. In most cases, you select Back 
(click � in the PC emulation display) to exit from a screen without 
making any changes. Exceptions are noted as part of a procedure.

Complete a procedure. In a few cases, you return to the System 
Programming menu when you select Back. In most cases, you 
return to an intermediate step within the procedure. You can then 
select one of the options shown on the screen and continue 
programming, or you can continue to use Back until you return to 
the System Programming menu.

Table 1-4. Screen Keys — Continued
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entry and move to the next step of the procedure. Procedures that allow the use of Next return 
you to the correct screen to continue programming.

System Programming Hierarchy 1

For a complete listing of the options available under each of the System Programming Main menu 
options displayed on the system programming console, see the fold-out in Appendix B.

Access to System Programming 
from the 4424LD+ or MLX-20L or Console 1

Follow the steps below to begin system programming. All of the procedures in Chapter 3, 
‘‘Programming Procedures” begin at the System Programming menu shown in Step 3 of the 
following procedure.

For information about accessing system programming through a PC with WinSPM, see Chapter 2, 
‘‘Programming with WinSPM.”

1. Press menu to display the Main menu.

2. Select System Programming. The System Set-Up screen appears.

MENU MODE: Select Feature

Press HOME to Exit

Directory

Messages

Posted Msg Sys Program

Alarm Clock Maintenance

Timer Ext Program

System Set-up: Ext Program does not appear 
Review and Exit  on this screen if the programming
Type: xxxx console is a QCC.
Mode: xxxx

Operator: xxxx xxxx On the System Set-up screen, system 
xxxx xxxx xxxx xxxx information appears in place of the x’s.
Back Type = Voice/Data

Mode = Key, Hybrid/PBX, 
or Behind Switch 
Operator = Position extension numbers 
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3. Select Back. The System Programming menu appears.

System Programming Menu 1

Figure 1-14 shows the two screens that make up the System Programming menu.

Figure 1-14. System Programming Menu Screens

Table 1-5 describes the options.

System Programming:    >

Make a selection

System Extensions

SysRenumber Options

Operator Tables

Lines/Trunks AuxEquip Press the button next to  
Back NightSrvce your selection.

System Programming:  > System Programming:  >

Make a Selection Make a Selection

System Extensions Labeling         Language

SysRenumber Options Data

Operator Tables Print

Lines/Trunks AuxEquip Cntr-Prg

Back NightSrvce Back

Table 1-5. System Programming Menu Options

Option Description

System Set system operating conditions.

SysRenumber Select the system numbering plan and/or reassign extension numbers with 1- 
to 4-digit numbers that are more appropriate or convenient for your company.

Operator Assign or remove operator positions, and program operator features (such as 
Operator Hold Timer or QCC options).

LinesTrunks Program line/trunk options.

Extensions Program extension features (such as line assignments).

Options Program system-wide features (such as Transfer Return).
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Exiting System Programming 1

Use the information in Table 1-6 to return to the System Programming menu, the Main menu 
(Menu Mode screen), or the Home screen from within a programming screen.

Tables Program features that require entering information in a table (such as Allowed 
Lists and Disallowed Lists).

AuxEquip Program auxiliary equipment connected to the system (such as loudspeaker 
paging and fax).

NightSrvce Program Night Service features.

Labeling Program the labels shown on display telephones (such as Posted Messages 
and entries in the System Directory).

Data Specify extensions that need voice and data capability.

Print Print system programming reports (such as system configuration and 
extension assignments).

Cntr-Prog Perform centralized telephone programming (assign features to specific 
buttons on telephones).

Language Select the language for: the system, 4400-Series or MLX display telephones, 
SMDR reports, and print reports.

Table 1-6. Exiting System Programming

To return to… On the console, press… On the PC display, click…

Previous menu Back � 

Main menu Menu � 

Normal Call-
Handling 

MLX-20L Console: Home 
4424LD+ Console: Exit

� 

Table 1-5. System Programming Menu Options — Continued

Option Description

+^OZ
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Idle States 1

Some programming procedures can be started only when the entire system, or some part of it, 
such as a trunk or an extension, is idle (not in use). Some procedures require that a trunk or 
extension be idle only at the instant of programming. Lengthy procedures require the system, 
trunk, or extension to remain idle until programming is completed. These procedures wait for the 
system, trunk, or extension to become idle and then prevent the initiation of any new calls. This 
condition is called forced idle.

For complete information, refer to “Idle States” in Chapter 2.

If a procedure requires an idle condition, do the programming outside of normal business 
hours.
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Overview 2

The Windows System Programming and Maintenance (WinSPM) software package offers an 
alternate method of programming the MERLIN MAGIX Integrated System using a PC. This 
method frees the system programming console for other uses and also provides the following 
additional functions:

■ Backing up system programming information.

■ Restoring system programming information from a backup.

■ Printing, viewing, and storing reports.

■ Programming the system remotely.

■ Programming in surrogate mode.

■ Creating button labels.

■ Storing print report data and/or user annotation notes using Notepad Editor.

WinSPM provides two modes for programming your MERLIN MAGIX Integrated System:

■ Quick Access Mode. A graphical interface (GUI) for those tasks most commonly performed 
by the System Manager–for example, adding or deleting members of groups, performing 
system inventories, creating reports, administering multiple systems, making station labels 
shown on display telephones, and more. 

■ Standard SPM Mode. Provides an emulation display of the system programming console. It 
allows basic SPM programming of the MERLIN MAGIX system and supports SPM 
programming for options not included in Quick Access mode.

WinSPM is available on CD-ROM and floppy disks. The WinSPM software can be used directly 
from the floppy disks or CD-ROM on your PC. If your PC has a hard disk, however, you should 
install WinSPM from either the floppy disks or CD-ROM onto the hard disk.

This guide describes the use of WinSPM in Standard SPM Mode. If you are using Quick Access, 
refer to the documentation and online help provided with the WinSPM application for additional 
information. 
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System Requirements 2

WinSPM is designed to function with:

■ Windows 95, Windows 98, or Windows NT Release 4.0 or higher.

■ IBM-compatible Personal Computer with a Pentium 100 or more (Pentium II or higher 
recommended).

■ 40 MB or more of available space on the hard drive.

■ 32 MB of RAM (64 MB recommended).

■ 1 COM Port.

■ Modem with auto baud capabilities (PEC 2569-839 recommended), with specific drivers 
loaded.

■ Video Card that supports at least 256 colors (65536 or more recommended).

Depending on how you connect the PC to the control unit, you also need the following items:

■ Direct local connection, if the PC is within 50 feet of the control unit:

— Either a 355AF modular adapter (if there is a male connector on the interface cable) or a 
355A modular adapter (if there is a female connector on the interface cable)

— A four-pair modular cord (D8W)

■ Direct local connection, if the PC is more than 50 feet from the control unit:

— 355AF adapter 

— EIA crossover cable

— Two Z3A2 Asynchronous Data Units (ADUs)

— ADU crossover cable

— 400B2 power adapter 

— 2012D transformer 

— BR1A-4P adapter and either a 102 connecting block or 103 connecting block

— 248B adapter

— Eight-position wall jacks

— Four-pair plug-ended cable

— D8W cords

— D6AP power cord

— EIA-232-D cables

■ Internal or External connection:

— Modem that supports 1200- or 2400-bps connections

— Modem cable

From the Display Properties window on your Windows desktop, be sure to select 
Small Fonts for the Font Size option. See ‘‘Font Size Settings’’ under ‘‘Desktop 
Setup’’ later in this chapter.
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In addition, a parallel printer is useful for reports. The PC needs a parallel port for the connection.

Installing the WinSPM Software 2

The WinSPM software can be installed from either CD-ROM or floppy disks.

CD-ROM 2

1. Insert the CD-ROM into your CD-ROM drive.

2. From the Start menu, select Run.

3. When prompted for the file or folder you want to open, type D:\setup.exe. (If your CD-ROM 
drive is set up as a different drive letter, replace D as necessary.)

4. Installation creates a program group named “Lucent Solutions.” This group contains a folder 
titled “WinSPM,” which contains an icon titled “WinSPM.” Clicking on this icon starts the 
WinSPM application.

Floppy Disks 2

Before installing or running WinSPM, it is recommended that you make a backup copy (see your 
operating system guide) of the WinSPM disk. Store the original in a safe place. Use the backup 
copy to run the installation program.

1. Insert diskette number 1 into your 3.5” floppy disk drive.

2. From the Start Menu, click Run.

3. When prompted for the file or folder you want to open, type A:\setup.exe.

4. Insert additional diskettes when prompted to do so.

WinSPM uses Interrupt 4 and I/O address 3F8 for COM1. It uses Interrupt 3 and I/O 
address 2F8 for COM2. 
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Getting Started 2

Upon installation of the WinSPM software, the following initial screen appears:

Figure 2-1. WinSPM Main Screen

The First Time User Wizard (FTUW) assists you through the following four steps:

1. Set up your desktop:

■ Font Size Settings

■ Modem Definition

■ Setting the Start Bar “Auto Hide” Property/Changing the Screen Resolution

2. Define your Password.

3. Set up your site:

■ Direct Connection

■ Internal Connection

■ External Connection

■ Manual Connection

4. Connect to the MERLIN MAGIX Integrated System:

■ Direct Connection

■ Internal Connection

■ External Connection
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Desktop Setup 2

Font Size Settings 2

At present, WinSPM does not support large fonts. Some fonts may be virtually unusable if Large 
Fonts is selected on the settings tab of the Display Properties window. To correct this setting:

1. Anywhere on your desktop, right-click and select Properties on the pop-up menu. The Display 
Properties window appears.

2. Click the Settings tab.

3. In the Font Size field, select Small Fonts from the drop-down list box.

4. Click Apply.

5. To close the window, click OK.

Modem Definition 2

If you are using a modem to connect to a MERLIN MAGIX Integrated System, and you have set 
the Maximum Speed to above 2400 baud, the modem in the MERLIN MAGIX Integrated System 
may time-out before your modem has enough time to step down to 2400 baud and establish 
communications. For this reason, it is suggested that you use a modem definition with a Maximum 
Speed of 2400 baud. You can create a new modem definition while retaining your original, higher 
speed definition if you choose.

Modifying an Existing Modem Definition 2

If your system is dedicated for connection with WinSPM to the MERLIN MAGIX Integrated System 
for programming and the modem on that system will not be used for any other purpose, do the 
following:

1. From the desktop, click Start.

2. Go to Settings and choose Control Panel.

3. Double-click the Modems icon. A list of modems configured in the system is displayed.

4. Highlight the name of the modem that is used to connect to the MERLIN MAGIX Integrated 
System and click the Properties button.

5. On the General tab, change the value in the drop-down list under Maximum Speed to 2400.
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6. Verify the following settings:

Connection Preferences 

Data Bits: 8

Parity: None

Stop Bits: 1

[X] Wait for dial tone before dialing.

Advanced 

[X] Use Flow Control

[X] Hardware (RTS/CTS)

7. To save the new settings, click OK.

8. To close the Modem Properties dialog box, click Close.

9. From the Control Panel, click File, then choose Exit to close the Control Panel and return to 
the Windows desktop.

Adding a New Modem Definition 2

If the system you are using is not dedicated for connection with WinSPM to the MERLIN MAGIX 
Integrated System for programming and the modem on that system can be used for other 
purposes, do the following:

1. From the Windows desktop, click Start.

2. Go to Settings and choose Control Panel.

3. Double-click the Modem icon. A list of modems configured in the system is displayed.

4. Take note of the name of the modem that is currently being used in the system to make 
connection to the MERLIN MAGIX Integrated System.

5. Press the Add button. The Install New Modem Wizard appears.

6. Select the “Don’t detect my modem” check box and click Next.

7. Highlight the name of the modem manufacturer for your modem.

8. Highlight the name of your modem in the Models list and click Next.

9. Select the COM port that corresponds to the COM port used by your modem and click Next.

10. Once your modem is set up successfully, click Finish to complete the operation. The new 
modem now appears in the list of modems on the Modem Properties form (usually with the 
same name as the modem identified in Step 4) with a #2 after it.

11. Highlight the name of the new modem and click Properties.

12. On the General tab, change the value in the drop-down list under Maximum Speed to 2400.
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13. Verify the following settings:

Connection Preferences 

Data Bits: 8

Parity: None

Stop Bits: 1

[X] Wait for dialtone before dialing.

     Advanced 

[X] Use Flow Control

[X] Hardware (RTS/CTS)

14. To save the new settings, click OK.

15. To close the Modem Properties dialog box, click Close.

16. From the Control Panel, click File, then choose Exit to leave the Control Panel and return to 
the Windows desktop.

Setting the Start Bar “Auto Hide” Property/Changing the 
Screen Resolution 2

Some WinSPM screens may be difficult to use in 640x480 resolution because they use the full 
height of the screen. For this reason, you must either turn “Autohide” on for the Taskbar or 
increase your screen resolution settings. If you cannot see the OK button at the bottom of the 
screen, perform one of the following procedures.

Setting the Start Bar “Auto hide” Property 2

1. Right click an area of the Taskbar that is not a button. By default, the Taskbar is located at the 
bottom of the screen.

2. Select “Properties” from the pop-up menu.

3. On the Taskbar Properties dialog box, make sure that the “Auto hide” check box is selected.

4. Click Apply, then click OK. The Taskbar disappears. To bring up the Taskbar, simply move your 
mouse to the edge of the screen where it was previously displayed.

5. You should now be able to see the OK button. Simply click it to continue your first-time 
execution of WinSPM.

Changing the Screen Resolution 2

1. On the Taskbar, click Start.

2. Select Settings, then Control Panel.

3. Click the Display icon.

Be sure to always select the new modem from the list presented during connection to 
WinSPM.
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4. When the “Display Properties” dialog box appears, click the Settings tab.

5. Move the Desktop Area slider so that the resolution setting is higher than 640 x 480.

6. Click Apply.

7. You should now be able to see the OK button. Simply click it to continue your first-time 
execution of WinSPM.

Defining Your Password 2

There are two passwords in WinSPM: 

■ Application Password. There is an application-level password that serves as a security 
measure for accessing the WinSPM software itself. You are prompted to enter this password 
during the application login. Any characters that can be entered with the keyboard are 
acceptable. An asterisk displays for each password character entered. Since the actual 
password characters are not displayed, you are prompted to reenter your password for 
confirmation. 

■ System Password. A password is always required to establish a modem connection with the 
MERLIN MAGIX Integrated System. You can perform remote system programming only if you 
enter the correct password. (See ‘‘Password’’ on page 2-40 for details on establishing your 
system password.)

SECURITY ALERT:
■ The password characters do not appear on the screen as you type them.

■ Use a minimum of five characters.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of 
characters.

Setting Up a Site 2

To use the WinSPM software, your PC must be connected to the MERLIN MAGIX Integrated 
System directly via a serial port on your PC; otherwise you must connect to the MERLIN MAGIX 
system’s internal modem using your PC’s modem. 

Once you install WinSPM on your PC, the First-Time User Wizard guides you through setting up 
your application password and using the Site Setup option to create “sites” that correspond to the 
MERLIN MAGIX Integrated System that you are responsible for programming. Each site can be 
labeled with as much information as you need to differentiate one site from another. 
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When you set up a site, you must first determine how your PC will connect to the MERLIN MAGIX 
Integrated System you want to program. A site can have multiple connection types set up. There 
are four connection types available (setup instructions for each type are provided on pages 2-9 
through 2-12):

■ Direct Connection. A serial port on your PC is connected directly to the MERLIN MAGIX 
system programming jack—the lower modular RS-232 jack on the processor module.

■ Internal Connection. You are using a modem (either connected to or built into your PC) that 
is connected to the MERLIN MAGIX Integrated System (for example, via an 012 T/R or 016 T/
R module) to access the MERLIN MAGIX internal modem.

■ External Connection. You are using a modem (either connected to or built into your PC) and 
using a dial-up connection to access the MERLIN MAGIX internal modem. The External 
Connection type requires use of the Remote Access feature to allow you to connect to the 
MERLIN MAGIX programming port without manual intervention.

■ Manual Connection. You are using a modem (either connected to or built into your PC) and 
using a dial-up connection to access the MERLIN MAGIX internal modem. The Manual 
Connection is used when you must reach the MERLIN MAGIX programming port by placing a 
call to the site and the person who answers transfers your call to the programming port.

Direct Connection 2

To set up a site for a Direct Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the TAB key. Site Names are limited to 30 
characters. You may only use characters that are acceptable for file names in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) you may want 
to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Direct tab.

5. Select the Enabled check box. A check mark appears in the box and the COM Port drop-down 
list box is no longer grayed out.

6. Click the arrow located on the right-hand side of the COM Port drop-down list box to get a list 
of the available COM ports on your PC. Click once on the number that corresponds to the 
COM port on your PC that is connected to the MERLIN MAGIX administration port.
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7. Set the COM port speed to 2400 (most instances).

8. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site.

9. When you finish adding sites, click OK.

Internal Connection 2

To set up a site for an Internal Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may only use characters that are acceptable for file names in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) that you may 
want to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Internal tab.

5. Select the Enabled check box. A check mark appears in the box and the Dial String dialog box 
is no longer grayed out.

6. Be sure that the Dial String check box displays *10.

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site.

8. When you finish adding sites, click OK.

■ If you have multiple modems installed in your system, after clicking OK, you may 
be prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to 
either the Main screen or the First-Time User Wizard, depending on from where 
the screen was started.
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External Connection 2

To set up a site for an External Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may use only characters that are acceptable for filenames in the Windows 
environment.

3. Complete the following fields to help differentiate this site from any other site(s) that you may 
want to add. These fields are not required; therefore, you may fill in as many or as few as you 
determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the External tab.

5. Select the Enabled check box. A check mark appears in the box and the Dial String dialog box 
is no longer grayed out.

6. Edit the contents of the Dial String dialog box for the exact dial string the modem will need to 
dial to access the remote MERLIN MAGIX administration port. The dial string must include the 
Remote Access line, the barrier code (if required), and the dial code for the MERLIN MAGIX 
admin port (*10). Use commas to create necessary pauses in the dial string.

Example: You are connecting to a remote MERLIN MAGIX Integrated System via a modem 
through the Remote Access line 800 555-9999. The Remote Access line is set up with barrier 
code 1234 for access to the remote dial tone. The site from which you are dialing requires you 
to dial 9 to get an outside line. Using commas for pauses in the dial string, the dial string would 
be 918005559999,,,,,1234,*10.

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site. 

■ If you have multiple modems installed in your system, after clicking OK, you may 
be prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to 
either the Main screen or the First-Time User Wizard, depending on from where 
the screen was started.
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8. When you finish adding sites, click OK.

Manual Connection 2

To set up a site for a Manual Connection, do the following:

1. From the Site Setup screen, click Add. The cursor moves to the Site Name field.

2. Type in the Site Name you wish to use and press the Tab key. Site Names are limited to 30 
characters. You may use only characters that are acceptable for filenames in the Windows 
environment.

3. Complete the following fields to help you differentiate this site from any other site(s) that you 
may want to add. These fields are not required; therefore, you may fill in as many or as few as 
you determine necessary:

— Address

— City

— State

— Postal Code

— Country

— Contact

— Telephone

— Notes

4. Click the Manual tab.

5. Click the Enabled check box. A check mark appears in the box and the Dial String dialog box 
is no longer grayed out.

6. When you try to connect using the Manual Connection type, WinSPM displays a dialog box 
with an OK button. Place a voice call to the system on a regular line and ask the operator to 
transfer you to the MERLIN MAGIX admin port by dialing *10. When you hear the modem 
answer tone, click OK to complete the connection and then hang up the handset. 

7. If you want to add another site, click Add and begin on Step 2 in the process for the 
appropriate connection type for the next site. 

■ If you have multiple modems installed in your system, after clicking OK, you may 
be prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to 
either the Main screen or the First-Time User Wizard, depending on from where 
the screen was started.
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8. When you finish adding sites, click OK.

Connecting to a MERLIN MAGIX Integrated System 2

Direct Local Connection 2

For a direct local connection, you must connect the PC to the system programming jack. This is 
the lower modular RS-232 jack on the processor module, as shown in Figure 2-2. (The upper jack 
is reserved for the SMDR printer.) 

To connect a PC more than 50 feet from the control unit, see Figure 2-3.

For direct local connections, the system supports speeds of 1,200 and 2,400 bps.

 

Figure 2-2. Direct Connection

■ If you have multiple modems installed in your system, after clicking OK, you may 
be prompted to select the modem you want to connect with.

■ Clicking CANCEL from the Connection Selection screen causes you to return to 
either the Main screen or the First-Time User Wizard, depending on from where 
the screen was started.

■ While setting up a Manual Connection, you will also be prompted to set the 
Maximum Speed for connection. It is recommended that you select 2400.

You must use a direct local connection to program in Surrogate mode. 
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Figure 2-3. Direct Connection, PC More Than 50 Feet Away

Internal Connection 2

For an internal connection, you must use a modem (either connected to, or built into, the PC) to 
access the internal modem in the control unit. Connect the modem to a T/R jack on an 012 (T/R) or 
016 (T/R) module, or to a jack that has been programmed for T/R on an 016 ETR module in the 
control unit, as shown in Figure 2-4. 

The internal modem operates at speeds of 1200 and 2400 bps.

Figure 2-4. Internal Connection

AC Outlet

D8W

D8W

D6AP

Z3A2 ADU

EIA-232-D

DIW

102 or 103
Connecting Block

2012D-50M
Transformer

EIA-232-D

BR1A-4P Adapter
or

102 Connecting Block
or

103 Connecting Block

ADU Crossover Cable Control Unit

Processor Module

EIA
Crossover

Cable

Z3A2 ADU

SMDR
Jack
ADMIN
Jack

355AF
Adapter

8DW

or Direct Connection

Wall
Jack

Wall
Jack

4 Pair Plug
Ended Cable

Building
Wiring

or

Cable Joints

D8W

400B2
Power

Adapter

RS-232

012 (T/R)
Port

Serial
Communications
Port

MODEM



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming with WinSPM 
2-15Getting Started 

2

External Connection 2

For an external connection, you must use a modem (either connected to, or built into, the PC) to 
access the internal modem in the control unit. You must also use a dial-up connection, as shown in 
Figure 2-5. 

The internal modem operates at speeds of 1200 and 2400 bps.

Figure 2-5. External Connection
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WinSPM Main Screen 2

When you connect your PC to the MERLIN MAGIX Integrated System and start the WinSPM 
application, the WinSPM Main screen shown in Figure 2-6 appears.

Figure 2-6. WinSPM Main Screen

The Main screen icons shown on the left-hand toolbar provide the following functionalities:

■ Site Setup. Launches the Site Setup screen which depicts all of the sites defined in the 
WinSPM application. Used to set up a new site or modify an existing site. 

■ Disconnect. Disconnects you from a MERLIN MAGIX Integrated System once a connection 
has been established. 

■ Standard SPM. Launches the Standard SPM Mode.

■ Pass-Thru. This icon appears if a 100R module is installed and you are not connected using a 
Direct Connection. It will launch a terminal emulation window, allowing the user to access the 
“command line” administration of the 100R module. 

■ View. Enables you to access the Log Viewer and browse notes and reports.

■ Settings. Enables you to define password, options, and TAPT settings.

■ Tools. Enables you to access the backup, restore, and convert features.
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■ Quick Access. Enables you to access many common features including: Allowed/Disallowed 
Lists, Automatic Route Selection, Call Pickup Groups, Calling Groups, Capture Data, 
Coverage Groups, Labeling, Personal Lines, Set Date & Time, Speed Dial, System Inventory, 
Telephone Programming, Telephone Restrictions. 

Using Quick Access 2

The Quick Access interface allows you to complete common tasks in an extremely user-friendly 
manner. The Quick Access window (see Figure 2-6) displays a series of large graphic buttons 
representing each of the following supported Quick Access tasks:

— Allowed/Disallowed Lists

— Automatic Route Selection

— Call Pickup Groups

— Calling Groups

— Capture Data

— Coverage Groups

— Labeling

— Personal Lines

— Set Date and Time

— Speed Dials

— System Inventory

— Telephone Programming

— Telephone Restrictions

Descriptions of each of the Quick Access tasks are provided in the following sections.

Allowed/Disallowed Lists 2

Used in conjunction with Calling Restrictions (Outward and Toll), an Allowed List is a list of 
numbers that the caller is allowed to dial, despite restrictions. For example, an Allowed List 
assigned to an outward-restricted extension can allow calls to specific local numbers, such as 
(911) or toll numbers. For toll-restricted extensions, an assigned Allowed List can allow calls to 
specific area codes and/or exchanges needed for daily tasks.

A Disallowed List is a list of local or toll numbers that the extension user is not allowed to dial, even 
if the extension is otherwise unrestricted. Disallowed Lists can be used as an alternative to or in 
conjunction with Calling Restrictions.

For additional information on programming your MERLIN MAGIX Integrated Systems 
in Quick Access mode, refer to the documentation and online help provided with the 
WinSPM application. For information on programming your MERLIN MAGIX 
Integrated System in Standard SPM Mode, see page 2-26.
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Both Allowed Lists and Disallowed Lists are assigned to individual extensions. Disallowed Lists 
can also be used in conjunction with Remote Access to restrict calls made through the system 
from remote locations. In this case, Disallowed Lists can be assigned either to specific Remote 
Access barrier codes or (if barrier codes are not used) to specific types of lines/trunks (all Tie/
Direct Inward Dialing (DID) and all non-Tie/non-DID trunks). For more information, refer to Chapter 
3, ‘‘Allowed Lists,” and Chapter 3, ‘‘Disallowed Lists.”

Automatic Route Selection (ARS) 2

ARS allows outgoing calls to be dynamically routed over selected facilities after dialing an ARS 
access code. This enables the system to select the least expensive route for each call. ARS is 
available only in Hybrid/PBX mode.

Programmable lists, called tables, indicate the desired routes (line/trunk facilities) for specified 
area codes and/or exchanges. There is a different ARS table for each type of call (local, toll, 
special number, and so on). The tables are chosen according to the telephone number digits that 
are dialed by a user. Each ARS table has a particular pool to which it routes calls. For more 
information, refer to Chapter 3, ‘‘Pickup Groups.”

Call Pickup Groups 2

An extension that is a member of a Call Pickup Group can program a button on the telephone or 
dial a feature code to pick up a call ringing on the telephone of any other member extension in that 
group. There is a limit of 30 groups with15 extensions per group. An extension may be a member 
of only one Pickup Group. For more information, refer to Chapter 3, ‘‘Automatic Route Selection.”

Call Pickup Groups contain the following:

■ Available Extensions. The list of extensions in the system. Double-click or use the right-
arrow button to move extensions into the Selected Extension.

■ Selected Extensions. The list of extensions that are members of the Call Pickup Group that 
is selected with the tabs. Double-click or use the right-arrow button to remove extensions to 
the Available Extensions. Note that this list is limited to 15 extensions per group.

■ Group Number. Select the Call Pickup Group to display its members in the Selected 
Extensions list box.

Calling Group 2

This feature is used to define the extensions that are members of a Calling Group, and to assign 
the lines/trunks pools that you want to ring directly into this Calling Group. 

From the Calling Group Quick Access screen, you pick the Calling Group you wish to modify by 
highlighting it. There are seven tabs able to be modified for each Calling Group. These are: 
General, Primary Delay, Overflow, Queue, Members, Lines & Pools, and Coverage.
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■ General:

— Group Type. Choose from the drop-down list box.

— Hunt Type. Allows you to specify whether the Hunt Type is circular, linear, or most 
available. Choose from the drop-down list box.

— Secondary Delay Announcement. Select from the drop-down list box the extension to 
be used as a secondary delay announcement.

— Delay Interval. Select an interval from 0-900 seconds for the secondary delay.

— Delay Announce Repeat. Select Yes or No if you wish the secondary delay.

— Message Waiting Receiver Extension. Select the extension at which you wish to light a 
message waiting light if the group is covered by a voice mail box.

■ Primary Delay: 

— Select the extensions you want to provide primary delay announcements for the chosen 
Calling Group.

■ Overflow:

— Overflow Coverage Calling Group Number or QCC LDN extension. From the drop-
down list box, choose a Calling Group or the QCC queue that you want to provide 
overflow coverage for this Calling Group.

— Overflow Threshold (Calls). Choose the number of calls (1-99) that are allowed to stay 
“queued” in this Calling Group before “overflowing.”

— Overflow Threshold Time (seconds). Choose the number of seconds (0-900) the oldest 
waiting call must wait before overflowing.

— Prompt-Based Overflow. Choose Yes or No to allow or disallow a waiting caller the 
ability to press the pound (#) key on their telephone to initiate overflow.

■ Queue:

— Calls In Queue Alarm Thresholds (seconds). For each choice, choose the flash rate 
interval. for example:

■ If the number of waiting calls is fewer than the value programmed for Threshold 1 or 
drops below that level, the LED is unlit.

■ If the number of waiting calls is greater than or equal to the Threshold 1 value, but less 
than the Threshold 2 value, the LED flashes.

■ If the number of waiting calls is greater than or equal to the Threshold 2 value, but 
fewer than the value for Threshold 3, the LED winks.

■ If the number of waiting calls is greater than or equal to the highest value, Threshold 
3, the LED lights steadily. 

An external alert only signals when the number of calls in the queue is greater than or 
equal to the programmed Threshold 3 value.

— External Alert for calls in Queue Alarm. Choose the adjunct extension associated with 
the external alert device. There are two choices:

■ An LED on any 4400-Series or MLX telephones can be associated with a Calls-in-
Queue Alarm button.
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■ An external alert on an MLX telephone using a Multi-Function Module set for 
Supplemental Alert Adapter operation and programmed as the alert.

— Queue Control. Choose the number of calls (0-99) allowed to back up in queue before 
sending a network busy signal.

■ Members: 

— Choose extensions from the list to place them into the selected Calling Group. Note that 
only the extensions for the tip/ring ports associated with a voice messaging system may 
be in VMI Calling Groups; there is a system maximum of 20 VMI Calling Groups, and any 
one Calling Group may have a maximum of 20 members. An extension may be a member 
of only one Calling Group.

— Using the Non-Local UDP button, extensions defined in the Non-Local UDP ranges can be 
added as a member of a Calling Group. When added to a group, the single non-local 
extension can be the ONLY member of the group. If there are already “local” members in 
the group when you attempt to add the Non-Local Extension, you are asked if you want 
them removed (WinSPM handles the removal).

Capture Data 2

This feature allows you to read from MERLIN MAGIX in one large batch. This is useful if you are 
setting up MERLIN MAGIX for the first time or if you are making significant changes. Capture Data 
reads all of the data needed for each selected Quick Access form.

■ Task Selection. Check the items that you want to read from the MERLIN MAGIX system. 
Some of the items are for the whole Quick Access form, some are broken down into the 
individual tabs that appear on the Quick Access forms. As you check/uncheck items, the 
estimated number of minutes for completion changes to give you a “best guess” as to how 
long the reading will take.

■ Baseline Values. These values help calculate the estimated number of minutes for 
completion. Some of these values will be changed to the correct values if the data has been 
retrieved. Other values need to be entered manually. These values are not retained after the 
Capture Data form is closed.

Coverage Groups 2

This feature is used to assign or remove an extension from a Coverage Group. A Coverage Group 
is a group of senders. Group Coverage is an arrangement where calls from a group of senders are 
redirected to one or more receivers. For more information, refer to Chapter 3, ‘‘Group Coverage 
Member Assignments.”

Coverage Groups include the following:

■ Available Extensions. The list of extensions in the system. Double-click or use the right-
arrow to move extensions into the Selected Extensions.
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■ Selected Extensions. The list of extensions that are members of the Coverage Group that is 
selected with the tabs. Double-click or use the right-arrow to remove extensions to the 
Available Extensions.

■ Group Number. Select the Calling Group Number to display its members in the Selected 
Extensions list box.

Labeling 2

This feature allows you to edit the various system labels. System Speed Dial changes are 
performed separately. A simple dialog box containing the following fields is available.

■ Label Type. A group of options including: System Directory, Extensions, Adjuncts, Lines and 
Trunks, Posted Messages, and Group Calling. Select the type for which you want to edit 
labels.

■ Entry Number. This field prompt changes to reflect the option you selected for Label Types. 
Use this field to select the extension number, line, trunk, posted message, or Calling Group 
that you want to change.

■ Name. Text for this label. Different label types are limited to different string lengths—for 
example, extensions and Calling Groups are limited to 7 characters.

Personal Lines 2

This feature allows you to add lines and pools to buttons on a telephone.

CAUTION:
After you click the Apply button, you will be able to see where the lines and pools were 
placed on the telephone. Keep in mind that adding a line that is a member of a pool results in 
a pool being assigned to the button on the telephone. You cannot assign the same line or 
pool to more than one button on the telephone twice. Also remember that lines and pools are 
added on the buttons immediately following the System Access buttons and overwrites any 
other feature programmed to those buttons.

All labels are always printed in capital letters, exactly as they appear on the MERLIN 
MAGIX display telephones.

By default, each added line or pool is programmed on available successive buttons 
starting with the lowest button on the telephone, and overwrites any programming that 
may already exist on these buttons. 
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Set Date and Time 2

This feature sets the current time and date on the MERLIN MAGIX Integrated System. The dialog 
box contains the following:

■ The PC’s date and time.

■ The MERLIN MAGIX system date and time, which can be edited and applied back to the 
MERLIN MAGIX system.

■ A Synchronize button that will give you the ability to set the MERLIN MAGIX system date and 
time to match the PC’s.

■ An OK button that applies any changes you made to the MERLIN MAGIX system date and 
time.

Speed Dial 2

This feature allows you to modify System Speed Dial entries. It consists of a simple display grid 
containing the following:

■ Speed Dial Code. A number field defining the system speed dial code (in the range of 600 to 
729).

■ Company/Name. A description of the directory entry.

■ Number. The number to dial.

■ Display Number. Select Yes to display the Name when dialing; select No to display the 
number being dialed.

Use the following buttons to edit the System Speed Dial entries:

■ Add. Adds a new entry.

■ Modify. Modifies an existing entry.

■ Delete. Removes an existing entry.

System Inventory 2

This feature offers a report on the MERLIN MAGIX Integrated System hardware configuration. 
Starting with the processor (installed in slot zero), it obtains the characteristics of the hardware 
components available in each slot in the MERLIN MAGIX system carrier.

By default, the Hardware Inventory screen lists the Board Type, Hardware Vintage, Firmware 
Vintage, and Application Vintage of each available control unit module (scroll down for more). To 
quickly obtain the specifications of a given module, click the module’s image. To obtain a total 
report, click the corresponding Print button.
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Use the Print button to view the printed report on the screen (Print Preview). You can either print a 
paper copy of the report or save the report to a file.

Telephone Programming 2

Telephone programming allows the centralized programming of a subscriber’s telephone. When 
you select this feature, a window is displayed containing the following elements:

■ A list of extensions, labels (if read), and logical IDs. To sort this list, click the arrow on the 
header bar for the column you want to sort by.

■ Notes window. Use this window to create or edit annotations.

■ OK button. Highlight the extension you wish to program and click OK. (Double-click the 
extension to go to the next screen.)

■ Print button. Use this button to print the list of extensions, labels, and LIDs.

■ Cancel button. Use this button to cancel and return to the previous menu.

■ Help button. Use this button to display Help information.

Telephone Restrictions 2

This feature is used to configure Calling Restrictions for an extension. Calling Restrictions include 
extension restrictions, Automatic Route Selection (ARS) restriction level, and Forced Account 
Entry. This feature is also used to assign Allowed Lists and Disallowed Lists to an extension.

This feature includes the following:

■ Authorization Code. Enter a unique 2 to 11-digit Access code for this extension. (Optional)

■ Restriction Level. Select Unrestricted, Outward Restrict, or Toll Restrict.

■ Facility Restriction Levels. Select ARS restriction level (0-6).

■ Delayed Call Forwarding Rings. Select the number of rings (0-9) before a call is forwarded 
using the Forward or Follow Me Feature.

■ Allow Trunk-to-Trunk Transfers. If checked, the extension user must enter an account code 
before making an outside call.

■ Remote Call Forwarding. Allows the extension user to forward all calls to an outside 
telephone number.

■ Pool Dial-Out Codes. The list of trunk pools that the extension user is allowed to use to make 
outside calls. A list box appears, plus two buttons (>>> and <<<). To add pools, highlight the 
pool dial-out code in the Available box and then click the >>> button. To remove pools, 
highlight one or more in the Selected list box and then click the <<< button.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming with WinSPM 
2-24Using Quick Access 

2

■ Allowed Lists. Use to assign one or more Assigned Lists to the extension. Use the Allowed 
List tab to view the current extensions in that list. Use the ‘Is User’ check box to add/remove 
the selected extension from the lists. Allowed List defines area codes and exchange prefixes 
that this extension user is allowed to dial when making an outside call.

■ Disallowed Lists. Use to assign one or more Unassigned Lists to the extension. Use the 
allowed list tab to view the current extensions in that list. Use the ‘Is User’ check box to add/
remove the selected extension from the lists. Disallowed List defines area codes and 
exchange prefixes that this extension user is not allowed to dial when making an outside call.

■ Show Number List. If checked, the Allowed or Disallowed List is read from the MERLIN 
MAGIX system and displayed for the currently selected Allowed/Disallowed List.

■ The Standard SPM Mode Interface must be used to define Night Service 
Coverage.

■ Automatic Route Selection (ARS) allows outgoing calls to be dynamically routed 
over selected facilities after dialing an ARS access code (usually 9). This enables 
the MERLIN MAGIX Integrated System to select the least expensive route for 
each call based on the area code and prefix that the extension user dials.
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WinSPM Help 2

To access the WinSPM Help screens, perform one of the following:

■ Press �.

■ Press 7/R.

■ Click the Help button (when available).

Figure 2-7. Sample WinSPM Help Screen
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Using Standard SPM Mode 2

This section describes how to use the Standard SPM Mode screens.

SPM Screens 2

Standard SPM Mode screens simulate the system programming console. Each Standard SPM 
Mode screen includes a 7-line by 24-character console simulation window that corresponds to the 
display area of the MLX-20L or 4424LD+ telephone. To the right and left of this console simulation 
window are columns that list the keys corresponding to similarly located buttons on the MLX-20L 
or 4424LD+ telephone. Figure 2-8 illustrates the Standard SPM Mode display screen.

Figure 2-8. Standard SPM Mode Display

� through � and � through � display on either side of the console simulation screen. They 
represent the function keys to use when you select screen options. When a screen contains 
several choices, click the function key identified by the label next to your choice. (If you were 
programming on the console, you would press the telephone button next to your choice.)

If you are using Quick Access, Backup and Restore can be selected from the Main menu. 
The System Inventory option in the Quick Access mode provides a graphical 
representation of your system inventory, which includes all modules and versions. All of 
the options listed above are available in the Standard SPM Mode. For additional 
information on using Quick Access, refer to the documentation and online Help provided 
with WinSPM. 
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Below the console simulation window are 20 simulated line buttons. The 20 line buttons can be 
selected by clicking on the appropriate button. By clicking � (the Inspect feature), you can 
determine the status of each line and the features programmed on each line according to the letter 
that appears next to the line number. 

The labels along the bottom of the screen correspond to buttons on the 4424LD+ or MLX-20L 
telephone. Table 2-1 describes the function of PC keys in WinSPM.

Table 2-1. Function of PC Keys in WinSPM

PC Key MLX-20L 4424LD+ WinSPM Function

Home Home Exit Quit. Exit from WinSPM when you finish with 
system programming. If you are using a 
modem, the call is disconnected.

End Menu Menu Return to the WinSPM Main menu.

PgUp More > Display more menu items (when there is 
another screen and the > symbol appears next 
to the key).

PgDn Inspct (MLX- 
20-L only)

Display the current information that has been 
programmed for a feature or button. (There is 
no fixed Inspct button on the 4424LD+ console. 
This button must be programmed onto a feature 
key on the 4424LD+ console.)

Drop Drop Drop Enter a stop in a speed-dialing sequence. This 
combination also deletes an entry in a field on 
any screen, except the one in which you are 
entering a speed-dialing sequence. 

Flash Conf Conf Flash. Enter a switchhook flash in a speed-
dialing sequence.

TopSP n/a n/a TopSP. Return to the top of the System 
Programming menu.

Pause Hold Hold Pause. Enter a pause in a speed-dialing 
sequence.

Toggle n/a n/a Toggle modem speed between 1200 and 
2400 bps.

Help n/a n/a Help. Display a Help screen about WinSPM 
operations. 

Reset n/a n/a Reset. Reset the communications port. For 
example, if the information on the screen is 
garbled, try exiting from and then re-entering 
the screen. If the screen remains garbled, use 
<+� to clear the screen and return to the 
WinSPM Welcome screen. Note that using 
<+� drops the modem connection.
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Basic System Management Procedures 2

This section demonstrates how to complete the following procedures using WinSPM operating in 
Standard Mode or the WinSPM menu:

■ Backup

■ Boards

■ Browse

■ Language

■ Maintenance

■ Monitor

■ Pass-Thru

■ Password

■ Print Options

■ Restore

■ System Programming

Browse n/a n/a Browse. View print reports saved with Print 
Opts.

Enter Enter Enter The 1 key on your PC can be used 
instead of � when Enter appears as a choice 
in the console simulation window.

Bksp Backspace Backspace The 3 key on your PC can be used instead of 
� (Backspace) when Backspace appears as 
a choice in the console simulation window.

Del Delete Delete The 9 key on your PC can be used instead of 

 (Delete) when Delete appears as a choice 
in the console simulation window.

� # 

� � 

n/a n/a The up, down, left, and right arrow keys can be 
used to highlight selections in a menu and to 
select the 20 line buttons below the console 
simulation window.

Table 2-1. Function of PC Keys in WinSPM — Continued

PC Key MLX-20L 4424LD+ WinSPM Function
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Table 2-2 gives a brief description of each procedure. 

The Backup procedure is used by qualified service personnel to create a file of system 
programming information either in a specified directory (on the hard drive of the PC) or on a floppy 
disk. 

Table 2-2. Management Procedures 

 Option Function

Sys Program To program the system.

Backup1 

1 WinSPM option only. Not available on the system programming console. To be used only by qualified service 
personnel.

Backup 1

To make a backup copy of your system programming and store it on a floppy 
disk or on hard disk.

Boards1 To show which modules (port boards) are in each slot of the control unit and 
allows you to assign boards to slots.

Print Opts1 To direct reports to printer or to the PC for storage on a floppy disk or on hard 
disk.

Monitor Restricted to use by your technical support organization.

Maintenance Restricted to use by your technical support organization and qualified 
technicians.

Restore1 To restore your system programming from floppy disk or from hard disk.

Pass-Thru (IS II/III and 100R only) To make a remote connection, through the control 
unit, to a 100R module or IS II/III PC to program applications on the IS II/III 
PC.

Password To change the password for remote entry into the system

Language To select a language (U.S. English, Canadian French, or Latin American 
Spanish) for the console simulation window on the PC. (There is also a 
Language option available on the System Programming menu that allows you 
to set the System Language.)

Back up your system programming information on a regular basis. A current backup file 
allows you to quickly and easily restore your system, if the need arises.
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Considerations 2

Review the following items before you begin the backup procedure:

■ The system does not have to be idle during backup; however, extension programming is 
blocked.

■ Any objects that are in a maintenance-busy state are stored in that state. When you restore 
system programming, these objects are busied out, even if they have since been released 
from the maintenance-busy state.

■ If you plan to store your backup file on a floppy disk, format a DOS disk.

■ Uncompressed backup files are 100,000 to 210,000 bytes in size; compressed files are about 
70,000 to 85,000 bytes. 

■ Maintenance data (error logs and other data used by qualified service technicians) is not 
saved in the backup file.

To perform the backup procedure, follow the steps below:

Standard SPM �→Select GOTO FLOPPY or GOTO HARD 
DISK→1→Specify default filename or Make new
file name→1→ *2to continue or 0 to abort→0 to abort or 
1%to return to the Standard SPM Main menu

WinSPM 

1. From the WinSPM Main window Outlook bar, select Tools.

2. From the Outlook bar, click the Backup icon.

A selection dialog box displays.

3. Select the File option.

4. Click Ok.
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The Save dialog box displays.

5. Enter the name and location of the file to be saved.

6. Click Save. 

The progress dialog box displays.

7. Click Cancel to exit.

Boards 2

The Boards option allows qualified service personnel to add a board to the next available slot. The 
system must be idle to use this option. This option is not available from the system programming 
console.

The Boards option is also available in Surrogate mode. In Surrogate mode, you can assign trunk 
and extension modules (boards) to slots, even though the boards have not actually been installed. 
This type of board is referred to as a “phantom” or “null” board.

You cannot use the Boards option to change an actual board type. All boards assigned with the 
Boards option, including phantom boards, are cleared (unassigned) if you perform a board 
renumber (System→Board Renum).

■ You must assign phantom boards to higher slot numbers than those you assign to any real 
boards. If you assign a phantom board to a lower slot number than a real board, the control 
unit does not recognize the real board or boards that follow the phantom board.
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■ If you remove a board but do not replace it, and then perform a board renumber, the control 
unit will not recognize any boards that follow the empty slot. You must reseat all of the boards 
to fill the empty slot before you perform the board renumber.

The Inspect function (�) lets you see which modules have been assigned to slots on the control 
unit. Note that both phantom boards and real boards display if you use the Inspect feature. 
Table 2-3 shows the type of boards that you can select. To see only real board assignments, you 
must print the System Information report: System→More→Print→SysSet-up.

Table 2-3. Board Types

Board Type Description

412LUP 4 loop-start line jacks and 12 digital extension jacks with 4 Touch-Tone 
Receivers; Caller ID

024UPO 24 digital extension jacks

016MLX 16 MLX extension jacks (32 endpoints); upgradable with PCMCIA card

008MLX 8 MLX extension jacks (16 endpoints)

016ETR 16 ETR extension jacks including 6 with tip/ring functionality with 4 Touch-
Tone Receivers 

016TRR 16 tip/ring extension jacks with 4 Touch-Tone Receivers

MsgOPT 008 OPT - 8 tip/ring extension jacks with 2 Touch-Tone Receivers

or

MERLIN Messaging - 7 internal tip/ring extension jacks with 2 Touch-Tone 
Receivers; MERLIN Messaging System resides on this module

100D 24 channels (“virtual” lines/trunks); upgradable with PCMCIA card

800BRI 8 BRI facilities 

408GLM 4 ground-start/loop-start line jacks and 8 MLX extension jacks (16 
endpoints); Caller ID; Upgradable with PCMCIA card

100R 24 channels (virtual lines/trunks) with internal CSU/DSU; upgradable with 
PCMCIA card

800DID 8 DID line jacks.

800LID 8 loop-start line jacks, Caller ID.

400E&M 4 tie trunks
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Follow the steps below to assign modules:

1. At the Standard SPM Mode Main menu, click � to select Boards.

2. Click the function key that corresponds to the module you want to select.

3. If the module you want to assign is not shown on the first screen of the Boards menu, click 
� to display the next menu screen.

4. Type the control unit slot number (01 through 17) in which the module is to be installed.

   SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

Boards:                >

Make a selection

412LUP 016ETR

024UPO 016TTR

016MLX MsgOPT

008MLX 100D

Back 800BRI

Boards:                

Make a selection

408GLM 400E&M

100R

800DID

800LID

Back

module name module name = option selected in Step 2
Enter slot numbers

(01–17)

 Delete

Backspace Next

Back Enter
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5. Assign or remove the module from the slot entered in the previous Step.

■ To remove the module type from the specified slot number, click 
 (Delete). The 
Boards menu reappears.

■ To assign the module type to the specified slot number and assign that same module type 
to another slot, click � (Next).

■ To assign the module type to the specified slot number and assign a different module type 
to another slot, click � (Enter).

■ To terminate the procedure and assign a different module, click � (Back) and repeat 
Steps 2 through 4.

■ To view types of modules assigned to all slots, click � (Inspect).

6. To save your entry, click � (Back).

The programming session terminates and the system restarts.

Browse 2

The Browse option allows you to browse through reports and notes saved in WinSPM.

Standard SPM <
→Select hard disk or floppy→�→Select a Report→ 
�→ 02to Exit

 To view the next page of a report, click �.

To view the previous page of a report, click �.

To return to the beginning of a report, click �.

module name module name = option selected in Step 2
Enter slot numbers

(01–17) nn = slot entered in Step 5 (second digit will 
not display. 

nn 

 Delete

Backspace Next

Back Enter
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WinSPM 

1. From the WinSPM Main window Outlook bar, select View.

2. From the Outlook bar, click the Browse Notes & Reports icon.

The Browse Notes & Reports dialog box displays.

3. From the Type field, select whether you want to view reports or notes.

4. From the drop-down list, select the report/notes you want to view.

5. Click Print to print the report to your default printer.

or 

Click Export.

The Save dialog box displays.
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6. Enter the name and location of the file to be saved.

7. Click Save.

8. Click Close to exit the Browse Notes and Reports dialog box.

Language 2

A Language attribute in WinSPM specifies whether WinSPM menus, pop-up windows, and other 
messages are presented in U.S. English, Canadian French, or Latin American Spanish. A Second 
Language selection option affects messages from the control unit to WinSPM, and controls the 
display on the console simulation window for the duration of the session. These two language 
options operate independently of each other.

The following discussion refers to the console window language.

Console Window Language 2

By default, the language used in the console simulation window is the language specified in the 
ams.cfg file; however, you can select a different language for this window for the duration of the 
current session. 

To select a different language for the current session, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Language.

2. Click the function key that corresponds to your language selection.

The Display Language screen reappears with the language you selected.

3. Click � (Back) to return to the Standard SPM Mode Main menu or select another language.

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language 

Display Language

Make a Selection:

English

French

Spanish

Back 
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Maintenance 2

CAUTION:
This option is for use by qualified technicians only. Maintenance procedures are provided in 
the documentation for qualified technicians. See ‘‘Related Documents’’ on page xxiv.

CAUTION:
This is a password-protected option and is for use by your technical support organization 
only.

Pass-Thru 2

The Pass-Thru option allows qualified service personnel to program IS II/III1 applications (and a 
100R module) on a remote PC. It permits you to establish a remote connection with the control unit 
to which the IS II/III PC is directly connected. Figure 2-9 illustrates the relationship of the SPM PC, 
the system control unit, and the IS II/III PC.

Figure 2-9. Pass-Thru

A Pass-Thru request must be initiated at a PC; it is not available from a UNIX System PC—that is, 
Pass-Thru cannot be established between two IS II/III PCs. The local admin PC must be in an idle 
state.

A Pass-Thru request to a locally connected IS II/III system causes the modem to fall back to 1200 
bps if the speed is set to 2400 bps and the modem call to the control unit is at 1200 bps. If 
necessary, the system adjusts its speed to that of the local SPM PC.

1 Can no longer be ordered.

SPM PC

Control Unit
IS II/III PC

Direct 
Connection

Remote
Connection
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Once the Pass-Thru connection is established, you can program in any of the following IS II/III 
applications from your SPM PC:

■ AUDIX Voice Power®1

■ Call Accounting System1

■ Fax Attendant System (IS III only)

■ CONVERSANT Intro (IS III only)

To initiate the Pass-Thru, follow the steps below:

1. At the SPM Main menu, click 
 to select Pass-Thru.

1 Can be ordered only as an upgrade to existing CAS installations.

You cannot program the SPM application on the IS II/III PC because the remote call (from 
your SPM PC) uses the IS II/III PC’s COM1 port; therefore, the system programming jack 
cannot be used for system programming. For the same reason, a user at the IS II/III PC 
end of the connection cannot use SPM while your Pass-Thru is in effect. If use of SPM is 
attempted, the user at the IS II/III end sees the following message:

PRE-EMPT IN PROGRESS
Please try again. 

To initiate Pass-Thru, establish a modem connection between the SPM PC and the 
control unit.

If the IS II/III PC does not respond to the Pass-Thru request from the control unit (for 
example, because the PC is turned off), you see the following message:

Pass-thru failed.
Please try again. 

If the connection between the control unit and the IS II/III PC fails, the connection 
between the control unit and the SPM PC is dropped. You see the following message:

Pass-through Session
unexpectedly terminated.
Please press Enter
to continue. 

When you press 1, you return to the SPM Main menu.

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru 

Print Opts Password

Monitor Language
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The display area changes to 24-lines by 80-characters, which is much larger than the display 
area on the console simulation window (7-lines by 24-characters).

2. Type your login name, and click 1.

3. Type the IS II/III password, and press 1.

4. Type ams for the terminal emulation type, and press 1.

■ If you are working with IS II, the IS II Main menu appears.

■ If you are working with IS III, the system prompts you for your login registration. After you 
enter your login and press 1, the IS III Main menu appears.

5. To exit from IS II/III programming, click � (Back).

The system prompts you for confirmation that you want to exit. After confirmation, the following 
message appears:

Welcome to IS-II/III

login:

Password:

Unix disk usage

information

Term=

Returning to SPM
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Password 2

The Password option is used by qualified service personnel to change the modem connection 
password. A password is always required to establish a connection with the built-in modem. The 
password always consists of seven characters. You can perform remote system programming only 
if you enter the password correctly. A default password is set at the factory. You must obtain this 
password from your system consultant (SC).

To change the modem connection password, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Password.

2. Type the old (current) password. Do not press 1.

If you type the old password incorrectly, the bottom of the screen displays the message, Not 
Equal. Repeat Step 2.

If you fail to enter the password correctly after three attempts, the bottom of the screen 
displays the message Old Password in Use, and the procedure terminates. Press 1 
to return to the Standard SPM Mode Main menu.

3. Type the new password (any seven characters). Do not press 1

  SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password 

Monitor Language

Password:

Enter Old Password

Password

Enter New Password
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SECURITY ALERT:
■ The password does not appear on the screen as you type it.

■ Always use the longest length password allowed on the system.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of 
characters.

4. Type the new password again. Do not press 1.

5. To return to the Standard SPM Mode Main menu, click �%(Back).

Print Options 2

The Print Opts option allows qualified service personnel to direct the output of system 
programming reports either to the PC (where you can save them, browse through them, or print 
them with the system programming Print option) or to the SMDR printer. 

To direct the output of the system programming reports, follow the steps below:

1. At the Standard SPM Mode Main menu, click � to select Print Opts.

2. Select the target device for the reports.

Password

Enter New Password again

New Password in use

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

Printer Options

Make a selection

SMDR Port

PC Port

Back
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3. To return to the Standard SPM Mode Main menu, click �%(Back).

SMDR Port Output 2

See ‘‘Printing System Reports’’ on page 3-201 for more information about the print procedure 
using the system console and the SMDR port.

PC Port Output 2

See ‘‘Printing Reports’’ on page 2-48 for more information about the print procedure using 
WinSPM and the PC port. 

Restore 2

The Restore option allows qualified service personnel to load system programming from either a 
disk or from the hard disk into the processor module memory.

This procedure is used either to program a new system if a disk was created through surrogate 
mode programming, or to restore information (using a backup disk) lost through system failure. It is 
also part of the upgrade procedure.

Considerations 2

Review the following items before you begin the restore procedure:

■ The system will be forced idle during a restore procedure.

■ You must have a backup file containing system programming before you use this procedure. 
See ‘‘Management Procedures’’ on page 2-29.

■ Features that were not programmed when the backup file was created are reset to factory 
settings.

■ The data restored reflects the number of extensions and lines available on the system at the 
time the backup was created. The remaining extensions and lines are set to the factory 
settings that are initialized during a Restart (cold start).

■ Restore is terminated under the following conditions:

— If fewer boards are listed on the backup disk than on the control unit.

— If any real board is out of sequence with the boards listed on the backup disk.

— If phantom boards are not listed last.

— If the operating mode of the system being restored is Hybrid/PBX, but the control unit 
processor module has been modified to operate only in Key mode.

■ A successful restore is followed automatically by a Restart (cold start).
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WARNING:

An unsuccessful or terminated restore results in a System Erase (frigid start). All calls 
are dropped. The system configuration is erased. All system programming is lost and the 
system returns to the factory settings. If the restore is being done remotely, the 
connection is dropped immediately. If this happens, attempt to reconnect to the control 
unit and immediately perform another restore. If this is not successful, programming 
must be restored on site. 

Standard SPM 	→Select Restore→Select hard disk or 
floppy→�→Select a file→1→<� to abort→1

WinSPM 

1. From the WinSPM Main window Outlook bar, select Tools.

2. From the Outlook bar, click the Restore icon.

A selection dialog box displays.

3. Select the File option.

4. Click Ok.

The Restore dialog box displays.

5. Enter the name and location of the file to be restored.

6. Click Open. 
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The progress dialog box displays.

7. Click Cancel to exit.

System Programming 2

A primary function of WinSPM is to provide a method for programming the system. The Sys 
Program option gives you access to all of the system programming features available from the 
system programming console. 

Basic Programming Information 2

To begin programming, you must perform one of the following to display the System Programming 
menu on the MLX-20L or 4424LD+ console, or on the PC:

In most cases, you can click � (Back) to exit from a screen without making any changes. 
Exceptions to this are noted as part of a procedure. When you complete a procedure and click � 
(Back), you usually move up one screen in the menu hierarchy. Occasionally, when you click � 
(Back), you return to the previous screen. In a few cases, clicking � (Back) brings you back to 
the System Programming menu, where you can select another option to program or exit from 
system programming.

To complete a procedure and save the information you have programmed, click � (Enter).

If you are programming a group of sequentially numbered extensions or trunks, you may have the 
option of clicking 
 (Next). This saves your entry and automatically provides the number of the 
next extension or trunk in the sequence, thus saving you a couple of steps. If Next displays on the 
screen, you can use it with the current option.

In most cases, you will be at an intermediate step in the procedure you have just completed. At 
that point, you can select one of the options shown on the screen and continue programming, or 
you can click � (Back) again. This usually takes you back to the System Programming menu. If 
not, you again can continue programming on the current screen or click � (Back) again. 

On the console: Menu→Sys Program →Back 
On the PC: Type spm →1→Press any key→�→� 
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Idle States 2

A few of the programming procedures can be started only when the entire system or some part of 
it, such as a trunk or an extension, is idle (not in use). Some procedures require that the trunk or 
extension be idle only at the instant of programming. Other procedures, which take longer, require 
the system, trunk, or extension to be forced to remain idle until programming is completed. These 
procedures wait for the system, trunk, or extension to become idle and then prevent the initiation 
of any new calls. This condition is called forced idle.

If a procedure requires that the system be in an idle state and the system is busy when you begin, 
the screen shown below displays.

The screen changes to the appropriate programming screen when the system is no longer busy.

System Forced Idle 2

When the entire system is forced idle, no calls can be made or received. The procedures listed 
below can be performed only when the entire system (every line and every extension) is idle:

■ Select system mode

■ Identify system operator positions

■ Renumber boards

■ Renumber system

■ Restore system programming information

■ Identify the Music-On-Hold jack

■ Program T/R on an 016 ETR module

When the system is forced idle, the following occurs: multiline telephone users hear a reminder 
tone that indicates the telephone cannot be used; display telephone users see the message 
Wait: System Busy; single-line telephone users do not hear a dial tone.

If a procedure requires an idle condition, perform the programming outside of normal 
business hours.

System Busy   Pls Wait

 

Dial Code:    nnnn 

Slot/Port:    ss/pp 

Exit 
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Line or Trunk Idle 2

Since these procedures require the line or trunk to be idle only at the instant of programming, the 
line or trunk is not forced idle. The following procedures can be performed only when the line or 
trunk being programmed is idle:

■ Identify loudspeaker paging line jack

■ Assign trunks to pools

■ Specify incoming or outgoing DID- or tie-trunk type

■ Specify tie-trunk direction

■ Specify tie-trunk E&M signal

Extension Forced Idle 2

When an extension is forced idle, no calls can be made or received on that extension. The 
following procedures can be performed only when the extension being programmed is idle:

■ Assign call restrictions

■ Assign pool dial-out restrictions

■ Copy extension assignments

■ Assign lines, trunks, or pools to extensions

■ Assign labels to a personal directory

■ Use centralized telephone programming

When the extension is forced idle, the following occurs: multiline telephone users hear a reminder 
tone that indicates the telephone cannot be used; display telephone users see the message 
Wait: System Busy; single-line telephone users do not hear a dial tone.

Forced Idle Reminder Tone 2

The forced idle reminder tone is a high-low “door-telephone” tone → 400 ms of 667 Hz tone 
followed by 400 ms of 571 Hz tone. The tone is provided under the following circumstances:

■ At the extension, to remind the user that the system or the extension is in the forced idle state.

■ At the programming console or at a PC running WinSPM, to remind the System Manager that 
the system (or at least one extension) is in the forced idle state because of administrative 
activity.

Forced idle reminder tones occur every 20 seconds. You can adjust the volume of these tones with 
the volume control on the system console or PC.
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100D and 100R Module Idle 2

The following procedures can be performed only when the 100D or 100R module is idle:

■ Specify board type

■ Specify frame format

■ Specify board signaling format

■ Specify board suppression format

■ Specify board facility compensation

Accessing System Programming 2

Follow the steps below to access system programming.

1. At the Standard SPM Mode Main menu, click � to select Sys Program.

2. Click the function key next to the option you want.

3. If the option you want does not appear on the first screen of the System Programming menu, 
click �%to display the second screen of the menu.

    SPM Main Menu

Menu: Select Function

Sys Program Maintenance

Backup Restore

Boards Pass-Thru

Print Opts Password

Monitor Language

System Programming:    > System Programming:    >

Make a selection Make a selection

� System Extensions � � Labeling Language � 
� SysRenumber Options 	 � Data

� Operator Tables 
 � Print

� LinesTrunks AuxEquip � � Cntr-Prg

� Back NightSrvce � � Exit
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Printing Reports 2

Use the following procedure to print system reports using WinSPM at the PC. The WinSPM Print 
Opts must be set to PC Port. See ‘‘Print Options’’ on page 2-41 for details about setting the printer 
output port.

1. At the second page of the System Programming menu, click � to select Print.

2. Click the function key that corresponds to the report to be printed.

3. Use one of the methods shown after this procedure to print the report or reports.

4. View the print status screen.

To interrupt printing and return to the Standard SPM Mode Main menu, press �.

System Programming:    >

Make a selection

Labeling

Data

Print 

Cntr-Prg

Back

Print (English):      >

Make a selection

All Trunk Info

SysSet-up T1 Info

Dial Plan Pri Info

Labels RmoteAccess

Back Oper Info

LPT1:

Please enter file name GOTO FLOPPY

to store print
(default is print.ams)

MAKE NEW FILE
PRINT.AMS

Press Esc to Abort.

Print in Progress ...

Back
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Print Hard Copy 2

To print a hardcopy of the report, use the arrow keys to highlight LPT1: 
and press 1.

Print to Hard Disk 2

To print the reports to the hard disk if the print file does not exist, use the arrow keys to highlight 
MAKE NEW FILE and press 1.

■ To save to the default print filename (print.ams), press 1.

■ To save to the filename of your choice, type [filename] and press 1.

To print the reports to the hard disk if the print file already exists, use the arrow keys to highlight 
the filename and press 1.

Print to Floppy Disk 2

Use the arrow keys to highlight GOTO FLOPPY: and press 1. Use one of the methods shown 
below.

■ To print the reports to a floppy disk if the print file does not exist, use the arrow keys to 
highlight MAKE NEW FILE and press 1.

— To save to the default print filename (print.ams), press 1.

— To save to the filename of your choice, type [filename] and press 1.

■ To print the reports to a floppy disk if the print file already exists, use the arrow keys to 
highlight the filename and press 1.

Surrogate Mode Programming 2

Surrogate mode allows qualified service personnel to perform system programming at an offsite 
service location. The actual system hardware does not have to be installed — the programmer 
needs a power supply, carrier, processor, and a direct connection from the PC to the processor 
module. By following a customer’s set of completed planning forms, the system can be 
programmed as if the appropriate modules, trunks, telephones, and other communications 
equipment have been installed. When system programming is completed, a system backup is 
performed to save the information on disk. This backup disk is then taken to the new installation 
site and used with the Restore option to provide complete system programming for a new system.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming with WinSPM 
2-50Surrogate Mode Programming 

2



Programming Procedures 
3-1Overview 

3

MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

3Programming Procedures 3

Overview 3

This chapter contains all of the procedures required for programming each of the features and 
options that is available for the MERLIN MAGIX Integrated System. 

Each of the procedures begins at the System Programming menu. Use one of the methods shown 
below to display the System Programming menu.

■ At the console: Menu→Sys Program→Back 

■ At a PC with WinSPM using Standard SPM Mode, do the following:

1. On your desktop, double-click the WinSPM icon. (Depending on options selected during 
installation, you might select WinSPM from your Start Menu or Lucent Solutions folder.)

2. Enter your user name and password, then click OK. The WinSPM main screen appears. 

3. On the toolbar on the left side of the WinSPM main screen, click the Connect button. The 
Connection Selection screen appears. 

4. From the Connection Selection screen, click the site name for the site you want to connect 
to.

5. Click the Connection Type for the session, then click OK.

6. On the toolbar on the left side of the WinSPM main screen, click the Standard SPM icon. 
The system programming console appears in the emulation window.

7. Click �, then �.

Before you begin any of the procedures in this chapter, you should read and understand all of the 
information presented in Chapter 1, ‘‘Programming Basics.” 

Basic System Operating Conditions 3

The procedures in this section are all related to the system, rather than to the operation of 
telephones, operator positions, lines, or trunks. These are operating conditions that must be set 
only once—when the system is new or when you reset the factory settings. 

You must reset the system time when Daylight Savings Time begins and ends.
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This section contains the following programming procedures:

■ System Restart

■ System Programming Position Assignment

■ System Language

■ Board Renumbering

■ Mode of Operation

■ Automatic Maintenance Busy

■ System Date

■ System Time

System Restart 3

CAUTION:
This procedure is to be performed by qualified support personnel only.

Use this procedure to perform a System Restart (cold start). All calls are dropped when you 
perform this procedure. Existing system programming is saved. Telephones with the Extension 
Status feature may lose Toll Restrictions as a result of a System Restart.

Summary: System Restart 3

Programmable by Qualified support personnel

Mode All

Idle Condition Not required

Planning Form Not applicable

Factory Setting None

Valid Entries None

Inspect No

Copy Option No

Console Procedure System→Restart→Yes 

PC Procedure �→�→� 
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System Programming Position Assignment 3

Use this procedure to reassign the extension used for system programming. This extension should 
not be the same extension used for the operator position. The system programming position can 
be reassigned only to one of the first five extension jacks on the first TDL Module if you are using a 
4424LD+ telephone, or the first MLX Module if you are using a MLX-20L telephone. Only one 
system programming console is allowed per system.

If you are programming on the 4424LD+ or MLX-20L console, be aware of the following:

■ The console must be connected to the extension currently assigned for system programming.

■ As soon as you change the system programming extension, the system programming session 
is terminated. To proceed with system programming, you must connect the system 
programming console to the newly assigned extension and enter system programming again.

Summary: System Programming Position Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting First extension jack on the first TDL module if you are using a 
4424LD+ telephone, or the MLX module if you are using a MLX-20L 
telephone (also set as an operator position)

Valid Entries Extension number of one of the first five extension jacks on the first 
TDL or MLX module

Inspect No

Copy Option No

Console Procedure System→SProg Port→Drop→Dial ext. no.→ Enter→Back 

PC Procedure �→�→ →Type ext. no.→�→� 

System Language 3

Your system offers you a choice of three languages (U.S. English, Canadian French, and Latin 
American Spanish) for the following options:

■ System Language. For system programming.

■ Station Message Detail Recording (SMDR) Reports. See ‘‘SMDR Language’’ on page 
3-154.

■ Print Reports. See ‘‘Report Language’’ on page 3-200.

■ Extensions. See ‘‘Optional Extension Features’’ on page 3-103.

*XUV
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Use this procedure to set the system language. See the sections listed above to set a different 
language for SMDR reports and print reports, as well as for 4400-Series or MLX display 
telephones.

Summary: System Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English

Valid Entries U.S. English, Canadian French, Latin American Spanish

Inspect No

Copy Option No

Console Procedure More→Language→SystemLang→Yes→
Select a language (English, French, or Spanish)→Enter 

PC Procedure �→�→�→�→Select a language (English, French, or 
Spanish)→� 

Board Renumbering 3

CAUTION:
This procedure is to be performed by qualified support personnel only.

Use this procedure to renumber boards that have already been installed. This procedure restarts 
the system (system programming is not lost). Note that this is not the same procedure used with 
the Boards option, which is available to qualified service personnel with WinSPM only. 

Board Renumbering is a system programming procedure that is required only when an existing 
module is replaced by a different type of module. When a Board Renumbering is performed, the 
system reassigns the logical ID numbers to the extension and line ports sequentially from left to 
right in the control unit and from bottom to top of each module. 
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Summary: Board Renumbering 3

Programmable by Qualified support personnel only

Mode All

Idle Condition System idle

Planning Form Not applicable

Factory Setting None

Valid Entries Not applicable

Inspect Not applicable

Copy Option Not applicable

Console Procedure System→Board Renum→Yes 

PC Procedure �→�→� 

Mode of Operation 3

The system mode—Key, Behind Switch, or Hybrid/PBX—determines how the system operates 
and directly affects the following operations:

■ How lines and/or trunks are provided to users

■ Types of operator consoles allowed

■ Features available

Changing this option causes a system restart and terminates the programming session. You must 
enter system programming again to program other features.

The following options cannot be programmed for Behind Switch or Key systems:

■ Automatic Route Selection (ARS)

■ Pools

■ Queued Call Consoles (QCCs) and associated features

■ Direct Inward Dialing (DID) Trunks

■ System Access buttons

■ Dial Plan Routing (PRI)

■ Call-by-Call Services (PRI)

The Ground-Start lines/trunks option cannot be programmed if the processor module has been 
modified for Permanent Key mode operation only.

The Hybrid/PBX option is not available if the control unit processor module has been 
modified to operate in Permanent Key mode only. See the Feature Reference for more 
information.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-6Basic System Operating Conditions 

3

Summary: Mode of Operation 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 1, System Planning

Factory Setting Hybrid/PBX

Valid Entries Key, Behind Switch, Hybrid/PBX

Inspect No

Copy Option No

Console Procedure System→Mode→Select mode (Key, Behind Switch, or Hybrid/
PBX)→Enter 

PC Procedure �→�→Select mode (Key, Behind Switch, or Hybrid/PBX)→� 

Automatic Maintenance Busy 3

Automatic Maintenance Busy allows the system to take a malfunctioning trunk out of service for 
outgoing calls (incoming calls are never blocked). This prevents faulty outside facilities from 
causing disruptions in outgoing calling patterns.

For optimal performance, enable Automatic Maintenance Busy for Hybrid/PBX systems with 
pooled trunks.

Summary: Automatic Maintenance Busy 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting Disabled

Valid Entries Enabled, Disabled

Inspect No

Copy Option No

No more than half of the trunks in a trunk pool are allowed to be placed in the 
Maintenance Busy state at one time, unless the central office has failed to disconnect a 
trunk (which prevents anyone from using that trunk) or an entire trunk module is manually 
taken out of use (a Maintenance-Busy state deliberately caused by the user).
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Console Procedure To disable Automatic Maintenance Busy:
System→MaintenBusy→Disable→Enter→
Back 

To enable Automatic Maintenance Busy 
excluding tie trunks: 
System→MaintenBusy→Enable→Enter→Back

To enable/disable with tie trunks:
System→MaintenBusy→Enable→Enter→
Enable or Disable→Enter→Back 

PC Procedure To disable Automatic Maintenance Busy:
�→�→�→�→� 

To enable Automatic Maintenance Busy excluding tie trunks:
�→�→�→�→� 

To enable/disable with tie trunks:
�→�→�→�→Enable or Disable→�→� 

Set System Date 3

The System Date feature allows you to set the month, day, and year that appear on 4400-Series 
and MLX display telephones as well as on Station Message Detail Recording (SMDR) reports.

Summary: Set System Date 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting 01-01-00

■ If you plan to use the SMDR feature, make sure the current date is set.

■ Where a MERLIN MAGIX Integrated System is networked in a private network 
with one or more MERLIN MAGIX Integrated Systems, with one or more MERLIN 
LEGEND Systems 6.0 or later, or with one or more DEFINITY Communications 
Systems, SMDR reports may report outgoing calls using more than one call 
record (for example, for tandem calls), depending upon how SMDR is 
programmed and how calls are routed. Therefore, if SMDR is reporting outgoing 
calls and users are employing private network lines to make these calls, ensure 
that the system date and time are set accurately on each system that carries 
these calls. As you examine call reports, you may need to be aware of time zone 
differences among networked system locations.
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Valid Entries Month: 01 to 12
Day: 01 to 31
Year: 00 to 99

Inspect No

Copy Option No

Console Procedure System→Date→Drop→Dial current date (Month: 01–12; 
Day: 01–31; Year: 00–99)→Enter→Back 

 PC Procedure �→	→ →Type current date (Month: 01–12; 
Day: 01–31; Year: 00–99)→�→� 

Set System Time 3

Summary: Set System Time 3

Programmable by System Manager

Mode All

Idle Condition Not Required

Planning Form 1, System Planning

Factory Setting 0000

Valid Entries 0000 to 2359

Inspect No

Copy Option No

■ The System Time feature allows you to set the time that appears on 4400-Series, MLX, 
ETR, and MLS display telephones and on SMDR reports.

■ If you are planning to use the SMDR feature, make sure the system time is set 
accurately. If you change the system time while the system is in Night Service mode, 
Night Service is deactivated and must be manually reactivated. If you have installed 
applications such as MERLIN Messaging or Intuity AUDIX, you may need to set the 
time in the applications software whenever you reset the system time.

■ When a MERLIN MAGIX Integrated System is networked in a private network with one 
or more MERLIN MAGIX Integrated Systems, with one or more MERLIN LEGEND 
Systems 6.0 or later, or with one or more DEFINITY Communications Systems, SMDR 
reports may report outgoing calls using more than one call record (especially for 
tandem calls), depending upon how SMDR is programmed and how calls are routed. 
Therefore, ensure that the system date and time are set accurately on each system 
that carries these calls. When you examine records for network calls, you may need to 
be aware of time zone differences among different system locations.

*XUV
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Console Procedure System→Time→Drop→Dial current time (0000–2359)→ 
Enter→Back 

PC Procedure �→
→ →Type current time (0000–2359)→�→� 

System Renumbering 3

The procedures in this section are used to assign the 2-digit, 3-digit, and Set-Up-Space numbering 
plans for the local MERLIN MAGIX Integrated System. 

Do not attempt to assign a numbering plan without Planning Forms 2a, System Numbering: 
Extension Jacks; 2b, System Numbering: Digital Adjuncts; and 2d, System Numbering: Special 
Renumbers. Form 6a, Optional Operator Features, is needed to assign a DSS Page button. This 
section contains the following programming procedures:

■ Select System Numbering Plan

■ Single Renumbering

■ Block Renumbering

■ Non-Local Dial Plan Numbering

■ Direct Station Selector (DSS) Page Button Assignment

For the local system, you then select only one of the numbering plans (2-digit numbering, 3-digit 
numbering, or Set-Up-Space numbering). In addition, you may need to perform single and/or block 
renumbering. You do not need to assign DSS Page buttons unless the system programming 
console or one of the operator positions is connected to a DSS. No matter which procedures you 
need to perform, assign the numbering plan first, then do single and/or block renumbering, and 
finally, assign DSS Page buttons (if necessary).

You may choose non-local dial plan numbering to specify the numbering of extensions connected 
to remote private network systems and to allow users on your system to access those extensions 
as if they were connected to your own system. You specify only ranges of extensions.

Use the single renumbering procedure whenever the extension numbers you are changing from or 
to are not sequential.

Block renumbering is quicker, but you can use block renumbering only when the extension 
numbers you are changing from and to are sequential.

When trunk or extension modules are removed from the control unit, the remaining modules must 
be rearranged so that no empty slots remain. The system does not acknowledge any modules 
installed after an empty slot; therefore, if the system is renumbered, extensions are not assigned 
to extension jacks after the empty slots.

Refer to the Network Reference for information on private networking and non-local dial 
plan numbering.

*XUV
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Figure 3-1. 2-Digit Numbering

Figure 3-1, Figure 3-2, and Figure 3-3 show the factory settings in the gray spaces. 
Extensions can be renumbered to any number shown in the white spaces.

0 Operator Console (not flexible) 0
1 Extensions 10–19 
2 Extensions 20–29 
3 Extensions 30–39 
4 Extensions 40–49 
5 Extensions 50–59 
6 Extensions 

60–66

Extra Extensions 

6700–6842 6843–6849

Extra 4400-
Series 

Adjuncts/
MFMs/ 

Terminal 
Adapters

6850–6992 6993–6999
7 Main Pool

70

Adjuncts

710–766 767– 769

Calling Groups

770–791,7920–7929

Paging Groups 

793–799
8

8001

1 LDN (QCC Queue)

Lines/Trunks 

801–880

Park

881–888 8892

2 Remote Access

Pools

 890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9
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Figure 3-2. 3-Digit Numbering

Figure 3-3. Set-Up-Space Numbering

0 Operator Console (not flexible) 0
1 Extensions 100–199
2 Extensions 200–299
3 4400-Series/MLX Adjuncts 300–399
4 4400-Series/MLX Adjuncts 400–499
5 500–599
6 600–699
7 Main Pool 

70 71–76

Calling Groups

770–791, 7920–7929

Paging 
Groups

793–799
8

8001

1 LDN (QCC Queue)

Lines/Trunks

801–880

Park

881–888 8892

2 Remote Access

Pools

890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9

0 Operator Console (not flexible) 0
1 100–199
2 200–299
3 300–399
4 400–499
5 500–599
6 600–699
7 Main Pool

70

Extensions

7100–7299

4400-Series/
MLX Adjuncts

7300–7499

7500–7699 Calling Groups

770–791,
7920–7929

Paging 
Groups

793–799
8 8001

1 LDN (QCC Queue)

Lines/Trunks

801–880

Park

881–888

8892

2 Remote Access

Pools

890–899
9 ARS Access (Hybrid/PBX mode)/Idle Line Access 9
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Select System Numbering Plan 3

WARNING:

To avoid possible loss of system programming information, renumber the system before you 
program the rest of the options described in this chapter.

The three available local system numbering plans listed below appear on System Planning Form 
2a.

■ Two-Digit. This plan is for systems with fewer than 50 extensions and no plans to exceed that 
number in the foreseeable future. Each of the first 58 extension jacks is assigned a 2-digit 
extension number, beginning with 10 and ending with 67. Any remaining extensions are 
assigned 4-digit numbers, starting with 6700 and ending with 6842.

■ Three-Digit. This plan is for systems with 50 or more extensions or plans to grow to that 
number in the foreseeable future. All extensions are assigned a 3-digit number, starting with 
100 and ending with 299.

■ Set-Up-Space. This plan is for systems with a need to customize extension numbers or use 
extension numbers of varying lengths (one to four digits). All extensions are assigned 4-digit 
numbers in the 7000 range. Extension numbers 1000–6999 are also available for use when 
you renumber.

In all three local numbering plans, the system assigns 3-digit extension numbers to pools (Hybrid/
PBX only), Calling Groups, Paging Groups, Remote Access codes, the Listed Directory Number, 
park codes, and Idle Line Access (Key and Behind Switch modes). In addition, the system assigns 
9 for Automatic Route Selection (Hybrid/PBX only) and Idle Line Access (Key and Behind Switch 
only). Zero (0) represents a special extension number—actually a fixed dial code—for the primary 
operator or QCC queue. Any extension number except 0 can be renumbered.

Extension numbers can be composed of any combination of digits; however, no number can begin 
with 0. Trunk numbers (801–880) are considered to be extensions and can be renumbered.

The system does not provide a message to indicate a successful renumber when either the 2-digit 
or 3-digit numbering plan is selected. For the Set-Up-Space numbering plan, the system provides 
a message indicating that all extensions are in the 7000 range.

CAUTION:
Select Back on the console, or click%� on the PC display, when you have finished selecting 
the numbering plan. If you press Exit (4424LD+ console) or Home (MLX-20L console), 
extensions may remain in the forced idle condition (indicated when the LED next to each 
DSS button is on). To restore extensions to their normal operating state, restart the system.
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Summary: Select System Numbering Plan 3

Programmable by System Manager

Mode All 

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting 2-Digit

Valid Entries 2-Digit, 3-Digit, SetUp-Space

Inspect No

Copy Option No

Console Procedure SysRenumber→Default Numbering→ Select numbering plan
(2-Digit, 3-Digit, SetUp-Space)→Back→Back 

PC Procedure �→�→Select numbering plan (2-Digit, 3-Digit, SetUp-Space)→ 
�→� 

Single Renumbering 3

Use this procedure to assign a specified extension number to a telephone, accessory, line, pool 
(Hybrid/PBX only), Calling Group, Paging Group, or Listed Directory Number. Single renumbering 
is also used for Remote Access, Park, Idle Line Access (Key and Behind Switch only), and 
Automatic Route Selection (Hybrid/PBX only).

CAUTION:
Select Back on the console, or click � on the PC display, after renumbering extensions. If 
you press Exit (4424LD+ console) or Home (MLX-20L console), extensions may remain in 
the forced idle condition (indicated when the LED next to each DSS button is on). To restore 
extensions to their normal operating state, restart the system.

When required, this procedure should be performed immediately following the selection of a 
system numbering plan.

Summary: Single Renumbering 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers

Factory Setting Not applicable

Valid Entries Old and new extension numbers
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Inspect Yes

Copy Option No

Console Procedure SysRenumber→Single→Select item→Dial old ext. no.→
Enter→Dial new ext. no.→Enter→Back→Back 

PC Procedure �→�→Select item→Type old ext. no.→�→
Type new ext. no.→�→�→� 

Block Renumbering 3

Use this procedure to assign extension numbers to a group of extensions, accessories, or lines. 
Both the original numbers and the numbers they are being changed to must be sequentially 
numbered.

When required, this procedure should be performed immediately following the selection of a 
system numbering plan.

CAUTION:
Select Back on the console, or click � on the PC display, when you have finished 
renumbering extensions. If you press Exit (4424LD+ console) or Home (MLX-20L console), 
extensions may remain in the forced idle condition (indicated when the LED next to each 
DSS button is on). To restore extensions to their normal operating state, restart the system.

Summary: Block Renumbering 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers

Factory Setting Not applicable

Valid Entries Old and new extension numbers

Inspect Yes

Copy Option Yes

Console Procedure SysRenumber→Block→Select type of group→
Dial no. of first group member→Enter→
Dial no. of last group member→Enter→Dial new beginning no.→ 
Enter→Back→Back→Back

PC Procedure �→�→Select type of group→Type no. of first group 
member→�→Type no. of last group member →�→
Type new beginning no.→�→�→�→� 
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Non-Local Dial Plan Extension Ranges 3

The System Manager can enter ranges of extensions for non-local systems networked to the local 
MERLIN MAGIX Integrated System. The process does not affect programming on non-local 
systems, each system must be individually programmed.

The maximum number of digits (1 to 11) the user can enter to reach an extension on the non-local 
system is specified for each non-local dial plan extension range. This accelerates dialing by 
allowing call processing to act immediately when the number of digits entered equals the number 
specified.

This topic describes the following procedures:

■ Specifying new extension number ranges

■ Deleting extension number ranges 

The extension ranges you enter using this procedure are the numbers that users on your system 
dial in order to make calls to users on the non-local system. Users select a System Access (SA) 
button and dial these calls in the same way that they dial inside calls on your local system. In most 
cases they should be the same numbers that users in the non-local system dial to reach one 
another. Numbering must be planned to avoid conflicts and provide unambiguous extension 
numbers across private networks.

Non-local dial plan calls are routed over pools of private trunks using UDP routing. Maintaining 
existing dial plans when systems are connected in a private network may not be possible due to 
ambiguity or when one system’s dial plan changes. UDP routing using digit absorption and digit 
prepending, which allow dialed numbers to be modified before they are actually sent to the remote 
system, may help to minimize changes. However, this will quickly increase dial plan complexity for 
private network UDP calls and can affect Centralized Voice Messaging operation. Therefore, these 
techniques should not be used except in special cases for non-local private network UDP calls. 
Deleting and prepending digits are very useful methods and are easily set up for routing non-local 
dial plan calls over the PSTN, if necessary. For additional information about UDP routing, see 
‘‘Uniform Dial Plan Routing’’ on page 3-186. 

It is recommended that all extensions in a range be of the same length to help minimize 
call processing times. For private networks that include Centralized Voice Messaging, it is 
recommended that all extensions in the private network be of the same length. See the 
Network Reference for additional considerations.
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WARNING:

Use extreme caution when employing the Default Numbering option of System 
Renumbering. Any numbering you have entered is erased and the system numbering is set 
to factory settings.

Specifying New Extension Ranges 3

This procedure verifies that extension numbers on the local system do not conflict with those on a 
non-local private network switch. For example, if Extension 110 exists in the local system, 
Extension 1100 cannot exist on a non-local system. It also checks to see whether new extension 
number ranges conflict with existing ranges set for the non-local system.

MERLIN MAGIX Integrated System non-local dial plan numbering supports extensions up to 4 
digits in length (2-, 3-, or 4-digit dial plans), while DEFINITY Communications Systems have 5-digit 
extension numbers. There are two methods you can use to number DEFINITY non-local dial plan 
ranges. 

Choose one of the following techniques, depending upon the actual extension numbers you are 
entering in ranges and potential conflicts:

■ Specify ranges that include the first four digits in the extension numbers. Each number you 
enter in the procedure represents 10 numbers in the remote system. For example, an 
extension range entered as 4321 through 4322 represents remote extensions 43210 through 
43220. Users actually dial five digits. The local system recognizes the number range by the 
first four digits. Program the number of dial digits to 5.

■ Enter the last four digits and use UDP routing to prepend the first digit in the DEFINITY 
extension number. The local system recognizes the number range using the last four digits. 
Users dial only the last four digits. This method must be used for DID trunks that terminate on 
a MERLIN MAGIX system which have numbers in the DID range that terminate on a 
DEFINITY System. For details about UDP routing, see ‘‘Uniform Dial Plan Routing’’ on page 
3-186. Program the number of dial digits to 4.

An extension range may stipulate a single extension number.

Renumbering of non-local extensions does not require putting those extensions in the forced-idle 
condition on the remote system.

■ The Default Numbering option of System Renumbering renumbers local system 
extensions only. It also removes the local system’s non-local dial plan entries.

■ Non-local dial plan ranges on local systems should be large enough to minimize 
range renumbering when a remote system changes. When the numbering of a 
remote system changes, the System Manager should check the new external 
numbers and ascertain their impact on the non-local dial plan numbers accessed 
using this procedure, then make changes manually.
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The pattern number specified in this procedure creates an index into a group of routes that are 
used to connect to the non-local dial plan extensions. More than one range of extensions can use 
the same pattern number. UDP routes within a pattern are assigned pools, routes, and other 
attributes. For more information, see ‘‘Uniform Dial Plan Routing’’ on page 3-186.

SECURITY ALERT:
Do not program the remote system ARS access code into the non-local dial plan. To do so 
will allow unauthorized calling over remote system facilities. If the local system interprets the 
number as an extension on the remote system, no ARS restriction checking is performed 
locally. Remote systems normally do not perform ARS restriction checking.

Summary: Specifying New Extension Ranges 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition None

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers
Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting Not applicable

Valid Entries Starting and ending numbers for old and new extension ranges

Ranges 50

Inspect Yes, existing number ranges

Copy Option No

Console Procedure SysRenumber→NonLocal UDP→Dial no. of first extension in 
range→Enter→Dial no. of last extension in range→Enter→
Dial max. no. of digits user can enter to reach an extension in the 
range (1–11)→Enter→Dial no. of pattern for extension range→
Enter→Back→Back 

PC Procedure �→�→Type no. of first extension in range→�→ 
Type no. of last extension in range→�→Type max. no. of digits 
user can enter to reach an extension in the range (1–11)→ 
�→Type no. of pattern for extension range→ �→�→� 

Deleting Extension Ranges 3

This procedure deletes the numbering for specified extension ranges of a non-local system and 
can be used, for example, to prepare for renumbering local or remote system extensions.
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Summary: Deleting Extension Ranges 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition None

Planning Form 2a, System Numbering: Extension Jacks
2b, System Numbering: Digital Adjuncts
2d, System Numbering: Special Renumbers
Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting Not applicable

Valid Entries Starting numbers for extension ranges to be deleted

Inspect Yes: existing number ranges

Copy Option No

Console Procedure SysRenumber→NonLocal UDP→Dial no. of first extension in 
range→Enter→DelRange→Back→ Back 

PC Procedure �→�→Type no. of first extension in range→�→
→�→
� 

Direct Station Selector (DSS) Page Buttons 3

Use this procedure to set the three Page buttons on the DSS to correspond to the system 
numbering plan. This procedure assigns extension numbers to DSS buttons. The procedure is the 
same for MLX DSS and DSS 4450 when used with 4424LD+ and 4424D+ telephones. You cannot 
program individual buttons on a DSS; this is the only method for programming DSS buttons.

Page button assignment should be sequential. If only one DSS is attached, each Page button 
assignment sets the console for a range of 50 extension numbers: Page 1: 0 to 49; Page 2: 50 to 
99; Page 3: 100 to 149.

If two DSSs are attached, each Page button assignment sets the console for a range of 100 
extension numbers. If two DSSs are attached to the console, change the factory setting so that the 
difference between extension numbers assigned to the range is at least 100. For example, assign 
Page 1 to begin with extension 10, Page 2 to begin with extension 110, and Page 3 to begin with 
extension 210.

Operator Park Zone codes must be included in the extension number range specified for one of 
the Page buttons.
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CAUTION:
Select Back on the console, or click � on the PC display, when you have finished this 
procedure. If you press Exit (4424LD+ console) or Home (MLX-20L console), extensions 
may remain in the forced idle condition (the LED next to each DSS button is on), and the 
system may have to be restarted.

Summary: Assign Direct Station Selector Page Buttons 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting Page 1=0; Page 2=50; Page 3=100

Valid Entries 1, 2, 3

Inspect Yes

Copy Option No

Console Procedure SysRenumber→Single→More→DSS Buttons→ 
Dial page no. (1–3)→Enter→Dial first ext. no.→ Enter→Back→
Back 

PC Procedure �→�→�→�→Type page no. (1–3)→�→
Type first ext. no.→�→�→� 

System Operator Positions 3

A system operator position, for a Queued Call Console (QCC) operator or a Direct-Line Console 
(DLC) operator, should be programmed before you program lines or trunks.

Use the following procedures to add an operator position or change an existing operator position. 

The QCC operator position is available only for Hybrid/PBX systems. The DLC operator position is 
available in any mode and must be programmed if you have Call Management Systems 
connected to any operator extension jacks.
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Table 3-1 shows the maximum number of operator positions allowed for any one system.

Any combination of operator positions can be assigned as long as no more than four operator 
positions are QCCs and the total number of operator positions does not exceed eight.

If you want to designate a new operator position and the system already has the maximum 
number of operator positions, you must change an existing operator position to a nonoperator 
position before you designate a new operator position.

Primary Operator Positions 3

The primary operator position is the extension to which your call is directed when 0 is dialed on a 
System Access button. The first extension jack on the first TDL or MLX module in your system is 
assigned as the primary operator position. If your system has QCC operator positions, this position 
must be changed from the factory setting (DLC) to a QCC operator position. (The primary operator 
extension cannot be changed from the first extension on the first TDL or MLX module.)

QCC System Operator Positions 3

This procedure applies to Hybrid/PBX systems only. Note that both QCC and DLC operator 
positions can be assigned with this procedure, although its primary purpose is to assign QCC 
operator positions.

Table 3-1. Maximum Number of Operator Positions

Position Type Type of Telephone Maximum Positions

QCC 4424LD+

MLX-20L

4

DLC 4424D+

4424LD+

MLX-20L 

MLX-28D

8

Total QCC + DLC 8

When you change an extension to an operator position, or vice versa, the system returns 
the port (extension jack) type of that extension to the factory setting. You must reprogram 
lines and any features for that telephone or console. You may also need to change any 
attached accessory equipment and optional features.
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QCC operators serve as central answering positions for all incoming calls. Incoming calls are held 
in the QCC queue and are directed to each QCC operator in a prioritized sequence. The calls are 
received one at a time, regardless of the number of incoming calls to the system.

Additional QCC operator positions can be assigned only to the first and fifth extension jacks of the 
412 LS-ID-TDL, 008 MLX, or 408 GS/LS-ID-MLX modules. You can also assign QCC operator 
positions to the first, fifth, thirteenth, and seventeenth extension jacks of the 024 TDL modules or 
to the first, fifth, ninth, and thirteenth extension jacks of the 016 MLX modules. A maximum of four 
QCC operator positions can be assigned. Use this procedure to specify QCC operator positions 
that serve as central answering positions for all incoming calls.

Summary: QCC Operator Positions 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Type: DLC

Valid Entries First or fifth extension jack on the 412 LS-ID-TDL, 008 MLX, or 
408 GS/LS-ID-MLX modules (maximum: two per module; four QCCs 
per system).
First, fifth, thirteenth, or seventeenth extension jack on an 024 TDL 
module.
First, fifth, ninth, or thirteenth extension jack on an 016 MLX module.

Inspect Yes

Copy Option No

Console Procedure Operator→Positions→Queued Call→Dial ext. no.→ 
Enter or Delete→Store All 

PC Procedure �→�→�→Type ext. no.→� or 
→� 

If you want to add or remove QCC operator positions, the following conditions apply:

■ If other QCC positions remain in your system, the primary QCC operator position 
cannot be removed.

■ When QCC operator positions are added, the primary QCC operator position should be 
the first one added.

■ If QCC operator positions are being removed, the primary QCC operator position must 
be the last one removed.
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DLC Operator Positions 3

DLC operator positions can be assigned to the first and fifth extension jacks on the first 412 LS-ID-
TDL, 008 MLX, or 408 GS/LS-ID-MLX modules with extension jacks. You also can assign DLC 
operator positions to the first, fifth, thirteenth, or seventeenth extension jacks on the 024 module or 
to the first, fifth, ninth, and thirteenth extensions jacks on the 016 MLX modules. A maximum of 
eight DLC operator positions can be assigned. Any combination of operator positions can be 
assigned as long as there are no more than four QCC operator positions and no more than a total 
of eight operator positions.

Use this procedure to specify extensions that serve as central answering positions for all incoming 
calls or as Calling Group supervisor extensions. (You do not need to use this procedure in a Key or 
Behind Switch system unless you have more than one DLC position.) For a new system, remove 
the factory-set DLC operator position assignment for any telephone not used as an operator 
position.

Lines and trunks are assigned to individual buttons.

Summary: Identify or Remove DLC Operator Positions 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Type: DLC

Valid Entries First or fifth extension jack on the 412 LS-ID-TDL, 008 MLX, or 408 
GS/LS-ID-MLX modules (maximum: two per module; eight DLCs per 
system).
First, fifth, thirteenth, or seventeenth extension jack on an 024 TDL 
module
First, fifth, ninth, or thirteenth extension jack on the 016 MLX module.

Inspect Yes

Copy Option No

Console Procedure Operator→Positions→Direct Line→Dial ext. no.→ 
Enter or Delete→Store All 

PC Procedure �→�→�→Type ext. no.→� or 
→� 
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Lines and Trunks 3

The procedures in this section are used to assign optional features to individual lines and trunks. 
The following optional features can be assigned:

■ Type of Trunk

■ Outmode Signaling for Loop- or Ground-Start Trunks

■ Rotary Trunk Digit Transfer

■ Disconnect Signaling Reliability

■ Toll Type

■ Hold Disconnect Interval

■ Principal User for Personal Line

■ QCC Queue Priority

■ QCC Operator to Receive Calls

■ Incoming Call Line Identification Delay

■ Trunks to Pools Assignment

The Copy Options feature (described at the end of this section) allows you to copy several optional 
features from an idle trunk. This option eliminates the need to individually enter each feature.

Separate sections cover ‘‘DS1 Facilities,” ‘‘Tie Trunks,” ‘‘Block Assignment,” ‘‘PRI Facilities,” and 
‘‘BRI Facilities.”

A slot is the physical location of the individual module on the control unit. There is a maximum of 
17 slots, which are numbered as follows:

■ Basic carrier: slots 1 through 5

■ First expansion carrier: slots 6 through 11

■ Second expansion carrier: slots 12 through 17

A port is a line or trunk jack on the module. Individual modules support different numbers of ports. 
On any module, port 1 is the lowest physical jack position. For modules with both line and 
extension jacks, the port numbers for the line jacks follow the numbers for the extension jacks 
instead of beginning with 1. For example, for a 408 LS-ID-MLS module, the port numbers for the 
extension jacks are 01 through 08 and the port numbers for the line jacks are 09 through 12. 
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Type of Trunk 3

Use this procedure to specify the type of trunk, loop-start (LS) or ground-start (GS), for each 
outside trunk connected to one of the following modules:

■ 412 LS-ID-TDL

■ 408 GS/LS-ID-MLX

■ 800 GS/LS-ID (loop-start trunks only)

Any combination of trunk types (all loop-start, all ground-start, or some of each) is permissible.

This procedure is not used for a system registered with a KF registration number (Key or Behind 
Switch). Ground-start trunks are allowed only for systems with an MF (Hybrid) or PF (PBX) 
registration number.

Summary: Type of Trunk 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting All Loop-Start

Valid Entries All Ground, All Loop, Ground-Start, Loop-Start

Inspect Yes

Copy Option Yes

Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→ Enter→
Select trunk type (all ground, all loop, ground-start, or loop-start)→
Dial port no.→ Enter→Back→Back 

PC Procedure �→�→Type slot no. (1–17)→�→Select trunk type (all 
ground, all loop, ground-start, or loop-start)→Type port no.→�→
�→� 

Outmode Signaling for Loop- or 
Ground-Start Trunks 3

Use this procedure to identify either touch-tone signaling or rotary-dial signaling for outgoing calls 
placed by using the specified loop- or ground-start trunk.

Since the factory setting is Touch-Tone, this procedure is not required if your system has 
only Touch-Tone lines/trunks.
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Summary: Outmode Signaling for Loop- or
Ground-Start Trunks 3

Programmable by System Manager

Mode Loop-Start: All; Ground-Start: Hybrid/PBX only

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Touch-Tone

Valid Entries Touch-Tone, Rotary

Inspect No

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→TT/LS Disc→Outmode→
Select entry mode (Touch-Tone or rotary)→Dial no. of line/trunk→
Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→TT/LS Disc→OutMode→
Select block of lines/trunks→Toggle LED On/Off→
Enter or Delete→Back→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→� (Touch-Tone or rotary)→
Type no. of the line/trunk→� or 
→�→�→� 

To program a block of lines/trunks:
�→�→�→Select block of lines/trunks→
Toggle letter G On/Off→� or%
→�→�→� 

Rotary Trunk Digit Transfer 3

Use this procedure to designate whether dialed digits on rotary-dial lines/trunks are sent one by 
one as they are dialed (no delay), or are stored and sent when dialing is completed (delay). 
Contact your service provider for more information about the appropriate setting.

Summary: Rotary Trunk Digit Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 8a, System Features

Factory Setting No Delay

Valid Entries Delay, No Delay
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Inspect No

Copy Option No

Console Procedure Options→More→Rotary→Select option (Delay or No Delay)→ 
Enter→Back 

PC Procedure 	→�→�→Select option (Delay or No Delay)→�→� 

Ringing Frequency 3

Use this procedure to program the ringing frequency on an 016 (T/R) module. Contact your service 
provider for more information about the appropriate setting. 

Summary: Ringing Frequency 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Form 8a, System Features

Factory Setting 20 Hz

Valid Entries 20 Hz, 25 Hz

Inspect No

Copy Option No

Console Procedure Options→More→Ringing Freq→Dial slot no. (1–17)→
Select 20Hz or 25Hz→Enter→Back 

PC Procedure 	→�→
→Type slot no. (1–17)→Select 20Hz or 
25Hz→�→� 

Second Dial Tone Timer 3

Use this procedure to program the second dial tone timer. The second dial tone timer sets a delay 
in providing a dial tone after a star code is dialed to obtain special services from the central office. 
See the Feature Reference for information about programming the second dial tone timer to 
prevent toll fraud. 

Summary: Second Dial Tone Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features
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Factory Setting 0 ms

Valid Entries 0–5,000 ms, in increments of 200 ms

Inspect No

Copy Option No

Console Procedure Options→More→SecDT→Drop→Dial second dial tone timer 
value (0–5000 ms, in increments of 200 ms)→Enter→Back 

PC Procedure 	→�→�→ →Type second dial tone timer value
(0–5000 ms, in increments of 200 ms)→�→� 

Disconnect Signaling Reliability 3

Use this procedure to classify the disconnect signal sent by the central office on loop-start trunks 
as one of the following:

■ Reliable. Signal sent within a short time.

■ Unreliable. Signal may not be provided.

SECURITY ALERT:
Toll fraud can occur if you have loop-start trunks with unreliable disconnect. In this situation, 
if someone calls you and you hang up, the central office could send dial tone before the caller 
hangs up, allowing the caller to place another call as if it originated at your company.

The setting selected applies to all trunks in the system because trunks cannot be programmed 
individually. The reliable/unreliable setting does not apply to loop-start trunks emulated on a T1 
facility. If you specify a reliable disconnect for trunks programmed with a short hold disconnect 
interval (see ‘‘Hold Disconnect Interval’’ on page 3-29), active calls, as well as trunks on hold, may 
be disconnected. For more information about reliable and unreliable disconnect and its 
implications, see the Feature Reference.

Summary: Disconnect Signaling Reliability 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Unreliable

Valid Entries Unreliable, Reliable

Certain features (Remote Call Forwarding and Transfer to outside numbers), applications 
(MERLIN Messaging System, Octel 100, and Intuity AUDIX), and private network systems 
are not recommended with loop-start trunks. See ‘‘Hold Disconnect Interval’’ on page 3-29.

*XUV
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Inspect No

Copy Option No

Console Procedure LinesTrunks→TT/LS Disc→LS Disconnect→ Select 
Yes or No→
Enter→Back→Back 

PC Procedure �→�→�→Select Yes or No→�→�→� 

Toll Type 3

Use this procedure to specify whether users have to dial a toll prefix (1 or 0) before dialing an area 
code and telephone number. (Your local telephone company should verify toll prefix requirements 
for each line/trunk.)

This setting is used by the system to classify calls as local or long distance, so that appropriate Toll 
Restrictions can be applied.

Summary: Toll Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Toll prefix required

Valid Entries Required, Not required

Inspect No

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→Toll Type→Select entry mode→
Dial no. of the line/trunk→Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→Toll Type→Select block of lines/trunks→
Toggle LED On/Off→Enter or Delete→Back→Back→Back

This option applies only to loop- and ground-start trunks; it does not apply to tie trunks or 
DID trunks.
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PC Procedure To program a single-line/trunk:
�→�→�→Type no. of the line/trunk→� or 
→ 
�→�→� 

To program a block of lines/trunks:
�→�→Select block of lines/trunk→Toggle letter G→On/Off→
Select Enter or Delete→�→�→� 

Hold Disconnect Interval 3

Use this procedure to specify the number of milliseconds before a loop-start 
line/trunk is released when a caller on hold hangs up and abandons the call. This can be specified 
as either a long interval (450 ms) or a short interval (50 ms). The hold disconnect interval applies 
to loop-start trunks; it does not apply to emulated loop-start trunks (T1 facility).

For more information on Hold Interval Disconnect and Reliable and Unreliable Disconnect, see the 
Feature Reference.

Summary: Hold Disconnect Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting Long interval (450 ms)

Valid Entries Long interval, Short interval

Inspect No

Copy Option No

■ If the disconnect interval is longer than the telephone company setting, the line is 
not released when a caller on hold hangs up.

■ Do not program a short interval unless the local telephone company’s central 
office is the crossbar type.

■ Do not program a reliable disconnect for lines/trunks with a short hold disconnect 
interval. This can cause active calls as well as lines/trunks on hold to be 
disconnected. See ‘‘Disconnect Signaling Reliability’’ on page 3-27.
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Console Procedure To program a single-line/trunk:
LinesTrunks→More→HoldDiscnct→Select entry mode→ 
Dial no. of the line/trunk→ Enter→Back→Back

To program a block of lines/trunks:
LinesTrunks→More→HoldDiscnct→Select block of lines/
trunks→Toggle LED On/Off→Enter→Back→Back

PC Procedure To program a single-line/trunk:
�→�→�→�→Type no. of the line/trunk→%
�→�→� 

To program a block of lines/trunks:
�→�→�→Select block of lines/trunks→ 
Toggle letter G On/Off→�→�→� 

Principal User for Personal Line 3

Use this procedure to assign or remove one telephone as principal user for a Personal Line. When 
a telephone with Remote Call Forwarding activated is assigned as principal user, calls received on 
the Personal Line are forwarded to an outside telephone number. In addition, calls received on that 
line are sent to that telephone’s individual and/or Group Coverage receivers unless the Personal 
Line button is set to No Ring.

The principal user assignment must be removed before the trunk can be removed from a button on 
the telephone.

When no principal user is assigned for a Personal Line, calls received on the Personal Line are not 
forwarded to outside telephone numbers; calls received on the Personal Line follow the coverage 
patterns for all users who share the line.

Summary: Principal User for Personal Line 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4l, Extension Copy: Multiline 4400-Series Telephone Template
4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX telephone
4f, Tip/Ring Equipment
5b, Direct Line Console
5c, MFM Adjunct: DLC

Factory Setting No principal user

Valid Entries Not applicable

Inspect No
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Copy Option No

Console Procedure LinesTrunks→More→PrncipalUsr→Dial line/trunk 
no.→Enter→Dial ext. no.→Enter or Delete→Back→Back

PC Procedure �→�→�→Type line/trunk no.→�→ Type ext. no.→
Select Enter or Delete→�→� 

QCC Queue Priority Level 3

Use this procedure to assign QCC queue priority level values (1 to 7) to each loop-start, ground-
start, and automatic-in tie trunk in your system. The value assigned determines the order in which 
calls are sent to the QCC operator positions. Call priority 1 is the highest priority, and 7 is the 
lowest priority.

Summary: QCC Queue Priority Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting 4

Valid Entries 1 to 7

Inspect Yes

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→More→QCC Prior→Dial priority level (1–7)→
Enter→Select entry mode→Dial trunk no.→Enter→Back→Back 

 To program a block of lines/trunks:
LinesTrunks→More→QCC Prior→Dial priority level (1–7)→
Enter→Select block of lines→Toggle LED On/Off→Enter→
Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→Type priority level (1–7)→Select entry mode→
Type trunk no.→�→�→� 

To program a block of lines/trunks:
�→�→�→Type priority level (1–7)→�→
Select block of lines→Toggle letter G On/Off→�→�→� 

This procedure applies to Hybrid/PBX mode only in a system that includes QCC operator 
positions.
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QCC Operator to Receive Calls 3

Use this procedure to specify whether or not incoming calls on each line/trunk ring into the QCC 
queue and to identify the QCC system operator positions that receive incoming calls on each 
line/trunk.

Summary: QCC Operator to Receive Calls 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting No QCC operator is assigned to receive calls.

Valid Entries Extension number of first or fifth extension jack

Inspect Yes

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→More→QCC Oper→Dial ext. no.→Enter→
Select entry mode→Dial line/trunk no.→Enter→Back→Back 

To program a block of lines/trunks:
LinesTrunks→More→QCC Oper→Dial ext. no.→Enter→
Select block of lines/trunks→Toggle LED On/Off→Enter→Back→
Back

■ This procedure applies to Hybrid/PBX mode only in a system that includes QCC 
operator positions.

■ Each ground-start, loop-start, or automatic-in tie trunk programmed to ring into 
the QCC queue can be associated with one or more QCC operator positions. 

■ If a trunk assigned to ring into the QCC queue is also used for shared Remote 
Access, see ‘‘Remote Access Features’’ on page 3-165 for instructions. You must 
assign Remote Access before you assign a QCC system operator to receive 
calls. See ‘‘QCC Operator to Receive Call Types’’ on page 3-125 for more 
information.

■ Do not change the factory setting of No QCC Operator Assigned to Receive Calls 
for trunks dedicated to incoming calls for Calling Groups, trunks used as Personal 
Lines, DID trunks, unequipped DS1 trunks, or dial-in tie trunks.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-33Lines and Trunks 

3

PC Procedure To program a single-line/trunk:
�→�→�→Type ext. no.→�→�→Type line/trunk no.→
�→�→� 

To program a block of lines/trunks:
�→�→�→Type ext. no.→�→
Select block of lines/trunks→Toggle letter G On/Off→�→�→ 
� 

Loop-Start Identification Delay 3

Use this procedure to delay the alerting (ringing) of calls arriving at all extensions that are on loop-
start lines/trunks connected to a 412 LS-ID-TDL, 408 GL/LS-ID MLX, or 800 GS/LS-ID module, 
until approximately six seconds have elapsed since the port module informed the system software 
that the line was ringing, or until the system software has been informed that Caller ID information 
is available, whichever comes first. 

This option can be programmed on a per-trunk basis. It gives the appearance to the users that the 
Caller-ID information is available the moment the call arrives at the extension, and prevents 
applications or adjuncts from answering the call too soon.

The LS-ID Delay setting appears on the Ground-Start/Loop-Start Trunk Information report.

Any extension or adjunct that answers an incoming central office line on the first ring causes the 
Caller ID information associated with the call to be lost. The adjunct must be programmed to either 
answer the call on the second (or later) ring, or delay the call. The call can be delayed either by 
setting the ring option on the buttons associated with the adjunct or by using the LS-ID Delay 
option.

Summary: Loop-Start Identification Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting No delay

Valid Entries Loop-start line/trunk numbers

Inspect Yes

Copy Option Yes, but only to the same trunk type

Caller-ID information is not available on ground-start lines/trunks.
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Console Procedure To program a single-line/trunk:
LinesTrunks→More→LS-ID Delay→Select entry mode→ 
Dial no. of the line/trunk→Enter→Back→ Back 

To program a block of lines/trunks:
LinesTrunks→More→LS-ID Delay→Select block of lines/trunks→
Toggle LED On/Off→Enter→Back→ Back 

PC Procedure To program a single-line/trunk:
�→�→�→�→Type no. of the line/
trunk→�→�→� 

To program a block of lines/trunks:
�→�→�→Select block of lines/trunks→
Toggle letter G On/Off→�→�→� 

Clock Synchronization 3

Use this procedure to specify the primary, secondary, and tertiary clock source. A clock source 
may be either a 100D or 100R module or a port on an 800 NI-BRI module. See the Feature 
Reference for more information about the appropriate setting. If the clock is taken from a 100D or 
100R module, you can also specify whether the clock is synchronized to the outside endpoint 
(loop) or to the clock reference source (local). 

Summary: Clock Synchronization 3

Programmable by System Manager

Mode All

Idle Condition  Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity 100D and 100R module
3i, Incoming Trunks: BRI Options

Factory Setting Primary clock: the first 100D/100R module in the control unit 
carrier

Valid Entries Primary, Secondary, Tertiary, Loop/Local

Inspect No

Copy Option No

The following information is for planning clock synchronization in systems that are not 
part of a private network. For planning clock synchronization in a private network 
configuration, see the Network Reference.

This procedure is necessary only if your system includes an 800 NI-BRI module or more 
than one 100D or 100R module.
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Console Procedure LinesTrunks→More→ClockSync→Primary→
Dial slot no. (1–17)→Enter→Dial port no. or select source of 
synchronization→Enter→Secondary→ Dial slot no. (1–17)→ 
Enter→Dial port no. or select source of synchronization→ 
Enter→Tertiary→Dial slot no. (1–17)→Enter→Dial port no. or 
select source of synchronization→Enter→Back→Back 

PC Procedure �→�→	→�→Type slot no. (1–17)→�→
Type port no. or select source of synchronization→�→�→
Type slot no. (1–17)→�→Type port no. or select source of 
synchronization→�→�→Type slot no. (1–17)→�→
Type port no. or select source of synchronization→�→�→� 

Trunks to Pools Assignment 3

Use this procedure to create trunk pools (groups of outside lines/trunks connected to the system). 
Trunk pools are used to specify preferred routes for Automatic Route Selection (ARS). In addition, 
trunk pools enable users to select a line/trunk by dialing a pool dial-out code or by pressing a 
single button on the telephone. (A separate button for each line/trunk is not needed.) Each pool 
should contain trunks of the same type (for example, loop- or ground-start or WATS); however, 
ground- and loop-start trunks of the same type can be included in the same pool. Ground-start 
trunks must be manually assigned. A maximum of 11 trunk pools is allowed. A trunk can be 
assigned to only one pool.

Do not mix different service areas of WATS (Wide Area Telecommunications Service) trunks or FX 
(Foreign Exchange) lines to different cities. Do not include both incoming-only and outgoing-only 
lines/trunks in the same pool.

When dialing 10*** and 101**** equal access (Interexchange Carrier or IXC) calls via a private 
networked switch that is not connected to the public switched network, the private trunks must be 
assigned to the main pool. When routing Dial 0 and N11 calls via this type of networked switch, the 
private trunks must be assigned to the main pool containing private network trunks. For more 
information, see ‘‘Automatic Route Selection’’ on page 3-175.

If you want to reassign a line/trunk to a different pool, you must remove it from the current pool 
before you assign it to the new pool. Once you assign a line/trunk to a pool, it can be assigned to a 
button only on a direct-line console operator position; individual lines intended for personal use on 
telephones other than the DLC console should not be assigned to pools.

DID trunks cannot be grouped in pools. Loop-start trunks are automatically placed in pools and 
must be removed manually if used for paging loudspeakers, Music-On-Hold, or maintenance 
alarms.

Dial-in tie trunks should not be grouped in pools if you intend to assign Pool buttons on 
telephones.
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SECURITY ALERT:
Do not assign pools of non-local tie or PRI tandem trunks to Pool buttons or DSS buttons, or 
allow dial access to them. When callers in your system need to use these pools for outside 
calls, use ARS to direct the calls to these pools. Callers in your system use normal calling 
procedures to reach extensions on private networked systems.

If you are using Automatic Route Selection, the main pool (factory-set dial-out code 70) must 
contain loop- or ground-start trunks.

The system provides an error tone when a line/trunk is in use, or if a loudspeaker paging system, 
Music-On-Hold, or maintenance alarm is already assigned; however, the system does not indicate 
the reason for the error tone.

Summary: Trunks to Pools Assignment 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Trunk idle

Planning Form 2c, System Numbering: Line/Trunk Jacks 

Factory Setting All loop-start trunks are assigned to the main trunk pool (factory-set 
extension number 70); all tie trunks are assigned to the trunk pool 
with the factory-set extension number 891. No factory-set extension 
numbers are assigned to ground-start trunks.

Valid Entries Line numbers

Inspect Yes

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→Pools→Dial pool dial-out code→
Select entry mode→Dial no. of the line/trunk→Enter→Back→
Back 

To program a block of lines/trunks:
LinesTrunks→Pools→Dial pool dial-out code→
Select block of lines/trunks→Toggle LED On/Off→Enter→Back→
Back

This procedure applies to Hybrid/PBX mode only.
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PC Procedure To program a single-line/trunk:
�→�→Type pool dial-out code→�→�→
Type no. of the line/trunk→�→�→� 

To program a block of lines/trunks:
�→�→Type pool dial-out code→�→
Select block of lines/trunks→Toggle letter R On/
Off→�→�→� 

Copy Options for Lines/Trunks 3

Use this procedure to copy options assigned to loop-start or ground-start trunks, tie trunks, or DID 
trunks. Note that many of these options apply to Hybrid/PBX systems only. The following 
information is copied for each line/trunk type:

■ Loop-Start or Ground-Start Trunks (including those emulated on T1 facilities). Toll type, 
signaling type, and trunk pool assignment (Hybrid/PBX only).

■ Tie Trunks. Direction, tie trunk type, E&M signal, dial mode, dial tone, answer supervision 
time, disconnect time, and trunk pool assignment (Hybrid/PBX only).

■ DID Trunks (Hybrid/PBX only). Block assignment and disconnect time.

To find out whether there is an optional feature assigned that you would like to copy, use Inspect 
from the system programming console, or click � in the console emulation display on the PC.

■ You can copy options to a block of lines/trunks only if they are all of the same type 
(loop-start, ground-start, Tie, or DID). If you attempt to copy assignments and 
there is a mismatch in line/trunk type, information is copied to that point only. You 
receive no error message.

■ Options cannot be copied from private lines/trunks.

■ If you are copying options to a block of lines/trunks, they must be sequentially 
numbered.

■ If the block you are copying to includes an invalid line/trunk type, the copying 
process stops at the invalid type. Only the lines/trunks that were copied to before 
the invalid type was found are copied successfully.

■ If you are copying assignments to a block of lines/trunks and one of the lines or 
trunks is in use, you see the message Trunk Busy - Pls wait on your display. 
The copying for the rest of the lines/trunks in the block is delayed until the busy 
line/trunk becomes idle. If you exit without waiting for the copying to complete, 
the copying done up to that point is not cancelled.

■ The Inspect feature must be programmed on a line button on the 4424LD+ 
telephone and is a fixed button on the MLX-20L telephone.
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Summary: Copy Options for Lines/Trunks 3

Programmable by System Manager

Mode All (but note differences)

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks 
3c, Incoming Trunks: TIE
3d, Incoming Trunks: DID

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option Not applicable

Console Procedure To copy individual lines/trunks:
LinesTrunks→Copy→Single→Dial copy-from trunk no.→ 
Enter→Dial copy-to trunk no.→Enter→Back→Back→Back

To copy blocks of lines/trunks:
LinesTrunks→Copy→Block→Dial copy-from trunk no.→
Enter→Dial first copy-to trunk no. in block→Enter→
Dial last copy-to trunk no. in block→Enter→Back→Back→Back

PC Procedure To copy individual lines/trunks:
�→	→�→Type copy to trunk no.→�→
Type copy-from trunk no.→�→�→�→� 

To copy blocks of lines/trunks:
�→	→�→Type copy-from trunk no.→
Type first copy-to trunk no. in block→�→�→
Type last copy-to trunk no. in block→�→�→�→� 

Uniform Dial Plan Facilities 3

The system, in Hybrid/PBX mode only, provides support for Uniform Dial Plan (UDP) facilities, 
private network tandem lines/trunks originating at one or more other MERLIN MAGIX Integrated 
Systems or DEFINITY Communications Systems. Use the procedures in this section to program 
the switch identifiers for private network trunks.

Switch Identifiers 3

Switch identifiers are 1- or 2-digit prefixes that appear in print reports and are used by the system 
for transmission level determination, route checking, and to identify calls. If your system uses 
private facilities, you must program switch identifiers. Switch identifiers indicate the switch 
connected to the far end of a private trunk.
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The procedures in this topic allow you to add, change, and remove switch identifiers.

Trunks connected to your system from the central office do not require identifiers. They are, by 
default, correctly assigned a null identifier.

When a private networked trunk is deleted, it is assigned a null identifier, as are trunks newly 
added to the system.

You can add a switch identifier to a block of trunks, and you can remove a switch identifier from a 
block of trunks that use the same switch identifier. 

The correct switch identifier for a trunk or block of trunks is determined by the type of switch to 
which the trunk is connected and whether or not that switch is a satellite switch located within 200 
miles of the local system. Identifying those switches greater than 200 miles from the local system 
as satellite is important in assuring transmission quality across the private network. The identifiers 
are switch numbers that have the following meanings:

■ Unassigned (null) = trunk connected to central office

■ 1–20 = trunk connected to a non-satellite MERLIN MAGIX, MERLIN LEGEND, DEFINITY 
ECS, DEFINITY BCS, or DEFINITY ProLogix system with Centralized Voice Messaging more 
than 200 miles away.

■ 21–40 = trunk connected to a satellite MERLIN MAGIX, MERLIN LEGEND, DEFINITY ECS, 
DEFINITY BCS, or DEFINITY ProLogix system with Centralized Voice Messaging more than 
200 miles away.

■ 41–50 = trunk connected to a non-satellite DEFINITY ECS, DEFINITY BCS, or DEFINITY 
ProLogix Solutions system without Centralized Voice Messaging, that is more than 200 miles 
away.

■ 51–60 = trunk connected to a satellite DEFINITY ECS, DEFINITY BCS, or DEFINITY ProLogix 
Solutions system without Centralized Voice Messaging, that is more than 200 miles away.

For more information, refer to the Network Reference.

The Enter Switch Number screens for the switch identifier procedures include a Help 
option that supplies the information above.
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Summary: Switch Identifiers 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks
3b, Incoming Trunks: DS1 Connectivity (100D and 100R Module)

Factory Setting Null (no value)

Valid Entries No value, 1–20, 21–40, 41–50, 51–60

Inspect No

Copy Option No

Console Procedure To enter or remove an identifier for one trunk:
LinesTrunks→More→UDP→SwNum-Single→Dial trunk no.→
Enter→Dial switch no. (no value, 1–20, 21–40, 41–50, or 51–60)→
Enter or Delete→ Back→Back→Back 

 To enter or remove identifiers for a block of trunks:
LinesTrunks→More→UDP→SwNum-Block→
Dial starting trunk in block→Enter→Dial ending trunk in block→
Enter→Dial switch no. (no value, 1–20, 21–40, 41–50, or 51–60)→
Enter or Delete→ Back→Back→Back 

PC Procedure To enter or remove an identifier for one trunk:
�→�→�→�→Type trunk no.→�→
Type switch no. (no value, 1–20, 21–40, 41–50, or 51–60)→
� or 
→�→�→� 

 To enter or remove identifiers for a block of trunks:
�→�→�→�→Type starting trunk in block→�→
Type ending trunk in block→�→Type switch no. (no value, 1–20, 
21–40, 41–50, or 51–60)→ � or 
→�→�→�%

DS1 Facilities 3

Use the procedures in this section to program the following options for DS1 (digital signal level 1) 
facilities (T1 or PRI) connected to a 100D or 100R (DS1) module: 

■ Activate/Deactivate the On-board CSU (100R)

■ Channel Selection

■ Type of DS1 facility

— T1

— ISDN (Integrated Services Digital Network) Primary Rate Interface (PRI)

■ Switched 56 Dial Plan Routing

■ Frame Format

■ Zero Code Suppression
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■ Signaling Mode

■ Line Compensation

■ Channel Service Unit

Activate/Deactivate the On-board CSU 3

The CSU is activated by default. It can be reached by using the following sequence: 

Console Procedure  SysProg→Lines and Trunks→More→More→CSU/DSU→Select 
Slot#→Enter→ActivateCSU→
Select Activated or Deactivated

PC Procdure �→More→More→�→Slot#→1→�→
Select Activated or Deactivated

Channel Selection 3

All channels are assigned to the switch by default.The 100R module can accommodate up to 23 
PRI channels or 24 T1 channels. Use the following sequence to assign a channel to the router. 

Console Procedure SysProg→Lines and Trunks→More→More→CSU/DSU→Select 
Slot#→Enter→ChannelSel→Select Channel#→1 

PC Procdure �→More→More→�→Select Slot#→1→�→
Select Channel#→1

Type of DS1 Facility 3

Use this procedure to specify the type of facility (T1 or PRI) connected to a 100R (DS1) module. If 
T1 type is programmed, and the channels are used for emulation and/or AT&T Switched Network 
(ASN), you must specify the type of channel emulation. 

Setting theCSU/DSU to Deactivated may affect voice calls.

For T1 configurations, you can only select a channel for the router if 
you have administered the channel as Unequipped or All 
Unequipped in the T1 properties.

You may order a point-to-point T1 circuit in order to provide amplification but not 
switching for a PRI tandem trunk that carries calls over long distances. PRI tandem trunks 
are preferable to T1 tandem trunks. Consult your Lucent Technologies representative for 
advice.
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If the type is T1 and the type of channel emulation is tie trunk, you must specify whether the lines/
trunks are TIE-PBX, Toll, or Switched 56 Data service. The valid settings are as follows:

■ TIE-PBX. Select when emulated tie trunks are used to connect to another system (such as 
PBX or Centrex). 

■ Toll. Select when emulated tie trunks are used for ASN services (such as Megacom‚
Megacom 800, or Software Defined Network). 

■ TIE – S56 Data. Select when emulated tie trunks are used for Switched 56 Data Service. The 
transmit/receive parameter is set to 0/0.

If the type is T1 and S56 Data Network Service is selected, you must specify the following 
parameters: 

■ Direction . Specifies whether the trunk operates in one- or two-way direction. For one-way 
trunks, Outgoing Only or Incoming Only must also be specified.

■ Trunk Seizure Type . Trunk seizure type is programmed independently for incoming or 
outgoing directions. Select one of the following: Wink Start, Delay Start, or Automatic Start. 

■ Answer Supervision Time . The time in milliseconds the answer supervision signal must be 
present to be considered valid.

■ Disconnect Time . The time in milliseconds the disconnect signal must be present to be 
considered valid.

■ Dial Mode . Select either Rotary or Touch-Tone. Dial mode is set independently for incoming or 
outgoing directions (Inmode or Outmode).

Table 3-2 on page 3-45 shows the factory setting for each S56 Data Network Service option and 
the valid range for each threshold.

T1 S56 service is not supported for private networks. Use PRI instead.

If you select T1, channels can emulate ground- or loop-start trunks, tie trunks, or DID trunks in any 
combination. Note that unused channels must be specified as unequipped.

If either T1 or PRI is selected, channels can be used for ASN services. When T1 channels are 
used for ASN services, each channel must be programmed for tie trunk emulation.

If you select PRI, you must perform additional procedures. At a minimum, the Framing Mode and 
Zero Code Suppression procedures must be performed. See ‘‘PRI Facilities’’ on page 3-61 for 
more information.

The transmit/receive gains are determined by the call constituents.

Touch-Tone Receivers are required on the far-end switch when the setting is Touch-Tone.
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Summary: Type of DS1 Facility 3

Programmable by System Manager

Mode All

Idle Condition 100R module idle

Planning Form 2c, System Numbering: Line/Trunk Jacks
3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting T1, see Table 3-2 for options

Valid Entries T1, PRI

Inspect Yes

Copy Option No

Console Procedure To select PRI:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→PRI→Enter→ Back→ Back→Back→Back

 To select T1: All Ground, All Loop, or All Unequip:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→ 
Type→T1→Enter→Select type of emulation→Enter→Back→
Back→Back→Back

To select T1: Ground-Start, Loop-Start, All Tie, or Unequip:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→T1→Enter→Select type of emulation→Enter→
Dial channel no.→ Enter→ Back→Back→Back→Back 

To select T1: All DID:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→T1→Enter→More→All DID→ Enter→Back→Back→
Back→Back

To select T1: DID:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→T1→Enter→More→DID→Enter→Dial channel no.→
Enter→Back→Back→Back→Back 

To select T1- All Tie:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→T1→Enter→All TIE→Enter→
TIE-PBX, Toll, or S56→Enter→Dial channel no.→Enter→
Back→Back→Back→Back 

To select T1- Tie:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→ Enter→
Type→T1→Enter→TIE→Enter→TIE-PBX, Toll, or S56→
Enter→Dial channel no.→Enter→Back→Back→Back→Back 

To select T1: All Switched 56 Data:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Type→T1→Enter→More→ALL S56 Data→Enter→
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Select Direction, Intype, Outtype, AnsSupv, Disconnect, 
Inmode, or Outmode→Program options→Enter→Back→
Back→Back→Back 

To select T1: Switched 56 Data:
LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→ 
Type→T1→Enter→More→S56 Data→ Enter→
Dial channel no.→Enter→Select Direction, Intype, Outtype, 
AnsSupv, Disconnect, Inmode, or Outmode→Program options→
Enter→Back→Back→Back→Back

PC Procedure To select PRI:
�→�→Type slot no. (1–17)→�→�→�→�→�→
�→�→� 

To select T1: All Ground, All Loop, All Unequip:
�→�→Type slot no. (1–17)→�→ �→�→�→�→
Select type of emulation→�→�→�→�→� 

To select T1: Ground-Start, Loop-Start, All Tie, or Unequip:
�→�→Type slot no. (1–17)→ �→�→�→�→
Select type of emulation→�→Type channel no.→�→�→
�→�→� 

To select T1: All DID:
�→�→Type slot no. (1–17)→�→�→�→�→�→
	→�→�→�→�→� 

To select T1: DID:
�→�→Type slot no. (1–17)→�→�→�→�→�→ 
�→�→Type channel no.→�→ �→�→�→� 

To select T1- All Tie:
�→�→Type slot no. (1–17)→�→�→�→�→
Select �, �, or �→�→�→�→ �→� 

To select T1- Tie:
�→�→Type slot no. (1–17)→�→�→�→�→
Select �, �, or �→�→Type channel no.→�→�→%
�→�→� 

To select T1: All Switched 56 Data:
�→�→Type slot no. (1–17)→�→�→�→�→�→
	→�→Select �,%�, �,%�,%�,%�, or 	→
Program options→�→�→�→�→� 

To select T1: Switched 56 Data:
�→�→Type slot no. (1–17)→�→�→�→�→�→
�→�→Type channel no.→�→Select �, �, �,%�, �, 
�, or 	→Program options→�→�→�→�→� 
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Switched 56 Dial Plan Routing 3

Dial plan routing provides a way to route incoming calls received on a Switched 56 Network line. 
An incoming call is routed by matching the incoming number and then optionally deleting and/or 
adding digits to direct the call to a specific endpoint. The expected digits are the number of 
incoming digits outpulsed from the central office.

Summary: Switched 56 Dial Plan Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition 100R module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting D4 compatible

Valid Entries D4, ESF

Inspect No

Copy Option No

Table 3-2. Switched 56 Data Signaling Options

Option Factory Setting Range

Direction Two-Way Two-Way, Outgoing, Incoming

Intype Wink-Route by 
Dial Plant

Wink-Route by Dial Plan, 
Delay-Route by Dial Plan
Auto-Route by Line Appearance

Outtype Wink Wink, Delay, Auto

Answer Supervision 300 ms 200–4,800 ms (increments of 20 ms)

Disconnect 300 ms 200–4,800 ms (increments of 20 ms)

Inmode Touch Tone Touch Tone, Rotary

Outmode Touch Tone Touch Tone, Rotary
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Console Procedure To specify Expected Digits:
LinesTrunks→More→T1 Data NW→S56 Dial Plan Routing→
Expected Digits→Drop→ Dial expected digits→Enter→
Back→ Back→Back 

To specify Delete Digits:
LinesTrunks→More→T1 Data NW→S56 Dial Plan Routing→
Delete Digits→Drop→Dial delete digits→Enter→Back→
Back→Back 

To specify Add Digits:
LinesTrunks→More→T1 Data NW→S56 Dial Plan Routing→
Add Digits→Drop→Dial add digits→Enter→Back→Back→
Back 

PC Procedure To specify Expected Digits:
�→�→�→�→�→ →Type expected digits→
�→�→�→� 

To specify Delete Digits:
�→�→�→�→�→ →Type delete digits→
�→�→�→� 

To specify Add Digits:
�→�→�→�→�→ →Type add digits→
�→�→�→� 

Frame Format 3

Use this procedure to specify the framing format for the 100R module as D4-compatible or 
Extended Superframe. Your selection must match the framing mode at the far end of the DS1 
facility.

Summary: Frame Format 3

Programmable by System Manager

Mode All

Idle Condition 100D module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting D4-compatible

Valid Entries D4, ESF

Inspect No

Use the Extended Superframe format for tandem PRI trunks.

*XUV

*XUV

*XUV
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Copy Option No

Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→ Enter→
FrameFormat→Select D4-Compatible or Extended 
Superframe→Enter→Back→Back 

PC Procedure �→�→Type slot no. (1–17)→ �→�→Select D4-
Compatible or Extended Superframe→�→�→� 

Zero Code Suppression 3

Use this procedure to specify zero code suppression for the 100D module as AMI zero code 
suppression (AMI-ZCS) or bipolar eight zero suppression (B8ZS). Your selection must match the 
suppression at the far end of the DS1 facility.

Summary: Zero Code Suppression 3

Programmable by System Manager

Mode All

Idle Condition 100D module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting AMI-ZCS

Valid Entries AMI-ZCS, B8ZS

Inspect No

Copy Option No

Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→ Enter→
Suppression→AMI-ZCS or B8ZS→ Enter→Back→Back

PC Procedure �→�→Type slot no. (1–17)→�→�→Select AMI-ZCS or 
B8ZS→�→�→� 

Signaling Mode 3

Use this procedure to specify the signaling for the 100D or 100R module as robbed-bit or 
common-channel signaling.

Use B8ZS for tandem PRI trunks.

This procedure is needed only for T1 facilities; common-channel signaling is set 
automatically for PRI facilities. For 100D and 100R modules, however, this procedure is 
not valid for T1 facilities.
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Summary: Signaling Mode 3

Programmable by System Manager

Mode All

Idle Condition 100R module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Robbed bit

Valid Entries Robbed Bit, Common Channel

Inspect No

Copy Option No

Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Signaling→Select type of signaling (Robbed Bit or Common 
Channel)→Enter→ Back→Back

PC Procedure �→�→Type slot no. (1–17)→�→�→
Select type of signaling (Robbed Bit or Common Channel)→�→
�→� 

Line Compensation 3

Use this procedure to specify the amount of cable loss in decibels. Cable loss is based on the 
length of cable between the 100R module and the Channel Service Unit, as shown below:

■ 1 = 0.6 dB loss

■ 2 = 1.2 dB loss

■ 3 = 1.8 dB loss

■ 4 = 2.4 dB loss

■ 5 = 3.0 dB loss

Summary: Line Compensation 3

Programmable by System Manager

Mode All

Idle Condition 100R module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting 1 (0.6 dB loss)

Valid Entries 1 to 5

Inspect No

Copy Option No
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Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→
Line Comp→Drop→Dial line compensation value (1–5)→Enter→
Back→Back 

PC Procedure �→�→Type slot no. (1–17)→�→�→ →
Type line compensation value (1–5)→ �→�→� 

Channel Service Unit 3

Use this procedure to specify the type of equipment provided by the local telephone company as 
foreign exchange or special access.

Summary: Channel Service Unit 3

Programmable by System Manager

Mode All

Idle Condition 100R module idle

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Foreign Exchange

Valid Entries Foreign Exchange, Special Access

Inspect No

Copy Option No

Console Procedure LinesTrunks→LS/GS/DS1→Dial slot no. (1–17)→Enter→ 
ChannelUnit→Foreign Exchange or Special Access→
Enter→Back→Back 

PC Procedure �→�→Type slot no. (1–17)→�→	→� or �→�→
�→� 

Tie Trunks 3

This section covers programming procedures for the following tie trunk options:

■ Direction

■ Tie Trunk Seizure Type

■ E&M Signal

■ Dial Mode

■ Tie Trunk Dial Tone

You do not need to use this procedure unless your system emulates loop-start or ground-
start with the T1 type of DS1 facility.

*XUV
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■ Tie Trunk Answer Supervision Time

■ Disconnect Time

Direction 3

Use this procedure to specify whether tie trunks operate in a one- or two-way direction. For one-
way tie trunks, you must also specify whether the direction is out or in.

Summary: Direction 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Two-way

Valid Entries Two-way, Outgoing, Incoming

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Direction→Dial trunk no.→ 
Enter→Specify direction (Two-way, Outgoing, or Incoming)→
Enter→Back→Back 

PC Procedure �→�→�→Type trunk no.→�→
Specify direction (Two-way, Outgoing, or 
Incoming)→�→�→� 

Tie Trunk Seizure Type 3

Use this procedure to specify whether the seizure type of incoming or outgoing tie trunk is wink, 
delay, immediate, or automatic.

The following settings are recommended when T1 facilities are programmed for tie-trunk 
emulation to provide special network services [such as Megacom, Megacom 800, or Software 
Defined Network (SDN)]:

■ If ARS is used for all outgoing calls and no Personal Line or Pool buttons are used, assign the 
wink signaling type. Set the network to wink.

Delay-start tie trunks should be used for private networks.
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■ If Personal Line or Pool buttons (pool or dial-out codes) are used for outgoing calls, assign the 
immediate signaling type. Set the network to dial. Contact your service provider for more 
information about the dial setting.

■ If Dialed Number Identification Service (DNIS) is used for incoming calls, assign the wink 
signaling type. The network is also set to wink. (Setting both ends to immediate also works.) 
Contact your service provider for more information about the appropriate setting.

■ When DNIS is not used for incoming calls, assign the automatic signaling type. The network is 
set to automatic.

Summary: Tie Trunk Seizure Type 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Wink

Valid Entries Wink, Delay, Immediate, Automatic

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Intype or Outtype→
Dial trunk no.→Enter→Specify seizure type (Wink, Delay, 
Immediate, or Automatic)→Enter→Back→Back 

PC Procedure �→�→� or%�→Type trunk no.→�→
Specify seizure type (Wink, Delay, Immediate, or Automatic)→�→
�→� 

E&M Signal 3

Use this procedure to specify the type of tie trunk signal, as follows:

■ E&M Mode:

— 1S, Type 1 Standard. Tie trunks that are connected through the local telephone company.

— 1C, Type 1 Compatible. Tie trunks that are connected directly to a system that uses 1S 
signaling.

■ Simplex Mode: 

— 5, Type 5 Simplex. Tie trunks that are connected to a system using Type 5 signaling.

E&M trunks that are used for private networking should be programmed at each end 
with a switch identifier that indicates the remote system where the trunk is connected. 
See ‘‘Uniform Dial Plan Facilities’’ on page 3-38 for details.
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Summary: E&M Signal 3

Programmable by System Manager

Mode All

Idle Condition Tie trunk idle

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 1S

Valid Entries 1S, 1C, 5

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→E&M Signal→Dial trunk no.→ 
Enter→Specify signaling type (1S, 1C, or 5)→Enter→Back→
Back 

PC Procedure �→�→�→Type trunk no.→�→
Specify signaling type (1S, 1C, or 5)→�→�→� 

Dial Mode 3

Use this procedure to specify whether an incoming or outgoing tie trunk is Touch-Tone or rotary.

Touch-Tone cannot be programmed for incoming immediate signaling tie trunks. Users of Touch-
Tone single-line telephones cannot make calls by using individual trunks programmed for rotary 
operation. The Touch-Tone signals generated from the telephone while the user is dialing are 
transmitted to the central office at the same time the rotary signals are sent to the system. The 
central office receives both signals and cannot process the call.

Summary: Dial Mode 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Rotary

Valid Entries Rotary, Touch-Tone

Inspect Yes

Copy Option Yes
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Console Procedure To program a single-line/trunk:
LinesTrunks→TIE Lines→Inmode or Outmode→
Entry Mode→Dial line/trunk no.→ Enter or Delete→Back→ 
Back→Back 

To program a block of lines/trunks:
LinesTrunks→TIE Lines→Inmode or Outmode→
Select block of lines→Toggle LED On/Off→Back→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→� or 	→�→Type line/trunk no.→� or 
→
�→�→� 

To program a block of lines/trunks:
�→�→� or 	→Select block of lines→
Toggle letter G On/Off→�→�→� 

Tie Trunk Dial Tone 3

Use this procedure to specify whether the system provides dial tone for people calling in on a tie 
trunk. The settings are remote (system provides dial tone) and local (system does not provide dial 
tone).

Summary: Tie Trunk Dial Tone 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting Remote

Valid Entries Remote, Local

Inspect Yes

Copy Option Yes

Console Procedure To program a single-line/trunk:
LinesTrunks→TIE Lines→Dialtone→Entry Mode→
Dial trunk no.→Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→TIE Lines→Dialtone→
Select block of lines/trunks→Toggle LED On/Off→Back→
Back→Back 
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PC Procedure To program a single-line/trunk:
�→�→
→�→Type trunk no.→� or 
→�→� 

To program a block of lines/trunks:
�→�→
→Select block of lines→Toggle letter G On/Off→
�→�→� 

Tie Trunk Answer Supervision Time 3

Use this procedure to specify the tie trunk answer supervision time in milliseconds. This is the time 
limit for the called system to respond.

Summary: Tie Trunk Answer Supervision Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 300 ms

Valid Entries 20 to 4,800 ms, in increments of 20 ms

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→AnsSupvr→Dial trunk no.→
Enter→Drop→Dial no. of ms (20–4,800)→Enter→Back→Back 

PC Procedure �→�→�→Type trunk no.→�→ →
Type no. of ms (20–4,800)→ �→�→� 

Disconnect Time 3

Use this procedure to specify the tie trunk disconnect time limit in milliseconds.

Summary: Disconnect Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3c, Incoming Trunks: Tie

Factory Setting 300 ms

Valid Entries 140 to 2,400 ms

*XUV
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Inspect No

Copy Option Yes

Console Procedure LinesTrunks→TIE Lines→Disconnect→Dial trunk no.→ 
Enter→Drop→Dial no. of ms (140–2,400)→Enter→Back→
Back

PC Procedure �→�→�→Type trunk no.→�→ →
Type no. of ms (140–2,400)→�→�→� 

DID Trunks 3

This section covers programming DID trunks and includes procedures for the following:

■ Block Assignment

■ DID Trunk Type

■ Disconnect Time

■ Expected Digits

■ Delete Digits

■ Add Digits

■ Signaling

■ Invalid Destination

Block Assignment 3

Use this procedure to assign each DID trunk connected to the system to either Block 1 or Block 2.

Summary: Block Assignment 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID

Factory Setting Block 1

Valid Entries Block 1, Block 2

Inspect Yes

Copy Option Yes

These procedures apply to Hybrid/PBX mode only.

*XUV
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3Programming Procedures

Console Procedure To program a single-line/trunk:
LinesTrunks→DID→Block→Dial trunk block no. (1 or 2)→ 
Enter→Entry Mode→Type the line/trunk no.→
Enter or Delete→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→DID→Block→Dial trunk block no. (1 or 2)→ 
Enter→Select trunk lines→Toggle LED On/Off→Enter→Back→
Back→Back 

PC Procedure To program a single-line/trunk:
�→�→�→Type trunk block no. (1 or 2)→�→
Type the line/trunk no.→� or 
→�→�→� 

To program a block of lines/trunks:
�→�→�→Type trunk block no.(1 or 2)→�→
Select trunk lines→Toggle letter G On/Off→�→�→�→� 

DID Trunk Type 3

Use this procedure to specify the DID trunk type as either immediate-start or wink-start. Wink-start 
is more reliable if the local telephone company supports it.

Summary: DID Trunk Type 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition DID trunk idle

Planning Form 3d, Incoming Trunks: DID 

Factory Setting Wink-start

Valid Entries Immediate-start, Wink-start

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→Type→Dial trunk block no.→Enter→ 
Immed or Wink→Enter→Back→Back 

PC Procedure �→�→�→Type trunk block no.→�→Select Immed or 
Wink→�→�→� 
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Disconnect Time 3

Use this procedure to specify the DID trunk disconnect time limit in milliseconds.

Summary: Disconnect Time 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 500 ms

Valid Entries 10 to 2,400 ms, in increments of 10 ms

Inspect No

Copy Option Yes

Console Procedure LinesTrunks→DID→Disconnect→Dial trunk no.→ 
Enter→Drop→Dial no. of ms (10–2,400)→ Enter→Back→Back 

PC Procedure �→�→�→Type trunk no.→�→ →
Type no. of ms (10–2,400)→�→�→� 

Expected Digits 3

Use this procedure to tell the system how many digits are sent by the local telephone Personal 
Line company.

SECURITY ALERT:
Do not assign a non-local remote ARS code to the non-local dial plan. Doing so would allow 
DID callers to use the private network to make outside calls. For more information, see 
‘‘Uniform Dial Plan Routing’’ on page 3-186.

If the dialed digits received on a DID trunk correspond to a non-local extension number, 
the call is routed to that extension.

*XUV
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Summary: Expected Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 3 digits

Valid Entries 1 to 4 digits

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→ExpectDigit→Dial trunk block no. 
(1 or 2)→Enter→Drop→Dial no. of digits (1–4)→Enter→ 
Back→Back 

PC Procedure �→�→�→Type trunk block no. (1 or 2)→�→ → Type 
no. of digits (1–4) �→�→� 

Delete Digits 3

Use this procedure to specify the number of leading digits to be deleted from the digits sent by the 
local telephone company. Use this procedure when the number of digits sent by the telephone 
company is greater than the number in the system numbering plan.

Summary: Delete Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 0 digits

Valid Entries 0 to 4 digits

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→DeleteDigit→
Dial trunk block no. (1 or 2)→Enter→Drop→
Dial no. of digits (0–4)→Enter→Back→Back

PC Procedure �→�→�→Type trunk block no. (1 or 2)→�→ → Type 
no. of digits (0–4)→�→�→� 

*XUV
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Add Digits 3

Use this procedure to specify the number of leading digits that must be added to the digits sent by 
the local telephone company. Use this procedure when the number of digits sent by the telephone 
company is fewer than the number in the system numbering plan.

Summary: Add Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting 0

Valid Entries 1 to 9999

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→Add Digits→Dial trunk block no. (1 or 2)→ 
Enter→Drop→Dial added digits (1–9999)→Enter→Back→Back 

PC Procedure �→�→	→Type trunk block no. (1 or 2)→�→ → Type 
added digits (1–9999)→�→�→� 

Signaling 3

Use this procedure to specify whether the type of dialing signal from the local telephone company 
is touch-tone or rotary. Touch-tone dial mode cannot be programmed for immediate-start DID 
trunks. 

Touch-Tone single-line telephone users cannot make calls by using individual trunks programmed 
for rotary operation. The Touch-Tone signals generated from the telephone while dialing are 
transmitted to the central office at the same time the rotary signals are sent to the system. The 
central office receives both signals and cannot process the call.

*XUV
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Summary: Signaling 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not Required

Planning Form 3d, Incoming Trunks: DID 

Factory Setting Rotary

Valid Entries Rotary, Touch-Tone

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→Signaling→Dial trunk block no.→ 
Enter→Rotary or TouchTone→Enter→Back→Back

PC Procedure �→�→
→Type trunk block no.→�→� or �→�→
�→� 

Invalid Destination 3

Use this procedure to specify where to direct outside calls (received on DID trunks) for unassigned 
extension numbers. Calls can be either directed to a backup position (normally the primary system 
operator) or given a fast busy signal. See ‘‘QCC Operator to Receive Call Types’’ on page 3-125 
for information on assigning a backup position.

Summary: Invalid Destination 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3d, incoming Trunks: DID 

Factory Setting Backup (calls are sent to the primary system operator)

Valid Entries Backup, Fast Busy

Inspect No

Copy Option No

Console Procedure LinesTrunks→DID→InvalDstn→Select Send to Backup 
Extension or Return Fast Busy→ Enter→Back→Back 

PC Procedure �→�→�→Select Send to Backup Extension or Return 
Fast Busy→�→�→� 
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PRI Facilities 3

The procedures in this section provide the steps for programming the following options for Primary 
Rate Interface (PRI) facilities connected to a 100D or 100R (DS1) module:

■ Switch Type

■ Telephone Number

■ B-Channel Groups

■ Network Service

■ Copy Telephone Number to Send

■ Incoming Routing

■ Telephone Number to Send

■ Test Telephone Number

■ Timers and Counters

■ Terminal Equipment Identifier

■ Dial Plan Routing

■ Outgoing Tables

■ Network Selection Tables

■ Special Services Tables

■ Call-by-Call Service Table

The settings for frame format and zero code suppression must be consistent with the options 
selected when the PRI connection was ordered.

If you are using ARS in connection with PRI, make sure you select voice, data, or voice and data, 
as appropriate, when you perform the ARS ‘‘Voice and/or Data Routing’’ on page 3-185.

If you are adding PRI facilities to an existing system, certain values must be set 
correctly. To inspect or change these values, see ‘‘DS1 Facilities’’ on page 3-40. Do 
not start these procedures until you have checked the following:

■ Type of DS1 Facility must be set to PRI.

■ Frame format must be specified correctly.

■ Zero code suppression must be specified correctly.

■ Clock synchronization source must be set to loop (derived from the T1 line).



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-62PRI Facilities 

3

Switch Type 3

Use this procedure to specify the PRI connection through the following switch types:

■ 4ESS

■ 5ESS

■ Nortel DMS-100 BCS 36 for local exchange carrier services

■ Nortel DMS-250 serving the MCI network

■ Digital Switch Corporation DEX600E serving the MCI network

Two additional switch types allow you to specify additional switch options in order to set up a PRI 
tandem trunk that connects two MERLIN MAGIX Integrated Systems or a MERLIN MAGIX 
Integrated System and a DEFINITY Communications System. The two additional options are the 
following:

■ MERLIN-NTWK 

■ MERLIN-PBX

To set up a PRI tandem trunk, one system is specified as operating in PBX mode and the other as 
operating in network mode. When you program this switch type, you specify the type of switch at 
the other end of the PRI trunk, not the local switch. The slot number that you enter is the slot 
number on the local system. 

The following rules apply to PRI tandem trunks in PBX or network mode:

■ A single unused B-channel group number is automatically assigned to all 23 B-channels on 
the trunk; B-channels may be removed or added (for more information, see ‘‘B-Channel 
Groups’’ on page 3-64). The group can still exist, even if it includes no B-channels.

■ PRI Dial Plan Routing does not apply for incoming calls on the trunk. Incoming routing is 
automatically set to Route Directly to UDP for B-channels in the automatically assigned group; 
this cannot be changed as long as the MERLIN-PBX or MERLIN-NTWK switch type is in effect 
(see ‘‘Incoming Routing’’ on page 3-68). However, local extensions need not be included in the 
UDP Routing table.

■ PRI outgoing tables do not apply to outgoing calls on the trunk.

■ The system automatically assigns Electronic Tandem Network (ETN) as the network service 
for the B-channel group that is automatically assigned to the PRI tandem trunk; this setting 
cannot be changed as long as the switch type is in effect (see ‘‘Network Service’’ on page 
3-66).

■ The Copy Telephone Number to Send setting is set to Do Not Copy for the PRI tandem trunk 
B-channel group; this setting cannot be changed as long as the switch type is in effect (see 
‘‘Copy Telephone Number to Send’’ on page 3-67).
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Summary: Switch Type 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting 4ESS

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure LinesTrunks→PRI→SwitchType→Dial slot no. (1–17)→ 
Enter→Specify switch type→Enter→Back→Back 

PC Procedure �→�→�→Type slot no. (1–17)→�→Specify switch type→
�→�→� 

Telephone Number 3

Use this procedure to assign a string of up to 12 digits to each PRI channel. This string must match 
the number sent by the network (that is, the number provided by the PRI service provider) to 
indicate the number dialed by an outside caller. The system uses this number to route the call to 
the correct destination, which means that the number assigned to each channel in the same B-
channel group must be unique. Note also that the number cannot be the same as the associated 
test telephone number.

Summary: Telephone Number 3

Programmable by System Manager

Mode Hybrid/PBX, Key

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting No digits

Valid Entries Up to 12 digits (any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→PhoneNumber→Dial trunk no.→Enter→
Drop→Dial telephone no. (up to 12 digits; 0–9)→Enter→Back→
Back 

PC Procedure �→�→�→Type trunk no.→�→ →
Type telephone no. (up to 12 digits; 0–9)→�→�→� 

*XUV
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B-Channel Groups 3

Use this procedure to perform the following:

■ Assign B-channels to a group.

■ Associate individual ISDN channels (that can place and receive calls) on the B-channels in 
each group.

B-channels are partitioned into trunk groups when PRI service is ordered. The trunk groups 
defined when service is ordered must match the B-channel groups defined when the MERLIN 
MAGIX Integrated System is programmed.

Each B-channel can be assigned to only one group, and each ISDN channel can be associated 
with only one group. Up to 80 B-channel groups can be established.

Each group can contain up to 23 channels; however, all channels assigned must signal through 
the same D-channel (that is, must be connected to the same 100D module).

CAUTION:
B-channels must be assigned in the order of system search (through the group) for an 
available channel. To minimize call attempts on the same line or trunk, you must arrange B-
channels in the opposite order of the hunting arrangement provided by the network service 
provider.

B-channels must be identified by control unit slot and port numbers since they are not associated 
with a line/trunk number or a logical ID. 

PRI B-channel groups programmed for line routing perform similarly to loop-start trunks. PRI B-
channel groups programmed for dial plan routing perform similarly to DID trunks.

When the PRI switch type is set to MERLIN-PBX or MERLIN-NTWK, all B-channels for a 
PRI tandem trunk are automatically assigned to a single unused B-channel group. If your 
private network includes drop-and-insert hardware between the networked switches, use 
this procedure to remove a dropped B-channel from the group, after the switch type has 
been programmed and the B-channels automatically assigned. This equipment must 
never drop channel 24, which provides necessary signalling for the B-channels. 

If more lines than B-channels are assigned to a B-channel group, users may experience 
situations where a line that is idle is not able to seize a B-channel. The user receives a 
fast busy tone.
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Summary: B-Channel Groups 3

Programmable by System Manager

Mode Hybrid/PBX, Key

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Not applicable

Valid Entries Group numbers (1 to 80)

Inspect Yes

Copy Option No

Console Procedure To program a single-line/trunk:
LinesTrunks→PRI→B-ChannlGrp→B Channels→
Dial group no. (1–80)→Enter→Dial B-channel slot and port nos.→
Enter→Lines→Dial group no.→Enter→Entry Mode→
Dial line/trunk no.→Enter→Back→Back→Back 

To program a block of lines/trunks:
LinesTrunks→PRI→B-ChannlGrp→B Channels→
Dial group no. (1–80)→Enter→Dial B-channel slot and port no.→ 
Enter→Lines→Dial group no.→Enter→
Select specific lines/trunks→Toggle LED On/Off→Back→Back→
Back

PC Procedure To program a single-line/trunk:
�→�→�→�→Type group no.→
Type B-channel slot and port nos.→�→Type group no.→�→
�→Type line/trunk no.→�→�→�→� 

To program a block of lines/trunks:
�→�→�→�→Type group no.→
Type B-channel slot and port nos.→�→Type group no.→�→
Select specific lines/trunks→Toggle letter G on or off→�→�→
� 
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Network Service 3

Use this procedure to specify the type of outgoing service provided by each B-channel group.

■ You can enter a service not shown on the Network Service screen by using the 5-digit binary 
code that represents the service in the Network Facilities Information Element of ISDN PRI 
signaling protocol. For information on these codes, contact your service provider. 

■ Setting the switch type to MERLIN-PBX or MERLIN-NTWK automatically assigns the 
B-channels for the specified PRI tandem trunk to a single unused B-channel group. This group 
is automatically assigned LEGEND UDP as the general type of network service and Electronic 
Tandem Network (ETN) as specific LEGEND UDP network service. As long as the switch type 
for the PRI trunk remains as MERLIN-PBX or MERLIN-NTWK, you cannot change the type of 
network service. For more information about switch types, see ‘‘Switch Type’’ on page 3-62.

Summary: Network Service 3

Programmable by System Manager

Mode Hybrid/PBX, Key

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Not applicable

Valid Entries AT&T Toll, 5ESS Local, MCI Toll, Miscellaneous,
DMS-100 Local, LEGEND UDP

Inspect Yes

Copy Option No

Console Procedure LinesTrunks→PRI→B-ChannlGrp→ NetworkServ→
Dial group no.→Enter→Specify network service (AT&T Toll, 5ESS 
Local, MCI Toll, Miscellaneous, DMS-100, Local, Legend UDP)→ 
Enter→Back→Back→Back→Back 

PC Procedure �→�→�→�→Type group no.→�→
Specify network service (AT&T Toll, 5ESS Local, MCI Toll, 
Miscellaneous, DMS-100, Local, Legend UDP)→�→�→�→
�→� 
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Copy Telephone Number to Send 3

Use this procedure to indicate whether or not the telephone number to send to the network (for 
calls going out over ISDN lines assigned to a B-channel group) is copied from the number 
assigned to that channel.

Select Do Not Copy Telephone Number either when a telephone number to send is assigned to 
each channel in the B-channel group or when no telephone number is to be sent to the network. In 
the latter case, make sure that no telephone numbers are assigned to any channels in the 
B-channel group by using the ‘‘Telephone Number to Send” procedure.

Summary: Copy Telephone Number to Send 3

Programmable by System Manager

Mode Hybrid/PBX, Key

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R Module)

Factory Setting Do Not Copy

Valid Entries Do Not Copy, Copy

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→B ChannlGrp→Copy Number→
Dial group no.→Enter→Specify copy or no copy→Enter→
Back→Back→Back 

PC Procedure �→�→�→�→Type group no.→�→
Specify copy or no copy→�→�→�→� 

Setting the switch type to MERLIN-PBX or MERLIN-NTWK automatically assigns Copy 
Number as the option for the single B-channel group associated with PRI tandem trunk 
that you specified in the Switch Type setting (Hybrid/PBS mode only). As long as the 
switch type for the slot is set this way, you cannot change the Copy programming. For 
more information about switch types, see ‘‘Switch Type’’ on page 3-62.
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Incoming Routing 3

Use this procedure to specify whether incoming routing is either by line appearance or according 
to dial plan. Dial Plan Routing is available in Hybrid/PBX mode only.

The Incoming Routing screen displays an option, Route Directly to UDP (Uniform Dial Plan). 
Setting the switch type to MERLIN-PBX or MERLIN-NTWK automatically assigns Route Directly to 
UDP as the Incoming Routing option for the single B-channel group associated with the Switch 
Type setting. As long as the switch type for the slot of the PRI tandem trunk is set this way, you 
cannot change the incoming routing for the group. This routing option cannot be selected for any 
other switch type. For more information about switch types, see ‘‘Switch Type’’ on page 3-62.

Summary: Incoming Routing 3

Programmable by System Manager

Mode Line appearance: Hybrid/PBX, Key; Dial Plan Routing or Route 
Directly to UDP; Hybrid/PBX only

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Line appearance

Valid Entries Dial Plan Routing, Routing by Line Appearance, Route Directly to 
UDP

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→B-ChannlGrp→Incoming Rtg→
Dial B-channel group no.→Enter→Specify routing method (Dial 
Plan Routing, Routing by Line Appearance, or Route Directly to 
UDP)→Enter→Back→ Back→Back 

PC Procedure �→�→�→�→Type B-channel group no.→�→
Specify routing method (Dial Plan Routing, Routing by Line 
Appearance, or Route Directly to UDP)→�→�→�→� 
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Telephone Number to Send 3

Use this procedure to assign the telephone number to send to the network when outgoing calls are 
made on an ISDN line. If the person being called subscribes to an automatic number identification 
service, the number indicates who is calling.

The number assigned to each channel does not have to be unique because it is not used for 
routing.

The telephone number sent to the network can be one of the following:

■ The extension number assigned to the calling telephone (Select Extension Only in Step 4).

■ The extension number substituted into the lower order digits of a system-wide base number 
(Select Base Number with Ext in Step 4).

■ The facility-based line telephone number (Select Line Telephone Number in Step 4).

Summary: Telephone Number to Send 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting No digits are assigned

Valid Entries Up to 12 digits (any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→NumbrToSend→Specify type of no.→ 
Enter→Drop→Dial base no.→Enter→ Dial line no.→Enter→
Drop→Dial telephone no. (up to 12 digits; 0–9)→Enter→Back→
Back 

PC Procedure �→�→�→Specify type of no.→�→ →
Type base no.→�→ →Type telephone no. (up to 12 digits;
0–9)→�→�→� 

Only one base number is supported per system. In systems having non-uniform 
extension numbers, for example, where there are some 3-digit extension numbers and 
some 4-digit extension numbers, one base number may not be sufficient to represent all 
the outside telephone numbers of all extensions.

*XUV
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Test Telephone Number 3

Use this procedure to assign a test line or trunk telephone number for each 100D module installed 
in the control unit.

The number assigned to the test line/trunk must be different from the numbers assigned to other 
channels in the same B-channel group. It must be identical to the number provided by the PRI 
service provider.

Summary: Test Telephone Number 3

Programmable by System Manager

Mode Hybrid/PBX, Key

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Not applicable

Valid Entries Telephone number of up to 12 digits

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→Test TelNum→Dial slot no. (1–17)→ 
Enter→Drop→Dial telephone no. (up to 12 digits; 0–9)→Enter→
Back→Back 

PC Procedure �→�→�→Type slot no. (1–17)→�→ → 
Type telephone no. (up to 12 digits; 0–9)→�→�→� 

Timers and Counters 3

Use this procedure to set timer and counter thresholds.

CAUTION:
The factory settings for these thresholds are standard and rarely need to be changed. If you 
are not sure of the correct timer and threshold settings for your PRI lines and trunks, check 
with your Lucent Technologies representative before you make a change. Incorrect settings 
can cause your PRI lines and trunks to malfunction.

If the network does not respond before the programmed time or count, the system takes the 
appropriate corrective action.

*XUV
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The timers and counters are listed below.

■ T200 Timer. Times the delay in the link layer acknowledgment of a message sent from the 
system to the network over a D-channel.

■ T203 Timer. Times the interval between each exchange of messages between the system 
and the network on the D-channel.

■ N200 Counter. Counts the number of times the system has transmitted a message on a D-
channel because no link layer acknowledgment is received from the network.

■ N201 Counter. Counts the maximum number of layer three octets the system can send or 
receive in a single D-channel message.

■ K Counter. Counts the number of layer three unacknowledged messages sent from the 
system to the network on a D-channel.

■ T303 Timer. Times the delay in network response when the system sends a setup message to 
initiate an outgoing call.

■ T305 Timer. Times the delay in network response when the system sends a disconnect 
message to clear a call.

■ T308 Timer. Times the delay in network response when the system sends a release message 
to clear a call.

■ T309 Timer. Times the duration of a D-channel data link failure (a loss of signaling for the 
entire PRI connection).

■ T310 Timer. Times the network delay following the receipt of a call preceding message on an 
outgoing call.

■ T313 Timer. Times the delay in network response when the system sends a connect message 
that indicates the completion of an incoming call.

■ T316 Timer. Times the delay in network response when the system sends a restart message 
to clear a B-channel.

Table 3-3 shows the factory setting for each timer and counter and the valid range for each 
threshold.

If you enter an invalid timer value, the number you enter is truncated to the closest 
valid value. For example, if you enter 45 for a counter that ranges from 0 to 30, 4 is 
recorded as the counter value.
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Summary: Timers and Counters 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting See Table 3-3

Valid Entries See Table 3-3

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→Protocol→Timers→
Dial slot no. (1–17)→Enter→Select timer/counter→Drop→
Dial no. of ms/octets/and so on→Enter→Back→Back→Back→ 
Back 

PC Procedure �→�→�→�→Type slot no. (1–17)→�→
Select timer/counter→ →Type no. of ms/octets/and so on→
�→�→�→�→� 

Table 3-3. Timers and Counters

Timer/Counter Purpose Factory Setting Valid Range

T200 Timer Maximum response time 1 second 1,000 to 3,000 ms

T203 Timer Maximum time 30 seconds 1 to 60 seconds

N200 Counter Maximum transmissions 3 transmissions 1 to 5 transmissions

N201 Counter Maximum octets 260 octets 16 to 260 octets

K Counter Maximum outstanding

I-frames

7 frames 1 to 15 frames

T303 Timer Set up timeout 4 seconds 4 to 12 seconds

T305 Timer Disconnect timeout 4 seconds 4 to 30 seconds

T308 Timer Release timeout 4 seconds 4 to 12 seconds

T309 Timer Signal loss 90 seconds 30 to 120 seconds

T310 Timer Call Proc. timeout 60 seconds 2 to 120 seconds

T313 Timer Connect timeout 4 seconds 4 to 60 seconds

T316 Timer Restart timeout 120 seconds 30 to 120 seconds

*XUV
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Terminal Equipment Identifier 3

Use this procedure to assign the link layer address of a piece of equipment connected to each D-
channel. Normally, only one piece is connected and the system assumes that the Terminal 
Equipment Identifier (TEI) is 0.

CAUTION:
The value of the TEI rarely has to be changed. Check with your Lucent Technologies 
representative before changing this value.

Summary: Terminal Equipment Identifier 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting 0

Valid Entries 0 to 63

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→Protocol→TEI→Dial slot no. (1–17)→
Enter→Drop→Dial new ID no. (0–63)→Enter→Back→Back→
Back 

PC Procedure �→�→�→�→Type slot no. (1–17)→�→ →
Type new ID no. (0–63)→�→�→�→� 

Dial Plan Routing 3

Dial plan routing provides a way to route incoming calls on a “per B-channel group” basis. An 
incoming call is routed by matching the incoming number (by service, number of digits, and 
pattern) and then optionally deleting and/or adding digits to direct the call to a specific endpoint. A 
service must be specified; the number of digits and pattern are optional. For example, you can 
specify that calls received from a particular area code should be routed to the specific individual or 
group responsible for accounts in that area.

Dial plan routing is available in Hybrid/PBX mode only. Key systems route incoming calls on a per-
line basis.

*XUV
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You can specify the following additional services:

■ MCI Toll Services available for a DMS-250 or DEX600E switch type:

— MCI PRISM

— MCI Vnet

— MCI 800

— MCI 900

■ Local exchange carrier services available for a DMS-100 switch type:

— DMS Private

— DMS INWATS

— DMS OUTWATS

— DMS FX (foreign exchange)

— DMS Tie Trunk

Summary: Dial Plan Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Service: empty; Patterns: blank; Total Digits: 0;
Delete Digits: 0; Add Digits: 0

Valid Entries Service: Toll, Local, Miscellaneous
Entries: 0–15
Digits per Pattern: 0–8
Total Digits: 1–14
Delete Digits: 0–14, 0=wildcard
Add Digits: 0–4 (valid digits: 0–9)

Inspect No

Copy Option No

■ You can enter a service not shown on the Network Service screen by using the 5-
digit binary code that represents the service in the Network Facilities Information 
Element of ISDN PRI layer 3 signaling protocol. Contact your service provider for 
more information about the codes.

■ Dial plan routing does not affect PRI tandem trunks connected to slots with switch 
types of MERLIN-NTWK or MERLIN-PBX. See ‘‘Switch Type’’ on page 3-62 for 
details.

■ You must program a service before you program any other Dial Plan Routing 
function. If you have not programmed a service, complete the procedure below 
for the Service option and then repeat the procedure for each optional function 
that you want to program.
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Console Procedure To specify Service:
LinesTrunks→PRI→DialPlanRtg→Service→
Dial entry no.→Enter→Select service (AT&T Toll, 5ESS Local, MCI 
Toll, Miscellaneous, or DMS-100 Local)→Back→Back→Back 

To specify Patterns:
LinesTrunks→PRI→DialPlanRtg→Patterns→Dial entry no.→
Enter→Drop→Dial pattern (0–8)→Enter→Back→Back→
Back 

To specify Total Digits:
LinesTrunks→PRI→DialPlanRtg→Total Digits→
Dial entry no.→Enter→Drop→Dial digits (1–14)→Enter→
Back→Back→Back 

To specify Delete Digits:
LinesTrunks→PRI→DialPlanRtg→Delete Digits→
Dial entry no.→Enter→Drop→
Dial delete digits (0–14; 0=wildcard)→Enter→Back→Back→
Back

To specify Add Digits:
LinesTrunks→PRI→DialPlanRtg→Add Digits→
Dial entry no.→Enter→Drop→
Dial add digits (0–14; valid digits: 0–9)→Enter→Back→Back→
Back 

PC Procedure To specify Service:
�→�→	→�→Type entry no.→�→Select service (AT&T 
Toll, 5ESS Local, MCI Toll, Miscellaneous, or DMS-100 Local)→
�→�→�→� 

To specify Patterns:
�→�→	→� Type entry no.→�→ →
Type pattern (0–8)→�→�→ �→� 

To specify Total Digits:
�→�→	→�→Type entry no.→�→ →
Type digits (1–14)→�→�→�→� 

To specify Delete Digits:
�→�→	→� Type entry no.→�→ →
Type delete digits (0–14; 0=wildcard)→�→�→�→� 

To specify Add Digits:
�→�→	→� Type entry no.→�→ →
Type add digits (0–14; valid digits: 0–9)→�→�→�→� 

*XUV
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Outgoing Tables 3

PRI provides tables that work in conjunction with Personal Lines, pools, and ARS tables to route 
calls. The following tables specify services for outgoing calls:

■ Call-by-Call. Selects an outgoing service, based on routing digits and the bearer capability 
(voice, data, or both) of the calling extension. It allows a single group of B-channels to carry a 
variety of services, such as ACCUNET, SDN, and Megacom WATS. 

■ Network Selection. Selects a long-distance carrier. Calls that match Network Selection tables 
can be routed to a specific service by the Call-by-Call tables.

■ Special Services. Selects services, such as international dialing and operator assistance. 
Calls that match these tables are not routed by the Call-by-Call tables.

Network Selection Tables 3

Dialed prefixes for selecting long-distance carriers are matched to entries in the four Network 
Selection tables. Eight default tables are provided, specifying 10*** and 101****. The asterisks 
are wildcards that represent the various long-distance carrier codes. (10*** is the current U.S. 
standard for specifying long-distance carriers; 101**** is provided for future use.)

■ PRI tables that work with pools and ARS apply to Hybrid/PBX mode only.

■ When the PRI switch type is set for MERLIN-PBX or MERLIN-NTWK to support a 
PRI tandem trunk, outgoing tables do not affect outgoing calls for the PRI facility 
connected to the slot specified by the Switch Type setting.

■ U.S. customers rarely need to program additional Network Selection tables 
because long-distance carrier codes match 10*** or 101****. 

■ When routing private network trunks for ARS 10*** and 101**** 
(Interexchange or IXC) calls from a networked switch that is not connected to the 
public switched network and only has private trunks, the private network trunks 
must be assigned to the main pool on the switch where ARS is dialed. The ARS 
access code for local and remote systems must be identical. The following 
procedure does not affect these PRI tandem trunks.
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Summary: Network Selection Tables 3

Programmable by System Manager

Mode Key and Hybrid/PBX

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1Connectivity (100D and 100R module)

Factory Setting Not applicable

Valid Entries Prefix for long distance carrier

Inspect No

Copy Option No

Console Procedure LinesTrunks→PRI→OutgoingTbl→NetwkSelect→
Dial entry no.→Enter→Drop→Dial prefix→Enter→Back→
Back→Back

PC Procedure �→�→
→�→Type entry no.→�→ →
Type prefix→�→�→�→� 

Special Services Tables 3

Eight tables provide for international calling and for operator-assisted calls. Default tables include 
the special prefixes 0 and 00 for operator-assisted calls. Dialed numbers are matched against 
entries in these tables for patterns (011, 010, 01, 00, 0, and 1); for operator assistance 
(operator-assisted, presubscribed common carrier operator, and none); and for type of number 
(national or international). Up to four digits can be deleted.

Summary: Special Services Tables 3

Programmable by System Manager

Mode Key and Hybrid/PBX

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting See Table 3-4

Valid Entries Prefix for international or operator-assisted calls

Inspect No

Copy Option No

Console Procedure To specify Pattern:
LinesTrunks→PRI→OutgoingTbl→SpecialServ→
Pattern→Dial entry no.→Enter→Drop→Dial pattern→ 
Enter→Back→Back→Back→Back 

*XUV
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To specify Operator:
LinesTrunks→PRI→OutgoingTbl→SpecialServ→
Operator→Dial entry no.→Enter→Select type of operator→ 
Enter→Back→Back→Back→Back 

To specify Type of Number:
LinesTrunks→PRI→OutgoingTbl→SpecialServ→
TypeOfNumbr→Dial entry no.→Enter→Select type→Enter→ 
Back→Back→Back→Back 

To specify Delete Digits:
LinesTrunks→PRI→OutgoingTbl→SpecialServ→
DeleteDigit→Dial entry no.→Enter→Drop→Dial pattern→ 
Enter→Back→Back→Back→Back 

PC Procedure To specify Pattern:
�→�→
→�→�→Type entry no.→�→ →
Type pattern→�→�→�→�→ � 

To specify Operator:
�→�→
→�→�→Type entry no.→�→
Select type of operator→�→�→�→�→ � 

To specify Type of Number:
�→�→
→�→�→Type entry no.→�→
Type number type→�→�→�→�→� 

To specify Delete Digits:
�→�→
→�→�→Type entry no.→�→ →
Type digits to be deleted→%�→�→�→�→� 

Table 3-4. Special Services Table

Table Pattern (up to 4 digits) Operator Delete Digits (0 to 4)

0  011 None  3

1  010 Local Operator  3

2  01 Local Operator  2

3  00 Local Operator/
Presubscribed Carrier

 2

4  0 Local Operator  1

5  1 None  1

*XUV

*XUV



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-79PRI Facilities 

3

Call-by-Call Service Table 3

When a call is placed on a Call-by-Call B-channel group, a specific service is selected. The 
selected service depends on the match between the dialed digits and the table entries. A service 
must be specified; otherwise the entry is ignored. 

The Call-by-Call table can contain up to 10 entries. Each entry can contain up to 10 patterns, each 
with a maximum of eight digits. If a dialed number matches two patterns, the longer pattern takes 
precedence. For example, 212555 matches both 212555 and 212, but the system will match the 
longer pattern. In addition to patterns, the Call-by-Call table can be used to specify from 0 through 
8 digits to be deleted (the factory setting is 0).

If the last entry in the table is empty (that is, if no pattern is specified), this entry is used as a 
default and matches any pattern and type of call.

If ARS (Hybrid/PBX only) is used, ARS selects the route. If the route points to a Call-by-Call 
B-Channel group, Call-by-Call service selects the network service. ARS Call-by-Call service is 
integrated according to the specified bearer capability (voice, data, or both) for each feature. In 
addition, ARS digit deletion/addition may help specify the service selected by the Call-by-Call 
feature. See ‘‘Automatic Route Selection’’ on page 3-175 for more information.

The following additional services are available:

■  MCI Toll Services for a DMS-250 or DEX600E switch type:

— MCI PRISM

— MCI VNET

■ Local exchange carrier services available for a DMS-100 switch type:

— DMS Private

— DMS OUTWATS

— DMS FX (foreign exchange)

— DMS Tie Trunk

Summary: Call-by-Call Service Table 3

Programmable by System Manager

Mode Key and Hybrid/PBX

Idle Condition Not required

Planning Form 3b, Incoming Trunks: DS1 Connectivity (100D and 100R module)

Factory Setting Not applicable

Valid Entries Pattern: up to eight digits
Call Type: voice, data, both
Service: AT&T Toll, 5ESS Local, MCI Toll, DMS-100 Local, 
Miscellaneous
Delete Digits: 0 to 8
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Inspect No

Copy Option No

Console Procedure To specify Patterns:
LinesTrunks→PRI→OutgoingTbl→CBC Service→ 
Patterns→Dial list no. (0–9)→Enter→Drop→
Dial pattern (up to 8 digits; 0–9)→Enter→Back→Back→Back→
Back 

To specify Voice/Data:
LinesTrunks→PRI→OutgoingTbl→CBC Service→
Voice/Data→Dial list no. (0–9)→Enter→
Select voice, data, or both→Enter→Back→Back→Back→Back 

To specify Network Service:
LinesTrunks→PRI→OutgoingTbl→CBC Service→
NetwkServ→Dial list no. (0–9)→Enter→Select service (AT&T 
Toll, 5ESS Local, MCI Toll, Miscellaneous, or DMS-100 Local)→ 
Enter→Back→Back→Back→Back 

To specify Delete Digits:
LinesTrunks→PRI→OutgoingTbl→CBC Service→ 
DeleteDigit→Dial list no.(0–9)→Enter→Drop→
Dial no. of digits (0–8)→Enter→Back→Back→Back→Back 

PC Procedure To specify Patterns:
�→�→
→�→�→Type list no.(0–9)→�→ → 
Type pattern (up to 8 digits; 0–9)→�→�→�→�→� 

To specify Voice/Data:
�→�→
→�→�→Type list no.(0–9)→�→
Select voice, data, or both→�→�→�→�→� 

To specify Network Service:
�→�→
→�→�→Type list no. (0–9)→�→
Select service (AT&T Toll, 5ESS Local, MCI Toll, Miscellaneous, or 
DMS-100 Local)→�→�→�→� 

To specify Delete Digits:
�→�→
→�→�→Dial list no.(0–9)→�→ → Dial 
no. of digits(0–8)→�→�→�→�→� 

*XUV

*XUV



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-81BRI Facilities 

3

BRI Facilities 3

The procedures in this section provide the steps for programming the following options for Basic 
Rate Interface (BRI) facilities connected to an 800 NI-BRI module:

■ Service Profile Identifier (SPID) and Directory Number (DN)

■ Timers

Service Profile Identifier (SPID) and
Directory Number (DN) 3

Use this procedure to program the Service Profile Identifier (SPID) and Directory Number (DN) for 
each BRI line in the system. Until these values are programmed for each line, the system 
considers the BRI line inactive and the line will not initialize.

Summary: Service Profile Identifier (SPID) and
Directory Number (DN) 3

Programmable by System Manager

Mode Key, Hybrid/PBX

Idle Condition Not required

Planning Form 3i, Incoming Trunks: BRI Options (800 NI-BRI module)

Factory Setting none

Valid Entries SPID: up to 20 digits (any combination of 0 to 9)DN: up to 10 digits 
(any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure LinesTrunks→  or More→BRI→SPID/DN.→
Dial line/trunk no. (1–80)→Enter→Dial SPID→Enter→
Dial DN→Enter→Back→Back 

PC Procedure �→�→
→�→Type line/trunk no.(1–80)→�→
Type SPID→�→Type DN→�→�→� 

If you are adding BRI facilities to an existing system, clock synchronization must be 
set correctly. To inspect or change these values, see ‘‘Clock Synchronization’’ on 
page 3-34. 

The system will not be forced idle when SPIDs are entered. However, if for some 
reason a SPID changes, the line must be idle (no active call on the line) in order to 
change the SPID. 
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Timers 3

Use this procedure to set timer thresholds.

CAUTION:
The factory settings for these thresholds are standard and rarely need to be changed. If you 
are not sure of the correct timer and threshold settings for your BRI lines and trunks, check 
with your Lucent Technologies representative before you make a change. Incorrect settings 
can cause your BRI lines and trunks to malfunction.

If the network does not respond before the programmed time, the system takes the appropriate 
corrective action.

The timers are listed below:

■ T200 Timer. Minimum time that the link layer waits for an acknowledgment of a message sent 
from the system to the network.

■ T203 Timer. Maximum time that the link layer can remain inactive.

■ T303 Timer. Times the delay in network response when the system sends a setup message to 
initiate an outgoing call.

■ T305 Timer. Times the delay in network response when the system sends a disconnect 
message to clear a call.

■ T308 Timer. Times the delay in network response when the system sends a release message 
to clear a call.

Table 3-5 shows the factory setting for each timer and the valid range for each threshold.

If you enter an invalid timer value, you hear an error beep and the value that was previously 
stored is displayed on the screen.

Table 3-5. Timers

Timer/
Counter Purpose

Factory 
Setting Valid Range Increments

T200 Timer maximum response time 1000 ms 500 to 5000 ms 500 ms

T203 Timer maximum time 33 seconds 10 to 255 sec 1 sec

T303 Timer Set up timeout 4 seconds 2 to 10 sec 1 sec

T305 Timer Disconnect timeout 30 seconds 2 to 60 sec 1 sec

T308 Timer Release timeout 4 seconds 2 to 10 sec 1 sec
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Summary: Timers 3

Programmable by System Manager

Mode Key, Hybrid/PBX

Idle Condition Not required

Planning Form Form 3i, Incoming Trunks: BRI Options (800 NI-BRI module)

Factory Setting See Table 3-5

Valid Entries See Table 3-5

Inspect No

Copy Option No

Console Procedure LinesTrunks→  or More→BRI→Timers→Select 
timer→Drop→Dial no. of seconds or ms→Enter→Back→Back 

PC Procedure �→�→
→�→Select timer→ →
Type no. of seconds or ms→�→�→� 

Extensions 3

This section contains the following procedures: 

■ Assigning outside lines or trunks to the buttons on a telephone (including lines and trunks 
used for loudspeaker paging)

■ Copying line button assignments from one extension to either an individual extension or a 
block of extensions

■ Assigning the following buttons on telephones (for Hybrid/PBX systems only):

— System Access or Intercom Voice

— System Access or Intercom Ring

— System Access or Intercom Originate Only

— Shared System or Intercom Access

■ Programming rotary signaling on tip/ring ports

■ Assigning tip/ring functionality on the 016 ETR (enhanced tip/ring) module

*XUV
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3Programming Procedures

Assign Trunks or Pools to Extensions 3

Use this procedure to assign outside lines/trunks (connected to the control unit) to specific buttons 
on each telephone. The lines/trunks assigned to a button on a telephone are called Personal 
Lines.

This procedure is used only to change or add Personal Lines, Loudspeaker Paging, or Pool 
buttons (Hybrid/PBX only) to telephones. See ‘‘Assign Intercom or System Access Buttons’’ on 
page 3-87 to add or change Intercom (ICOM) or System Access (SA) buttons.

SECURITY ALERT:
Do not assign private networked lines as Personal Lines on telephone buttons (Hybrid/PBX 
mode only). Do not assign pools of private network trunks (tandem PRI or tandem tie) to 
telephones. Do not provide dial access to these pools. Use ARS to provide access to a 
remote networked system’s trunks for making outside calls. System users can reach 
extensions on the remote system by using normal inside calling procedures.

Individual lines/trunks can be assigned to a maximum of 64 extensions. Individual pools can be 
assigned as a Pool button on a maximum of 64 extensions.

The following lines/trunks cannot be assigned to a button on a telephone:

■ Lines/trunks used for Music-On-Hold

■ Lines/trunks used for maintenance alarms

Pool buttons cannot be assigned to or removed from extensions unless the pool has trunks 
assigned. If all trunks are to be removed from a pool, all Pool button assignments must first be 
removed from extensions. Another way of handling this situation is to program another trunk into 
the pool and then remove the Pool button assignments from the extensions.

■ Hybrid/PBX only. Individual lines/trunks assigned to a pool can be assigned to a button only 
on a DLC operator position. If one of the lines/trunks in a pool is assigned to a button on a 
non-DLC telephone, the result is a Pool button assignment.

■ Key only. The system assigns the first eight line numbers to buttons on multiline telephones 
whether or not an outside line is physically connected. If a line is not connected, the button 
assignment must be removed so the user can assign a feature to the button.

■ For the Transtalk 9031 wireless multiline telephone. The system assigns the first eight 
lines connected to the control unit even though the telephone has fewer than eight buttons 
available. Remove the extra lines in system programming so that the appropriate number of 
lines is assigned to buttons on these telephones.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be 
required to obtain a copyright license from and pay license fees to a third party (such as 
the American Society of Composers, Artists, and Producers or Broadcast Music 
Incorporated). Magic On Hold requires no such license and can be purchased from 
Lucent Technologies.
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Lines and trunks are assigned to buttons in the order in which you press each line button on the 
system programming console or keyboard. Existing line assignments can be rearranged by 
removing all current assignments and then pressing the line buttons on the console or keyboard in 
the order in which they should appear on the buttons. For information on the order of the 
programmed buttons, refer to the button numbers on the applicable planning form for each 
telephone.

If you want to reserve some blank buttons for features between line buttons, a line must be 
assigned as a placeholder for each blank button. After all lines are assigned, remove the lines 
used as placeholders on the buttons reserved for features.

Summary: Assign Trunks or Pools to Extensions 3

Programmable by System Manager

Mode All, but note differences in factory settings.

Idle Condition Extension idle

Planning Form 4l, Extension Copy: Multiline 4400-Series Telephone Template
4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Key Mode. An Intercom Ring (ICOM Ring) button, an Intercom Voice 
(ICOM Voice) button, and the first eight lines connected to the control 
unit are assigned to all multiline 4400-Series telephones, ETR, MLS, 
and MLX telephones (excluding operator positions), and MFMs 
connected to MLX telephones. Two ICOM Ring buttons are assigned 
to 4400, 4400D, and single-line telephones; no outside lines are 
assigned.

Behind Switch Mode. ICOM Ring, ICOM Voice, and prime line 
buttons are assigned to all multiline 4400-Series telephones, ETR, 
MLS, and MLX telephones (excluding operator positions), and MFMs 
connected to MLX telephones. Two ICOM Ring buttons are assigned 
to 4400, 4400D, and single-line telephones; no outside lines are 
assigned. When prime lines are assigned to MLX extensions, lines 
are not assigned to MFMs used to connect adjuncts. Lines for MFMs 
must be assigned separately.

Hybrid/PBX Mode. System Access Ring (SA Ring), System Access 
Voice (SA Voice), and System Access Originate Only (SA Orig Only) 
buttons are assigned to all multiline 4400-Series telephones, ETR, 
MLS, and MLX telephones (excluding operator positions). Five Call 
buttons are assigned to QCC operator positions. Two SA Ring 
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buttons and one SA Orig Only button are assigned to 4400, 4400D, 
and single-line telephones. No Personal Line or Pool buttons are 
assigned.

Valid Entries Extension numbers

Inspect Yes

Copy Option Yes

Console Procedure To program a single-line/trunk:
Extensions→Lines/Trunks→Dial ext. no.→ Enter→
Entry Mode→Dial line/trunk no.→Enter→Back→Back 

To program a block of lines/trunks:
Extensions→Lines/Trunks→Dial ext. no.→Enter→
Select trunk range→Toggle LED On/Off→Enter→Back→Back 

PC Procedure To program a single-line/trunk:
�→�→Type ext. no.→�→�→Type line/trunk no.→�→
�→� 

To program a block of lines/trunks: →�→�→Type ext. no.→ 
�→Select trunk range→Toggle letter G On/Off→�→�→� 

Copy Line/Trunk Assignments 3

Use this procedure to copy outside line/trunk button assignments, pool dial-out code restrictions 
(Hybrid/PBX only), and (for operator positions only) Night Service information from one extension 
to another extension or block of extensions with identical requirements.

If you are copying assignments to a block of extensions and one of the extensions in the block is in 
use, the display shows the Station Busy - Pls Wait message. Copying for the rest of the 
extensions in the block is delayed until the busy extension becomes idle. The number of the busy 
extension is not shown. If a DSS is attached, the LED associated with the busy extension is on. If 
you exit instead of waiting for the busy extension to become idle, copying for the rest of the 
extensions is cancelled; however, the assignments that have already been copied are not 
cancelled.

If you are copying assignments from an operator position to a block of extensions that includes 
both operator and non-operator extensions, the information is copied to only the operator 
positions; the non-operator positions are not affected. Similarly, if you are copying assignments 
from a non-operator position to a block of extensions that includes both operator and non-operator 
extensions, the information is copied to only the non-operator positions; the operator positions are 
not affected. The system does not provide an error tone to signal that the copy did not work for all 
of the extensions in the block.
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Summary: Copy Line/Trunk Assignments 3

Programmable by System Manager

Mode All

Idle Condition Extension idle

Planning Form 4l, Extension Copy: Multiline 4400-Series Telephone Template
4c, Extension Copy: MLX Telephone Template
4g, Extension Copy: ETR Telephone Template
4i, Extension Copy: MLS Telephone Template

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes: lines/pools assigned to an extension.

Copy Option Not applicable

Console Procedure To copy to a single extension:
Extensions→Line Copy→Single→Dial copy from ext. no.→
Enter→Dial copy to ext. no.→Enter→Back→Back 

To copy to a block of extensions: 
Extensions→Line Copy→Block→Dial copy from ext. no.→
Enter→Dial ext. no. of first extension in block→Enter→
Dial ext. no of last extension in block→Enter→Back→Back 

PC Procedure To copy to a single extension:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→� 

To copy to a block of extensions:
�→�→�→Type copy from ext. no.→�→
Type ext. no. of first extension in block→�→
Type ext. no. of last extension in block→�→�→� 

Assign Intercom or System Access Buttons 3

Use this procedure to assign or change the assignments for Intercom (ICOM) buttons used to 
make and receive inside calls. This includes the following types of ICOM buttons:

■ Ring

■ Voice

■ Originate Only (Ring or Voice)

In Hybrid/PBX mode only, use this procedure to assign or change assignments for System Access 
(SA) buttons used to make or receive inside and outside calls. This procedure includes the 
following types of System Access buttons:

■ Ring

■ Voice
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■ Originate Only (Ring or Voice)

■ Shared (Ring or Voice)

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Summary: Assign Intercom or 
System Access Buttons 3

Programmable by System Manager

Mode All, but note differences in factory settings

Idle Condition Extension idle

■ You cannot change the factory setting for Call buttons assigned to QCC operator 
positions, and you cannot assign Ring, Voice, Originate Only, or Shared buttons to 
QCC operator positions. However, the Call 5 (Ring/Voice) button on a QCC can be 
programmed for Voice Announce. See ‘‘Voice Announce’’ on page 3-131

■ System Access or Intercom buttons can be assigned to only the first 10 buttons on 
a multiline telephone. This allows for a combination of up to 10 SA or ICOM 
buttons for each telephone (excluding QCC operator positions).

■ You can remove SA or ICOM buttons, but at least one must remain on the 
extension.

■ When 4400, 4400D, and single-line sets are programmed with only one SA or ICOM 
button, the Transfer, Conference and Drop features are disabled. Other features that 
require a second dial tone, such as Account Code/Number Entry, After Call Work 
States, Call Pickup, Call Waiting, and Privacy, are also affected. For more information, 
see the Feature Reference.

■ Each System Access Ring or Voice on an individual telephone can be assigned as a 
Shared System Access (SSA) button on up to 16 other extensions.

■ Shared SA buttons cannot be assigned to 4400, 4400D, and single-line telephones or 
other tip/ring equipment connected to an 016 (T/R) or 008 OPT module; or to an 016 
ETR port when the port is programmed for T/R operation. Shared SA buttons can be 
assigned to a tip/ring or external alert device connected to an MFM in an MLX 
telephone. Shared SA buttons cannot be assigned when the corresponding SA button 
is on a 4400, 4400D, and single-line telephone.

■ Each System Access Ring or Voice on an individual extension can be assigned as a 
SSA button on up to 27 other extensions

■ SA and ICOM buttons are centrally programmed and cannot be programmed by 
individual extension users.
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Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjuncts: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct (DLC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Key Mode. An Intercom Ring (ICOM Ring) button, an Intercom Voice 
(ICOM Voice) button, and the first eight lines connected to the system 
are assigned to all multiline 4400-Series and MLX telephones, 
excluding operator positions. Two ICOM Ring buttons are assigned to 
4400 and 4400D telephones and to tip/ring equipment connected to 
an 016 (T/R) module or to an 016 ETR port when the port is 
programmed for T/R operation. An ICOM Ring and an Intercom 
Originate Only (ICOM Orig Only) button are assigned to tip/ring 
equipment connected by an MFM. No outside lines are assigned.

Behind Switch Mode. An ICOM Ring button, an ICOM Voice button, 
and a prime line button are assigned to all multiline 4400-Series and 
MLX telephones, excluding operator positions. Two ICOM Ring 
buttons and a prime line button are assigned to 4400 and 4400D 
telephones and to tip/ring equipment connected to an 016 (T/R) 
module or to an 016 ETR port when the port is programmed for T/R 
operation. An ICOM Ring button and an Intercom Originate Only Ring 
button are assigned to tip/ring equipment connected by an MFM. No 
outside lines are assigned.

Hybrid/PBX Mode. System Access Ring (SA Ring), System Access 
Voice (SA Voice), and System Access Originate Only (SA Orig Only) 
buttons are assigned to all multiline 4400-Series, ETR, MLS, and 
MLX telephones, excluding operator positions. Two SA Ring buttons 
and an SA Orig Only Ring button are assigned to 4400 and 4400D 
telephones and to tip/ring equipment (for example, single-line 
telephones or fax machines connected to an 016 (T/R) module). No 
Personal Line or pool buttons are assigned.

All Modes. System Access Ring (Hybrid/PBX mode) or Intercom 
Ring (Key and Behind Switch modes), System Access Voice (Hybrid/
PBX mode) or Intercom Voice (Key and Behind Switch modes), and 
the first 18 through 29 lines connected to the control unit are assigned 
to all DLC operator positions. The number of lines assigned depends 
on the type of telephone used as a DLC operator position. Refer to 
the appropriate telephone planning form for details.
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Valid Entries Not applicable.

Inspect Yes: specific button options.

Copy Option Yes. (You can copy additional SA buttons to another extension, but 
you cannot overwrite SA buttons that are already assigned.)

Console Procedure To program an extension:
More→Cntr-Prg→Program Ext→Dial ext. no.→Enter→ 
Start→Select button→Dial feature code (*16 or *18)→Enter→ 
(repeat from beginning to program another button)→Back→Back 

To copy extension programming:
More→Cntr-Prg→Copy ext→Dial copy from ext. no.→
Enter→Dial copy to ext. no.→Enter→ Back→Back 

PC Procedure To program an extension:
�→�→�→Type ext. no.→�→�→Select button→Type 
feature code (*16 or *18)→�→(repeat from beginning to program 
another button)→�→� 

To copy extension programming:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, using programming codes to perform these functions speeds the button 
assignment process.

Table 3-6 provides the programming codes for assigning Ring and Voice buttons. You can handle 
errors in data entry as follows:

■ If you enter a code incorrectly while programming, the display shows the Programming 
Error message and the red LED next to the button flashes. If this happens, press the button 
again and repeat the procedure.

■ If you make a mistake and program the wrong feature on a button, press the button, select 
Delete (� on the PC display), and press the button again.

Table 3-6. Programming Codes for Assigning Buttons

To... On the console... On the PC...

Assign SA or ICOM Ring button Dial *16 Type *16 

Assign SA or ICOM Voice 
button

Dial *16, press button being 
programmed again, and dial *19 

Type *16, press V + 
function key for button 
being programmed again, 
and type *19 

Assign SA or ICOM Originate 
Only Ring button

Dial *18 Type *18
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Rotary Signaling on Tip/Ring Ports 3

Use this procedure to enable or disable rotary signaling on tip/ring ports. You can program any tip/
ring port on an individual basis (including ports on the 016 ETR modules that are programmed for 
tip/ring operation). The factory setting is that rotary signaling is disabled.

Whenever the system receives a rotary digit on a port, it determines if the port is programmed as 
rotary-enabled. If the port is rotary-enabled, the system processes the digit. If the port is not rotary-
enabled, the digit is rejected. Touch-Tone digits are always accepted by the port, regardless 
whether it is rotary-enabled or not.

Summary: Rotary Signaling on Tip/Ring Ports 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 4f, Tip/Ring Equipment

Factory Setting Touch-Tone

Valid Entries Extension numbers for rotary dial telephones

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→  or More→RotaryEnabl→
Type rotary ext. no.→Enter→Back→Back 

Assign SA or ICOM Originate 
Only Voice button

Dial *18, press button being 
programmed again, and dial 
*19 

Type *18, press V + 
function key for button 
being programmed again, 
and type *19 

Assign SA button Dial *17, press the extension 
number of principal telephone 
[nnnn] then press the button 
number being shared [nn] 

Type *17, press the 
extension number of 
principal telephone 
[nnnn] then press the 
button number of specific 
button being shared [nn] 

Change current assignment for 
SA or ICOM Voice, Originate 
Only or Shared SA buttons 
from Voice to Ring

Dial **19 Type **19 

Table 3-6. Programming Codes for Assigning Buttons — Continued

To... On the console... On the PC...
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PC Procedure �→�→	→Type rotary ext. no.→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Tip/Ring Functionality on 016 ETR Modules 3

Use this procedure to assign either T/R or ETR functionality to ports on an 016 ETR module. Ports 
11–16 can be either T/R or ETR, but not both simultaneously. Ports 1–10 can be ETR only.

When a port on an 016 ETR module is changed from ETR to T/R or from T/R to ETR, all 
programming assigned to the extension (such as inclusion in coverage groups and Calling 
Groups) is cleared and the extension is restored to the functionality defined with the factory 
settings (such as calling restrictions and button assignments).

Summary: Tip/Ring Functionality on 
016 ETR Modules 3

Programmable by System Manager

Mode All

Idle Condition System idle

Planning Form 4g, Extension Copy: ETR Telephone Template

Factory Setting ETR

Valid Entries Tip/ring port

A system forced idle occurs when you perform this task. In addition to assigning either 
T/R or ETR functionality, with this task you are also able to determine whether a port on 
an 016 ETR module has been administered as T/R or ETR. However, because this task 
forces the entire system into a forced idle state, it is recommended you do not use it to 
determine how the port has been administered. Instead, to determine the functionality of 
an ETR port, it is recommended that you do either of the following:

■ Print an Extension Print Report. The report shows:

— “T/R” if the port is programmed as T/R.

— “ETR” if the port is programmed as ETR and an MLS or ETR telephone is 
connected to the port.

— “UNEQUIPPED” if the port is programmed as ETR and an MLS or ETR telephone 
is not connected to the ports.

■ View the extension profile by using this procedure:

Maintenance→Port→Station→Status

The profile shows the same information as previously listed for the Extensions Print 
Report.
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Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→  or More→ETR→Type ext. no.→ 
Enter→Select port type (ETR or Tip Ring)→Enter→Back→Back 

PC Procedure �→�→�→
→Type ext. no.→�→
Select port type (ETR or Tip Ring)→�→�→� 

Auxiliary Equipment 3

The procedures in this section describe the steps needed to perform the following:

■ Identify the line/trunk jacks used for Music-On-Hold, loudspeaker paging, and maintenance 
alarms.

■ Identify the extension jacks used for fax and CTI link.

■ Specify parameters for the MERLIN Messaging System, Octel 100 Messaging, and Intuity 
AUDIX.

Music-On-Hold 3

Use this procedure to identify the line/trunk jack reserved for connection of a music source, such 
as a radio, tape player, or stereo system.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be required 
to obtain a copyright license from and pay license fees to a third party [such as the American 
Society of Composers, Artists, and Producers (ASCAP) or Broadcast Music Incorporated (BMI)]. 
Magic On Hold requires no such license and can be purchased from your Lucent Technologies 
dealer.

Only one Music-On-Hold line/trunk jack is allowed per system.

You cannot assign the line/trunk identified for Music-On-Hold to a line/trunk pool. If the line/trunk is 
currently assigned to a pool, you must remove it before you program this option.

You cannot assign the line/trunk identified for use with Music-On-Hold to a button on any extension 
or as a Remote Access trunk, and you cannot use the line/trunk jack identified for Music-On-Hold 
for a loudspeaker paging system or maintenance alarm.

Each system in a private network must have its own music source. A music source connected to a 
remote private networked switch cannot be used by the local system.

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.
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Summary: Music-On-Hold 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode the line/trunk designated for Music-On-
Hold cannot be assigned to a line/trunk pool.

Idle Condition System idle

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk number

Inspect No

Copy Option No

Console Procedure AuxEquip→MusicOnHold→Dial line/trunk no.→Enter→Back 

PC Procedure �→�→Type line/trunk no.→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Loudspeaker Paging 3

Use this procedure to identify the line/trunk jack reserved for connection of loudspeaker paging 
equipment.

If you use equipment that rebroadcasts music or other copyrighted materials, you may be required 
to obtain a copyright license from and pay license fees to a third party (such as ASCAP or BMI). 
Magic On Hold requires no such license and can be purchased from your Lucent Technologies 
dealer.

A maximum of three single-zone or multizone loudspeaker paging systems can be connected to 
the system.

You cannot assign the line/trunk identified for loudspeaker paging equipment to a line/trunk pool. If 
the line/trunk is currently assigned to a pool, you must remove it before you program this option.

You cannot assign the line/trunk identified for loudspeaker paging equipment as a Remote Access 
line/trunk, and you cannot use its jack for Music-On-Hold or maintenance alarm.

Summary: Loudspeaker Paging 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode the line/trunk designated for loudspeaker 
paging cannot be assigned to a line/trunk pool.

Idle Condition Line/trunk idle
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Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk numbers

Inspect Yes

Copy Option No

Console Procedure AuxEquip→Ldspkr Pg→Dial line/trunk no.→Enter→Back 

PC Procedure �→�→Type line/trunk no.→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Fax Machines 3

Use this procedure to add a fax machine by assigning the extension jack used to connect the fax 
machine. To remove a fax machine and free the extension jack for another use, you must remove 
the extension jack assignment.

In addition, you can specify the extensions to receive a message-waiting indication (MWI) when a 
fax transmission is received, and specify the length of time before the system registers that a fax 
has arrived and sends the message-waiting indication.

A maximum of 16 fax machines can have the Fax Message Waiting feature. Additional fax 
machines (more than 16) can be installed, but these machines cannot have this feature.

You can specify up to four telephones to receive the message-waiting indication when a fax 
transmission is received. Note that fax machines can only send and not receive message-waiting 
indications.

Summary: Fax Machines 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 10 seconds
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Valid Entries 0 to 30 seconds

Inspect Yes

Copy Option No

Console Procedure To program an extension for a fax machine:
AuxEquip→Fax→Extension→Dial ext. no.→Enter→Back

To have a message waiting light for a fax machine:
Fax→Extension→Dial ext. no.→Enter→Back→
Msg Waiting→Dial fax machine ext. no.→Enter→
Dial MWI ext. no.→Enter→Threshold→Drop→
Dial no. of seconds (0–30)→Enter→ Back→Back

PC Procedure To program an extension for a fax machine:
�→�→�→Type ext. no.→�→�

To have a message waiting light for a fax machine:
�→�→Type ext. no.→�→�→�→ 
Type fax machine ext. no.→�→Type MWI ext. no.→�→�→

→Type no. of seconds (0–30)→�→�→� 

Maintenance Alarms 3

Use this procedure to identify the line/trunk jack that connects an external alerting device that 
sounds or flashes when major maintenance problems occur.

You cannot assign the line/trunk identified for the maintenance alarm to a button on any telephone 
or as a Remote Access trunk, and you cannot use its line/trunk jack to connect a loudspeaker 
paging system or Music-On-Hold.

Summary: Maintenance Alarms 3

Programmable by System Manager

Mode All, but in Hybrid/PBX mode, the line/trunk designated for the 
maintenance alarm cannot be assigned to a line/trunk pool. 

Idle Condition  System idle

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not Applicable

Valid Entries Line/trunk number

Inspect No

Copy Option No

Console Procedure AuxEquip→MaintAlarms→Dial line/trunk no.→Enter→Back→
Back 

PC Procedure �→�→Type line/trunk no.→�→�→� 

*XUV
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Voice Messaging System and Automated Attendant 3

Use this procedure to specify the Touch-Tone duration and the interval between digits in codes 
sent between a voice messaging system and the MERLIN MAGIX system. The Touch-Tone 
duration and interval between digit assignment must be the same as those programmed on the 
voice messaging system.

In addition, this procedure can be used to specify the number of rings before a call transferred to a 
local extension by the voice messaging system is sent to the backup position for both integrated 
and generic VMI ports. The number of rings cannot be programmed for individual voice messaging 
systems; the single setting applies for all. Use the Group Type procedure in ‘‘Optional Group 
Features’’ on page 3-131 to assign VMI ports as either integrated or generic.

SECURITY ALERT:
See ‘‘Security Risks Associated with the Automated Attendant Feature of Voice Messaging 
Systems’’ on page A-11 and ‘‘Security Risks Associated with Transferring through Voice 
Messaging Systems’’ on page A-9 in Appendix A, ‘‘Customer Support Information,” for details 
on preventing toll fraud.

Summary: Voice Messaging System and Automated 
Attendant 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form See forms packaged with application

Factory Setting Touch-Tone duration: 100 ms 
Interval between digits: 50 ms 
Number of rings before transfer sent to backup: 4

Valid Entries Touch-Tone duration: 50 to 200 ms, in increments of25 ms
Interval between digits: 50 to 200 ms, in increments of 25 ms
Number of rings before transfer sent to backup: 0 to 9

Inspect No

Copy Option No

Console Procedure AuxEquip→VMS/AA→TransferRtn→Drop→
Dial no. of rings (0–9)→Enter→TT Duration→Drop→
Dial no. of ms (50–200 ms, in increments of 25 ms)→Enter→
TT Interval→Drop→Dial no. of ms (50–200 ms, in increments of 
25 ms)→Enter→ Back→Back 

This does not apply to calls transferred to a non-local extension. See the Network 
Reference for information.
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PC Procedure �→�→�→ →Type no. of rings(0–9)→�→ 
�→ →Type no. of ms (50–200 ms, in increments of 25 ms)→ 
�→�→ →Type no. of ms (50–200 ms, in increments of 25 
ms)→�→�→� 

Computer Telephony Integration (CTI) Link 3

The system supports the use of an MLX port as a Computer Telephony Integration (CTI) link on 
Hybrid/PBX mode systems. The CTI link feature allows CTI applications to interact with the 
MERLIN MAGIX Integrated System over a local area network (LAN). The CTI link is the system’s 
hardware and software interface to the Lucent Technologies PassageWay Telephony Services 
product, which supports the Windows 95, Windows NT, Windows 3.1, Windows 3.11 for 
Workgroups, Apple® Macintosh® OS and UNIX Systems platforms on the client side. CTI link 
circuitry connects to an MLX port on the system and to a LAN server using Novell NetWare or 
Windows NT 4.0 Server or Workstation software (Server is recommended).

Programming a CTI Link 3

Before programming a CTI link, refer to the Feature Reference, System Planning, and the 
documentation provided with the telephony platform.

The following constraints apply to programming an MLX port as a CTI link:

■ CTI links cannot be used with systems operating in Key mode or Behind Switch mode. 

■ CTI link extensions cannot be programmed on tip/ring extension module ports. You must 
choose a free extension jack on an MLX extension module. The free extension jack cannot be 
the first or fifth port on an 008 MLX or 408 GS/LS-ID-MLX module; or the first, fifth, ninth, or 
thirteenth port on an 016 MLX module. 

■ You cannot use a port reserved for an operator extension as the CTI link extension.

■ You cannot use a system programming port as the CTI link extension.

■ You cannot program a port as a CTI link if it has a telephone or other equipment 
connected to it.

■ MLX modules with firmware vintage 29 do not work correctly with the CTI link. You must either 
choose a port on a board with firmware vintage that is not 29 or replace the module with a 
module that has a firmware vintage other than 29.

■ You should choose a module other than the one that has the system 
programming port so that you can still perform maintenance and system 
programming when the board with the CTI link extension is busied-out. 

■ Be sure to busy-out the board with the CTI link before starting any programming 
activities.

*XUV

*XUV

*XUV
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When you add a CTI link, the system performs the following actions: 

■ The programmed buttons for that extension revert to the factory settings for a non-operator 
MLX telephone.

■ Forwarding is deactivated to the extension.

■ The extension is removed from membership in Calling Groups.

■ The extension is removed from membership in coverage groups.

■ The extension is removed from membership in Service Observing groups, or as an Observer 
of a Service Observing group.

■ The Extension Directory label for the extension is changed to CTILINK.

■ The factory setting for alarms is active on this link.

■ Dial access to pools is removed from the station.

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Summary: CTI Link 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 2b, System Numbering: Digital Adjuncts

Factory Setting No port programmed as CTI link

Valid Entries Any extension on an MLX port board except the System 
Programming console port and the first and fifth ports.

Inspect Yes

Copy Option No

■ Be sure to restore the board after finishing any programming activities.

■ If the primary and secondary cover buttons are not removed, the following 
message appears on the programming device (WinSPM, 4424LD+, or MLX-20L):

CTI Link Extension xxxx 
added, but it has 
primary or secondary 
cover buttons at other 
extensions. 
Please remove them.
Exit
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Console Procedure Busy out the board first. This is a Maintenance step. Start the 
procedure from the Main menu, not the System Programming screen.
Menu→Maintenance→Slot→Dial slot no. (1–17)→Enter→
Busy-Out→Yes

Program the CTI link:
AuxEquip→CTI Link→Dial extension no.→Enter→Back→
Back

Restore the slot. This is a Maintenance step. Start the procedure from 
the Main menu, not the System Programming screen.
Menu→Maintenance→Slot→Dial slot no. (1–17)→Enter→ 
Restore→Yes 

PC Procedure Busy out the board first:
�→�→Type slot no. (1–17)→�→�→� 

Program the CTI link:
�→	→Type extension number→�→�→� 

Restore the slot. This is a Maintenance step. Start the procedure from 
the Main menu, not the System Programming screen.
�→�→Dial slot no. (1–17)→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

CTI Link Programming Errors 3

During the programming of the CTI link, entering an inappropriate extension number can give you 
an error message. This section contains displays of each screen and information about what to do 
if the screen appears.

System Not in Hybrid/PBX Mode 3

This message appears if the system is not in Hybrid/PBX mode. CTI links cannot be used with 
systems operating in Key mode or Behind Switch mode. 

CTI Link Extensions:

Extension xxxx Failed.

System Not in

Hybrid/PBX Mode.

Back 
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Extension Selected Not on MLX Port Module 3

This message appears if you have chosen an extension that is not on an MLX Port Module. CTI 
link extensions cannot be programmed on tip/ring extension module ports. You must choose an 
extension that is on an MLX port module (008 MLX, 016 MLX, or 408 GS/LS-ID-MLX).

Extension Selected Is System Programming Port 3

This message appears if you have chosen an extension that has been programmed as a system 
programming port, which is not permitted as the CTI link port. You must choose another port for 
the CTI link extension.

MLX Port Module Contains Firmware Vintage 29 3

This message appears when the port that you are programming as the CTI link is on an MLX 
module with firmware vintage 29. Modules with this firmware vintage do not work correctly with the 
CTI link. You must either choose a port on a board with firmware vintage other than 29 or replace 
the module with a module that has a firmware vintage other than 29.

CTI Link Extensions:

Extension xxxx Failed.

Not on MLX Port Module.

Back

CTI Link Extensions:

Extension xxxx Failed.

Extension Selected is

System Programming Port.

Back

You should choose a module other than the one that has the system programming port, 
so that you can still perform maintenance and system programming when the board with 
the CTI link extension is busied-out.

CTI Link Extensions:

Extension xxxx Failed.

MLX Port Module Contains

Firmware Vintage 29.

Back
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Port Reserved for Operator Positions 3

This message appears when the port that you are programming as the CTI link is on the Operator 
Position list (as a QCC or DLC). Check your printout of the Operator Information Report for 
programmed operator positions. 

Extensions Covered by Extension 3

This message appears when the port that you are programming as the CTI link is covered by other 
extensions. You should remove the Cover buttons on these extensions.

Slot Not Busied-Out 3

This message appears when the port that you are programming as the CTI link is on a board that 
has not been busied-out. Busy-out the board. 

CTI Link Extensions:

Extension xxxx Failed.

This Port is Reserved

For Operator Positions.

Back

CTI Link Extension: xxxx 

added, but it has

primary or secondary

cover buttons at other

extensions.

Please remove them.

Back

CTI Link Extension: xxxx 

not added. Please

busy out slot xx first.

If this is the only MLX

port module, use SPM for 

CTI link administration

Back
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Optional Extension Features 3

The summaries in this section detail the steps in programming the following optional features:

■ Extension Language

■ Pool Dial-Out Code

■ Calling Restrictions

■ Copy Calling Restrictions

■ ARS Restriction Level for Extensions

■ Forced Account Code Entry

■ Microphone Operation

■ Authorization Codes

■ Remote Call Forwarding

■ Delayed Call Forwarding

■ Trunk-to-Trunk Transfer

■ Primary Cover Ring Delay

■ Secondary Cover Ring Delay

■ Group Coverage Ring Delay

■ Hotline (single-line telephone only)

■ Display Preference

■ Service Observing

Extension Language 3

Use this procedure to change the language for 4400-Series, ETR, and MLX display telephones.

Summary: Extension Language 3

Programmable by Users and System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
4h, ETR telephone
4k, 4400/4400D telephone
5b, Direct-Line Console (DLC)
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting U.S. English

Valid Entries U.S. English, Canadian French, Latin American Spanish



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-104Optional Extension Features 

3

Inspect No

Copy Option No

Console Procedure To program a single extension:
 or More→Language→Extensions→Single→Dial ext. no.→

Enter→Select a language (English, French, or 
Spanish)→Enter→
Back→Back 

To program a block of extensions:
 or More→Language→Extensions→Block→

Dial starting ext. no.→Enter→Dial ending ext. no.→Enter→
Select a language (English, French, or Spanish)→Enter→Back→
Back 

PC Procedure To program a single extension:
�→�→�→�→Type ext. no.→�→
Select a language (English, French, or Spanish)→�→�→� 

To program a block of extensions:
�→�→�→�→Type starting ext. no.→�→
Type ending ext. no.→Select a language (English, French, or 
Spanish)→�→�→� 

Pool Dial-Out Code 3

Use this procedure to allow or restrict dialing pool dial-out codes and placing calls on specific line/
trunk pools. The factory settings restrict all extensions from dialing any line/trunk pool dial-out 
code. 

SECURITY ALERT:
Do not allow dial access to pools of non-local tie or PRI tandem trunks (Hybrid/PBX mode 
only). When callers in your system need to use these pools for outside calls, use ARS to 
direct the calls to these pools. Callers in your system use normal inside calling procedures to 
reach extensions on private networked systems.

The factory settings allow all extensions to dial any line/trunk pool dial-out code. Entering 
a pool dial-out code and then deleting that code restricts the user from using the pool 
associated with the entered code.
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Summary: Pool Dial-Out Code 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Extension idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct (DLC)
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Main pool: 70; All other pools: 890 to 899. All telephones are 
restricted from dialing any pool dial-out code.

Valid Entries Pool numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→Dial OutCd→Dial ext. no.→Enter→
Dial pool dial-out code→Enter→Back→Back 

PC Procedure �→�→Type ext. no.→�→Type pool dial-out code→�→
�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Calling Restrictions 3

Use this procedure to change individual extension calling restrictions to one of the following:

■ Unrestricted

■ Restricted from making all outgoing calls

■ Restricted from making toll calls
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SECURITY ALERT:
Toll fraud can occur if extensions are not properly restricted. See ‘‘Security of Your System: 
Preventing Toll Fraud’’ on page A-7 in Appendix A for more information and security 
procedures.

Summary: Calling Restrictions 3

Programmable by System Manager

Mode All

Idle Condition Extension idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Unrestricted

Valid Entries Unrestricted, Outward restricted, Toll restricted

Inspect No

Copy Option Yes

Console Procedure Extensions→Restriction→Dial ext. no.→Enter→
Select restriction (Unrestricted, Outward restricted, or Toll 
restricted)→Enter→Back 

PC Procedure �→�→Type ext. no.→�→Select restriction (Unrestricted, 
Outward restricted, or Toll restricted)→�→� 

Outward and toll calling restrictions are automatically removed when a caller dials an 
extension in the non-local dial plan. FRL restrictions still apply. For details, see 
‘‘Uniform Dial Plan Routing’’ on page 3-186.
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Copy Calling Restrictions 3

Use this procedure to copy calling restrictions, Allowed Lists, and Disallowed Lists. Feature 
assignment must be completed for the “copy from” extension. These features can then be copied 
to an individual extension or block of extensions with identical calling restriction requirements.

If you are copying restrictions to a block of extensions and one of the extensions in the block is in 
use, the display shows the Station Busy - Pls Wait message. Copying for the rest of the 
extensions in the block is delayed until the busy extension becomes idle. The number of the busy 
extension is not shown. If a DSS is attached, the LED associated with the busy extension is on. If 
you exit instead of waiting for the busy extension to become idle, copying for the rest of the 
extensions in the block is cancelled; however, the restrictions that have already been copied are 
not cancelled.

If you are copying restrictions to a block of extensions, they must be sequentially numbered.

The extensions you are copying to and from can be both operator and nonoperator positions.

Summary: Copy Calling Restrictions 3

Programmable by System Manager

Mode All

Idle Condition “Copy to” extension or extensions idle

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option Not applicable

Dial-out code restrictions are not copied.
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Console Procedure To copy to a single extension:
Extensions→RestrctCopy→Single→Dial copy from
ext. no.→Enter→Dial copy to ext. no.→Enter→Back→ 
Back→Back 

To copy to a block of extensions:
Extensions→RestrctCopy→Block→Dial copy from ext. no.→
Enter→Dial first no. in copy to block→Enter→
Dial last no. in copy to block→Enter→Back→Back→Back 

PC Procedure To copy to a single extension:
�→�→�→Type copy from ext. no.→�→
Type copy to ext. no.→�→�→�→� 

To copy to a block of extensions:
�→�→�→Type copy from ext. no.→�→
Type first copy no. in copy to block→�→�→�→� 

ARS Restriction Level for Extensions 3

Use this procedure to assign an ARS restriction level to an extension. Outgoing calls can be made 
only to routes that have a Facility Restriction Level (FRL) lower than or equal to that of the 
extension for which the call is being made. Only outgoing calls are affected; users can receive 
inside, local, and toll calls on restricted telephones and can join any type of call in progress. 

The restriction level assigned to extensions is opposite to the FRL assigned to routes, where 0 is 
the most and 6 is the least restrictive.

FRLs assigned to extensions apply not only to ARS calls, but also to calls for non-local dial plan 
extensions connected by private trunks to your local system. For this reason, use care in assigning 
FRLs both to extensions and to UDP routes. For example, if a user must be restricted from toll 
calls on your local system, you may need to plan UDP routes’ FRLs to allow the user to reach 
necessary non-local dial plan extensions. For details, see ‘‘Uniform Dial Plan Routing’’ on page 
3-186.

Summary: Assigning ARS Restriction Level For an 
Extension 3

Programmable by System Manager

Mode Hybrid/PBX only

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
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5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
6g, Call Restriction Assignments and Lists

Factory Setting  3

Valid Entries 0–6 (0 is most restrictive and 6 is least restrictive)

Inspect No

Copy Option No

Console Procedure Extensions→  or More→ARS Restrict→Dial ext. 
no.→Enter→
Drop→Dial restriction level (0–6)→Enter→Back 

PC Procedure �→�→�→Type ext. no.→�→ →
Type restriction level (0–6)→�→� 

Forced Account Code Entry 3

Use this procedure to assign or remove Forced Account Code Entry. When this feature is 
programmed on individual extensions, the user must enter a 1- to 16-digit account code before 
making an outside call.

Summary: Forced Account Code Entry 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Not assigned

Valid Entries Assigned, not assigned

Inspect Yes

Copy Option No

*XUV
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Console Procedure Extensions→Account→Toggle LED On/Off or dial ext. no.→
Enter→Back→Back 

PC Procedure �→	→Toggle letter R On/Off or type ext. no.→�→�→� 

Microphone Operation 3

Use this procedure to enable or disable microphones on MLX telephones (except QCC operator 
positions). When the microphone is disabled, users cannot use the speakerphone to conduct 
conversations.

Summary: Microphone Operation 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
5b, Direct-Line Console (DLC)

Factory Setting Enabled

Valid Entries Enabled, Disabled

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Mic Disable→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→	→Toggle letter R On/Off or type ext. no.→�→ 
�→� 

Authorization Codes 3

The Authorization Code feature allows you to pick up someone else’s telephone, enter your 
authorization code, and complete a call with the restrictions that apply to your own telephone 
(home extension). This includes toll restrictions, outward restriction, FRL, Allowed Lists, 

The microphone cannot be disabled on MLX telephones used as QCC operator positions.
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Disallowed Lists, Forced Account Code Entry (FACE), Night Service Exclusion List, and Dial 
Access to Pools.

Use this procedure to assign or remove an authorization code to an extension. The authorization 
code can range from 2 to 11 characters (0 – 9, *) and must be unique for each extension. An 
authorization code cannot begin with an “*.”

If you are assigning authorization codes for a group of sequential extensions, begin programming 
the lowest extension number to take advantage of the Next screen key (see “Standard 
Procedures”).

Summary: Authorization Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6h, Authorization Codes

Factory Setting Not assigned

Valid Entries 2–11 characters (0–9, *)

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Auth Code→Dial ext. no.→Enter→
Dial authorization code (2–11 digits, 0–9, *)→ Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→
Type authorization code (2–11 digits, 0–9, *)→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Remote Call Forwarding 3

Use this procedure to allow or disallow the Remote Call Forwarding capability, which permits users 
to forward calls to an outside number. Remote Call Forwarding must be enabled in order for an 
extension user to activate Centrex Transfer via Remote Call Forwarding. Remote Call Forwarding 
may be used to forward calls across the private network.

A user can activate Call Forwarding and Remote Call Forwarding by entering his or her 
home extension authorization code while at any telephone in the system; this is useful 
when activating Call Forwarding or Remote Call Forwarding at phantom stations. It is also 
useful when a single-line telephone extension needs a PAUSE character in the Remote 
Call Forwarding digit string.
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If an extension with Remote Call Forwarding has one or more Personal Lines assigned, that 
extension can be assigned as the principal user, and calls received on that line are forwarded to 
outside numbers. See ‘‘Principal User for Personal Line’’ on page 3-30.

SECURITY ALERT:
See ‘‘Security of Your System: Preventing Toll Fraud’’ on page A-7 in Appendix A for more 
information and security procedures on preventing toll fraud with Remote Call Forwarding.

Summary: Remote Call Forwarding 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Disallowed

Valid Entries Disallowed, allowed

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Remote Frwd→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→
→Toggle letter R On/Off or type ext. no.→�→ 
�→� 

■ This feature is not recommended unless you have ground-start trunks. See 
‘‘Disconnect Signaling Reliability’’ on page 3-27. 

■ Ensure that the number of rings for Remote Call Forwarding is less than the 
Coverage Delay or the call will not forward.

■ Use the Forwarding feature.
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Delayed Call Forwarding 3

Delayed Call Forwarding allows a user to answer or screen a call arriving at an extension before 
the call is forwarded through Call Forwarding, Remote Call Forwarding, or Follow Me. The 
forwarding delay is the number of rings before the call is forwarded. This delay can range from 0 to 
9 rings. If the forwarding delay is set to 0, the call is forwarded immediately.

Use this procedure to assign or remove Delayed Call Forwarding from an extension. If you are 
assigning Delayed Call Forwarding to a group of sequential extensions, begin by programming the 
lowest extension number to take advantage of the Next screen key (see “Standard Procedures”).

Summary: Delayed Call Forwarding 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting 0 rings

Valid Entries 0–9 rings

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Delay Frwd→Dial ext. no.→Enter→
Drop→Dial no. of delay rings (0–9)→Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→ →
Type no. of delay rings (0–9)→�→�→� 

When Do Not Disturb is activated at an extension, it overrides Delayed Call Forwarding 
and the call is forwarded immediately.

*XUV
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Trunk-to-Trunk Transfer 3

Use this procedure to enable or disable trunk-to-trunk transfer at an extension. When trunk-to-
trunk transfer is disabled, users cannot transfer an outside call to an outside line. 

Summary: Trunk-to-Trunk Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC
5d, Queued Call Console (QCC)
Data Form 1a, Modem Data Workstation
Data Form 1b, ISDN Terminal Adapter Data Workstation

Factory Setting Disabled

Valid Entries Enabled, Disabled

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→  or More→TrkTransfer→
Toggle LED On/Off or dial ext. no.→Enter→Back→Back 

PC Procedure �→�→�→�→Toggle letter R On/Off or type ext. no.→
�→�→� 

Calls can be transferred to members in the non-local dial plan tables, even if trunk-to-
trunk transfer is not allowed (Hybrid/PBX mode only). This allows users of single-line 
telephones to transfer incoming calls from the PSTN to non-local dial plan extensions.
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Primary Cover Ring Delay 3

Use this procedure to specify the following:

■ The delay before a Primary Cover button, programmed for Delay Ring, begins to ring audibly.

■ The delay, in addition to the Group Coverage Ring Delay, before sending calls to Group 
Coverage when the sender has Primary or Secondary Coverage and any receiver is available.

The Primary Cover Ring Delay is programmed for each sender’s extension.

Summary: Primary Cover Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 2 rings

Valid Entries 1–6 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Primary→Dial sender’s extension→Enter→Dial no. of rings
(1–6)→Enter→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→
Type no. of rings (1–6)→�→� 

Secondary Cover Ring Delay 3

Use this procedure to specify the delay, in addition to the fixed Secondary Coverage Delay Interval 
(two rings), before a Secondary Cover button programmed for Delay Ring begins to ring audibly.

The Secondary Cover Ring Delay is programmed for each sender’s extension.
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Summary: Secondary Cover Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4m, Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 2 rings

Valid Entries 1–6 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Secondary→Dial sender’s extension→Enter→Dial no. of rings
(1–6)→Enter→ Back→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→ 
Type no. of rings (1–6)→�→�→� 

Group Coverage Ring Delay 3

Use this procedure to specify the following:

■ The number of rings before sending calls to Group Coverage when the sender does not have 
Primary or Secondary Coverage or the receivers are not available, and the Group Coverage 
receiver is either a Calling Group only or the QCC queue only (no Group Cover buttons on 
multiline telephones)

■ The number of rings, in addition to the Primary Cover Ring delay, before sending calls to 
Group Coverage when the sender has Primary or Secondary Coverage and the receivers are 
available

The Group Coverage Ring Delay is programmed for each sender’s extension.

Summary: Group Coverage Ring Delay 3

Programmable by System Manager

Mode All

Idle Condition Not required
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Planning Form 4m,Multiline 4400-Series Telephone
4k, 4400/4400D Telephone
4d, MLX Telephone
4e, MFM Adjunct: MLX Telephone
4f, Tip/Ring Equipment
4h, ETR Telephone
4j, MLS Telephone
5b, Direct-Line Console (DLC)
5c, MFM Adjunct: DLC

Factory Setting 3 rings

Valid Entries 1–9 rings

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→Cover Delay→ 
Group→Dial sender’s extension→Enter→Dial no. of rings 
(1–9)→Enter→Back→Back 

PC Procedure �→�→�→�→�→Type sender’s extension→�→
Type no. of rings (1–9)→�→�→� 

HotLine 3

Use this procedure to enable or disable the HotLine feature on a tip/ring single-line telephone or 
device. 

Summary: HotLine 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4f, Tip/Ring Equipment

Factory Setting Disabled

Valid Entries Yes, No

Inspect No

Copy Option No

Console Procedure Extensions→  or More→  or More→HotLine→
Enter HotLine extension→Enter→Back→Back 

PC Procedure �→�→�→�→Type HotLine extension→�→�→
� 
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Display Preference 3

Use this procedure to specify display preferences for incoming inside calls or non-local dial plan 
calls that arrive on PRI tandem trunks. Non-local dial plan calls that arrive on private networked 
tandem tie trunks are not affected; such calls display on the recipient’s telephone like outside calls 
do—that is, they do not have Calling Party information. For details about the display content, see 
the Feature Reference.

Summary: Display Preference 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting Calling Number

Valid Entries Calling Name, Calling Number, Both

Inspect No

Copy Option Yes

Console Procedure Extensions→  or More→  or More→DisplayPref→
Dial extension no.→Enter→Select display option (Calling Name, 
Calling Number, or Both)→Enter→ Back→Back 

PC Procedure �→�→�→�→Type extension no.→�→
Select display option (Calling Name, Calling Number, or Both)→
�→�→� 

Service Observing 3

Use this procedure to configure up to 16 Service Observing groups on a system. Each Service 
Observing group consists of one Service Observer and a list of the stations (up to the system 
maximum of 200) that the observer is allowed to monitor. A warning tone is programmed on a per 
group basis to provide an audible indication that a station is being observed.

Service Observing may be subject to federal, state, or local laws, rules, or regulations or 
require the consent of one or both of the call parties. You must check in your jurisdiction 
and comply with all applicable laws, rules, and regulations before using this feature. 
Failure to comply may result in severe penalties.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-119Optional Extension Features 

3

Summary: Service Observing 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 4d, MLX Telephone
4m, Multiline 4400-Series Telephone
5b, Direct-Line Console (DLC)
11, Service Observing: Group Assignment

Factory Setting Warning: Yes

Valid Entries Warning: Yes, No

Inspect Yes

Copy Option No

Console Procedure To assign a Service Observer to a Service Observing group:
Extensions→  or More→  or More→ServiceObs→ 
Observer→Dial group no. (1–32)→Enter→Dial ext. no. of Service 
Observer→Enter or Delete→ Back→Back 

To enable or disable Warning Tone on a per group basis:
Extensions→  or More→  or More→ ServiceObs→ 
Warning→Dial group no. (1–32)→Enter→Yes or No→ 
Enter→Back→Back 

To assign a member extension to a Service Observing group:
Extensions→  or More→  or More→ServiceObs→ 
Members→Dial group no. (1–32)→Enter→Dial ext. no.→
Enter or Delete→Back→Back→Back 

PC Procedure To assign a Service Observer to a Service Observing group:
�→�→�→�→�→Type group no. (1–32)→�→
Type ext. no. of Service Observer→� or 
→�→� 

To enable or disable Warning Tone on a per group basis:
�→�→�→�→�→Type group no. (1–32)→�→
� or �→�→�→� 

To assign a member extension to a Service Observing group:
�→�→�→�→�→Type group no. (1–32)→�→
Type ext. no.→� or 
→�→�→� 
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Optional Operator Features 3

The summaries in this section affect feature programming for both DLC and QCC operator 
positions and include the following:

■ Operator Hold Timer

■ DLC Operator Automatic Hold

QCC operator features are covered in the next section.

Operator Hold Timer 3

Use this procedure to set the length of the operator hold timer for all DLCs and QCCs. If the 
system operator does not pick up the call within the time programmed, an abbreviated ring 
reminds the operator that a call is being held.

This option cannot be programmed for individual operator positions.

Summary: Operator Hold Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 60 seconds

Valid Entries 10 to 255 seconds

Inspect No

Copy Option No

Console Procedure Operator→Hold Timer→Drop→Dial no. of seconds (10–255)→ 
Enter→Back 

PC Procedure �→�→ →Type no. of seconds(10–255)→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process. 

*XUV
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DLC Operator Automatic Hold 3

Use this procedure to enable or disable the DLC Operator Automatic Hold feature for DLC 
operator positions. When this feature is enabled, it prevents accidental call disconnection.

Summary: DLC Operator Automatic Hold 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disabled

Valid Entries Disabled, Enabled

Inspect No

Copy Option No

Console Procedure Operator→DLC Hold→Automatic Hold Enable or Automatic 
Hold Disable→Enter→Back 

PC Procedure �→�→� or �→�→� 

QCC Optional Features 3

This section contains programming summaries for the following options for QCC operator 
positions:

■ Hold Return

■ Automatic Hold or Release

■ Queue over Threshold

■ Elevate Priority

■ Calls-in-Queue Alert

■ QCC Operator to Receive Call Types

■ Call Type Queue Priority Level

■ Message Center Operation

■ Automatic or Manual Extended (Directed) Call Completion

■ Return Ring

■ Position Busy Backup

■ Voice Announce

These options are available in Hybrid/PBX mode only.
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Hold Return 3

Use this procedure to determine whether calls on hold are returned to the QCC queue or remain 
on hold, on the QCC operator console, after the hold timer has expired twice. After the hold timer 
expires the first time, the operator hears an abbreviated ring as a call-on-hold reminder. If another 
call is received at the same time that the hold timer expires, 10 seconds are added to the 
programmed operator hold timer interval for the first call. If the QCC operator does not pick up a 
call by the time the hold timer expires twice, the call can be programmed to either remain on hold 
or return to the QCC queue.

This option cannot be programmed for individual QCC operator positions. The single setting 
applies to all QCC operator positions.

Summary: Hold Return 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Calls remain on hold

Valid Entries Remain on hold, Return to QCC queue

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Hold Rtrn→Select 
Return to Queue or Remain on Hold→Enter→Back→Back 

PC Procedure �→�→�→Select Return to Queue or Remain on 
Hold→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.
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Automatic Hold or Release 3

Use this procedure to specify whether a call in progress (on a Call button) is automatically put on 
hold (Automatic Hold) or disconnected (Automatic Release) when the operator presses another 
button.

This option cannot be programmed for individual QCC operator positions. The single setting 
applies to all QCC operator positions.

Summary: Automatic Hold or Release 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Automatic Release

Valid Entries Auto Hold, Auto Release

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→HoldRelease→Select
Auto Hold or Auto Release→Enter→Back→Back 

PC Procedure �→�→�→Select Auto Hold or Auto Release→
�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Queue over Threshold 3

Use this procedure to specify the maximum number of calls (threshold) in the QCC queue before 
system operators are notified with a tone that the threshold has been reached or exceeded. If the 
threshold is set to 0, operators are not notified.

Summary: Queue over Threshold 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-124QCC Optional Features 

3

Factory Setting 0

Valid Entries 0 to 99

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Threshold→Drop→
Dial no. of calls (0–99)→Enter→Back→Back 

PC Procedure �→�→�→ →Type no. of calls(0–99)→�→�→
� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Elevate Priority 3

Use this procedure to specify the length of time before calls waiting in the QCC queue are 
automatically reprioritized to a higher level. If priority is set to 0, calls are not prioritized.

Summary: Elevate Priority 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Form 6a, Optional Operator Features

Factory Setting 0 seconds

Valid Entries 0 and 5 to 30 seconds

Inspect No

Copy Option No

Console Procedure Operator→QueuedCall→ElvatePrior→Drop→Dial no. of 
seconds (0 and 5–30)→ Enter→Back→Back 

PC Procedure �→�→�→ →Type no. of seconds (0 and 5–30)→
�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

*XUV
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Calls-In-Queue Alert 3

Use this procedure to specify whether each QCC operator is notified (with a single beep) when a 
new call enters the QCC queue.

Summary: Calls-In-Queue Alert 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disable

Valid Entries Enable, Disable

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→InQue Alert→Dial ext. no.→
Enter→Select InQue Alert Enable or InQue Alert Disable→
Enter→Back→Back 

PC Procedure �→�→�→Type ext. no.→�→Select InQue Alert 
Enable or InQue Alert Disable→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

QCC Operator to Receive Call Types 3

Use this procedure to specify which QCC operators receive the following types of calls:

■ Dial 0 calls (internal calls to the system operator)

■ DID calls to invalid destinations (unassigned extension numbers)

■ Calls to the Listed Directory Number (extension for the QCC queue)

■ Calls programmed to return to the QCC queue (returning from directing, camped-on, held 
calls, and operator parked calls)

■ Group Coverage calls

■ Forward/Follow Me calls

The QCC queue can be a receiver for the maximum number of coverage 
groups (30).
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Summary: QCC Operator to Receive Call Types 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting QCC operator receives the following calls:
Dial 0
Unassigned DID
Listed Directory Number
Returning

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→Call Types→Select a call 
type→Operator→Dial coverage group no.→Enter→
Dial ext. no.→Enter→Back→Back→Back→Back→Back 

PC Procedure �→�→	→Select a call type→�→
Type coverage group no.→�→Type ext. no.→�→�→�→
�→�→� 

■ If you want a QCC operator position to operate as a message center (receiving 
returning parked and directed calls, Group Coverage calls, and calls to 
unassigned DID numbers), program the Message Center option before you 
assign the operator to receive call types.

■ This procedure does not include use of the menu options Follow/Frwd or QCC 
Ext. These two options are used to assign queue priorities and are not associated 
with individual QCC operators. See ‘‘Call Type Queue Priority Level’’ on page 
3-127.

■ This procedure does not include programming the operator position to receive 
calls on individual lines or trunks. 

■ Programming an operator position to receive DID calls to invalid destinations 
does not cause the calls to ring into the QCC queue unless you program such 
calls to be sent to a backup extension. When no operator is assigned to receive 
the call types, the call does not ring into the QCC queue, and the caller hears an 
error tone.

■ If a trunk assigned to ring into the QCC queue is to be assigned shared Remote 
Access, assign that trunk Remote Access before performing this procedure. See 
‘‘Remote Access Features’’ on page 3-165.
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Call Type Queue Priority Level 3

Use this procedure to assign a priority value (1 to 7) that determines the order in which calls 
programmed to ring into the QCC queue are sent to QCC system operator positions. A value of 1 
is the highest priority. The QCC queue priority level is assigned for the following types of calls:

■ Dial 0 calls (internal calls to the system operator)

■ DID calls to invalid destinations (unassigned extension numbers)

■ Calls to the Listed Directory Number (extension for the QCC queue)

■ Calls programmed to return to the QCC queue (returning from extending, camped-on, held 
calls, and operator parked calls)

■ Group Coverage calls

■ Calls signed in (Follow) or forwarded to the system operator

■ Calls to a system operator extension number

This procedure does not include programming the QCC queue priority level for individual lines or 
trunks to ring into the queue. See ‘‘QCC Queue Priority Level’’ on page 3-31.

Summary: Call Type Queue Priority Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 4

Valid Entries 1 to 7

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Call Types→Select call 
type→Priority→Dial group coverage number (1–30)→Enter→
Drop→Dial priority level (1–7)→Enter→Back→Back→Back→
Back 

PC Procedure �→�→	→Select call type→�→
Type Group Coverage number (1–30)→�→ →
Type priority level (1–7)→�→�→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process. 

*XUV
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Message Center Operation 3

Use this procedure to designate one or more QCC operator positions to operate as a message 
center. The following options are automatically set for the message center position:

■ Incoming calls are not directed to this position

■ Returning calls are directed to this position (return from extending and operator parked calls)

■ All group coverage calls are directed to this position

■ All DID calls to invalid destinations are directed to this position

Designating message center operation does not change any call type option programming, except 
that the call types mentioned above are added to the calls received at the QCC Message Center.

Summary: Message Center Operation 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Not applicable

Valid Entries QCC extension numbers

Inspect Yes

Copy Option No

Console Procedure Operator→Queued Call→Msg Center→Dial ext. no.→
Enter→Back→Back→Back 

PC Procedure �→�→
→Type ext. no.→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Extended (Directed) Call Completion 3

Use this procedure to specify one of the two basic options shown below for QCC operator 
positions with a DSS only:

■ Automatic Completion. Allows one-touch call transfer—that is, calls are transferred by 
touching only an extension button on the DSS. The operator does not have to press the 
Release button.

■ Manual Completion. QCC operators must press the Release button to direct a call using a 
DSS.
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This option cannot be programmed for individual QCC operator positions. The setting applies to all 
QCC operator positions.

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Summary: Extended (Directed) Call Completion 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Automatic Extended Completion

Valid Entries Automatic, Manual

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→ExtndComplt→Select
Automatic Complete or Manual Complete→Enter→Back→
Back 

PC Procedure �→�→�→Select Automatic Complete or
Manual Complete→�→�→� 

Return Ring 3

Use this procedure to specify the number of rings before an unanswered directed call is returned 
to the QCC queue or QCC Message Center position.

This option cannot be programmed for individual QCC operator positions. The setting applies to all 
QCC operator positions.

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

If you want unanswered calls to proceed to voice mail, lengthen the return ring setting.
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Summary: Return Ring 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting 4 rings

Valid Entries 1 to 15 rings

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→Return Ring→Drop→
Dial no. of rings (1–15)→Enter→Back→Back 

PC Procedure �→�→�→ →Type no. of rings (1–15)→�→
�→� 

Position Busy Backup 3

Use this procedure to designate or remove the Calling Group to provide the backup position for the 
QCC queue. The specified Calling Group receives incoming calls when all QCC operator positions 
are in position-busy mode.

Position Busy Backup is programmed for the QCC queue rather than for individual QCC operator 
positions. The Calling Group designated as the QCC queue backup serves as the backup for the 
Remote Access feature and as backup when the QCC is being used as the system programming 
console. 

Only one Position Busy Backup can be programmed per system.

Summary: Position Busy Backup 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting No backup

Valid Entries Calling Group number

Inspect No

Copy Option No

*XUV
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Console Procedure Operator→Queued Call→  or More→QCC Backup→Drop→
Dial ext. number→Select Enter or Delete→Back→Back 

PC Procedure �→�→�→�→ →Type ext. number→Select
Enter or Delete→�→� 

Voice Announce 3

Use this procedure to enable or disable Voice Announce for the QCC. 

When Voice Announce is enabled, every QCC in the system has one Voice Announce Call button, 
the Call 5 (Ring/Voice) button. All Intercom calls that originate from a QCC Call 5 (Ring/Voice) 
button are delivered as Voice Announce calls. 

When Voice Announce is disabled, all Intercom calls originating at the QCC Call buttons are 
Intercom Ringing calls.

Summary: Voice Announce 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 6a, Optional Operator Features

Factory Setting Disabled

Valid Entries Disabled, Enabled

Inspect No

Copy Option No

Console Procedure Operator→Queued Call→  or More→Voice Annc→Select
Enabled or Disabled→Enter→Back→Back 

PC Procedure �→�→�→�→Select Enabled or 
Disabled→�→�→� 

Optional Group Features 3

This section contains programming summaries for the following optional features:

■ Pickup Groups

■ Group Paging

■ Group Coverage Member Assignments

■ Group Calling Member Assignments

*XUV
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■ Group Calling Line/Trunk or Pool Assignments

■ Priority Call Queuing for Group Calling

Pickup Groups 3

Use this procedure to assign or remove an extension from a call pickup group. A pickup group 
consists of telephone users who can answer each other’s calls either by pressing a button or by 
dialing a code.

Summary: Pickup Groups 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7a, Pickup Groups

Factory Setting Not applicable

Valid Entries Pickup group number, extension number

Inspect Yes

Copy Option No

Console Procedure Extensions→Call Pickup→Dial pickup group no.→Enter→
Dial ext. no.→Enter→Enter→ Back→Back 

PC Procedure �→�→Type pickup group no.→�→Type ext. no.→�→
�→� 

Group Paging 3

Use this procedure to assign or remove an extension from a Paging Group. A Paging Group 
consists of telephone users who hear common announcements over the telephone speakerphone. 
Only multiline 4400-Series, ETR, MLS and MLX telephones with speakerphones can be members 
of a Paging Group.

■ A maximum of 30 pickup groups, with a maximum of 15 extensions per group, is 
allowed.

■ An extension can belong to only one group.

■ Before reassigning an extension to a new group, you must remove it from its 
current group.
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A maximum of six Paging Groups with a maximum of 10 extensions per group is allowed. A 
seventh Paging Group, called the Page All group, is not limited and includes all telephones 
connected to the system. Extensions cannot be added to or removed from the Page All group.

To reassign an extension to a new Paging Group, just assign it; the extension is automatically 
removed from its old Paging Group.

Summary: Group Paging 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7b, Group Paging

Factory Setting Not applicable

Valid Entries Extension number

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Group Page→Dial Paging 
Group no.→Enter→Dial ext. no.→Enter→Back→Back 

PC Procedure �→�→�→Type Paging Group no.→�→Type ext. no.→
�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Group Coverage Member Assignments 3

Use this procedure to assign or remove an extension from a coverage group. A coverage group is 
a group of senders. Coverage is an arrangement in which calls from a group of senders are 
redirected to one or more receivers. 

A maximum of 30 coverage groups are allowed, each with an unlimited number of members. Up to 
eight receivers can be assigned per coverage group.

■ This procedure assigns senders. Before you begin, make certain that the receivers for 
the coverage group are also programmed. Receivers can be assigned through 
individual or centralized telephone programming. You can also use the Integrated 
Solution III/IV feature, Integrated Administration, to assign coverage receivers. See 
Chapter 4, ‘‘Centralized Telephone Programming,” for information about the 
appropriate centralized programming procedure.
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An extension can be a sender in only one group; it can be a receiver for more than one coverage 
group. A Calling Group can be assigned as a receiver for a coverage group (see ‘‘Group Coverage 
Receiver’’ on page 3-140). In Hybrid/PBX mode only, the QCC queue can be a receiver for up to 
30 coverage groups. See ‘‘QCC Operator to Receive Calls’’ on page 3-32.

If the sender’s extension has one or more Personal Lines assigned, the sender can be assigned 
as the principal user so that calls received on the Personal Line are sent to receivers programmed 
for Individual or Group Coverage. See ‘‘Principal User for Personal Line’’ on page 3-30.

To reassign an extension to a new coverage group, just make the assignment; the extension is 
automatically removed from its old group.

Summary: Group Coverage Member Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Extension numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Group Cover→Dial group no.
(1–30)→Enter→Dial ext. no.→Enter→ Back→Back 

PC Procedure �→�→�→Type group no. (1–30)→�→Type ext. no.→
�→�→� 

Group Calling Member Assignments 3

Use this procedure to assign or remove an extension to or from a Calling Group. A Calling Group 
is used to direct calls to a group of people who all handle the same type of call. A single extension 
number is assigned to the group and is used by both inside and outside callers to reach the group.

To reassign an extension to a new Calling Group, you must remove it from its old group before 
programming the new assignment.
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Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Summary: Group Calling Member Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Extension numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Members→
Dial Calling Group ext. no.→Enter→Dial ext. no.→ Enter→ 
Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type ext. no.→�→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

■ If a linear hunting pattern is indicated on the back of the system planning form 
(6d), be sure to assign extensions to the group in the exact order that they are 
shown on the form. The system searches for an available member in the order in 
which you assign the extensions to the group.

■ A maximum of 32 Calling Groups with a maximum of 20 extensions per group is 
allowed.

■ An extension can belong to only one Calling Group. A QCC cannot be a member 
of a Calling Group. A delay announcement device should not be programmed as 
a Calling Group member.

■ The extension status feature must be set to the Calling Group or CMS mode 
before you assign members to the group. See ‘‘Extension Status’’ on page 3-153.

■ One non-local member may be in a Calling Group. A Calling Group cannot 
contain both local and non-local members. See the Network Reference for 
information.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-136Optional Group Features 

3

Group Calling Line/Trunk or Pool Assignments 3

Use this procedure to assign or remove lines, trunks, or pools (Hybrid/PBX only) that ring directly 
into a Calling Group.

Incoming calls on each line/trunk or pool can be directed to only one Calling Group. 

To reassign a line/trunk or pool to a new Calling Group, you must remove it from its old group 
before making the new assignment.

Summary: Group Calling Line/Trunk or Pool 
Assignments 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Not applicable

Valid Entries Line, trunk, or pool number

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Line/Pool→
Dial Calling Group ext. no.→Enter→Dial line/trunk no.→Enter→
Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type line/trunk no.→�→�→�→� 

Priority Call Queuing 3

Use this procedure to establish a supportive relationship between Calling Groups. Calls that arrive 
in one Calling Group (a home group) can be processed by another Calling Group (a support 
group) when no one from the first Calling Group is available to answer the call.

A Calling Group can be assigned a priority level between 1 (highest priority) and 32 (lowest 
priority) and then designated as a support group for a home group. There can be only one support 
group per home group. Each support group can support up to 31 home groups.
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Summary: Priority Call Queuing 3

Programmable by System Manager

Mode All

Idle Condition Not Required

Planning Form 7d, Group Calling

Factory Setting 16

Valid Entries Priority Level (1 to 32)

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→  or More→ 
Priority→Enter extension number of group→ Enter→
Enter Group Priority (1–32)→
(To program the next group, select Next)→Enter→Back→ 
Support→Enter extension number of group→ Enter→Enter 
Support Group→(To program the next group, select Next)→ 
Enter→Back→Back→Back 

PC Procedure �→�→�→�→�→Type extension number of 
group→�→Type Group Priority (1–32)→
(To program the next group, press �)→ �→�→�→
Type extension number of group→�→Type support group→
(To program the next group, press �)→�→�→�→� 

Optional Group Calling Features 3

This section includes programming summaries for the following optional group calling features:

■ Hunt Type

■ Group Calling Delay Announcements

■ Group Calling Announcement Interval

■ Group Calling Repeat Announcement

■ Group Coverage Receiver

■ Group Calling Overflow and Thresholds

■ Group Calling Message-Waiting Indicator

■ Group Calling Calls-in-Queue Alarm Threshold

■ Group Calling External Alert for Calls-in-Queue Alarm

■ Group Type

■ Queue Control 
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Hunt Type 3

Use this procedure to assign one of the following hunt-type patterns to Calling Groups:

■ Circular Hunting Pattern. The system distributes calls to group members by hunting in a 
circular pattern for the first available extension after the one that received the last call to the 
group.

■ Linear Hunting Pattern. The system searches for an available group member in the order in 
which the extensions were assigned to the Calling Group.

■ Most Idle Hunting Pattern. The system searches for the available member that is “most idle.” 
This distribution scheme can be more equitable than the circular hunting pattern. 

Summary: Hunt Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Circular hunting pattern

Valid Entries Circular, Linear, Most Idle

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Hunt Type→Dial 
Calling Group ext. no.→Enter→Circular, Linear, or Most 
Idle→Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→
�→� or � or �→�→�→�→� 

Group Calling Delay Announcements 3

Use this procedure to designate the announcement devices used to play messages to callers 
while they are waiting in the queue.

Two announcement devices can be designated for each Calling Group; however, more than one 
Calling Group can use the same announcement device. The extensions to which the delay 
announcement devices are connected should not be programmed as a Calling Group member.
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If the extension jack or MFM was previously programmed as a regular extension, you must 
remove all line/trunk button assignments before you designate the extension jack as a delay 
announcement device.

Summary: Group Calling Delay Announcement 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No delay announcement devices are assigned

Valid Entries Primary Announcement, Secondary Announcement

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Enter→
Select Primary Announcement or Secondary Announcement→
Enter extension number of announcement device→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→
�→Select Primary Announcement or Secondary 
Announcement→Enter ext. no. of announcement device→�→
�→� 

Group Calling Announcement Interval 3

Use this procedure to set the delay before the secondary announcement is played and/or 
repeated.

Summary: Group Calling Announcement Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting 0 (disabled)

Valid Entries 0–900 seconds

A delay announcement device must be in the local system; it cannot be shared by non-
local private networked systems (Hybrid/PBX mode only).
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Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Announcement Interval→
Enter the Announcement Interval (0–900)→Enter→ Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type the Announcement Interval (0–900)→�→�→� 

Group Calling Repeat Announcement 3

Use this procedure to set the secondary announcement to repeat after the Announcement Interval.

Summary: Group Calling Repeat Announcement 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No repeat

Valid Entries Yes, No

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→DelayAnnce→
Dial Calling Group ext. no.→Enter→Repeat 
Announcement→Select Yes or No→Enter→Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
Select Yes or No→�→�→� 

Although you can make selections from the screen (with the ListFeature option) to assign Ring 
and Voice buttons, the following procedure provides the programming codes to perform these 
functions. Using the codes speeds the button assignment process.

Group Coverage Receiver 3

Use this procedure to assign or remove a Calling Group as a receiver for a coverage group.

Calling Group member assignments must be made before you assign the group as a receiver for a 
coverage group.
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Summary: Group Coverage Receiver 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7c, Group Coverage

Factory Setting Not applicable

Valid Entries Group numbers

Inspect Yes

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Grp Coverage→
Dial Calling Group ext. no.→Enter→Dial coverage group no.→
Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type coverage group no.→�→�→�→� 

Group Calling Overflow and Thresholds 3

Use this procedure to designate either another Calling Group or the QCC queue (Hybrid/PBX only) 
to receive overflow calls. This procedure also specifies overflow threshold and methods.

Call overflow occurs in one of the three following ways:

■ The number of calls waiting in the queue for a Calling Group is equal to or greater than the 
programmed threshold (overflow threshold). 

■ The time that a call has spent in the queue exceeds the programmed timeout value (overflow 
threshold time).

■ A caller responds to a voice prompt by pressing the # key to indicate that his or her call should 
be handled as an overflow call. For example, a delay announcement may specify that a caller 
can press # to leave a message with voice mail or an operator. 

If the overflow threshold time is set to 0 seconds (factory setting), then overflow by time is turned 
off. Prompt-based overflow distribution can coexist with either or both of the other methods. 
Overflow distribution based on the number of calls in the queue or the time spent in the queue 
takes precedence over calls that go to overflow because of the caller’s prompt.

Overflow coverage can be provided only by Calling Groups or the QCC queue (Hybrid/PBX only), 
not by individual extensions.

A Calling Group or the QCC queue (Hybrid/PBX only) can provide overflow coverage for more 
than one Calling Group; however, the particular group whose calls go to an available member in 
the overflow Calling Group is unpredictable.

The factory-set extension number for the QCC Listed Directory Number is 800.
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Summary: Group Calling Overflow and Thresholds 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Overflow coverage: none
Threshold: 1 call
Timeout: 0 sec
Prompt-based overflow: Disabled

Valid Entries Overflow coverage: Backup extension number
Threshold: 1 to 99 calls
Timeout: 0 to 900 seconds
Prompt-based overflow: Enabled, Disabled

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Overflow→
Dial Calling Group ext. no.→Enter→Dial overflow ext. no.→
Enter→Number Based Overflow→Drop→Dial no. of calls 
(1-99)→Enter→Time Based Overflow→Drop→
Dial no. of seconds(0-900)→Enter→Prompt Based Overflow→
Select Yes or No→Enter→Back→
Back→Back 

PC Procedure �→�→�→
→Type Calling Group ext. no.→�→
Type overflow ext. no.→�→�→ →Type no. of calls(1-99)→
�→�→ →Type no. of seconds(0-900)→�→�→
Select Yes or No→�→�→�→� 

Group Calling Message-Waiting Indicator 3

Use this procedure to designate the extension to receive message-waiting indications (MWIs) for 
the Calling Group.

Only one extension can be designated as a message-waiting receiver for each Calling Group; 
however, more than one Calling Group can use the same message-waiting receiver. The 
extension assigned as a message-waiting receiver does not have to be a member of the Calling 
Group.

Message-waiting indications cannot be sent to the extension assigned to the group unless this 
option is programmed. The message-waiting receiver cannot distinguish between messages left 
for the Calling Group and personal messages.

*XUV

*XUV
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Summary: Group Calling Message-Waiting Indicator 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting No message-waiting receiver assigned

Valid Entries Extension number

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Message→
Dial Calling Group ext. no.→Enter→Dial ext. no. for 
MWI receiver→Enter→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→�→
Type ext. no. for MWI receiver→�→�→� 

Group Calling Calls-In-Queue Alarm Thresholds 3

Use this procedure to specify the number of unanswered calls that wait in the Calling Group queue 
before group members are notified with either an external alert (an external alert is turned on when 
the third threshold is met) or a light on the telephone. Group members are notified when the 
number of calls waiting in the queue is equal to or greater than the programmed thresholds as 
follows:

■ First Threshold, flashing light

■ Second Threshold, winking light

■ Third Threshold, solid light

Summary: Group Calling Calls-In-Queue Alarm 
Thresholds 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Settings 1 call, for all Thresholds

To configure only one threshold, set all thresholds to the same number. The LED 
states are off and on. To configure only two thresholds, set two of the thresholds to 
be the same number.
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Valid Entries 1 to 99

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Queue Alarm→
Dial Calling Group ext. no.→Enter→Select Alarm Threshold 1 
or Alarm Threshold 2 or Alarm Threshold 3→Drop→
Dial no. of calls (1–99)→ Enter→Back→Back 

PC Procedure �→�→�→�→Type Calling Group ext. no.→
�→ →Select Alarm Threshold 1 or Alarm Threshold 2 or 
Alarm Threshold 3→Type no. of calls (1–99)→�→
�→� 

Group Calling External Alert for 
Calls-In-Queue Alarm 3

Use this procedure to designate the external alert device used to notify Calling Group members 
when the number of calls in the queue reaches the programmed Threshold 3.

Only one external alert device can be designated for each Calling Group. Since the external alert 
signal is continuous, it is recommended that only light-type external alert devices be designated for 
the Calls-in-Queue alarm.

Summary: Group Calling External Alert for Calls-In-
Queue Alarm 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Not applicable

Valid Entries Extension number

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→Xtnl Alert→
Dial Calling Group ext. no.→Enter→Drop→Dial ext. no. for alert→
Enter→Back→Back 

PC Procedure �→�→�→	→Type Calling Group ext. no.→�→
→Type ext. no. for alert→�→�→� 

*XUV
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Group Type 3

Use this procedure to determine whether or not the system automatically logs in members of a 
Calling Group after a power failure. This setting also determines the type of voice messaging 
interface when the Calling Group is used to connect voice messaging or Automated Attendant 
applications. The settings are listed below.

■ Automatic Log Out. Used for Calling Groups to specify that the system does not 
automatically log in Calling Group members after a power failure. Calling Group members 
must manually log themselves into the group.

■ Automatic Log In. Used for Calling Groups that consist of fax machines or data workstations 
(also called data hunt groups) to specify that the system automatically logs in Calling Group 
members after a power failure. This setting can also be used for Calling Groups consisting of 
telephones. 

■ Integrated VMI. Used when a voice messaging system that requires special signaling for 
integrated operation (for example, MERLIN Messaging, Intuity AUDIX, or IS III) is connected 
to one or more extension jacks assigned to a Calling Group. The system automatically logs in 
the group members after a power failure.

■ Generic VMI. Used when a voice messaging system that does not need special signaling is 
connected to one or more extension jacks assigned to a Calling Group. The system 
automatically logs in the group members after a power failure.

If the System Manager changes a VMI port to non-VMI port, the restrictions are not turned off. To 
remove restrictions, the System Manager must change them through system programming.

Summary: Group Type 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting Automatic Log Out

Valid Entries Automatic login, Automatic logout, Integrated VMI, Generic VMI

Inspect No

Copy Option No

Any port programmed as a VMI port is programmed with:

■ Outward restriction on

■ A factory set FRL of 0 (the most restrictive)

■ A factory set Disallowed List (List 7) that includes the numbers frequently 
associated with fraud
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Console Procedure Extensions→  or More→Grp Calling→More→ Group 
Type→Dial Calling Group ext. no.→Enter→Specify login type 
(Auto login, Auto logout, Integrated VMI, or Generic VMI)→ Enter→ 
Back→Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
�→Specify login type (Auto login, Auto logout, Integrated VMI, or 
Generic VMI)→�→�→�→� 

Queue Control 3

The System Manager can control the maximum number of calls allowed in the primary Calling 
Group queue for calls that arrive on the following types of facilities:

■ DID (Direct Inward Dialing) and dial-in TIE

■ PRI facilities programmed for dial plan routing

■ All calls transferred from a VMI (voice messaging interface) port

■ Internal calls to the Calling Group

■ Internal calls to the Calling Group through the QCC Position-Busy backup (PBB)

■ Intrasystem calls to the Calling Group

■ All private network dialed calls, including remote DID

When the number of the calls in queue reaches the programmed maximum, subsequent callers 
receive a busy signal.

Remote-access calls to a Calling Group, coverage calls directed to a Calling Group, and all 
outside/central office calls are not eligible for queue control.

Queue control does not apply to calls received directly on any of the following facilities:

■ Loop-start lines

■ Ground-start lines/trunks

■ Auto-in tie trunks

■ BRI (Basic Rate Interface) channels

■ T1 facilities emulating ground-start or loop-start lines/trunks

■ PRI facilities programmed for line-appearance routing

Dial-in tie trunks, including private tandem tie trunks (Hybrid/PBX mode only) cannot be 
assigned directly to Calling Groups. 
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When a call arrives on one of the above facilities, it is added to the Calling Group queue, even if 
that queue has reached or exceeded the programmed maximum number of calls. For example, if 
the maximum number of Calling Group calls is set to 40, and 40 calls have come in, subsequent 
callers on eligible facilities hear the busy tone. Calls that come in on an LS line, however, are 
added to the queue. 

Summary: Queue Control 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 7d, Group Calling

Factory Setting 99 calls

Valid Entries 0–99 (0 indicates no calls are queued)

Inspect No

Copy Option No

Console Procedure Extensions→  or More→Grp Calling→More→Queue 
Ctrl→Dial Calling Group ext. no.→Enter→
Dial no. of calls allowed in queue (0–99)→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→�→Type Calling Group ext. no.→
�→Type no. of calls allowed in queue (0–99)→�→�→�→
� 
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3Programming Procedures

System Features 3

This section contains programming summaries for the optional system features that affect all or 
most system users and includes the following:

■ Transfer Return Time

■ One-Touch Transfer/Hold

■ Transfer Audible

■ Type of Transfer

■ Camp-On Return Time

■ Call Park Return Time

■ Delay Ring Interval

■ Automatic Callback Interval

■ Extension Status

■ SMDR Language

■ SMDR Call Report Format

■ SMDR Call Length

■ SMDR Calls Recorded on Call Report

■ SMDR Account Code Format

■ SMDR Talk Time

■ SMDR UDP Calls Recorded on Call Report

■ Inside Dial Tone

■ Reminder Service Cancel

■ Redirect Outside Calls to Unassigned Extension Numbers

■ Host System Dial Codes for Behind Switch Mode

■ Recall Timer

■ Interdigit Timers

■ Allowed Lists

■ Assign Allowed Lists to Extensions

■ Disallowed Lists

■ Assign Disallowed Lists to Extensions
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Transfer Return Time 3

Use this procedure to specify the number of times the telephone rings before a call transferred to 
another inside telephone is returned to the originator. A setting of 0 means that transferred calls 
are never returned to the originator.

Summary: Transfer Return Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 4 rings

Valid Entries 0 to 9 rings

Inspect No

Copy Option No

Console Procedure Options→Transfer→Return Time→ →
Dial no. of rings (0–9)→Enter→Back→Back 

PC Procedure 	→�→�→ →Type no. of rings (0–9)→�→�→
� 

One-Touch Transfer/One-Touch Hold 3

Use this procedure to assign either the One-Touch Transfer or One-Touch Hold feature.

One-Touch Transfer allows users to initiate transfers to another extension by pressing an Auto Dial 
or DSS button for that extension. If the One-Touch Transfer feature is assigned, you must also 
specify whether the transfer completion is manual (the user has to press another button to 
complete the transfer) or automatic (the transfer is completed automatically).

The transfer return time should not be set to 0 in a system with single-line telephones.

The One-Touch Transfer feature is not available on single-line telephones.

*XUV

*XUV
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One-Touch Hold applies to incoming central office calls only. When the user presses an Auto Dial 
or DSS button to initiate a transfer, the outside caller is put on hold. The system automatically 
selects an intercom facility and dials the transfer destination. There is no transfer return function 
with this method. Consequently, if the transfer destination does not answer or is busy, the user 
who initiates the transfer must notify the outside caller, or the outside caller will remain on hold.

One-Touch Hold is the factory setting in Behind Switch mode only.

Summary: One-Touch Transfer/Hold 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting One-Touch Transfer, automatic completion (One-Touch Hold is the 
factory setting in Behind Switch mode.)

Valid Entries Transfer, Hold

Inspect No

Copy Option No

Console Procedure To program One-Touch Transfer:
Options→Transfer→One Touch→Transfer→ 
Enter→Select Manual or Automatic→Enter→ Back→Back 

To program One-Touch Hold:
Options→Transfer→One Touch→Hold→Enter→Back→
Back 

PC Procedure To program One-Touch Transfer:
	→�→�→�→�→Select Manual or 
Automatic→�→�→� 

To program One-Touch Hold:
	→�→�→�→�→�→� 

Transfer Audible 3

Use this procedure to specify whether an outside caller hears ringing (also called ringback) or 
Music-On-Hold while being transferred. Inside callers always hear ringback during a transfer.
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Summary: Transfer Audible 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Music-On-Hold

Valid Entries Music-On-Hold, Ringback

Inspect No

Copy Option No

Console Procedure Options→Transfer→Audible→Select
Music-On-Hold or Ringback→Enter→Back→Back 

PC Procedure 	→�→�→Select Music-On-Hold or 
Ringback→�→�→� 

Type of Transfer 3

Use this procedure to specify whether the system automatically selects an Intercom or System 
Access Ring or Voice button when the Transfer button or an Auto Dial or DSS button (for One-
Touch Transfer) is pressed.

Summary: Type of Transfer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

■ If you use equipment that rebroadcasts music or other copyrighted materials, you 
may be required to obtain a copyright license from and pay license fees to a third 
party (such as the American Society of Composers, Artists, and Producers or 
Broadcast Music Incorporated). Magic On Hold requires no such license and can 
be purchased from Lucent Technologies.

■ When extensions are programmed to use the Centrex Transfer via Remote Call 
Forwarding feature, do not program Music-On-Hold as the transfer audible. If 
Music-On-Hold is programmed in this case, a caller being transferred hears a 
click, three seconds of Music-On-Hold, a second click, silence for about 10 
seconds, then ringback or a busy tone from the central office. This can confuse 
callers, who may then hang up.
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Factory Setting Ring button (Intercom or System Access) is automatically selected

Valid Entries Voice Announce, Ring

Inspect No

Copy Option No

Console Procedure Options→Transfer→Type→Select Voice Announce or 
Ring→Enter→Back→Back 

PC Procedure 	→�→�→Select Voice Announce or 
Ring→�→�→� 

Camp-On Return Time 3

Use this procedure to specify the number of seconds before a camped-on call (a call transferred to 
a busy telephone with the Camp-On feature) is returned to the originator.

Summary Camp-On Return Time: 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6f, System Features

Factory Setting 90 seconds

Valid Entries 30 to 300 seconds, in 10-second increments

Inspect No

Copy Option No

Console Procedure Options→CampOn→ →Dial no. of seconds (30–300)→
Enter→Back 

PC Procedure 	→�→ →Type no. of seconds (30–300)→�→� 

Call Park Return Time 3

Use this procedure to specify the number of seconds before a call put on hold with the Park 
feature is returned to the originator.

Summary: Call Park Return Time 3

Programmable by System Manager

Mode All

Idle Condition Not required
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Planning Form 8a, System Features

Factory Setting 180 seconds

Valid Entries 30 to 300 seconds, in 10-second increments

Inspect No

Copy Option No

Console Procedure Options→CallParkRtn→ →Dial no. of seconds (30–300)→
Enter→Back 

PC Procedure 	→�→ →Type no. of seconds (30–300)→�→� 

Automatic Callback Interval 3

Use this procedure to specify the number of times the telephone rings at the originator’s telephone 
before the system cancels a Callback request.

Summary: Automatic Callback Interval 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 3 rings

Valid Entries 1 to 6 rings

Inspect No

Copy Option No

Console Procedure Options→Callback→ →Dial no. of rings 
(1–6)→Enter→Back 

PC Procedure 	→�→ →Type no. of rings (1–6)→�→� 

Extension Status 3

Use this procedure to specify whether the Extension Status (ES) feature is used in Hotel mode or 
Group Calling Supervisor mode.

The calling mode affects the meaning of the LEDs and the use of Auto Dial or DSS buttons when 
the DLC operator position is in Extension Status mode.

In Hotel mode, telephones are restricted from making calls in Extension Status states 1 and 2 
(ES1 and ES2). In Group Calling Supervisor mode, ES states reflect member or agent status 
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without restricting the telephones. In the Group Calling Supervisor mode, the Extension Status 
feature is used by the agents to log in and out, and by the supervisor to see agent status.

Summary: Extension Status 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Group Calling Supervisor 

Valid Entries Group Calling Supervisor, Hotel mode

Inspect No

Copy Option No

Console Procedure Options→Ext Status→Select Hotel or 
GrpCallSupv→Enter→
Back 

PC Procedure 	→	→Select Hotel or GrpCallSupv→�→� 

SMDR Language 3

Use this procedure to change the language of the SMDR reports. The report language is initially 
set to the same as that set for the system language. See ‘‘System Language’’ on page 3-3.

Summary: SMDR Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English (matches System Language setting)

Valid Entries U.S. English, Canadian French, Latin American Spanish

Inspect No

Copy Option No

Console Procedure More→Language→SMDR→Select language (English, French, or 
Spanish)→Enter→Back 

PC Procedure �→�→�→Select language (English, French, or Spanish)→
�→� 
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SMDR Call Report Format 3

Use this procedure to specify whether the SMDR call reports are printed in Basic format or ISDN 
format. In ISDN format, Automatic Number Identification (ANI) or Caller ID information appears in 
the Calling Number field in place of IN (which appears in the Basic report format). The call 
recording type for these calls is I in ISDN format and C in Basic format.

ISDN format should be used only in conjunction with ANI or Caller ID service subscription.

Summary: SMDR Call Report Format 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Basic format

Valid Entries Basic, ISDN

Inspect No

Copy Option No

Console Procedure Options→SMDR→Format→Select Basic SMDR or ISDN SMDR→
Enter→Back→Back 

PC Procedure 	→
→�→Select Basic SMDR or ISDN 
SMDR→�→�→� 

SMDR Call Length 3

Use this procedure to set the minimum time length of a call before it is recorded on SMDR call 
reports.

Caller ID name information is not captured in SMDR call reports.

■ If the majority of lines/trunks are PRI, the recommended call length is 1. See the 
Feature Reference for more information. 

■ The outbound call of a Centrex Transfer via Remote Call Forwarding call will not 
be recorded unless the minimum time length is set to zero (0). The inbound 
Centrex call to the Principle User who has Centrex Transfer via Remote Call 
Forwarding will also not be recorded unless the minimum time length is 0.
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Summary: SMDR Call Length 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 40 seconds

Valid Entries 0 to 255 seconds

Inspect No

Copy Option No

Console Procedure Options→SMDR→Call Length→ →
Dial no. of seconds (0–255)→Enter→Back→Back

PC Procedure 	→
→�→ →Type no. of seconds (0–255)→�→
�→� 

SMDR Calls Recorded on Call Report 3

Use this procedure to specify whether SMDR information should be recorded for both incoming 
and outgoing non-private network calls or for outgoing non-private network calls only.

Summary: SMDR Calls Recorded on Call Report 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Incoming and outgoing

Valid Entries In/Out, Out Only

Inspect No

Copy Option No

Console Procedure Options→SMDR→Call Report→Select In/Out or Out Only→
Enter→Back→Back 

PC Procedure 	→
→�→Select In/Out or Out Only→�→�→� 

Refer to ‘‘SMDR UDP Calls Recorded on Call Report’’ on page 3-158 to program call 
recording for calls on private network tandem trunks.
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SMDR Account Code Format 3

For calls made using an authorization code, SMDR can be programmed to have either the “home 
extension” or the actual authorization codes recorded in the Account Code field if no Account 
Code is entered. Account Code overrides the Authorization Code entry in the SMDR record when 
both features are used. 

Summary: SMDR Account Code Format 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6h, Authorization Codes

Factory Setting Home Extension Number

Valid Entries Home Extension Number, Authorization Code

Inspect No

Copy Option No

Console Procedure Options→SMDR→Auth Code→Select Home Extension Number 
or Authorization Code→Enter→Back→Back 

PC Procedure 	→
→�→Select Home Extension Number or 
Authorization Code→�→�→� 

SMDR Talk Time 3

The Talk field was added to the SMDR call record. The Talk field is designed for the MERLIN 
MAGIX Reporter application that is used to capture detailed information on incoming and outgoing 
voice and data calls with a special emphasis on Calling Groups. The Talk field contains the talk-
time duration—the amount of time (59:59 maximum) that a Calling Group agent spends on an 
incoming call, including any actions that the agent takes while handling the call.

If your system includes an MERLIN MAGIX Reporter, the Talk Time option must be enabled. All 
other configurations must have the Talk Time option disabled. 
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Summary: SMDR Talk Time 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Disabled

Valid Entries Enable, Disable

Inspect No

Copy Option No

Console Procedure Options→SMDR→Talk Time→Select Enable or 
Disable→Enter→
Back→Back

PC Procedure 	→
→	→Select Enable or Disable→�→�→� 

SMDR UDP Calls Recorded on Call Report 3

Use this procedure to specify whether SMDR information should be recorded for both incoming 
and outgoing calls on private network tandem trunks, or if call recording will not be performed on 
private network calls.

Summary: SMDR UDP Calls Recorded on Call Report 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Log Incoming/Outgoing

Valid Entries Log Incoming/Outgoing, Log None

Inspect No

Copy Option No

Console Procedure Options→SMDR→UDP→Select Log Incoming/Outgoing or 
Log None→Enter→Back→Back

PC Procedure 	→
→
→Select Log Incoming/Outgoing or 
Log None→�→�→� 

Refer to ‘‘SMDR Calls Recorded on Call Report’’ on page 3-156 to program call recording 
for non-private network calls.
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Inside Dial Tone 3

Use this procedure to set the inside (system) dial tone to be either different from, or the same as 
the outside line/trunk dial tone.

Summary: Inside Dial Tone 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Inside dial tone is different from outside dial tone

Valid Entries Inside, Outside

Inspect No

Copy Option No

Console Procedure Options→InsideDial→Select Inside or 
Outside→Enter→Back 

PC Procedure 	→�→Select Inside or Outside→�→� 

Reminder Service Cancel 3

Use this procedure to set the time of day when all programmed Reminder Service calls are 
automatically cancelled.

To deactivate Reminder Service Cancel, erase the currently programmed time and do not enter a 
new time.

Summary: Reminder Service Cancel 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Not applicable

Valid Entries 0000 to 2359

The inside dial tone must be the same as the outside dial tone when the internal dial tone 
is not recognized by software applications or modems.
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Inspect No

Copy Option No

 Console Procedure To deactivate Reminder Service Cancel:
Options→Reminder Srv→ →Enter→Back 

To set Reminder Service Cancel time:
Options→Reminder Srv→ →Dial time (0000–2359)→
Enter→Back 

PC Procedure To deactivate Reminder Service Cancel:
	→�→ →�→� 

To set Reminder Service Cancel time:
	→�→ →Type time (0000–2359)→�→� 

Redirect Outside Calls to Unassigned Extension 
Numbers 3

Use this procedure to specify the extension number to receive redirected calls. Redirected calls 
include calls made to unassigned numbers by Remote Access users, by users on DID trunks 
(Hybrid/PBX only), or by users on dial-in tie trunks. Calls can be redirected to the following 
locations:

■ QCC queue (Hybrid/PBX only)

■ Another extension number

■ A Calling Group

This setting does not affect calls received on DID trunks if you have specified that calls to 
unassigned DID extensions are to receive a fast busy signal. See ‘‘Invalid Destination’’ on page 
3-60

Summary: Redirect Outside Calls to Unassigned 
Extension Numbers 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting Extension number of primary operator

Valid Entries QCC queue extension number, other extension number

Inspect No

Copy Option No
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Console Procedure To select QCC queue:
Options→More→Unassigned→QCC Queue→Enter→Back 

To select extension or Calling Group:
Options→More→Unassigned→Select Extension or 
Grp Calling→
Enter→Dial ext. no. or group no.→Enter→Back 

PC Procedure To select QCC queue:
	→�→�→�→�→� 

To select extension or Calling Group:
	→�→�→Select Extension or Grp Calling→Type ext. 
no. or group no.→�→� 

Host System Dial Codes for Behind Switch Mode 3

Use this procedure to assign the host system dial codes for the Transfer, Conference, and Drop 
features.

When multiline telephone users press the Transfer, Conference, or Drop button, a signal is sent to 
the host service and the system features are not accessed. Assigning dial codes to these features 
ensures that users can take advantage of them through the host system.

Summary: Host System Dial Codes for Behind Switch 
Mode 3

Programmable by System Manager

Mode Behind Switch

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting No host dial codes are assigned

Valid Entries Host system dial code of up to six digits 

Inspect No

Copy Option No

Console Procedure Options→More→BehndSwitch→Select feature→ →
Dial host system dial code (up to 6 digits)→Enter→Back→Back 

PC Procedure 	→�→�→Select feature→ →
Type host system dial code (up to 6 digits)→�→�→� 

This procedure applies to Behind Switch mode only.
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Recall Timer 3

Use this procedure to designate the length of the timed flash that is sent when Recall is used to 
disconnect a call and get a new dial tone without hanging up. Both the interval of the timed flash 
and the way Recall works depend on the type of telephone and system operating mode.

The recall timer should be reset if multiline telephone users experience either of the following 
problems:

■ Nothing happens when the user presses the Recall button on an outside call. This indicates 
that the interval is too short and should be increased to 650 milliseconds or one second.

■ In a system operating in Behind Switch mode, the call is disconnected when the user presses 
the Recall button on an outside call. This indicates that the interval is too long and should be 
decreased to 350 milliseconds.

Summary: Recall Timer 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, System Features

Factory Setting 450 ms

Valid Entries 350 ms, 450 ms, 650 ms, 1 second

Inspect No

Copy Option No

Console Procedure Options→More→RecallTimer→Select time (350 ms, 450 ms, 
650 ms, or 1 second)→Enter→Back 

PC Procedure 	→�→�→Select time (350 ms, 450 ms, 650 ms, or 1 
second)→�→� 

Interdigit Timers 3

Programming for interdigit timers is reserved for Lucent Technologies technical support personnel 
or authorized dealers.

Interdigit timers are used by the MERLIN MAGIX Integrated System to determine when a user 
originating an outside call has completed dialing the digits. The information is necessary to allow 
the system to perform subsequent operations. You should not change the factory settings for 
interdigit timers unless instructed to do so by Lucent Technologies technical support or by an 
authorized dealer.
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Allowed Lists 3

Use this procedure to establish Allowed Lists. These lists are telephone numbers that can be 
dialed from specified telephones, regardless of any calling restrictions  assigned to the telephones.

A maximum of eight lists (numbered 0 through 7) with a maximum of 10 numbers each (numbered 
0 through 9) are allowed. Each allowed number can be no more than six digits (an area code plus 
an exchange) or six digits with a leading 1, where required.

If you program 0 as the first digit of a list entry, any Toll Restriction assigned to the extension is 
removed for calls that can be placed by a toll operator. 

Special characters (such as Pause) are not permitted in Allowed List entries.

Summary: Allowed Lists 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting Not applicable

Valid Entries Area code/exchange (1- to 6-digits with leading 1, if necessary)

Inspect No

Copy Option No

Console Procedure Tables→AllowList→Dial list no. (0–7) and entry no. (0–9)→
Enter→ →Dial no.→Enter→Back 

PC Procedure 
→�→Type list no. (0–7) and entry no. (0–9)→�→
→Type no.→�→� 

Assign Allowed Lists to Extensions 3

Use this procedure to assign individual extensions access to established Allowed Lists. More than 
one Allowed List can be assigned to an extension.

Summary: Assign Allowed Lists to Extensions 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists
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Factory Setting Not applicable

Valid Entries 0 to 7

Inspect Yes

Copy Option Yes

Console Procedure Tables→AllowTo→Dial list no. (0–7)→Enter→Dial ext. no.→
Enter→Back→Back 

PC Procedure 
→�→Type list no. (0–7)→�→Type ext. no.→�→�→
� 

Disallowed Lists 3

Use this procedure to establish Disallowed Lists. These lists are telephone numbers that cannot 
be dialed from specified extensions (including unrestricted extensions).

A maximum of eight lists (numbered 0 through 7) with 10 entries each (numbered 0 through 9) is 
allowed. Each number can have a maximum of 11 digits, including wildcards. The Pause character 
(entered by pressing the Hold button) is used to designate a wildcard character—for example, to 
indicate that calls to a given exchange are restricted in every area code.

SECURITY ALERT:
Create a Disallowed List or use the pre-prepared Disallowed List number 7 to disallow dialing 
0, 11, 10, 1700, 1809, 1900, and 976 or 1(wildcard)976. Disallowed List number 7 does 
not include 800 and 1800 and 411 and 1411, but Lucent Technologies recommends that 
you add them. Assign all voice mail port extensions to this Disallowed List. Lucent 
Technologies recommends assigning Disallowed List number 7. This is an added layer of 
security in case outward restriction is inadvertently removed. (Voice messaging ports are 
assigned, 3 by default, to Disallowed List number 7.) 

Summary: Disallowed Lists 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting List #7, containing the following:
0, 10, 11, 1809, 1700, 1900, 976, 1ppp976 (p = wildcard), *

Valid Entries 1- to 11-digits (including wildcards)

Inspect No

Copy Option No

Console Procedure Tables→Disallow→Dial list no.(0–7) and entry no. (0–9)→
Enter→ →Dial no.→Enter→Back *XUV
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PC Procedure 
→�→Type list no.(0–7) and entry no. (0–9)→�→ →
Type no.→�→� 

Assign Disallowed Lists to Extensions 3

Use this procedure to assign established Disallowed Lists to individual extensions. Each restricted 
extension can be assigned to more than one list.

Summary: Assign Disallowed Lists to Extensions 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6g, Call Restriction Assignments and Lists

Factory Setting Not applicable

Valid Entries 0 to 7

Inspect Yes

Copy Option Yes

Console Procedure Tables→DisallowTo→Dial list no. (0–7)→Enter→
Dial ext. no.→Enter→Back→Back 

PC Procedure 
→�→Type list no. (0–7)→�→Type ext. no.→�→�→
� 

Remote Access Features 3

This section covers the following Remote Access features:

■ Remote Access over Networked Tandem and Tie Trunks 

■ Remote Access Trunk Assignment

■ Remote Access Automatic Callback

■ Remote Access without Barrier Codes

■ Remote Access Barrier Codes

■ Remote Access with Barrier Codes

*XUV
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SECURITY ALERT:
As a customer of a new system, you should be aware that telephone fraud has become an 
increasingly prevalent problem. It can occur in many forms, despite the numerous efforts of 
telephone companies and telephone equipment manufacturers to control it. Some individuals 
use electronic devices to prevent or falsify records of these calls. Others charge calls to 
someone else’s number by illegally using lost or stolen calling cards, billing innocent parties, 
clipping on to someone else’s line, or breaking into someone else’s telephone equipment 
physically or electronically. In certain instances, unauthorized individuals make connections 
to the public switched network through the use of Remote Access features.

The Remote Access feature of your system, if you choose to use it, permits off-premises 
callers to access the system from a remote telephone by using an 800 number or a 7- or 10-
digit telephone number. The system returns an acknowledgment signaling the user to key in 
his or her barrier code, which is selected and programmed by the System Manager. After the 
barrier code is accepted, the system returns dial tone to the user. If you do not program 
specific restrictions, the user will be able to place any call normally dialed from a telephone 
associated with the system. Such an off-premises network call is originated at and will be 
billed from the system location.

The Remote Access feature helps the customer, through proper administration, to minimize 
the ability of unauthorized persons to gain access to the network. Most commonly, telephone 
numbers and codes are compromised when overheard in a public location, through theft of a 
wallet or purse containing access information, or through carelessness (writing codes on a 
piece of paper and improperly discarding it). Additionally, hackers may use a computer to dial 
an access code and then publish the information to other hackers. Enormous charges can be 
run up quickly. It is the customer’s responsibility to take the appropriate steps to properly 
implement the features, evaluate and program the various restriction levels, and protect and 
distribute access codes only to individuals who have been fully advised of the sensitive 
nature of the access information.

Common carriers are required by law to collect their tariffed charges. While these charges 
are fraudulent charges when made by persons with criminal intent, applicable tariffs state 
that the customer of record is responsible for payment of all long-distance or other network 
charges. Lucent Technologies cannot be responsible for such charges and will not make any 
allowance or give any credit for charges that result from unauthorized access.

To minimize the risk of unauthorized access to your system, follow these basic rules:

■ Use a nonpublished Remote Access number.

■ Assign barrier codes randomly to users on a need-to-have basis, keeping a log of ALL 
authorized users and assigning one code to one person.

■ Use random sequence barrier codes, which are less likely to be broken.

■ Deactivate all unassigned codes promptly.

■ Ensure that Remote Access users are aware of their responsibility to keep the telephone 
number and any barrier codes secure.

■ When possible, restrict the off-network capability of off-premises callers using the Calling 
Restrictions and Disallowed List capabilities.
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■ When possible, block out-of-hours calling.

■ Frequently monitor system call detail reports for quicker detection of any unauthorized or 
abnormal calling patterns.

■ Limit remote call forward to persons on a need-to-have basis.

■ Always use the longest length password allowed on the system.

■ Passwords should consist of a random, non-repetitive, hard-to-guess sequence of digits.

Remote Access over Networked Tandem PRI
and Tie Trunks 3

In Hybrid/PBX mode only, an ARS call originating at a remote, private networked system can 
arrive on a networked tandem tie or PRI trunk of the local system and receive remote-access 
treatment automatically. This operation allows callers on one system to use lines on another 
system speedily and transparently when optimal cost efficiency dictates the need for lines 
connected to a different switch in the organization’s private network. (In prior systems and for calls 
over other Remote Access trunks, it is necessary to make an explicit remote-access call, enter a 
barrier code, and finally use ARS.) 

To permit this operation, both the local and remote systems must be programmed using ARS and 
Remote Access options. If two or more different System Managers program the private networked 
systems, they should work together to coordinate their efforts.

Local Users Calling out on Private Networked Lines 3

To implement this operation on a local system where callers will use the networked lines on a 
remote system, use the procedures outlined in the section, ‘‘Automatic Route Selection’’ on page 
3-175. 

Remote Users Calling out on Local Lines 3

When your system is in a private network with a remote system, you can set up your system so 
that remote users can use public switched network trunks connected to your control unit for cost-
efficient calling. Your system treats such calls as Remote Access calls, but the networked user 
does not enter a barrier code. Instead, the system applies default restrictions that apply to all tie 
and/or all non-tie trunks, as described later in this topic. These restrictions do not affect other 
remote-access trunks that are programmed for use with barrier codes.

Calling restrictions should be imposed at the remote originating switch using ARS and extension 
FRLs as necessary. In addition, it is unnecessary to assign tandem trunks for Remote Access. It is 
easiest if private networked systems that share outside facilities also use the same ARS access 
code (9, for example).

To implement this operation on a local system where callers on a remote networked system will 
use the local trunks connected to your MERLIN MAGIX Integrated System control unit, use the 
procedures in this chapter as outlined below. The relevant topics provide additional details.
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■ It is not necessary to assign private networked trunks for Remote Access. Callback for non-
local trunk-to-trunk tandem calls does not work. Automatic Callback can be used at the local 
system when all private networked trunks are busy.

■ Specify that all tie trunks (that is, networked tandem tie trunks) and/or all non-tie trunks (that is, 
all PRI tandem trunks) will not require barrier codes. This will not affect calls dialing the 
Remote Access code if the trunks on the remote system are regular, assigned remote-access 
trunks accessed by Remote Access users on your own system. See ‘‘Remote Access without 
Barrier Codes’’ on page 3-170.

■ Change the factory set class of restrictions, as necessary, on tie or non-tie trunks. Any 
necessary restrictions should be imposed by the System Manager for a call at the originating 
switch. For example, extensions may be assigned a Disallowed List to prevent 900 and 976 
calls. If certain private trunks are reserved for particular purposes, the remote System 
Manager may use UDP routing FRLs for this purpose.

■ Make any necessary changes to ARS in order to route remote users’ calls to yet another 
system if more cost effective, or to add or absorb digits (an area code, for example) before 
sending a call over a trunk that is connected to your system. See ‘‘Automatic Route Selection’’ 
on page 3-175 for the procedures.

Remote Access Trunk Assignment 3

Use this procedure to assign or remove the trunks used for Remote Access. You can also use this 
procedure to specify whether the Remote Access feature is dedicated (always used for Remote 
Access) or shared (used for Remote Access only when Night Service is activated).

Trunks used for dedicated Remote Access must not be assigned to ring into a Calling Group or the 
QCC queue (Hybrid/PBX mode only).

A remote-access caller who calls into his or her own local system can reach extensions private-
networked to the local system (non-local dial plan extensions), just as on-site users of the local 
system can.

In Hybrid/PBX mode, if a trunk assigned to ring into the QCC queue is also used for shared 
Remote Access, perform the procedure below before you attempt the procedure ‘‘QCC Operator 
to Receive Calls’’ on page 3-32.

A loop-start line must be programmed for Reliable Disconnect if it is to be used for 
Remote Access (See ‘‘Disconnect Signaling Reliability’’ on page 3-27).
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Summary: Remote Access Trunk Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Remote Access is not assigned

Valid Entries Dedicated, Shared, No Remote

Inspect Yes

Copy Option No

Console Procedure LinesTrunks→RemoteAccss→LinesTrunks→
Dial line/trunk no.→Enter→specify how trunk is used (Dedicated, 
Shared, No Remote)→Enter→Back→Back

PC Procedure �→
→�→Type line/trunk no.→�→
specify how trunk is used (Dedicated, Shared, No Remote)→�→
�→� 

Remote Access Automatic Callback 3

Use this procedure either to allow Remote Access users to use the Automatic Callback feature to 
request busy lines/trunks or pools or to prevent use of the Automatic Callback feature.

Summary: Remote Access Automatic Callback 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Disable

Valid Entries Disable, Enable

Inspect No

Copy Option No

Console Procedure LinesTrunks→RemoteAccss→AutoQueuing→Select
Enable or Disable→Enter→Back→Back

PC Procedure �→
→�→Select Enable or Disable→�→�→� 

This feature applies to Hybrid/PBX mode only.
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Remote Access without Barrier Codes 3

Use this procedure to change the class of restriction for one of the following:

■ All non-tie lines/trunks

■ All tie trunks and DID trunks with Remote Access

■ DID Remote Access code

SECURITY ALERT:
Your system will be highly susceptible to toll fraud if you activate the Remote Access feature 
without barrier codes. Lucent Technologies does not recommend doing this except in cases 
where your remote-access trunks are being used by external users connected to a system 
that is in a private network with your own. Even in these cases, the lack of barrier codes 
poses a risk of toll fraud. Be sure that the remote System Manager assigns any necessary 
restrictions.

The class of restriction assigned may be one of the following:

■ Restriction. Determines whether Remote Access users can make local and/or toll calls and 
includes the following settings:

— Unrestricted

— Toll restricted

— Outward restricted

■ ARS Facility Restriction Level (Hybrid/PBX only). Allows or disallows use of outgoing trunks 
by assigning a facility restriction level from 0 through 6. The FRL ranges from 0 (most 
restrictive) to 6 (least restrictive). The FRL value assigned here is the opposite of the FRL 
value assigned to the ARS route, where a value of 0 is the least restrictive and a value of 6 is 
the most restrictive.

■ Allowed Lists Assignment. Assigns Allowed Lists and is used when Remote Access users 
are restricted from making local or toll calls.

■ Disallowed Lists Assignment. Assigns Disallowed Lists and is used when Remote Access 
users are not restricted from making local or toll calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to lines/trunks.

Class of restriction settings are assigned either to all non-tie trunks or to all tie trunks and DID 
trunks. They cannot be assigned to each trunk on an individual basis.

If barrier code requirements have been established for Remote Access users, use 
‘‘Remote Access with Barrier Codes’’ on page 3-174; do not use this procedure.
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Summary: Remote Access without Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Call restriction: Outward restricted
ARS restriction level: 3

Valid Entries Unrestricted, Toll Restricted, Outward Restricted; 0 to 6

Inspect No

Copy Option No

Console Procedure To change calling restrictions:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
Restriction→Select restriction→Enter→Back→Back→
Back→Back 

To change ARS Facility Restriction Level:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
ARS Restrict→ →Dial FRL value→Enter→Back→Back→
Back→Back 

To assign/remove Allowed Lists:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
Allow List→Dial list no.→Enter→Back→Back→Back→Back 

To assign/remove Disallowed Lists:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
DisallowLst→Dial list no.→ Enter→Back→Back→Back→
Back 

PC Procedure To change calling restrictions:
�→
→Select Non-TIE or TIE Lines→�→Select 
restriction→�→�→�→�→� 

To change ARS Facility Restriction Level:
�→
→Select Non-TIE or TIE Lines→�→ →
Type FRL value→�→�→�→�→� 

To assign/remove Allowed Lists:
�→
→Select Non-TIE or TIE Lines→�→Type list no.→ 
�→�→�→� 

To assign/remove Disallowed Lists:
�→
→Select Non-TIE or TIE Lines→�→Type list no.→
�→�→�→�→� 

*XUV

*XUV
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Remote Access Barrier Codes 3

Use this procedure to establish or remove barrier code requirements, as well as to establish or 
remove the barrier codes themselves. 

Barrier codes are security passwords that restrict users from making unauthorized Remote Access 
calls on tie and non-tie lines and trunks. Callers are allowed three attempts per call to enter the 
correct Remote Access barrier code. If the caller enters an incorrect barrier code or times out 
during code entry, the caller hears the retry tone. The caller can erase an entered code by dialing 
** (two asterisks). Code erasure is counted as one of the three permitted attempts. After three 
unsuccessful attempts, the caller hears a reorder tone and the call is disconnected. If this 
happens, the SMDR contains sixteen 0s in the Account Code field to flag the three failed attempts.

A maximum of 16 barrier codes are allowed for all lines/trunks. Each of the 16 barrier codes may 
be programmed with its own class of restriction (COR). 

The system-wide barrier code length can range from a minimum of 4 characters to a maximum of 
11 characters. The factory setting length is 7. If you enter a length that is less than 4 or greater 
than 11, the entry is erased and the previous entry displays on the screen. When the barrier code 
length is changed, all barrier codes are erased and must be reassigned. If the barrier code length 
is changed and barrier codes are not reassigned, users can dial into Remote Access trunks and 
enter a barrier code, but are denied access into the Remote Access trunks no matter what code is 
entered.

SECURITY ALERT:
Always use the longest length barrier code allowed on the system. The code
should consist of a random, non-repetitive, hard-to-guess sequence of digits. 

The time and date of the most recent change made to the system-wide barrier code length is 
shown during the system programming procedure, as well as on the Remote Access DISA 
Information report. The SMDR record for incoming Remote Access trunks includes the barrier 
code IDs established in this procedure.

Use numbers 0 through 9 and the asterisk (*) to enter the barrier codes. The codes cannot start 
with an asterisk and cannot contain two consecutive asterisks. (The use of two consecutive 
asterisks is reserved for users to erase an incorrect barrier code entry.) 

See ‘‘Remote Access without Barrier Codes’’ on page 3-170 to allow or deny use of system 
features for each barrier code assigned.
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Summary: Remote Access Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting No barrier codes are established

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure To establish or remove code requirements:
LinesTrunks→RemoteAccss→Select Non-TIE or TIE Lines→
BarrierCode→Specify whether barrier codes are required→
Enter→Back→Back→Back

 To change barrier code length:
LinesTrunks→RemoteAccss→BarrierCode→Code Info→
Code Length→ →Dial code length→Enter→Yes→Back→
Back→Back

To change barrier code:
LinesTrunks→RemoteAccss→BarrierCode→Code Info→
Code Entry→Dial code ID→Enter→ →Dial code→Enter→
Back→Back→Back 

PC Procedure To establish or remove code requirements:
�→
→Select Non-TIE or TIE Lines→�→
Specify whether barrier codes are required→�→�→�→� 

To change barrier code length:
�→
→�→�→�→ →Type code length→�→
�→�→�→� 

To change barrier code:
�→
→�→�→�→Type Code ID→�→ →
Dial code length→�→�→�→� 

*XUV
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Remote Access with Barrier Codes 3

Use this procedure to change the class of restriction for individual Remote Access barrier codes. 
The class of restriction assigned to each barrier code allows or denies the use of the following 
system features:

■ Restriction. Determines whether Remote Access users can make local and/or toll calls, and 
includes the following settings:

— Unrestricted

— Toll restricted

— Outward restricted

■ ARS Facility Restriction Level (Hybrid/PBX only). Allows or restricts use of outgoing trunks 
by assigning a facility restriction level (FRL) from 0 through 6. The FRL ranges from 0 (most 
restrictive) to 6 (least restrictive). The FRL value assigned here is the opposite of the FRL 
value assigned to the ARS route, where a value of 0 is the least restrictive and a value of 6 is 
the most restrictive.

■ Allowed Lists Assignment. Assigns Allowed Lists and is used when Remote Access users 
are restricted from making local or toll calls.

■ Disallowed Lists Assignment. Assigns Disallowed Lists and is used when Remote Access 
users are not restricted from making local or toll calls.

A maximum of eight Allowed or Disallowed Lists can be assigned to each barrier code. Class of 
restriction settings apply to individual barrier codes.

Summary: Remote Access with Barrier Codes 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 3a, Incoming Trunks: Remote Access

Factory Setting Calling restrictions:
Barrier Code: outward restricted
All other barrier codes: unrestricted
ARS restriction level: 3

Valid Entries Unrestricted, Toll Restricted, Outward Restricted; 
0 to 6

Inspect No

Copy Option No

If barrier code requirements have not been established or have been removed for 
Remote Access users, do not use this procedure. See ‘‘Remote Access without Barrier 
Codes’’ on page 3-170.
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Console Procedure LinesTrunks→RemoteAccss→BarrierCode→
Restriction→Dial barrier code no.→Enter→Select 
restriction→
Enter→ARS Restrict→Dial barrier code no.→Enter→ →
Dial FRL value→Enter→Select Allow List or Disallow List→
Dial barrier code no. (1–16)→Enter→Dial list no.→Enter→
Back→Back→Back→Back 

PC Procedure �→
→�→�→Type barrier code no.→�→
Select restriction→�→�→Type barrier code no. (1–16)→
�→ →Type FRL value→�→Select Allow List or 
Disallow List→Dial barrier code no.→ �→�→�→�%
→� 

Automatic Route Selection 3

This section contains programming procedures for the following Automatic Route Selection (ARS) 
features:

■ 1 + 7-Digit Dialing Requirements

■ ARS Tables

■ Start and Stop Times for Subpatterns

■ Pool Routing

■ Facility Restriction Level (FRL)

■ Digit Absorption

■ Other Digits

■ N11 Special Numbers Tables

■ Dial 0 Table

■ Voice and/or Data Routing

ARS over Private Networked Tandem PRI 
and Tie Trunks 3

In Hybrid/PBX mode only, callers on one system can use lines on another system quickly and 
transparently for optimal cost by routing calls to a different switch in the organization’s private 
network (in prior systems, it is necessary to make an explicit Remote Access call, enter a barrier 
code, and finally use ARS). To permit this operation, both the local and remote systems must be 
programmed using ARS and Remote Access options.

ARS applies to Hybrid/PBX mode only.

*XUV

*XUV
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Remote Users Calling out on Local Private 
Networked Lines 3

To implement this operation on a local system where remote callers will use the private networked 
lines connected to your system, use the procedures outlined in the section ‘‘Remote Access 
Features’’ on page 3-165.

Local Users Calling out on Private Networked Lines 3

To implement this operation on a local system where callers will use the trunks on a remote 
system, use the procedures outlined in this section. The relevant topics provide additional details.

■ Assign the private networked tandem tie and/or PRI tandem trunks to a pool or pools including 
only those types of trunks. See ‘‘Trunks to Pools Assignment’’ on page 3-35.

■ Use one or more ARS tables for routing calls. Typically, you might need an area code table. 
For example, if the remote system is in the 617 area code, and your local system is in the 908 
area code, the area code table that you set up should include the entry 617. The type of table 
required depends upon how users in your system will employ private networked lines. At the 
remote system, ARS can be used, if necessary, to route the call to yet another networked 
system. See ‘‘ARS Tables’’ on page 3-177.

■ Set up the subpatterns for the table. In doing so, you may wish to check with the remote 
System Manager to ensure that routing will stipulate the most cost-effective timing based on 
the rates at the remote location. If the remote system is in a different time zone from your own, 
you may need to take this into consideration as well. See ‘‘Start and Stop Times for 
Subpatterns’’ on page 3-178.

■ Assign each tandem and/or tie trunk pool to an ARS table. See ‘‘Pool Routing’’ on page 3-179.

■ Assign appropriate Facility Restriction Levels to the routes and to the extensions that will use 
the private network lines. Factory settings restrict toll calls. See ‘‘Facility Restriction Level’’ on 
page 3-180 and ‘‘ARS Restriction Level for Extensions’’ on page 3-108, respectively.

■ Assign absorbed and other (added) digits as required by the final destination. The local ARS 
feature adds (prepends) the ARS access code of the remote system. At the remote system, 
digit absorption may be needed. For example, if local callers are in the 908 area code but the 
private network lines are connected to a system in the 617 area code, callers might dial 
916175551212, where 9 is the local ARS access code. At the remote system, because the 
call would be a local call, the absorbed digits would be 1617. See the ARS topics ‘‘Digit 
Absorption’’ on page 3-182 and ‘‘Other Digits’’ on page 3-183 for additional information.

SECURITY ALERT:

Do not place remote ARS access codes in the non-local dial plan by specifying, for 
example, a non-local extension range such as 9000–9050 when the remote ARS access 
code is 9. Doing so allows DID callers to make outside calls through the remote switch 
and may allow transferring of outside callers to outside dial tone on a remote switch, 
possibly resulting in toll fraud.
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1 + 7-Digit Dialing Requirements 3

Use this procedure for calls placed within the same (home) area code as the system. The 
procedure allows you to specify whether or not the local telephone company requires a 1 to 
precede the 7-digit number. The two available settings are:

■ Within Area Code. Requires that a 1 plus a 7-digit number must be dialed; the system checks 
the 1 plus 7-digit tables for routing.

■ Not within Area Code. Does not require that a 1 precede the 7-digit number (the system does 
this automatically).

Summary: 1 + 7-Digit Dialing Requirements 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting Not within area code

Valid Entries Not within area code, Within area code

Inspect No

Copy Option No

Console Procedure Tables→ARS→ARS 1+7Dial→Select Within Area Code or 
Not within Area Code→Enter→Back→Back 

PC Procedure 
→�→�→Select Within Area Code or Not within Area 
Code→�→�→� 

ARS Tables 3

Use this procedure for the following tasks:

■ To specify type of table (6-digit, area code, exchange, or 1 plus 7-digit number)

■ To add or change area codes to be included in each table

■ To add or change exchanges to be included in each table

A maximum of 16 tables can be established, numbered 1 through 16. Each table can have a 
maximum of 100 entries, numbered 1 through 100. Tables 17 and 18, the Default Toll and Default 
Local tables respectively, cannot be changed.

The first entry in a 6-digit table must be the area code. Subsequent entries consist of exchanges 
within that area code.
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Area code tables can contain only area codes. These tables are often used to provide cost-
efficient calling through private network lines/trunks connected to another system. The type of 
table required depends upon how users in the networked systems will employ networked lines. 
When you use ARS in this way, the ARS access code is only permitted on private trunks and is 
blocked from calls that arrive from the public switched network.

Exchange and 1 plus 7-digit tables can contain only exchanges.

The wildcard character (Pause) cannot be used to enter area codes or exchanges in ARS tables.

Summary: ARS Tables 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Tables→ARS→ARS Input→Dial table no.→Enter→
Specify table type→Enter→Dial entry no.→Enter→ →
Dial no.→Enter→Back→Back 

PC Procedure 
→�→�→Type table no.→�→Select table type→�→
Type entry no.→�→ →Type no.→�→�→� 

Start and Stop Times for Subpatterns 3

Use this procedure to specify the time of day that calls are routed using Subpattern B routing 
information.

Subpatterns are used to provide two different routing patterns according to the time of day. This 
allows you to take advantage of lower rates that may apply to some or all lines, or to change 
restrictions on some facilities during off hours.

The stop time for Subpattern B is the start time for Subpattern A.

Enter the time in 4-digit, 24-hour notation, using leading zeros as necessary.

If you are setting up ARS to allow local users to make cost-efficient calls on trunks connected to 
remote systems, you may wish to check with the remote System Manager to ensure that routing 
stipulates the most cost-effective timing based on the rates at the remote location. If the remote 
system is in a different time zone from your own, you may need to take this into consideration as 
well

*XUV
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Summary: Start and Stop Times for Subpatterns 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and
Special Numbers Tables

Factory Setting No time is specified, thus all calls are routed according to Subpattern 
A.

Valid Entries 0000 to 2359

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub B Start→Dial table no.→Enter→ →
Dial start time (0000–2359)→Enter→Sub B Stop→
Dial table no.→Enter→ →Dial stop time→Enter→Back→
Back 

PC Procedure 
→�→
→Type table no.→�→ →
Type start time (0000–2359)→�→
→Type table no.→�→

→Type stop time→�→�→� 

Pool Routing 3

Use this procedure to identify the trunk pools on which to route calls to area codes and/or 
exchanges included in ARS tables.

A maximum of six routes (numbered 1 through 6) can be specified for each subpattern. Pool 
routing is programmed for Tables 1 through 16. Tables 17 and 18, the Default Toll and Default 
Local tables respectively, are factory set to the main pool and can be changed.

■ When routing for ARS 10*** and 101**** equal-access calls (Interexchange 
Carrier or IXC) from a private networked switch that is not connected to the public 
switched network and only has private network tandem trunks, the private 
network tandem trunks must be assigned to the main pool on the system where 
ARS is dialed. The ARS access code for the caller’s system must match that of 
the system where the public switched network trunks are connected. For this 
reason, consider using the same ARS access code for all systems in the private 
network.

■ For Dial 0 and Special Numbers N11 calls (for example, 411 or 911) routed from 
systems with only private trunks, the private trunks must be assigned to the main 
pool, and the ARS access code of the remote system must be prepended to the 
dialed number (see ‘‘Dial 0 Table’’ on page 3-185 and ‘‘N11 Special Numbers 
Tables’’ on page 3-184). ARS access codes, therefore, should be the same.

*XUV
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Summary: Pool Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub A Pools or Sub B Pool→
Dial table no. and pool route no.→Enter→
Dial pool dial-out code→Enter→Back→Back 

PC Procedure 
→�→� or �→Type table no. and pool route no.→
�→Type pool dial-out code→�→�→� 

Facility Restriction Level 3

Use this procedure to assign a Facility Restriction Level (FRL) to each route. The FRL ranges from 
0 (least restrictive) to 6 (most restrictive) and is used to restrict user access to the route. The FRL 
assigned to extensions and Remote Access users is the opposite of the FRL assigned to routes, 
where 0 is the most restrictive and 6 is the least restrictive.

Facility Restriction Levels are assigned to Tables 1 through 18. Tables 17 and 18, the Default Toll 
and Default Local tables respectively, cannot be changed.

Pool routes must be programmed before you assign Facility Restriction Levels.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-181Automatic Route Selection 

3

Summary: Facility Restriction Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables
3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting 3 (Table 18, the Default Local table has a factory setting of 2)

Valid Entries 0 to 6

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub A FRL or More and Sub B FRL→
Dial table no. (1–18) and pool route no. (1–6)→Enter→
Dial restriction level (0–6)→Enter→Back→Back 

PC Procedure 
→�→� or%�%and �→Type table no. (1–18) and pool 
route no. (1–6)→�→Type restriction level (0–6)→�→�→� 
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Digit Absorption 3

Use this procedure to specify how many of the digits dialed (0 through 11) by the caller should be 
absorbed (not sent to the telephone company’s central office) by the system when a call is made 
on an identified route.

Entries of 1 through 11 indicate that the system should not send the specified number of digits, 
starting with the first digit dialed by the user after the dial-out code.

Digit absorption is assigned to Tables 1 through 18.

Summary: Digit Absorption 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting 0

Valid Entries 0 to 11

Inspect No

Copy Option No

Console Procedure Tables→ARS→SubA Absorb or  or More and SubB Absorb→
Dial table no. (1–18) and pool route no. (1–6)→Enter→ →
Dial no. of digits to absorb (0–11)→Enter→Back→Back 

PC Procedure 
→�→� or � and �→Type table no. (1–18) and pool 
route no. (1–6)→�→ →Type no. of digits to absorb 
(0–11)→�→�→� 

■ Pool routes must be programmed before you assign digit absorption.

■ Where remote users will dial out via private network lines, absorbed digits are 
often useful. For example, if remote callers are in the 908 area code but your 
system is in the 617 area code, callers might dial 916175551212, where 9 is 
the remote ARS access code. Because the call is a local call on the remote 
system, the absorbed digits on that system would be 1617.

*XUV
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Other Digits 3

Use this procedure to specify other (extra) digits that must be added by the system to the 
beginning of the number dialed by the caller when calls are placed on an identified route.

A maximum of 20 digits can be added in any combination of the digits 0 through 9.

Special characters such as switchhook flash, Stop, and # cannot be included as extra digits. 
Pause is allowed in every position but the first.

Other digits are assigned to Tables 1 through 18.

Summary: Other Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3f, Automatic Route Selection Tables

Factory Setting 0

Valid Entries Up to 20 digits (any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure Tables→ARS→Sub A Digit or  or More and Sub B Digit→
Dial table no. (1–18) and pool route no. (1–6)→Enter→ →
Dial digits to be added (up to 20 digits; any combination of 0–9)→
Enter→Back→Back 

PC Procedure 
→�→	 or � and �→
Type table no. (1–18) and pool route no. (1–6)→�→ → Type 
digits to be added (up to 20 digits; any combination of 0–9)→
�→�→� 

■ Pool routes must be programmed before you assign other digits.

■ Where ARS calls will be made from lines/trunks connected to a remote private 
network system, the local ARS feature adds (prepends) the ARS access code of 
the remote system.

*XUV
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N11 Special Numbers Tables 3

Use this procedure to specify FRL and/or digits that must be added when emergency numbers in 
the N11 Special Numbers table are dialed (for example, 411, 811, or 911).

Subpattern B, absorb, and pool routing cannot be programmed for the N11 Special Numbers 
tables.

Summary: N11 Special Numbers Tables 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure To change Facility Restriction Level:
Tables→ARS→  or More→SpeclNumber→ARS FRL→ →
Dial FRL value→Enter→Back→Back→Back 

 To program other digits:
Tables→ARS→  or More→SpeclNumber→ARS Digit→ 

→Dial digits→Enter→Back→Back→Back 

PC Procedure To change Facility Restriction Level:

→�→�→�→�→ →Type FRL value→�→
�→� 

 To program other digits:

→�→�→�→�→ →Type digits→�→
�→� 

When routing for ARS Special Numbers N11 calls from a private network switch that is 
not connected to the public switched network, the private trunks must be assigned to the 
main pool (factory set to 70). The local system must prepend the ARS access code of the 
connected switch from which the calls will be directed to the public switched network.

*XUV
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Dial 0 Table 3

Use this procedure to specify pool routing, FRL, and Other Digits for the Dial 0 table.

Only one route can be specified. The Subpattern B route cannot be specified for this table, and 
digit absorption cannot be specified.

Summary: Dial 0 Table 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting 3

Valid Entries 0 to 6 

Inspect No

Copy Option No

Console Procedure Tables→ARS→  or More→Dial 0→Select 
ARS Pool or ARS FRL (0–6) or ARS Digits→
Dial value→Enter→Back→Back→Back 

PC Procedure 
→�→�→�→Select 
ARS Pool or ARS FRL (0–6) or ARS Digits→Type value→
�→�→�→� 

Voice and/or Data Routing 3

Use this procedure to route voice, data, or voice and data. The voice/data specification is used 
mainly in conjunction with PRI. See ‘‘PRI Facilities’’ on page 3-61, especially its subtopic, 
‘‘Outgoing Tables’’ on page 3-76.

Voice/data routes can be associated with Subpattern A or Subpattern B.

When routing for ARS Dial 0 calls via a private network switch that is not connected to the 
public switched network, the external private trunks must be assigned to a pool, and the 
ARS access code must be prepended to the dialed number using this procedure.
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Summary: Voice and/or Data Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form 3g, Automatic Route Selection Default and 
Special Numbers Tables

Factory Setting Voice

Valid Entries Voice Only, Data Only, Voice/Data

Inspect No

Copy Option No

Console Procedure Tables→ARS→  or More→Sub A Data or Sub B Data→
Dial table no. and route no.→Enter→Select capability (Voice Only, 
Data Only, or Voice/Data)→Enter→Back→Back

PC Procedure 
→�→�→	 or 
→Type table no. and route 
no.→�→
Select capability (Voice Only, Data Only, or Voice/Data)→�→
�→� 

Uniform Dial Plan Routing 3

This section includes programming procedures for assigning Uniform Dial Plan (UDP) Routing, 
available for Hybrid/PBX mode only. 

UDP Routing is very similar to Automatic Route Selection (ARS). UDP Routing allows system 
users to reach non-local extensions at a remote DEFINITY or MERLIN MAGIX Integrated System 
that is connected to the local system in a private network. Users simply dial the non-local 
extension number as they would an inside extension number. Then UDP Routing associates the 
dialed extension number with one of up to 20 programmed patterns. For each pattern, you can 
specify up to four routes. For each route, you specify a pool dial-out code. Then you can program 
FRLs, absorbed digits, added digits, and voice and/or data capability.

This section contains programming procedures for the following UDP Routing features:

■ UDP Pool Routing

■ Facility Restriction Level (FRL)

■ Digit Absorption

■ Other Digits

■ Voice and/or Data Routing

Before assigning routes, patterns must be assigned to non-local extensions, which is part 
of the numbering of the extensions. To perform this procedure, see ‘‘Non-Local Dial Plan 
Extension Ranges’’ on page 3-15. 
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SECURITY ALERT:
Do not include the ARS codes of non-local systems in the non-local dial plan, or calling 
restrictions may be violated.

Refer to the Network Reference for additional information.

UDP Pool Routing 3

Before beginning this procedure, assign tandem tie or PRI trunks to pools. To do so, see ‘‘Trunks 
to Pools Assignment’’ on page 3-35. In UDP routing, routes (1–4) are associated with patterns, 
which are assigned first. Each route has various attributes (FRL, digit absorption, and so on) for 
call delivery. You may assign from one to four routes, with Route 1 having the highest priority. See 
the Network Reference for additional information.

In many cases, only one pool may be needed. Multiple pools, however, can help prioritize certain 
types of calls and maximize the use of shared facilities.

PRI tandem trunk pools, if available, should be included in the first route.

SECURITY ALERT:
Do not provide dial access to PRI or tie tandem trunk pools or assign these trunk pools to 
buttons on telephones or DSS buttons (Hybrid/PBX mode only). Use ARS to provide access 
to a remote private network system’s trunks for making outside calls. System users can 
reach extensions on the remote system by using normal calling procedures. 

Summary: UDP Pool Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting Not applicable

Valid Entries Routes (1–4)

Inspect Yes

Copy Option No

Console Procedure Tables→UDP Routing→Dial pattern no. (1–20)→ Enter→
Dial route no. (1–4)→Enter→Pool→Dial pool dial-out code (up to 
4 digits)→Enter→ Back→Back→Back→Back 

PC Procedure 
→	→Type pattern no. (1–20)→�→Type route no. (1–4)→
�→�→Type pool dial-out code (up to 4 digits)→�→�→
�→�→� 
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UDP Facility Restriction Level 3

Use this procedure to assign a FRL to each UDP route. The FRL ranges from 0 (least restrictive) 
to 6 (most restrictive) and prevents users from accessing the route. The FRL assigned to 
extensions and Remote Access users is the opposite of the FRL assigned to routes, with 0 being 
the most restrictive FRL, and 6 the least restrictive. A call will succeed if the extension’s (or 
Remote Access) FRL is greater than or equal to the facility’s FRL.

FRLs assigned to extensions (or Remote Access) apply not only to ARS calls but also to calls for 
non-local dial plan extensions connected by private trunks to your local system. For this reason, 
use care in assigning FRLs both to extensions and to UDP routes. For example, if a user must be 
restricted from toll calls on your local system, you may need to plan UDP routes’ FRLs to be 
unrestricted so that the user can reach necessary non-local dial plan extensions. For information 
about assigning FRLs to extensions, see ‘‘ARS Restriction Level for Extensions’’ on page 3-108.

Summary: UDP Route Facility Restriction Level 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting 3 

Valid Entries 0 to 6

Inspect No

Copy Option No

Console Procedure Tables→UDP Routing→Dial pattern no. (1–20)→ Enter→
Dial route no. (1–4)→Enter→FRL→Dial restriction level (0–6)→
Enter→Back→Back→Back→Back 

PC Procedure 
→	→Enter pattern no. (1–20)→�→Type route no. (1–4)→
�→�→Type restriction level (0–6)→�→�→�→
�→� 

■ UDP pool routes must be programmed before you assign Facility Restriction 
Levels to those routes.

■ Extension outward and toll calling restrictions are removed when a user dials a 
non-local dial plan extension. FRL extension restrictions, however, remain in 
effect but are not sent with the call.

■ If you have Centralized Voice Messaging, program an FRL of 0 for the routes 
used to send calls to Centralized Voice Messaging. See the Network Reference 
for additional information.
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UDP Digit Absorption 3

Use this procedure to specify how many of the digits dialed (0 to 11) by the caller should be 
absorbed (not sent over the trunk) by the system when a UDP call to a non-local extension is 
made on an identified route. If the number is dialed without a pool access code or without using a 
Pool button, therefore, the dialed digits correspond to the non-local dial plan numbering. Digit 
absorption can be used to modify the digits that are actually sent to the remote system.

Entries of 1 through 11 indicate that the system should not send the specified number of digits, 
starting with the first digit dialed by the user.

Summary: UDP Digit Absorption 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting 0

Valid Entries 0 to 11

Inspect No

Copy Option No

Console Procedure Tables→UDP Routing→Dial pattern no. (1–20)→ Enter→
Dial route no. (1–4)→Enter→Absorb→ →
Dial number of absorption digits (0–11)→Enter→Back→Back→
Back→Back 

PC Procedure 
→	→Enter pattern no. (1–20)→�→Type route no. (1–4)→
�→�→ →Type number of digits to absorb (0–11)→
�→�→�→�→� 

■ UDP pool routes must be programmed before you assign digit absorption.

■ Do not use this procedure to overcome conflicts between local and remote 
extension numbering. Such conflicts can result in numerous problems with 
system features.

*XUV
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UDP Other Digits 3

Use this procedure to specify other (extra) digits that must be added by the system to the 
beginning of the dialed digits when calls are placed on an identified route. You may need to 
prepend a digit in order to accommodate the 5-digit numbering of DEFINITY Communications 
System extensions in your private network. For more information about techniques for handling 
these non-local dial plan extension numbers, see ‘‘Non-Local Dial Plan Extension Ranges’’ on 
page 3-15.

The user does not use a Pool button or pool dial-out code. The dialed digits, therefore, correspond 
to the non-local dial plan numbering. 

A maximum of 20 digits can be added, in any combination of digits 0 through 9.

Special characters such as switchhook flash, Stop, and # cannot be included as extra digits. 
Pause is allowed in every position except the first.

Summary: UDP Other Digits 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting 0

Valid Entries Up to 20 digits (any combination of 0 to 9)

Inspect No

Copy Option No

Console Procedure Tables→UDP Routing→Dial pattern no. (1–20)→ Enter→
Dial route no. (1–4)→Enter→Digits→ →
Dial digits to add (up to 20; any combination of 0–9)→Enter→
Back→Back→Back→Back 

PC Procedure 
→	→Enter pattern no. (1–20)→�→Type route no. (1–4)→
�→�→ →Type digits to add (up to 20; any combination of 
0–9)→�→�→�→�→� 

■ UDP pool routes must be programmed before you assign digit absorption.

■ Do not use this procedure to overcome conflicts between local and remote 
extension numbering. Such conflicts can result in numerous problems with 
system features.

*XUV
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UDP Voice and/or Data Routing 3

Use this procedure to route voice, data, or voice and data. For UDP routing, the voice/data 
specification is used in conjunction with PRI tandem trunks. See ‘‘PRI Facilities’’ on page 3-61 for 
more information. When using Fractional-T1 tandem trunks, each channel on the trunk can be 
used for either voice or data, but not for voice/data. See ‘‘DS1 Facilities’’ on page 3-40 for more 
information.

Voice/data routes can be associated with any UDP pattern.

Summary: UDP Voice and/or Data Routing 3

Programmable by System Manager

Mode Hybrid/PBX

Idle Condition Not required

Planning Form Non-Local Dial Plan Administration Form in the Installation 
Specification

Factory Setting Voice/Data

Valid Entries Voice Only, Data Only, Voice/Data

Inspect No

Copy Option No

Console Procedure Tables→UDP Routing→Dial pattern no.→ Enter→
Dial route no.→Enter→Data→Select capability (Voice Only, Data 
Only, Voice/Data)→ Enter→Back→Back→Back→Back 

PC Procedure 
→	→Type pattern no.→�→Type route no.→�→�→
Select capability (Voice Only, Data Only, Voice Data)→�→�→
�→�→� 

Night Service 3

The procedures in this section cover how to program the following optional Night Service features:

■ Night Service Group Assignment

■ Night Service with Outward Restriction

■ Night Service with Time Set

■ Night Service with Coverage Control
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Night Service Group Assignment 3

Use this procedure to assign extensions and Calling Groups to a Night Service group for coverage 
after hours.

A maximum of eight Night Service groups can be assigned (no more than one for each operator 
position assigned). Any number of extensions can be assigned to a Night Service group, and an 
extension can belong to more than one group.

A Calling Group can also be assigned to a Night Service group.

This option allows the System Manager to assign outside lines to Night Service groups in addition 
to extensions and Calling Groups for coverage after hours.

Any number of outside lines can be assigned to a Night Service group. Each outside line can 
belong to more than one group.

Summary: Night Service Group Assignment 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9a, Night Service: Group Assignment

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes (extensions only)

Copy Option No

Console Procedure To assign a Calling Group to a Night Service group:
NightSrvce→GroupAssign→Calling Group→Dial ext. no. of 
Night Service operator→Enter→Dial Calling Group no.→Enter→
Back→Back

To assign an extension to a Night Service group:
NightSrvce→GroupAssign→Extensions→
Dial ext. no. of Night Service operator→Enter→
Dial no. of extension→Enter→Back→Back

To assign an outside line to a Night Service group:
NightSrvce→GroupAssign→Lines→
Dial ext. no. of Night Service operator→Enter→
Dial outside line number (801–880)→Enter→Back→Back 
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PC Procedure To assign a Calling Group to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type Calling Group no.→�→�→� 

To assign an extension to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type no. of extension→�→�→� 

To assign an outside line to a Night Service group: 
�→�→�→Type ext. no. of Night Service operator→�→
Type outside line number (801–880)→�→�→� 

Night Service with Outward Restriction 3

Use this procedure to prevent unauthorized use of telephones after hours. This feature requires 
the user to enter a password to make a call when Night Service is activated, unless one of the lists 
below applies. It also requires an operator to enter a password in order to activate Night Service 
manually.

To remove the password requirement, follow the procedure below and delete the current password 
(press the  button).

This procedure is also used to establish the following lists:

■ Emergency Allowed List. A list of telephone numbers that can be dialed without a password.

■ Exclusion List. A list of extensions that are exempt from password requirements.

A maximum of 10 telephone numbers can be included on the Emergency Allowed List, each 
number with a maximum of 12 digits.

Extensions included in the Exclusion List keep normal call restrictions (if any are assigned); 
however, they are not protected in any other way from unauthorized use after hours.

Summary: Night Service with Outward Restriction 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9b, Night Service: Outward Restrictions

Factory Setting No password

Valid Entries Four digits (any combination of 0 to 9)

Inspect Yes (Exclusion List)

Copy Option No

*XUV
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Console Procedure NightSrvce→OutRestrict→ →
Dial password (4 digits; 0–9)→Enter→Emergency→
Dial item no.→Enter→ →Dial telephone no.→Enter→
ExcludeList→Dial ext. no.→Enter→Back→Back

PC Procedure �→�→ →Type password (4 digits; 0–9)→�→�→
Type item no.→�→ →Type telephone no.→�→�→
Type ext. no.→�→�→� 

Night Service with Time Set 3

Use this procedure to specify the time of day and the days of the week when Night Service is to be 
activated and deactivated.

Enter the time of day as four digits, using 24-hour notation. Enter the day of the week as a single 
digit (0 to 6), with 0 being Sunday. If you enter an invalid number, the system truncates the 
number.

If you change the system time while Night Service is active, Night Service is deactivated 
automatically and you must manually reactivate it.

Operators can override the timer and turn Night Service on and off manually. This feature can be 
deactivated when out-of-the-ordinary situations occur (for example, a midweek holiday).

If system programming information is being loaded into memory from a backup diskette, the 
current day of the week must be reset.

Night Service can be turned off by using the following procedure:

NightSrvce→Day of Week→Dial 9→Enter→Back

Summary: Night Service with Time Set 3

Programmable by  System Manager

Mode  All

Idle Condition  Not required

Planning Form 9c, Night Service: Time Set

Factory Setting Not applicable

Valid Entries Day: 0 to 6; Time: 0000 to 2359

Inspect No

Copy Option No

*XUV
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Console Procedure To add or change start/stop time:
NightSrvce→Start→ →
Dial start day (0–6) and time (0000–2359)→Enter→Stop→

→Dial stop day and time→Enter→Back 

To activate/deactivate:
NightSrvce→Time Control→Off or On→Enter→Back 

PC Procedure To add or change start/stop time:
�→�→ →Type start day (0–6) and time (0000–2359)→
�→	→ →Type stop day (0–6) and time (0000–2359)→
�→� 

To activate/deactivate:
�→
→� or �→�→� 

Night Service with Coverage Control 3

Use this procedure to enable or disable the Night Service Coverage Control option to 
automatically control the status of programmed Coverage VMS Off buttons.

When the Coverage Control option is enabled, a transition into Night Service (either by pressing a 
Night Service button or automatically by the Time Set option) automatically deactivates the VMS 
Coverage Off buttons (LED is off) and allows outside calls to go to VMS Coverage at night. When 
the system is taken out of Night Service (either by pressing a Night Service button or automatically 
by the Time Set option), programmed VMS Coverage Off buttons are activated (LED is on) and 
outside calls are prevented from going to VMS Coverage during the day.

When the Coverage Control option is disabled, Night Service status has no effect on programmed 
VMS Coverage Off buttons.

Summary: Night Service with Coverage Control 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 9c, Night Service: Options

Factory Setting Disabled

Valid Entries Enable or Disable

Inspect No

Copy Option No

Console Procedure NightSrvce→CoverContrl→Select Enable or 
Disable→Enter→
Back 

PC Procedure �→�→Select Enable or Disable→�→� 

*XUV
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Labeling 3

The procedures in this section cover how to add or change labels for the following:

■ Extension Directory

■ Lines or Trunks

■ Posted Message

■ Group Calling

■ System Speed Dial Directory

Programming on the system programming console:

Use the buttons next to the display to specify the letters A through I and punctuation. Use the line/
feature buttons to specify additional alphanumeric characters for labels. Use the template provided 
with the 4424LD+ or MLX-20L telephone to see which line buttons correspond to which 
alphanumeric characters.

Programming with WinSPM:

■ Use the PC keyboard for labels. All letters appear on the screen in uppercase.

Extension Directory 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
the person calling or leaving a message. This procedure is also used to program the Extension 
Directory feature for the 4412D+, 4424D+, and 4424LD+ telephones and for the MLX telephones.

See the 4424LD+ User’s Guide or the MLX-20L User’s Guide for instructions on creating 
or editing a personal directory.

■ Where private networked systems are connected by PRI tandem trunks, 
programmed labels for extensions on the remote system may be displayed at a 
call recipient’s 4400-Series, ETR, MLS, or MLX display telephone on a local 
system. If other types of trunks connect the private network systems, the call 
display is the same as for an outside call. For additional information about 
controlling the display for such incoming calls, see ‘‘Display Preference’’ on page 
3-118.

■ A label can have a maximum of seven characters.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-197Labeling 

3

Summary: Extension Directory 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2a, System Numbering: Extension Jacks

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option

No

Console Procedure  or More→Labeling→Directory→Extension→Dial ext. 
no.→Enter→ →Enter label→Enter→Back→Back→Back 

PC Procedure �→�→�→�→Type ext. no.→�→ →
Type label→�→�→�→� 

Lines or Trunks 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
the line or trunk being used.

Summary: Lines or Trunks 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 2c, System Numbering: Line/Trunk Jacks

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure  or More→Labeling→LinesTrunks→Dial line/trunk no.→ 
Enter→ →Enter label→Enter→Back→Back 

PC Procedure �→�→�→Type line/trunk no.→�→ →
Type label→�→�→� 
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Posted Message 3

Use this procedure to add or change existing posted messages. The posted messages allow 
callers with display telephones to know why the called extension does not answer.

Each posted message can have a maximum of 16 characters. Messages 2 through 20 can be 
changed through programming. Message 1, Do Not Disturb, cannot be changed.

Summary: Posted Messages 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8a, Label Form: Posted Message

Factory Setting First 10 messages

Valid Entries 1 to 20

Inspect No

Copy Option No

Console Procedure  or More→Labeling→PostMessage→Dial message no.
(1–20)→Enter→ →Enter message→Enter→Back→Back 

PC Procedure �→�→�→Type message no. (1–20)→�→ →
Type message→�→�→� 

Group Calling 3

Use this procedure to establish alphanumeric system labels for display telephone users to identify 
Calling Groups.

A label can have a maximum of seven characters.

Posted messages are not supported across private network systems.

*XUV
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Summary: Group Calling 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 6e, Group Calling

Factory Setting Not applicable

Valid Entries Not applicable

Inspect No

Copy Option No

Console Procedure  or More→Labeling→Grp Calling→Dial Calling Group ext. 
no.→Enter→ →Enter label→Enter→Back→Back

PC Procedure �→�→�→Type Calling Group ext. no.→�→ →
Type label→�→�→� 

System Speed Dial Directory 3

Use this procedure to establish System Speed Dial numbers for all system users. You can also 
use this procedure to enter the alphanumeric labels shown on display telephones (for the System 
Directory feature of the MLX telephone).

A total of 130 System Speed Dial numbers can be entered, with a maximum of 11 characters per 
label.

Speed dial code assignments are 600 through 729.

Summary: System Speed Dial Directory 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 8b, System Speed Dial

Factory Setting Not applicable

Valid Entries 600 to 729

Inspect No

Copy Option No

*XUV

*XUV
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Console Procedure  or More→Labeling→Directory→System→
Dial dial code no. (600–729)→Enter→ →Enter label→
Enter→Backspace→Dial telephone no. (up to 20 digits and 
special characters)→Enter→ Yes or No→Enter→Back→
Back→Back 

PC Procedure �→�→�→�→Type dial code no. (600–729)→�→
→Type label→�→�→Type telephone no. (up to 20 digits 

and special characters)→�→� or �→�→�→�→� 

Print Reports 3

Use the procedures in this section to change the language for system reports and to print the 
system reports.

Report Language 3

Use this procedure to change the language of the system reports. Unless you change the report 
language, reports are printed in the language chosen as the system language.

Summary: Report Language 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form 1, System Planning

Factory Setting U.S. English

Valid Entries U.S. English, Canadian French, Latin American Spanish

Inspect No

Copy Option No

Console Procedure  or More→Language→Printer→Select English or French 
or Spanish→Enter→Back

PC Procedure �→�→�→Select English or French or 
Spanish→�→� 

*XUV

*XUV
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Printing System Reports 3

The system can be used to print a variety of reports. You can print individual reports or use the All 
option to print the entire set of available reports, including all report sections and options. See 
Appendix F for samples of the print reports.

Use this procedure to print the reports listed below. With the exception of Trunk Information, the 
dash lists under the bullets show the sections of each report that automatically print when the 
report option is selected.

■ All

— Each report

— All report options

■ System Set Up

■ System Dial Plan

— Pools

— Telephone Paging Zones

— Direct Group Calling

— Lines/Trunks

— Stations (Extensions)

■ Label Information

— Telephone Personal Directory

— Message Numbers and Posted Messages

■ Trunk Information1

— TIE

— DID

— Loop/Ground

— General

— Switched 56 Data 

■ T1 Information

■ PRI Information

■ Remote Access

— General Options

— Non-TIE Restrictions

— TIE Restrictions

— Barrier Code Restrictions

1 Trunk option must be specified
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■ Operator Information

— Position

— General Options

— DSS Options

— QCC Operators

— Operator Information

■ Allowed Lists

■ Allowed Lists Assigned to Extensions

■ Disallowed Lists

■ Disallowed Lists Assigned to Extensions

■ Automatic Route Selection

■ Tables

■ Extension Directory

■ System Directory

■ Group Page

■ Extension Information

■ Group Coverage

■ Group Calling

■ Night Service

■ Call Pickup Groups

■ Error Logs

■ Authorization Codes

■ BRI Information Report

■ Non-Local Dial Plan

■ Service Observing Groups

If you select a report for which there is no information, the report header still prints.

Print reports if you cannot back up your system programming information.

Do not print reports if your system must handle more than 100 calls per hour.

If you select the All option, keep in mind that the reports take from 30 minutes to 6 hours 
to print depending on the size of the system. You may want to schedule use of the printer 
during off-peak hours.
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If you are printing from the console, your printer must be connected to the SMDR port. If you are 
programming on a PC with WinSPM, you have the following choices:

■ Print reports on the SMDR printer (if available)

■ Print reports on the PC printer

■ Save reports (on hard disk or floppy)

■ View reports (browse)

See Chapter 2, ‘‘Programming with WinSPM,” for details.

Summary: Printing System Reports 3

Programmable by System Manager

Mode All

Idle Condition Not required

Planning Form Not applicable

Factory Setting Not applicable

Valid Entries Any saved report

Inspect No

Copy Option No

Console Procedure To print trunk information:
 or More→Print→Trunk Info→Select trunk type→Back 

To print extension information:
 or More→Print→More→Ext Info→Dial extension no.→ 

Enter→Back 

To print all other reports:
 or More→Print→Select report→Back

PC Procedure To print trunk information:
�→�→�→Select trunk type→� 

To print extension information:
�→�→�→�→Type extension no.→�→� 

To print all other reports:
�→�→Select report→� 

To save report on disk:
�→�→Select report→�→Select GOTO FLOPPY→� 

To view report:
(XU]YK
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Data Features 3

Other data programming procedures can be found in earlier sections of this book (see Table 3-7), 
with the exception of ringing options. See ‘‘Ringing Options’’ on page 4-35 for information about 
ringing options.

Table 3-7. Other Data Programming Procedures

Procedure Location

Assign Trunks or Pools to Data 
Workstations

‘‘Assign Trunks or Pools to Extensions’’ on page 3-84

Copy Trunk Assignments ‘‘Copy Line/Trunk Assignments’’ on page 3-86

Assign Intercom or System 
Access Buttons 

‘‘Assign Intercom or System Access Buttons’’ on page 3-87

Pool Dial-Out Code
(Hybrid/PBX only)

‘‘Pool Dial-Out Code’’ on page 3-104

Calling Restrictions ‘‘Calling Restrictions’’ on page 3-105

Copy Calling Restrictions ‘‘Copy Calling Restrictions’’ on page 3-107

Forced Account Code Entry ‘‘Forced Account Code Entry’’ on page 3-109

Ringing Options ‘‘Ringing Options’’ on page 4-35

Assign Data Hunt Group 
Members

‘‘Group Calling Member Assignments’’ on page 3-134

Assign Data Hunt Group Trunks 
or Pools 

‘‘Group Calling Line/Trunk or Pool Assignments’’ on page 
3-136

Group Type ‘‘Group Type’’ on page 3-145 (choice restricted to Automatic 
Log ln)
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2B Data 3

Use this procedure to program an MLX port for 2B data capability. Assigning a port for 2B data 
allows both B-channels of a single MLX port to be used for speeds up to 128 Kbps on data calls. 

Consider the following when programming ports for 2B data capability:

■ The extension number of the port cannot be the first or fifth port on an MLX module. These 
ports are designated as potential operator ports and cannot be used for 2B data connections.

■ The extension number must correspond to the adjunct extension number of an MLX port. By 
default, these extensions begin with “7.”

■ Devices that are not intended for 2B data should not be connected to a port programmed for 
2B data. These devices probably will not work.

Summary: 2B Data 3

Programmable by System Manager

Mode Key, Hybrid/PBX

Idle Condition Required

Planning Form Data Form 2b, Digital Data Workstation

Factory Setting None

Valid Entries Adjunct extension number up to four digits

Inspect Yes

Copy Option No

Console Procedure Data→2B Data→Dial adjunct ext. no.→Enter→Back→Back 

PC Procedure �→�→Type adjunct ext. no.→�→�→� 
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Memory Card 3

A PCMCIA (Personal Computer Memory Card International Association) interface slot is present 
on the processor module. The slot is a standard interface through which information can be added 
to or obtained from the system using a memory card. The PCMCIA interface slot accepts one 
memory card at a time. 

This section covers the following memory card functions:

■ Memory Card Formatting

■ Backup

■ Automatic Backup

■ Restore

Card Types 3

The types of memory cards are described below. The card type is identified by a preprinted, color-
coded label.

■ Upgrade Card. This card is used for MERLIN MAGIX Integrated System software upgrades. 
The upgrade can be performed by the System Manager using the memory card and the 
Maintenance option on the SPM Main menu. See Maintenance and Troubleshooting for 
information about this feature.

This card is identified by an orange label with black lettering.

■ Translation Card. The backup and restore procedures previously available to System 
Managers through SPM (using the PC and floppy disks) can now be performed using the 
memory card and the new Backup/Restore option on the System menu. A new automatic 
backup feature permits you to set the system to perform automatic backups to the memory 
card on a daily or weekly basis. See ‘‘Backup’’ on page 3-211 and ‘‘Restore’’ on page 3-216 for 
more information.

This card is identified by a white label with black lettering.

■ Forced Installation. For use by qualified service technicians only, this card is used when the 
system software has been corrupted and a re-installation must be done at the customer site. 
The use of the card for forced installation is reserved for emergency situations in which the 
system software on the processor module has been damaged.

This card is identified by an orange label with black lettering. In addition, black stripes are 
present on the card to distinguish it from an upgrade card.
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Figure 3-4 shows a sample Translation card.

Figure 3-4. PCMCIA Memory Card

LUCENT TECHNOLOGIES PROPRIETARY
THIS MEMORY CARD CONTAINS PROPRIETARY INFORMATION OF

LUCENT TECHNOLOGIES THAT IS NOT TO BE DISCLOSED OR USED 
EXCEPT IN ACCORDANCE WITH APPLICABLE AGREEMENTS.

COPYRIGHT© 1993 LUCENT TECHNOLOGIES
ALL RIGHTS RESERVED 
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Inserting the Card 3

To insert the card, hold the card with the Lucent logo facing up and the arrow pointing toward the 
slot. See Figure 3-5 for the proper way to insert the memory card into the slot on the processor 
module.

Figure 3-5. Inserting the Memory Card

INSERT

COPYRIGHT© 1993 AT&T

ALL RIGHTS RESERVED 

AT&T PROPRIETARY

THIS MEMORY CARD CONTAINS PROPRIETARY INFORMATION OF

AT&T THAT IS NOT TO BE DISCLOSED OR USED EXCEPT

IN ACCORDANCE WITH APPLICABLE AGREEMENTS.

PCMCIA
Interface Slot

Error/Status Code
Display

Memory
Card

PROCESSOR
MODULE

Alarm Status
LED

M
E

R
L

IN
 M

A
G

IX
™

F
o

rc
e

d
 I
n

s
ta

lla
ti
o

n
 

S
N

 0
0

D
R

 0
0

0
0

0
0

0
4

1
2

3
4

5
6

7
8

9
F

o
u

r 
(4

) 
M

e
g

a
b

y
te

s
…

P
R

O
P

E
R

T
Y

 O
F

 A
T

&
T

…



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-209Memory Card 

3

Memory Card Formatting 3

The memory card may have to be formatted before you begin any manual or automatic backup 
procedures. This section details the screens and messages that appear during the format 
procedure.

CAUTION:
Formatting overwrites previous data on the memory card. Make certain that there is no 
important information on the card before you begin formatting.

Unformatted Card 3

If you begin a backup procedure with an unformatted or incorrectly formatted card, the above 
screen appears.

The inserted memory card is not the correct type. You have the option of formatting the memory 
card as a translation memory card or repeating the backup procedure with a different memory 
card.

Memory Card Backup:

Inserted Memory Card is

not the correct type.

Do you want it formatted?

Yes

No

Back

■ Only 4 MB Series I or Series II PCMCIA memory cards may be formatted, except 
those already formatted as translation cards.

■ If a memory card cannot be formatted, a message appears on screen. These 
messages are noted in the procedures as appropriate.

■ A memory card may need to be formatted if it is intended for use as a translation 
card but is currently blank or contains data other than MERLIN MAGIX Integrated 
System backup files.
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Format Warning 3

This screen appears if you respond to the system prompt to format the memory card.

Select Yes (or click �) to begin the memory card format. Table 3-8 lists the screen messages 
that may appear while formatting is in progress.

If Exit (on the 4424LD+ telephone), Home (on the MLX-20L telephone) or Menu (on both 
telephones) is pressed during a format procedure, the format is terminated. The data on the 
memory card may be lost. See Chapter 1, ‘‘Programming Basics,” for details about these keys. 

Format Memory Card:

All data on card will be

DELETED.

Do you want to continue?

Yes

No

Back

Table 3-8. Memory Card Formatting Messages

Message What it Means

Formatting Memory Card The format is in progress.

Formatting of Memory Card 
Completed

The format was successful and has completed.

Memory Card cannot be 
formatted

The memory card cannot be formatted. Remove the card 
and repeat the procedure with another card.

Formatting of Memory Card 
FAILED

The format was unsuccessful. Remove the card and repeat 
the procedure with another card.

Missing Card or Card Not 
Inserted Correctly

Verify that the card is inserted correctly and repeat the 
procedure.
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Backup 3

Use this procedure to make a copy of your customized system data. You should create a backup 
at least three times during system installation (so that programmed information is not lost) and 
once after each system upgrade, service technician visit, or major system reconfiguration.

The Inspect feature (Inspct or%�) is available to view the attributes of the backup files on the 
memory card prior to initiating the backup procedure. The attributes included on the Inspect 
screen are the filename, the time and date of the file creation/update, the location of the system 
programming port, and information about the system software release from which the backup was 
made.

The list of backup files contains three manual backup filenames and two automatic backup 
filenames. The factory set names of the manual backup files are BACK1.*****, BACK2.*****, and 
BACK3.*****. When you select one of the backup filenames, the system automatically replaces the 
* in the filename with the current month and day (mmdd). For example, BACK1.0116 would appear 
if you selected BACK1.***** and performed the backup procedure on January 16. You can rename 
any of the three files during the backup procedure. The automatic backup filenames are 
AUTO.BACK1 and AUTO.BACK2. You cannot change the names of these files.

If you enter a filename that currently exists, the message File already exists appears. You 
must enter another filename.

While the backup is in progress, you cannot access system programming functions, your Personal 
Directory, or alarm clock functions (any programmed alarms are temporarily deactivated). You may 
terminate the backup procedure at any point prior to receiving confirmation of a successful 
backup.

If any type of programming is taking place at another extension when you begin the backup 
procedure, the backup is cancelled and the number of the first busy extension appears on the 
screen. Attempt the backup procedure again when the busy extension becomes idle.

If the system is turned off during a backup procedure, the backup is terminated. The system 
performs a System Reset (cold start), after which you may repeat the backup procedure.

If Exit (on the 4424LD+ telephone), Home (on the MLX-20L telephone) or Menu (on both 
telephones) is pressed during a backup procedure, the backup is terminated. This may result in 
the deletion of an old backup file. See Chapter 1, ‘‘Programming Basics,” for details about these 
keys. 

If the system performs a System Erase (frigid start), all programming is set to the factory-
set values. If a previous backup file is available, perform a restore. If not, the system must 
be reprogrammed. See ‘‘Restore’’ on page 3-216 for information about the system restore 
procedure. Also see ‘‘Backup Messages’’ on page 3-214 for information about errors that 
may occur during the backup procedure.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-212Memory Card 

3

Summary: Backup 3

Programmable by System Manager

Mode All

Idle Condition Not required (No extensions are allowed to be in programming mode 
except system programming console)

Planning Form 1, System Planning

Factory Setting Not applicable

Valid Entries 1- to 11-character filename

Inspect Yes

Copy Option No

Console Procedure Insert memory card→System→Back/Restore→Backup→
Select backup file→Dial the new backup filename→Enter→Yes→
Back→Back→Back 

PC Procedure Insert memory card→�→�→�→Select backup file→
Type the new backup filename→ �→�→�→�→� 

Automatic Backup 3

To preserve the most recent copy of your customized system data, you can program the system to 
automatically backup programming information onto the translation memory card. Automatic 
backups may be set for daily or weekly operation. If automatic backup is activated, the time may 
be set for daily backup (factory setting is 2:00 am) or the time and day may be set for weekly 
backup (factory setting is 2:00 am Sunday).

The system places the automatic backup into one of two designated files: AUTO.BACK1 and 
AUTO.BACK2. If both files are empty, the system places the backup in AUTO.BACK1. If both files 
already contain backups, the system selects the older of the two files and overwrites it. The 
system performs this file “toggle” each time it performs an automatic backup.

While the backup is in progress, you cannot access system programming functions, your Personal 
Directory, or alarm clock functions (any programmed alarms are temporarily deactivated).

If any type of programming is taking place at an extension during the automatic backup procedure, 
the backup is cancelled. The system does not re-attempt the backup.

If an automatic backup fails for any reason (including a system-busy condition), all of the 
programmed alarm buttons on system operator consoles light and the information is recorded in 
both the permanent error log and the last 10 error logs. The system does not re-attempt the 
backup. 
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Also see ‘‘Backup Messages’’ on page 3-214 for information about errors that may occur during 
the automatic backup procedure.

Summary: Automatic Backup 3

Programmable by System Manager

Mode All

Idle Condition Not required (No extensions are allowed to be in programming mode, 
including the system programming console)

Planning Form 1, System Planning

Factory Setting Weekly backup: Sunday at 2:00 am
(if daily backup is selected, time is factory set for 
2:00 am)

Valid Entries Daily: hhmm (00 to 23; 00 to 59)
Weekly: dhhmm (0 to 6; 00 to 23; 00 to 59)

Inspect No

Copy Option No

Console Procedure To program daily backup:
Insert memory card→System→Back/Restore→Auto Backup→
Daily→ →Dial time (00–23; 00–59)→Enter→Back→Back

To program weekly backup:
Insert memory card→System→Back/Restore→Auto Backup→
Weekly→ →Dial day and time (0–6; 00–23; 00–59)→Enter→
Back→Back 

PC Procedure To program daily backup:
Insert memory card→�→�→�→�→ →
Type time (00–23; 00–59)→�→�→� 

To program weekly backup:
Insert memory card→�→�→�→�→ →
Type day and time (0–6; 00–23; 00–59)→�→�→� 

If an automatic backup fails for any reason (except when the failure results because the 
memory card is write-protected), the automatic backup feature is turned off. Follow the 
procedure below to reprogram automatic backups.

*XUV

*XUV

*XUV

*XUV
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Backup Messages 3

During manual or automatic backup procedures, additional screens may appear to alert you to 
problems with the translation memory card, the backup file, or the backup procedure. This section 
contains displays of each screen and information about what to do if the screen appears.

Backup Cancelled 3

If the system detects an error, either on the Memory Card or with the backup file, or if you 
terminate the backup, this screen appears.

The backup file being created is deleted and the backup is terminated. You must repeat the 
backup procedure.

Card Removed While Backup Is in Progress 3

The Memory Card is not inserted or is inserted incorrectly while a backup is in progress. The 
backup file that was being created is deleted and the backup is terminated. You must reinsert the 
Memory Card and repeat the backup procedure.

The screens shown in this section are from the manual backup procedure; however, the 
screens that may appear in both the manual and automatic backup procedures are 
similar. The screens in both procedures differ only in the appearance of the first line. On 
the automatic backup screens, Auto Memory Card Backup replaces Memory Card 
Backup shown on the screens below.

Backup x: x = backup filename 
BACKUP IS CANCELLED.

File has been DELETED.

Back

Backup x:
BACKUP IS CANCELLED.

x = backup filename

Verify that Memory Card

has been inserted

correctly.

File has been DELETED.

Back
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Card Missing or Card Not Inserted Correctly 3

The Memory Card is either not inserted or is inserted incorrectly. The backup is terminated. You 
must reinsert the Memory Card and repeat the backup procedure. This screen may also appear if 
the wrong type of Memory Card is inserted and a backup or automatic backup is requested within 
one minute of insertion. Verify that the card is a translation Memory Card.

Card Is Write-Protected 3

The Memory Card is write-protected. You must remove the Memory Card, flip the write-protect tab, 
reinsert the Memory Card, and repeat the backup procedure.

CAUTION:
The Memory Card may be write-protected to avoid the accidental erasure of the backup files. 
Make certain this is not the case before you change the Write-Protect Tab.

Memory Card Backup:

Verify that Memory Card

has been inserted

correctly.

Back

Memory Card Backup:

Memory Card is Write-

Protected.

Reset Write-Protect Tab

on Memory Card.

Back
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Card Failure 3

If the card is damaged, repeat the backup with a different card. If a backup is in progress and fails, 
the system makes two additional attempts at the backup. At the start of each attempt, a message 
appears with the percentage of the backup that is completed. If the backup fails after three 
attempts, the screen shown below appears. Repeat the backup procedure using a different file 
and/or Memory Card.

Restore 3

Use this procedure to restore system conditions that were backed up onto a translation memory 
card. The information in a backup file on the translation card is copied to the system.

The restore procedure is necessary under the following conditions:

■ System RAM is corrupt.

■ A previously stored set of system conditions is preferred over the current set.

■ Processor module is replaced.

■ After a System Erase (frigid start) has been performed.

■ System software has been reinstalled.

The Inspect feature (Inspct or%�) is available to view the attributes of the backup files on the 
memory card prior to initiating the restore procedure. The attributes included on the Inspect screen 
are the filename, the time and day of the file creation/update, the location of the system 
programming port, and information about the system software release from which the backup was 
made.

If any type of programming is taking place at another extension when you begin the restore 
procedure, the restore is cancelled and the number of the first busy extension appears on the 
screen. Repeat the restore procedure when the busy extension becomes idle.

If a line is busy (incoming call or active call) when you begin the restore procedure, the restore is 
cancelled and the number of the first active line appears on the screen. Repeat the restore 
procedure when the line becomes idle.

Also see ‘‘Restore Messages’’ on page 3-217 for information about errors that may occur during 
the restore procedure.

Memory Card Backup:

Backup Failure

Try a different file or

a new Memory Card.

Back



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Programming Procedures 
3-217Memory Card 

3

Summary: Restore 3

Programmable by System Manager

Mode All

Idle Condition System Forced Idle

Planning Form Not applicable

Factory Setting Not applicable

Valid Entries Not applicable

Inspect Yes

Copy Option No

Console Procedure Insert memory card→System→Back/Restore→Restore→
Select restore file→Yes

PC Procedure Insert memory card→�→�→�→Select restore file→
� 

Restore Messages 3

During the restore procedure, additional screens may appear to alert you to problems with the 
translation Memory Card, the backup file or the restore procedure. This section contains displays 
of each screen and information about what to do if the screen appears.

Card Missing or Card Not Inserted Correctly 3

The Memory Card is either not inserted or inserted incorrectly. The restore is aborted. You must 
reinsert the card and repeat the restore procedure. This screen may also appear if the wrong type 
of Memory Card is inserted and a restore is requested within one minute of insertion. Verify that 
the card is a translation Memory Card.

Memory Card Restore:

Verify that Memory Card

has been inserted

correctly.

Back
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Card Removed after Confirmation 3

The Memory Card was removed from the PCMCIA interface slot while the restore was in progress. 
The restore is aborted and the system performs a System Erase (frigid start). You must reinsert 
the Memory Card and repeat the restore procedure.

Wrong System Programming Port 3

The system programming port is not set to the same system programming port as that set in the 
backup file. The restore is aborted. Use the Inspect feature to view the port of the file on the card. 
Change the system programming port to match the port shown on the card (see ‘‘System 
Programming Position Assignment’’ on page 3-3) and repeat the restore procedure. 

Release Mismatch 3

This screen only appears if the releases are not compatible.

Memory Card Restore:

RESTORE IS CANCELLED.

System is DOWN.

Restore n: n = filename selected 
Change Sys Programming xxxx = system programming port 
Port to Extension xxxx extension
before Restoring.

Back

Restore n: n = filename selected
File is Not Compatible X.Y = release number
for Release X.Y

Restore Cancelled.

Conversion Required.

Back
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Card Failure Before Confirmation 3

If the restore fails because the card is damaged, repeat the restore procedure using a different file 
and/or Memory Card.

Card Failure after Confirmation 3

If the restore fails because the card is damaged, the system performs a System Erase (frigid start). 
Repeat the restore procedure using a different file and/or Memory Card.

Wrong Type of Card 3

The inserted card does not match the card option selected from the System menu. Remove the 
card and repeat the restore procedure with the correct type of card. See ‘‘Card Types’’ on page 
3-206 for information about the card labels.

 

Memory Card Restore:

Restore Failure.

Try a different file

or a new Memory Card.

Back

Restore n: n = filename selected
Restore Failure

RESTORE IS CANCELLED.

System is DOWN.

Memory Card Restore:

Inserted Memory Card is

not the correct type.

Remove and insert MERLIN

MAGIX Backup/Restore

Card.

Back
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4Centralized Telephone Programming 4

Overview 4

This chapter describes centralized telephone programming for the System Manager and includes 
the following information:

■ Accessing centralized telephone programming

■ Programming the features available with this function

■ Programming a single telephone

■ Copying programmed features from one extension to another extension

See the Feature Reference, or the appropriate user or operator guide, for details about each 
feature.

Introduction 4

Centralized telephone programming allows the System Manager to program any feature that can 
be programmed by individual telephone users, or by the system operator, onto another telephone 
in the system. Any feature that can be programmed at an individual telephone can be programmed 
using centralized telephone programming. 

The following features can be programmed only by using centralized programming: 

■ Barge-In

■ Headset Hang Up

■ Intercom buttons: all types (Key and Behind Switch mode only)

■ Service Observing button

■ System Access buttons: all types (Hybrid/PBX mode only)

Only the System Manager should perform the programming procedures described in this 
chapter.
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4

To perform centralized telephone programming, you can use the system programming console 
(see Chapter 1, ‘‘Programming Basics”) or a PC with SPM software (see Chapter 2, ‘‘Programming 
with WinSPM”).

If you are programming several telephones of the same type (that is, all 4400-Series or all MLX), 
program one extension and then use the programmed extension as a template for programming 
additional extensions. See ‘‘Copy Extension’’ on page 4-12, and also refer to the planning forms.

Some programming can be performed only when the entire system or some part of it (such as a 
trunk or an extension) is idle. See ‘‘Idle States’’ on page 1-22.

Access to Centralized Telephone 
Programming 4

Access the Centralized Programming menu from the System Programming menu. Centralized 
programming is performed by selecting features from the display or by using programming codes.

Follow the procedure below to access the Centralized Programming menu.

Console Display/Instructions Additional Information PC

1. Go to the second screen of the System Programming menu.

2. Select Centralized Programming.

Service Observing may be subject to federal, state, or local laws, rules, or 
regulations, or require the consent of one or both of the call parties. You must check 
in your jurisdiction and comply with all applicable laws, rules, and regulations before 
using this feature. Failure to comply may result in severe penalties.

System Programming:     >

Make a Selection

System Extensions

SysRenumber Options

Operator Tables

LinesTrunks AuxEquip

Back NightSrvce Press More. � 

System Programming 

Make a selection

Labeling

Data

Print

Cntr-Prg

Back � 
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Console Display/Instructions Additional Information PC

3. Select a programming option.

4. Go to the “Program Extension” or “Copy Extension” section, as appropriate.

The sections that follow explain the use of menu selections for programming a single extension 
(Program Extension), and for using one extension as a template for programming several 
extensions of the same type (Copy Extension).

Program Extension 4

Review the items below before you begin to program extensions.

■ Use Table 4-1 on page 4-6 to locate the code for the feature that you want to program.

■ If you enter a feature code incorrectly or enter a feature code that is not appropriate for the 
button, a beep sounds or the message Programming Error appears and the green LED 
next to the button flashes. If this happens, press the button again and repeat the procedure.

■ If you make a mistake and program the wrong feature on a button, follow the steps below:

1. Press the button.

2. Select Delete (press 2 on the PC).

3. Press the button again.

■ If you press a line button that is not active, the screen shown here appears. Press  
(4424LD+ telephone) or  (MLX-20L telephone) to return to the Home screen.

Centralized Programming:

Make a selection

Program Ext

Copy Ext

Select Program Ext � 
Back Enter or Copy Ext. � 

It is recommended that you use the programming codes for centralized programming; 
however, you may also use the List Features option that is available on the programming 
screen. See ‘‘Using the List Feature Menu’’ on page 4-11 for details about this option.

Blank

Press HOME to Exit

     Page 1

     Page 2

Sys Program ListFeature

+^OZ

HOME
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■ You can use the Extension Information (Ext Info) report option on the Print menu to print all 
of the programmed features for a specific extension.

At the Centralized Programming menu, follow the procedure below to program features onto a 
single telephone.

Console Display/Instructions Additional Information PC

1. Select Program Extension. 

2. Specify the extension you want to program.

3. Save your entry.

Select Enter. � 

4. Select Start. 

Centralized Programming:

Make a selection

Program Ext

Copy Ext

Back Enter � 

Centralized Programming:

Enter extension

Backspace

Back Enter SP: “Entering an Extension” Ã 

Extension Program    xxxx xxxx = extension entered in Step 2
Press HOME to Exit

Sys Program       Start � 
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Console Display/Instructions Additional Information PC

5. Select the line button to which you want to assign the feature.

If you are programming a telephone with more than 20 line buttons, use Page 2 to select line 
button 21 and above. See Appendix E for button diagrams of all telephones.

6. Program the feature or features.

(See ‘‘Using the List Feature Menu’’ on page 4-11.)

When the line button is programmed, the system 
automatically returns to the screen in Step 5.

7. Repeat Steps 5 and 6 for each line button you want to program for the extension, or press  
(4424LD+ telephone) or  (MLX-20L telephone) to return to the Centralized Programming 
menu. 

Select Button: xxxx = extension entered in Step 2
Extension Program    xxxx

     Page 1

     Page 2 Press the line button or click the function 
key that corresponds to your selection

Ã
 

Sys Program or select Page 2 to access line button 21 	 
and above.

Line xxx * xxx = line selected in Step 5
Press HOME to Exit * = current feature programmed

Page 1

Page 2 Use Table 4-1 to dial or type the

programming code: *[nnn] Ã 

Sys Program ListFeature or select ListFeature. � 

+^OZ

HOME
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Programming Codes 4

Table 4-1 provides a quick reference to the programming codes for the system features using the 
List Feature menu.

Table 4-1. Features and Programming Codes

Feature Programming Code

Account Code Entry *82 

Alarm1 *759 

Authorization Code *80 

Auto Dial 

Multiline 4400-Series, MLX, ETR, and MLS 
telephones

Inside (ext., group, zone)
Outside

4400, 4400D, single-line telephones (see 
Personal Speed Dial)

*22 + ext. no.
*21 + tel. no.

Automatic Line Selection

Begin Sequence
End Sequence

*14
**14 

Barge-ln1,2 *58 

Call Waiting

On
Off

*11 
**11 

Callback

Automatic
On
Off

Selective

*12
**12
*55 

Caller ID Number/Name Toggle Button3 *763 

Camp-On *57 

Conference *772 
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Coverage

Receiver buttons
Group
Primary
Secondary

Sender buttons

Cover inside and outside calls
Cover outside calls only
Coverage Off

Coverage VMS Off

*42 + ext. no.
*40 + ext. no.
*41 + ext. no.

*48
**48
*49 

*46 

Data Status *83 + ext. no.

Direct Voice Mail *56 

Directories 

Extension Directory 
Personal Directory 
System Directory 

(display only)
(display only)
(sys. prog.)

Do Not Disturb4 *47 

Drop

MLX, ETR, and MLS telephones
ETR Drop button

Multiline 4400-Series telephones
4400-Series Drop button

*773 
*777 
*771 
*787 

Extension Status

Direct-Line Console1

Status Off
Status 1
Status 2

Telephones (rooms or agents)
Status 1 
Status 2 

*760
*761
*762 

*45
*44 

Feature Button *20 

Forward

Activate 
Forward (inside) 
Remote Call Forward (outside)
Centrex Transfer via Remote Call 
Forward

*33
*33 
*33 + dial-out code or
* + optional pauses + tel. no. + #

Table 4-1. Features and Programming Codes — Continued

Feature Programming Code
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Group Calling

ln-Queue Alarm button
Calling Group supervisor1

Member available
Member unavailable

Calling Group members
Sign in (Available) 

*22 + Calling Group ext. no.

*762
*760 

*44 

Group Page Auto Dial Button *22 + Paging Group ext. no.

Headset Options

Auto Answer 
Hang Up2

Mute (Headset/Handset) 
Status 

*780
*781
*783
*782 

Inspect Button (Multiline 4400-Series 
telephones only)

*778 

Intercom buttons

Assign buttons2

ICOM (Default Ring) 
ICOM Originate Only 

Change button type
Ring
Voice 

*16
*18 

**19
*19 

Messaging

Leave Message
Message LED Off (for non-display 
telephones)
Message operation mode (for 
4406D+,ETR, and MLS display 
telephones)5

Posted Message
Send/Remove Msg1

Receiving Messages
Delete Message6 
Delete Message (for 4400/4400D, 
single-line telephones)

Next Message6

Return Call6

Scroll6

*25 
*54 

*54 

*751 
*38 

*26 
*25 within 15 seconds of entering ext. no.

*28 
*27
*29 

Night Service1 *39 

Notify

Send
Receive

*757 + ext. no. 
*758 + ext. no. 

Table 4-1. Features and Programming Codes — Continued

Feature Programming Code
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Park *86 

Park Zone Auto Dial1 *22 + Park Zone

Personal Speed Dial # + (01–24) +*21 + tel no. +## 

Personalized Ringing *32 + ring (1–8)

Pickup

General use
Specific extension
Specific line
Group

*9 
*9 + ext. no.
*9 + line no.
*88 

Privacy On *31 

Recall *775 

Redial (4400, ETR, and MLS telephones 
only)7

*84 

Reminder Service

Set8

Cancel
Missed1

*81 
**81 
*752 

Ringing/Idle Line Preference

On
Off

*343 
*344 

Ringing Options

Individual lines
Immediate ring
Delay ring
No ring

All lines
Immediate ring
Delay ring
No ring

Abbreviated ring
On
Off

Send Ring (Shared SA)
On
Off

*37
*36
*35 

*347
*346
*345 

*341
*342 

*15 
**15 

Saved Number Dial *85 

Send/Remove Message1 *38 

Service Observing2 *59 + ext. no.

Signal (manual) *23 + ext. no.

Table 4-1. Features and Programming Codes — Continued

Feature Programming Code
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System Access buttons

Assign buttons2

SA (Default Ring) 
SA Originate Only
Shared SA

Change type (SA or Shared SA)
Ring 
Voice 

*16
*18
*17 + primary ext. no.

**19
*19 

System Speed Dial *24 + code (600–729)

Transfer *774 

Voice Announce

On 
Off 
VA on Idle Only (MLX telephones only)

*10
**10 
*130 

1 System operator feature only.

2 Centralized telephone programming only.

3 You cannot program a button on a 4400D telephone, but you can use the feature by dialing #763.

4 Does not work for 4400/4400D telephones.

5 For the 4406D+, MLS, and ETR display telephone user, pressing *54 enters/exits Message operation mode. MLS 
telephones return to normal call handling after 15 seconds if the user has no messages. If MLS telephone users have 
messages, they must delete them or use the feature code or programmed button to exit Message operation mode. 
4400-Series and ETR telephone users must use the feature code or programmed button to exit Message operation 
mode whether or not they have messages.

6 Display telephones only. Programming codes are used for ETR and MLS telephones. Feature codes are used for 
4400, 4400D, ETR, and MLS telephones.

7 The 4400-Series telephones (excluding the 4400 telephone) have a fixed Redial button.

8 U.S. English only: time is 12-hour (0100-1259) + 2 (A) or 7 (P); Canadian French and Latin American Spanish: time 
is 24-hour (000-2359).

Table 4-1. Features and Programming Codes — Continued

Feature Programming Code
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Using the List Feature Menu 4

You can use the List Feature menu to select a feature, instead of using a programming code. 
When you select ListFeature (or press 0), the first screen of features appears as shown below.

There are additional feature option screens. Press  (4424LD+ telephone) or More (MLX-20L 
telephone) to move through the screens. Press the button or click the function key that 
corresponds to your selection. You can also use the FindFeature option to display alphabetized 
lists of features that begin with the letter or letters you select.

The Find Feature screen is shown below.

Press the button or click the function key that corresponds to the first letter of the feature you want. 
The resulting screen displays all of the features that begin with the selected letters. If the list of 
features for the letters you select does not fill a complete screen, the screen display continues with 
the next alphabetic feature. Press Exit (4424LD+ telephone) or Home (MLX-20L telephone) to 
return to the Home screen.

Select a Feature:      >

Extension Program   xxxx xxxx = previously entered extension
Find Feature Barge In

AccountCode Call Waiting

Auth Code Camp On

Auto Dial Cback Auto

AutoLineSel Cback Sel

Choose Starting Letter  

Press HOME to Exit

ABC PQRS

DEF TUV

GHI WXYZ

JKL

MNO
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Copy Extension 4

The System Manager uses the copy extension feature to copy an extension’s programmed 
buttons (with some exceptions) to one or more extensions. The features are individually 
programmed on an extension, creating a template that can then be copied to other extensions in 
the system.

Only extensions of the same type can be copied to one another (that is, 4400-Series to
4400-Series, and MLX to MLX) since the two extension types have different button layouts. For a 
system that has both 4400-Series and MLX telephone types, you will need two templates: one for 
4400-Series and one for MLX.

An MFM can be copied to or from another MFM. A DLC can be copied only to another DLC. 
Single-line telephones and QCCs cannot be copied to or from.

Features That Can Be Copied 4

Table 4-2 lists the features that can be copied to another extension. Features that can be copied 
for DLC operator extensions are listed in Table 4-3 on page 4-15.

Table 4-2. Features That Can Be Copied: All Telephones

Feature

Multiline 
4400-Series 
Telephones

MLX 
Telephones 

MLS 
Telephones 

ETR 
Telephones 

Account Code Entry ✔ ✔ ✔ ✔ 

Authorization Code ✔ ✔ ✔ ✔ 

Auto Answer All ✔  

Auto Answer Intercom ✔ 

Auto Dial Inside ✔ ✔ ✔ ✔ 

Auto Dial Outside1
✔ ✔ ✔ ✔ 

Barge-In ✔ ✔ ✔ ✔ 

Callback-Selective ✔ ✔ ✔ ✔ 

Camp-On ✔ ✔ ✔ ✔ 

Conference2
✔ ✔ ✔ ✔ 

Coverage: Group ✔ ✔ ✔ ✔ 

Coverage: Primary ✔ ✔ ✔ ✔ 

Coverage Off ✔ ✔ ✔ ✔ 

Coverage VMS Off ✔ ✔ ✔ ✔ 

Data Status ✔ ✔ ✔ ✔ 
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Delete Message ✔ ✔ ✔ 

Direct Voice Mail ✔ ✔ ✔ ✔ 

Do Not Disturb ✔ ✔ ✔ ✔ 

Drop ✔ ✔ ✔ ✔ 

ETR Drop ✔ ✔ 

Extension Status 2 (ES2) 
(Non-operator)

✔ ✔ ✔ ✔ 

Extension Status 1 (ES1) 
(Non-operator)

✔ ✔ ✔ ✔ 

Feature Button ✔  

Forward ✔ 4 ✔ ✔ 

Group Calling ✔ ✔ ✔ ✔ 

Group Page ✔ ✔ ✔ ✔ 

Headset Auto Answer  ✔  

Headset Hang Up  ✔  

Headset Status ✔  

Headset/Handset Mute  ✔  

Redial1 ✔ ✔ ✔ ✔ 

Leave Message ✔ ✔ ✔ ✔ 

Message Light Off ✔ ✔ ✔ ✔ 

Next Message ✔ ✔ ✔ 

Notify  ✔ ✔ 

Park ✔ ✔ ✔ ✔ 

Personal Speed Dial ✔ ✔ 

Pickup: Group ✔ ✔ ✔ ✔ 

Pickup: General ✔ ✔ ✔ ✔ 

Pickup: Extension ✔ ✔ ✔ ✔ 

Pickup: Line ✔ ✔ ✔ ✔ 

Posted Message ✔ ✔ ✔ ✔ 

Privacy ✔ ✔ ✔ ✔ 

Recall ✔ ✔ ✔ ✔ 

Table 4-2. Features That Can Be Copied: All Telephones — Continued

Feature

Multiline 
4400-Series 
Telephones

MLX 
Telephones 

MLS 
Telephones 

ETR 
Telephones 
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Reminder Service: Set ✔ ✔ ✔ ✔ 

Reminder Service: Cancel ✔ ✔ ✔ ✔ 

Return Call ✔ ✔ ✔ 

SA Shared3
✔ ✔ ✔ ✔ 

SA/ICOM Ring3
✔ ✔ ✔ ✔ 

SA/ICOM Voice3
✔ ✔ ✔ ✔ 

SA/ICOM Originate Only3
✔ ✔ ✔ ✔ 

Saved Number Dial1 ✔ ✔ ✔ ✔ 

Scroll ✔ ✔ ✔ 

More ✔ 

Secondary Coverage ✔ ✔ 

Signaling ✔ 4 4 4 

System Speed Dial ✔ 4 4 4 

Transfer2 ✔ 4 4 4 

Account Code Entry ✔ 4 4 4 
1 Number is not copied.

2 Behind Switch mode only.

3 Ringing options (No Ring, Delay Ring, and Immediate Ring) are copied with the button.

Table 4-2. Features That Can Be Copied: All Telephones — Continued

Feature

Multiline 
4400-Series 
Telephones

MLX 
Telephones 

MLS 
Telephones 

ETR 
Telephones 
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Table 4-3 shows the operator features than can be copied for operator consoles. QCC features 
cannot be copied.

Use the procedure below to copy programming from one extension to another.

Console Display/Instructions Additional Information PC

1. Select Copy Extension.

2. Specify the number of the extension from which you want to copy programming features.

3. Save your entry.

Select Enter. � 

Table 4-3. Features That Can Be Copied: Direct-Line Consoles Only

Feature
4400-Series Direct Line 
Console (DLC)

MLX Direct Line Console 
(DLC)

Alarm ✔ ✔ 

Extension Status Off ✔ ✔ 

Extension Status 1 ✔ ✔ 

Extension Status 2 ✔ ✔ 

Missed Reminder ✔ ✔ 

Night Service ✔ ✔ 

Operator Park ✔ ✔ 

Send/Remove Message ✔ ✔ 

Centralized Programming:

Make a selection

Program Ext

Copy Ext

Back Enter � 

Extension Program Copy:

Enter extension to copy

from

Backspace

Back Enter SP: “Entering an Extension” Ã 
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Console Display/Instructions Additional Information PC

4. Specify the number of the extension to which you want to copy programming features.

5. Continue to copy line assignments from the copy extension shown to another extension or go 
to Step 7.

Select Enter � 

or Next. � 

Use Enter to continue to copy line
assignments from the extension 
currently displayed on Line 1 to
additional extensions. 

Use Next if the extension numbers �
to be copied to are sequential. Select
Enter after completing programming.

Go to Step 4 to continue programming. 
The extension to be copied from will be 
displayed on Line 1. 

6. Return to Centralized Programming menu.

Select Back. � 

Copy extension xxxx to: xxxx = extension entered in Step 2
Enter extension

Backspace

Back Enter SP: “Entering an Extension” Ã 
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Feature Quick Reference 4

The following feature descriptions provide a quick reference for using centralized telephone 
programming.

Account Code Entry 4

Assign a button for account code entry.

Summary: Account Code Entry 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All (except 4400, 4400D, and single-line telephones in Behind Switch 
mode)

Programmable by Users and System Manager

Programming Code *82 

Display Label AccountCode 

Alarm 4

Assign a button to alert the operator to system problems.

Summary: Alarm 4

Telephones DLC operator only

Mode All

Programmable by DLC operator and System Manager

Programming Code *759 

Display Label Alarm 
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Authorization Code 4

Assign a button for authorization code entry.

Summary: Authorization Code 4

Telephones All (except QCC)

Mode All (except 4400, 4400D, and single-line telephones in Behind Switch 
mode)

Programmable by Users and System Manager

Programming Code *80 

Display Label Auth Code 

Auto Dial 4

Assign buttons for one-touch dialing of frequently called inside or outside numbers.

Summary: Auto Dial Inside and Outside 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code Inside: *22 + ext. no. + Enter
Outside: *21 + telephone no. + Enter 

Display Label Auto Dial Inside/Outside 

Automatic Line Selection 4

Select the order in which the system makes outside lines available to the user.

Your current Automatic Line Selection table is deleted immediately after you select this 
feature by either selecting AutoLineSel from the display or pressing *14. There is no 
way to cancel the operation. You must program new selections and then press **14 to 
end the operation.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

 
4-19Feature Quick Reference 

4

Summary: Automatic Line Selection 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code Enter: *14
Exit: **14 

Display Label AutoLineSel 

Barge-In 4

Assign a button to allow an operator to interrupt a user’s call in an emergency.

Summary: Barge-In 4

Telephones All except 4400, 4400D, and single-line telephones or QCC

Mode All

Programmable by System Manager only

Programming Code *58 

Display Label Barge In 

Callback 4

With Automatic Callback turned on, the system retries calls to busy extensions or busy trunk pools. 
Assign a Selective Callback button to allow the system to retry calls to busy extensions or busy 
trunk pools on a call-by-call basis.

Summary: Automatic Callback 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code On: *12
Off: **12 

Display Label Cback Auto On/Off 

To use the Callback feature on loop-start lines/trunks, the loop-start 
line/trunk must be programmed for reliable disconnect. See ‘‘Disconnect Signaling 
Reliability’’ on page 3-27.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

 
4-20Feature Quick Reference 

4

Summary: Selective Callback 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code *55 

Display Label Cback Sel 

Caller Number and Name on Caller ID 4

This feature allows the display of caller number or caller name when Caller ID is subscribed to 
through your local telephone company. Once programmed, the user can toggle between the 
display of number or name. 

Summary: Caller Number and Name 4

Telephones 4400-Series, MLX, MLS, and ETR display telephones (Only Caller 
Number is displayed on the QCC; Caller Name is not displayed)

Mode All

Programmable by Users and System Manager

Programming Code *763 

Display Label Calling Party Name or Calling Party Number 

Call Waiting 4

With Call Waiting turned on, a user on a call will know that another call is waiting. The person at 
the extension hears one beep for a waiting inside call, two for an outside call.

The calling party name can be up to 15 characters on 4400-Series, MLX, ETR, and MLS 
display telephones.
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Summary: Call Waiting 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code On: *11
Off: **11 

Display Label CallWaiting On/Off 

Camp-On 4

Assign a button to allow a user to complete a transfer to a busy extension.

Summary: Camp-On 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *57 

Display Label Camp On 

Conference 4

Assign a button to access the host system conference feature.

Summary: Conference 4

Telephones Multiline 400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode Behind Switch

Programmable by Users and System Manager

Programming Code *772 

Display Label Conference 
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Coverage 4

Assign a button to establish Coverage; senders’ calls are covered by receivers.

Summary: Receiver Buttons–Primary, Secondary, Group 4

This procedure assigns primary, secondary, or group coverage receivers.

Telephones All (except QCC)

Mode All

Programmable by Users and System Manager

Programming Code Primary: *40 + ext. no. + Enter
Secondary: *41 + ext. no. + Enter
Group: *42 + group no. + Enter 

Display Label Coverage Primary/Secondary/Group 

Summary: Coverage Inside Off/On 4

This procedure allows or prevents Coverage of inside calls.

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code In/Outside Calls: *48
Outside Calls Only: **48 

Display Label CoverInside, On/Off 

Summary: Sender Buttons, Coverage Off 4

This procedure turns off all Coverage.

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *49 

Display Label Coverage Off 
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Summary: Coverage VMS Off 4

This procedure prevents outside calls from being sent to voice mail.

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming code *46 

Display Label Coverage VMS Off 

Data Status 4

Assign a button to indicate when a data call is in progress.

Summary: Data Status 4

Telephones All (except QCC)

Mode All

Programmable by Users and System Manager

Programming Code *83 + ext. no. + Enter 

Display Label Data Status 

Direct Voice Mail 4

This feature allows one user to call another user’s voice mail, without ringing that user’s telephone.

Summary: Direct Voice Mail 4

Telephones All 

Mode All

Programmable by Users and System Manager

Programming Code *56 

Display Label Direct VoiceMail 
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Do Not Disturb 4

Assign a button to prevent calls from ringing at the telephone.

Summary: Do Not Disturb 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *47 

Display Label DoNotDisturb 

Drop 4

Drop is a function that allows a conference participant to eliminate a party from a conference.

Summary: Drop 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, and 
ETR telephones. 

In Hybrid/PBX and Key modes, MLX telephones have a fixed Drop 
button, while multiline 4400-Series, MLS, and ETR telephones do not. 
On the multiline 4400-Series, MLS, and ETR telephones, an ETR 
Drop button can be programmed with program code *777.

In Behind Switch mode for multiline 4400-Series, MLX, MLS, and 
ETR telephones, rather than using a fixed drop button, use program 
code *773 to program a drop button on the telephone. 

Mode All

Programmable by Users and System Manager

Programming Code *773 (for multiline 4400-Series, MLX, MLS, and ETR telephones in 
Behind Switch mode)

*777 (to program a Drop button for MLS and ETR telephones)

*787 (to program a Drop button for 4400-Series telephones)

Display Label Drop 
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Extension Status 4

Assign a button to allow system operators or supervisors to monitor the status of extensions and 
restrict use of telephones (hotel configuration) or change group members’ availability to take calls 
(Group Calling/CMS configuration).

Summary: DLC Extension Status 4

Telephones DLCs

Mode All

Programmable by System Manager only

Programming Code Off: *760
ES1: *761
ES2: *762 

Display Label OperatorES, ESOff/ES1/ES2

Summary: Telephone Extension Status 1 and 2 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code ES1: *45
ES2: *44 

Display Label ES Status, ES1/ES2 

Feature Button 4

Assign a button to press in conjunction with features that require dial codes.

Summary: Forward 4

Telephones Multiline 4400-Series telephones

Mode All

Programmable by Users and System Manager

Programming Code *20 

Display Label FeatureBtn 
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Forward 4

Assign a button to activate the forwarding of a user’s calls to another extension or to an outside 
number.

Summary: Forward 4

Telephones Multiline 4400-Series (except QCC), MLX (except QCC), MLS, ETR, 
and single-line telephones

Mode All

Programmable by Users and System Manager

Programming Code *33 

Display Label Forward 

Group Calling 4

Assign buttons to allow the Calling Group supervisor or group members to monitor the number of 
calls in the queue.

Summary: Calls-In-Queue Alarm Button 4

Telephones Multiline 4400-Series, MLX, ETR, and MLS telephones

Mode All

Programmable by Users and System Manager

Programming Code *22 + Calling Group ext. no. + Enter 

Display Label Group Call 
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Calling Group Supervisor 4

Assign buttons to allow the Calling Group supervisor to monitor the number of calls in the queue or 
to change Calling Group members’ availability to take calls.

Summary: Calling Group Supervisor 4

Telephones 4412D+, 4424D+, 4424LD+, MLX-28D, and MLX-20L

Mode All

Programmable by Users and System Manager

Programming Code ES2, Available: *762
ES Off, Unavailable: *760 

Display Label OperatorES, ES2/ES Off 

Summary: Calling Group Members 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code Sign-in, Available: *44
After-Call Work State, CMS only: *45 

Display Label ES Status, ES2/ES1 

Group Page Auto Dial Button 4

Assign a button to allow the user to broadcast an announcement to individuals or groups using a 
speakerphone or loudspeaker.

Summary: Group Page Auto Dial button 4

Telephones Multiline 4400-Series and MLX telephones

Mode All

Programmable by Users and System Manager

Programming Code *22 + Paging Group ext. no. + Enter 

Display Label Group Page 
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Headset 4

Program headset buttons on most 4400-Series telephones and all MLX telephones.

Summary: Headset Auto Answer 4

Assign a button to automatically answer a ringing call.

Telephones Multiline 4400-Series, and all MLX telephones 

Mode All

Programmable by Users and System Manager

Programming Code *780 

Display Label Hdset Auto Answer 

Summary: Headset Hang Up 4

Assign a button to disconnect a call.

Telephones Multiline 4400-Series, and all MLX telephones

Mode All

Programmable by System Manager only

Programming Code *781 

Display Label Hdset Hang Up 

Summary: Headset Mute 4

Assign a button to turn microphone operation on or off for both headset and handset.

Telephones Multiline 4400-Series, and all MLX telephones

Mode All

Programmable by Users and System Manager

Programming Code *783 

Display Label Hdset Mute 
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Summary: Headset Status 4

Assign a button to activate headset operation.

Telephones Multiline 4400-Series, and all MLX telephones

Mode All

Programmable by Users and System Manager

Programming Code *782 

Display Label Hdset Status 

Redial 4

Assign a button to redial the last number dialed.

Summary: Redial 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code *84 

Display Label LastNumDial 

Messaging 4

Assign a button to allow users to send, receive, and post messages.

Summary: Leave Message After Calling 4

Telephones 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *25 

Display Label Leave Msg 
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Summary: Leave Message–Message LED Off 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *54 

Display Label none

Summary: Posted Message 4

Telephones 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *751 

Display Label Posted Msg 

Summary: Send/Remove Message 4

Telephones DLC operator only

Mode All

Programmable by Users and System Manager

Programming Code *38 

Display Label Send/RmvMsg 

Summary: Receiving Messages–Delete 4

Telephones 4406D+, MLS, and ETR telephones 

Mode All

Programmable by Users and System Manager

Programming Code *26 

Display Label Messages Delete Msg 

Summary: Receiving Messages–Next 4

Telephones 4406D+, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *28 

Display Label Messages Next Msg 
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Summary: Receiving Messages–Return Call 4

Telephones 4406D+, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *27 

Display Label Return Call 

Night Service 4

Assign a button to activate telephone operation after normal business hours.

Summary: Night Service 4

Telephones DLC operator only (4424D+, 4424LD+, MLX-28D, or MLX-20L 
telephones)

Mode All

Programmable by Operators and System Manager

Programming Code *39 

Display Label Night Srvc 

Notify 4

Assign buttons to allow users to send a visual signal to another extension without making a call to 
that extension.

Summary: Notify–Send and Receive 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code Send: *757 + ext. no. + Enter
Receive: *758 + ext. no. + Enter 

Display Label Notify Send/Receive 
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Park 4

Assign a button to hold a call and allow the call to be picked up at any telephone in the system.

Summary: Park 4

Telephones All (except single-line telephones in Behind Switch mode)

Mode All

Programmable by Users and System Manager

Programming Code *86 

Display Label Park 

Park Zone Auto Dial 4

Assign a button to allow DLC operators to hold a call at a specified extension or Park Zone.

Summary: Park Zone Auto Dial 4

Telephones  DLC operator only

Mode  All

Programmable by  Users and System Manager

Programming Code  *22 + Park Zone + Enter 

Display Label  Park Zone 

Personal Speed Dial 4

Program codes that allow users to dial outside numbers by dialing a 2-digit code.

Summary: Personal Speed Dial 4

Telephones  Multiline telephones with 10 or fewer buttons, 4400, 4400D+, and 
single-line telephones 

Mode  All

Programmable by  Users and System Manager

Programming Code  # + 2-digit code (01–24) + *21 + tel. no. + # + Enter 

Display Label PerSpeedD1 
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Pickup 4

Assign buttons to allow users to answer calls that are ringing, parked, or on hold anywhere in the 
system.

Summary: Pickup–General Use,
Specific Extension, Specific Line 4

Telephones  All

Mode  All

Programmable by  Users and System Manager

Programming Code General: *9
Specific line or ext.: *9 + line no./ext. no. + Enter 
Group: *88 

Display Label  General Use, Specific Extension, Specific Line:
Pickup General/Extension/Line 

Group: Pickup Group 

Privacy 4

Assign a button to prevent other users from connecting to a call on this telephone.

Summary: Privacy 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code *31 

Display Label Privacy 
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Recall 4

Assign a button to send a switchhook flash.

Summary: Recall 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *775 

Display Label Recall 

Reminder Service 4

Assign buttons to allow the system to make calls automatically at preset times and cancel 
reminder service calls and operator reminder calls that were not answered.

Summary: Set, Cancel, or Missed Reminder Service 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code Set: *81
Cancel: **81
Missed: *752 

Display Label Reminder Set/Cancel/Missed 
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Ringing/Idle Line Preference 4

Turn on Ringing/Idle Line Preference.

Summary: Ringing and Idle Line Preference 4

Telephones 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code On: *343
Off: *344 

Display Label Line Prefer, On/Off 

Ringing Options 4

Summary: Personalized Ringing 4

Individualize the telephone ring.

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *32 + ring pattern (1–8 )

Display Label Personal  Ring  Pattern  #n  
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Summary: Ring Timing Options 4

Establish whether and how individual lines, or all lines, ring at a telephone.

Telephones 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code Individual Lines:
Immediate: *37
Delay: *36
No Ring: *35 

All Lines:
Immediate: *347
Delay: *346
No Ring: *345 

Display Label Individual Lines:
Ring Options One Line Immed/Delay/No Ring 

All Lines:
Ring Options All Lines Immed/Delay/No Ring 

Summary: Abbreviated Ringing Options 4

Turn abbreviated ringing on or off.

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code On: *341
Off: *342 

Display Label Ring Options Abbreviated On/Off 

Summary: Send Ringing Options 4

Override Delay Ring on an extension with Shared SA buttons.

Telephones All

Mode Hybrid/PBX

Programmable by Users and System Manager

Programming Code On: *15
Off: **15 

Display Label Shared SA Ring On/Off 
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Saved Number Dial 4

Assign a button to selectively save the last number dialed and call that number again without 
manually redialing.

Summary: Saved Number Dial 4

Telephones 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *85 

Display Label SaveNumDial 

Send/Remove Message 4

Assign a button to allow the system operator to turn the Message LED on or off for any telephone 
connected to the system.

Summary: Send/Remove Message 4

Telephones DLC operator only

Mode All

Programmable by Users and System Manager

Programming Code *38 

Display Label Send/RmvMsg 

Service Observing 4

Assign a button to allow a Service Observer to monitor calls at a specified station.

Service Observing may be subject to federal, state, or local laws, rules, or regulations or 
require the consent of one or both of the call parties. You must check in your jurisdiction 
and comply with all applicable laws, rules, and regulations before using this feature. 
Failure to comply may result in severe penalties.
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Summary: Service Observing 4

Telephones Multiline 4400-Series telephones (except QCC); MLX telephones 
(except QCC or CTI link)

Mode All

Programmable by System Manager only

Programming Code *59 + ext. no.

Display Label Service Observing: nnnn 

Signaling 4

Assign a button to allow a user to send an audible signal to another extension without making a 
call to that extension.

Summary: Signaling (manual) 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode All

Programmable by Users and System Manager

Programming Code *23 + ext. no. + Enter 

Display Label Signal 

System Access/Intercom Buttons 4

Assign Intercom or System Access buttons on telephones.

Summary: Assign System Access/Intercom Buttons 4

Telephones All

Mode Intercom buttons
Key, Behind Switch

System Access buttons
Hybrid/PBX

Programmable by System Manager only
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Programming Code Intercom buttons:
Assign Intercom Ring button: *16
Assign Intercom Originate Only button: *18 

System Access buttons:
Assign Ring button: *16
Assign Originate Only button: *18 

Display Label SysAccess/SysAcc-00 

Summary: Assign Shared System Access Buttons 4

Telephones All

Mode Hybrid/PBX

Programmable by System Manager only

Programming Code *17 + primary ext. no.

Display Label ShareSysAcc 

Summary: Change Type of System Access Button 4

Telephones All

Mode Intercom buttons:
Key, Behind Switch

System Access buttons:
Hybrid/PBX

Programmable by Users and System Manager

Programming Code Ring: **19
Voice: *19 

Display Label Voice Annce, Place Ring/Voice 

System Speed Dial 4

Assign a button to dial any 3-digit speed dial code.

Summary: System Speed Dial 4

Telephones All

Mode All

Programmable by Users and System Manager

Programming Code *24 + 3-digit code (600–729) + Enter

Display Label SysSpeedDl 
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Transfer 4

Assign a button to access the host system Transfer feature.

Summary: Transfer 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones

Mode Behind Switch

Programmable by Users and System Manager

Programming Code *774 

Display Label Transfer 

Voice Announce 4

Allows users to prevent inside calls on their speakerphone, receive inside calls on their 
speakerphone whether they are busy on a call or not, or —for MLX telephone users only—receive 
inside calls on their speakerphone only when their telephone is idle and they are not busy on a 
call.

Summary: Voice Announce 4

Telephones Multiline 4400-Series, MLX, MLS, and ETR telephones 

Mode All

Programmable by Users and System Manager

Programming Code On: *10
Off: **10 
VA on Idle Only: *999130 (MLX telephones only)

Display Label Voice Annce Receive On/Off/
VA on Idle Only 
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Support Telephone Number 4

In the USA only, Lucent Technologies provides a toll free customer Helpline (1 800 628-2888) 
24 hours a day. If you need assistance when installing, programming, or using your system, call 
the Helpline or your Lucent Technologies representative. Consultation charges may apply.

Outside the USA, if you need assistance when installing, programming, or using your system, 
contact your Lucent Technologies representative.

Federal Communications Commission (FCC)
Electromagnetic Interference Information 4

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
interference, in which case the user will be required to correct the interference at his or her own 
expense.

Canadian Department of Communications
(DOC) Interference Information 4

This digital apparatus does not exceed the Class A limits for radio noise emissions set out in the 
radio interference regulations of the Canadian Department of Communications.

Le Présent Appareil Numérique n’émet pas de bruits radioélectriques dépassant les limites 
applicables aux appareils numériques de la classe A préscrites dans le règlement sur le brouillage 
radioélectrique edicté par le ministère des Communications du Canada.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Customer Support Information 
A-2FCC Notification and Repair Information 

A

FCC Notification and Repair Information 4

This equipment is registered with the FCC in accordance with Part 68 of its rules. In compliance 
with those rules, you are advised of the following:

■  Means of Connection. Connection of this equipment to the telephone network shall be 
through a standard network interface jack, USOC RJ11C, RJ14C, or RJ21X. Connection to 
E&M tie trunks requires a USOC RJ2GX. Connection to off-premises extensions requires a 
USOC RJ11C or RJ14C. Connection to 1.544-mbps digital facilities must be through a USOC 
RJ48C or RJ48X. Connection to DID requires a USOC RJ11C, RJ14C, or RJ21X. These 
USOCs must be ordered from your telephone company. Connection to 56-kbps or 64-kbps 
facilities requires a USOC RJ11C, RJ14C, or RJ21.

■ Party Lines and Coin Telephones. This equipment may not be used with party lines or coin 
telephone lines.

■ Notification to the Telephone Companies. Before connecting this equipment, you or your 
equipment supplier must notify your local telephone company’s business office of the 
following:

— The telephone number or numbers you will be using with this equipment.

• The appropriate registration number and ringer equivalence number (REN), which can 
be found on the back or bottom of the control unit, as follows:

•  If this equipment is to be used as a Key system, report the number AS593M-72914-
KF-E.

•  If the system provides both manual and automatic selection of incoming/outgoing 
access to the network, report the number AS593M-72682-MF-E.

•  If there are no directly terminated trunks, or if the only directly terminated facilities are 
Personal Lines, report the number AS593M-65646-PF-E.

• The REN (Ringer Equivalence Number) for all three systems is 1.5A.

— The facility interface code (FIC) and service order code (SOC): For tie line connection, the 
FIC is TL31M and the SOC is 9.0F.

•  For connection to off-premises stations, the FIC is OL13C and the SOC is 9.0F.

•  For equipment to be connected to DID facilities, the FIC is 02RV2-T and the SOC is 
AS.2.

•  For equipment to be connected to 1.544-mbps digital service, the SOC is 6.0P and 
the FIC is:

— 04DU9-BN for D4 framing format with AMI zero code suppression.

— 04DU9-DN for D4 framing format with bipolar 8 zero code suppression 
(B8ZS).04DU9-IKN for extended superframe format (ESF) with AMI zero code 
suppression.

— 04DU9-ISN with ESF and B8ZS.

•  For equipment to be connected to 56-kbps or 64-kbps digital facilities, the FIC is 
02B1Q.

— The quantities and USOC numbers of the jacks required.

— For each jack, the sequence in which lines are to be connected, the line types, the FIC, 
and the REN by position, when applicable.
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■ Ringer Equivalence Number (REN). The REN is used to determine the number of devices 
that may be connected to the telephone line. Excessive RENs on the line may result in the 
devices not ringing in response to an incoming call. In most, but not all, areas, the sum of the 
RENs should not exceed five (5.0). To be certain of the number of devices that may be 
connected to the line, as determined by the total RENs, contact the local telephone company 
to determine the maximum REN for the calling area.

■ Disconnection. You must also notify your local telephone company if and when this 
equipment is permanently disconnected from the line or lines.

Installation and Operational Procedures 4

The guides for your system contain information about installation and operational procedures.

■ Repair Instructions. If you experience trouble because your equipment is malfunctioning, the 
FCC requires that the equipment not be used and that it be disconnected from the network 
until the problem has been corrected. Repairs to this equipment can be made only by the 
manufacturers, their authorized agents, or others who may be authorized by the FCC. In the 
event repairs are needed on this equipment, contact your authorized Lucent Technologies 
dealer or, in the USA only, contact the National Service Assistance Center (NSAC) at 1 800 
628-2888.

■ Rights of the Local Telephone Company. If this equipment causes harm to the telephone 
network, the local telephone company may discontinue your service temporarily. If possible, 
they will notify you in advance. But if advance notice is not practical, you will be notified as 
soon as possible. You will also be informed of your right to file a complaint with the FCC.

■ Changes at Local Telephone Company. Your local telephone company may make changes 
in its facilities, equipment, operations, or procedures that affect the proper functioning of this 
equipment. If they do, you will be notified in advance to give you an opportunity to maintain 
uninterrupted telephone service.

■ Hearing Aid Compatibility. The custom telephone sets for this system are compatible with 
inductively coupled hearing aids as prescribed by the FCC.

■ Automatic Dialers. WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR MAKING 
TEST CALLS TO EMERGENCY NUMBERS:

— Remain on the line and briefly explain to the dispatcher the reason for the call.

— Perform such activities in off-peak hours, such as early morning or late evening.

■ Direct Inward Dialing (DID). This equipment returns answer supervision signals to the Public 
Switched Telephone Network when:

— Answered by the called station.

— Answered by the attendant.

— Routed to a recorded announcement that can be administered by the customer premises 
equipment user.

— Routed to a dial prompt.



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Customer Support Information 
A-4DOC Notification and Repair Information 

A

This equipment returns answer supervision on all DID calls forwarded back to the Public 
Switched Telephone Network. Permissible exceptions are when:

— A call is unanswered

— A busy tone is received

— A reorder tone is received

Allowing this equipment to be operated in such a manner as not to provide proper answer 
supervision signaling is in violation of Part 68 rules.

New Network Area and Exchange Codes. The MERLIN MAGIX Integrated System software 
does not restrict access to any new area codes or exchange codes established by a local 
telephone company. If the user has established Toll Restrictions on the system that could restrict 
access, then the user should check the lists of allowed and disallowed dial codes and modify them 
as needed.

Equal Access Codes. This equipment is capable of providing users access to interstate providers 
of operator services through the use of access codes. Modifications of this equipment by call 
aggregators to block access dialing codes is a violation of the Telephone Operator Consumers Act 
of 1990.

DOC Notification and Repair Information 4

NOTICE: The Canadian Department of Communications (DOC) label identifies certified 
equipment. This certification means that the equipment meets certain protective, operational, and 
safety requirements of the telecommunications network. The DOC does not guarantee the 
equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible to connect it to the 
facilities of the local telecommunications company. The equipment must also be installed using an 
acceptable method of connection. In some cases, the company’s inside wiring for single-line 
individual service may be extended by means of a certified connector assembly (telephone 
extension cord). The customer should be aware that compliance with the above conditions may 
not prevent degradation of service in some situations. 

Repairs to certified equipment should be made by an authorized Canadian maintenance facility 
designated by the supplier. Any repairs or alterations made by the user to this equipment, or any 
equipment malfunctions, may give the telecommunications company cause to request the user to 
disconnect the equipment.

Users should ensure, for their own protection, that the electrical ground connections of the power 
utility, telephone lines, and internal metallic water pipe system, if present, are connected. This 
precaution may be particularly important in rural areas.

CAUTION:
Users should not attempt to make such connections themselves, but should contact the 
appropriate electrical inspection authority or electrician.
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To prevent overloading, the Load Number (LN) assigned to each terminal device denotes the 
percentage of the total load to be connected to a telephone loop used by the device. The 
termination on a loop may consist of any combination of devices subject only to the requirement 
that the total of the Load Numbers of all the devices does not exceed 100.

DOC Certification No.: 230 4095A
CSA Certification No.: LR 56260
Load No.: 6

Renseignements sur la Notification du
Ministère des Communications du Canada et
la Réparation 4

AVIS: L’étiquette du ministère des Communications du Canada identifie le matériel homologué. 
Cette étiquette certifie que le matériel est conforme à certaines normes de protection, 
d’exploitation et de sécurité des réseaux de télécommunications. Le Ministère n’assure toutefois 
pas que le matériel fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder aux 
installations de l’entreprise locale de télécommunication. Le matériel doit également être installé 
en suivant une méthode acceptée de raccordement. Dans certains cas, les fils intérieurs de 
l’enterprise utilisés pour un service individuel à ligne unique peuvent être prolongés au moyen 
d’un dispositif homologué de raccordement (cordon prolongateur téléphonique interne). L’abonné 
ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus 
n’empêchent pas la dégradation du service dans certaines situations. Actuellement, les 
entreprises de télécommunication ne permettent pas que l’on raccorde leur matériel à des jacks 
d’abonné, sauf dans les cas précis prévus pas les tarifs particuliers de ces entreprises.

Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien 
autorisé désigné par le fournisseur. La compagnie de télécommunications peut demander à 
l’utilisateur de débrancher un appareil à la suite de réparations ou de modifications effectuées par 
l’utilisateur ou à cause de mauvais fonctionnement.

Pour sa propre protection, l’utilisateur doit s’assurer que tous les fils de mise à la terre de la source 
d’énergie électrique, des lignes téléphoniques et des canalisations d’eau métalliques, s’il y en a, 
sont raccordés ensemble. Cette précaution est particuliérement importante dans les régions 
rurales. 

AVERTISSEMENT: L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit 
avoir recours à un service d’inspection des installations électriques, ou à un électricien, selon le 
cas.

L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute surcharge, le 
pourcentage de la charge totale qui peut être raccordée à un circuit téléphonique bouclé utilisé par 
ce dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison 
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de dispositifs, pourvu que la somme des indices de charge de l’ensemble des dispositifs ne 
dépasse pas 100.

No d’homologation : 230 4095A
No de certification : CSA LR 56260
L’indice de charge : 6
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Security of Your System: Preventing Toll 
Fraud 4

As a customer of a new telephone system, you should be aware that there is an increasing 
problem of telephone toll fraud. Telephone toll fraud can occur in many forms, despite the 
numerous efforts of telephone companies and telephone equipment manufacturers to control it. 
Some individuals use electronic devices to prevent or falsify records of these calls. Others charge 
calls to someone else’s number by illegally using lost or stolen calling cards, billing innocent 
parties, clipping on to someone else’s line, and breaking into someone else’s telephone equipment 
physically or electronically. In certain instances, unauthorized individuals make connections to the 
telephone network through the use of the Remote Access features of your system.

The Remote Access features of your system, if you choose to use them, permit off-premises 
callers to access the system from a remote telephone by using a telephone number with or without 
a barrier code. The system returns an acknowledgment, signaling the user to key in his or her 
barrier code, which is selected and administered by the System Manager. After the barrier code is 
accepted, the system returns dial tone to the user. Barrier codes are, by default, restricted from 
making outside calls. If no specific outward calling restrictions are programmed, the user is able to 
place any call normally dialed from a telephone associated with the system. Such an off-premises 
network call is originated at, and will be billed from, the system location.

The Remote Access feature, as designed, helps the customer, through proper administration, to 
minimize the ability of unauthorized persons to gain access to the network. Most commonly, 
telephone numbers and codes are compromised when overheard in a public location, through theft 
of a wallet or purse containing access information, or through carelessness (for example, writing 
codes on a piece of paper and improperly discarding it). Additionally, hackers may use a computer 
to dial an access code and then publish the information to other hackers. Enormous charges can 
be run up quickly. It is the customer’s responsibility to take the appropriate steps to properly 
implement the features, evaluate and administer the various restriction levels, protect access 
codes, and distribute access codes only to individuals who have been fully advised of the sensitive 
nature of the access information.

Common carriers are required by law to collect their tariffed charges. While these charges are 
fraudulent charges made by persons with criminal intent, applicable tariffs state that the customer 
of record is responsible for payment of all long-distance or other network charges. Lucent 
Technologies cannot be responsible for such charges and will not make any allowance or give any 
credit for charges that result from unauthorized access.

To minimize the risk of unauthorized access to your system:

■ Use an unpublished Remote Access number.

■ Assign access codes randomly to users on a need-to-have basis, keeping a log of all 
authorized users and assigning one code to each person.

■ Use random-sequence access codes, which are less likely to be broken.

■ Use the longest-length access codes the system will allow.

■ Deactivate all unassigned codes promptly.

■ Ensure that Remote Access users are aware of their responsibility to keep the telephone 
number and any access codes secure.
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■ When possible, restrict the off-network capability of off-premises callers, using calling 
restrictions, Facility Restriction Levels (Hybrid/PBX mode only), and Disallowed List 
capabilities. A prepared Disallowed List (number 7) is provided and is designed to prevent the 
types of calls that toll fraud abusers often make.

■ When possible, block out-of-hours calling.

■ Frequently monitor system call detail reports for quicker detection of any unauthorized or 
abnormal calling patterns.

■ Limit Remote Call Forwarding to persons on a need-to-have basis.

■ Change access codes every 90 days.

■ Use the longest-length barrier codes possible, following the guidelines for passwords. (See 
‘‘Choosing Passwords’’ on page A-15.)

Toll Fraud Prevention 4

Toll fraud is the unauthorized use of your telecommunications system by third parties to make 
long-distance telephone calls. Under the law, you, the customer, are responsible for paying part or 
all of those unauthorized calls. Thus, the following information is of critical importance. 

Unauthorized persons concentrate their activities in two areas with the MERLIN MAGIX Integrated 
System:

■ They try to transfer out of the MERLIN MAGIX Integrated System to gain access to an 
outgoing trunk and make long-distance calls.

■ They try to locate unused or unprotected mailboxes and use them as drop-off points for their 
own messages.

The following is a discussion of how toll fraud is often perpetrated and ways to prevent 
unauthorized access that can lead to toll fraud.

Physical Security, Social Engineering, and
General Security Measures 4

Criminals called hackers may attempt to gain unauthorized access to your system and voice 
messaging system in order to use the system features. Hackers often attempt to trick employees 
into providing them with access to a network facility (line/trunk) or a network operator. This is 
referred to as social engineering. Hackers may pose as telephone company employees or 
employees of Lucent Technologies or your authorized dealer. Hackers will go through a company’s 
trash to find directories, dialing instructions, and other information that will enable them to break 
into the system. The more knowledgeable they appear to be about the employee names, 
departments, telephone numbers, and the internal procedures of your company, the more likely it 
is that they will be able to trick an employee into helping them.
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Preventive Measures 4

Take the following preventive measures to limit the risk of unauthorized access by hackers:

■ Provide good physical security for the room containing your telecommunications equipment 
and the room with administrative tools, records, and System Manager information. These 
areas should be locked when not attended.

■ Provide a secure trash disposal for all sensitive information, including telephone directories, 
call accounting records, or anything that may supply information about your system. This trash 
should be shredded.

■ Educate employees that hackers may try to trick them into providing them with dial tone or 
dialing a number for them. All reports of trouble, requests for moving extensions, or any other 
administrative details associated with the MERLIN MAGIX Integrated System should be 
handled by one person (the System Manager) or within a specified department. Anyone 
claiming to be a telephone company representative should be referred to this person or 
department. 

■ No one outside of Lucent Technologies needs to use the MERLIN MAGIX Integrated System 
to test facilities (lines/trunks). If a caller claims to be a Lucent Technologies employee, the 
System Manager should ask for a telephone number where the caller can be reached. The 
System Manager should be able to recognize the number as a Lucent Technologies telephone 
number. Before connecting the caller to the administrative port of the MERLIN MAGIX 
Integrated System, the System Manager should feel comfortable that a good reason to do so 
exists. In any event, it is not advisable to give anyone access to network facilities or operators, 
or to dial a number at the request of the caller.

■ Any time a call appears to be suspicious, call the Lucent Technologies BCS Fraud Intervention 
Center at 1 800 628-2888 (fraud intervention for System 25, PARTNER, MERLIN, and 
MERLIN MAGIX systems). 

■ Customers should also take advantage of Lucent Technologies monitoring services and 
devices, such as the NetPROTECT family of fraud-detection services, CAS with 
HackerTracker, and CAT Terminal with Watchdog. Call 1 800 638-7233 to get more 
information on these Lucent Technologies fraud detection services and products.

Security Risks Associated with Transferring
through Voice Messaging Systems 4

Toll fraud hackers try to dial into a voice mailbox and then execute a transfer by dialing *T. The 
hacker then dials an access code (either 9 for Automatic Route Selection or a pooled facility 
code), followed by the appropriate digit string to either direct dial or access a network operator to 
complete the call.

All extensions are initially, and by default, restricted from dial access to pools. In order for 
an extension to use a pool to access an outside line/trunk, this restriction must be 
removed.
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Preventive Measures 4

Take the following preventive measures to limit the risk of unauthorized transfers by hackers:

■ Confirm that all MERLIN MAGIX Integrated System voice mail port extension numbers are 
outward restricted. This denies access to facilities (lines/trunks). Voice mail ports are, by 
default, outward restricted.

■ As an additional security step, network dialing for all extensions, including voice mail port 
extensions, should be processed through ARS using dial access code 9. 

SECURITY ALERT:

The MERLIN MAGIX Integrated System ships with ARS activated with all extensions set 
to Facility Restriction Level 3, allowing all international calling. To prevent toll fraud, 
ARS Facility Restriction Levels (FRLs) should be established using: 

■ FRL 0 for restriction to internal dialing only.

■ FRL 2 for restriction to local network calling only.

■ FRL 3 for restriction to domestic long-distance (excluding area code 809 for the 
Dominican Republic as this is part of the North American Numbering Plan, unless 809 
is required).

■ FRL 4 for international calling.

WARNING:

Default local and default toll tables are factory-assigned an FRL of 2. This simplifies the 
task of restricting extensions: the FRL for an extension merely needs to be changed 
from the default of 3.

WARNING:

Each extension should be assigned the appropriate FRL to match its calling 
requirements. All voice mail port extensions not used for Outcalling should be assigned 
to FRL 0 (the factory setting).

■ Deny access to pooled facility codes by removing pool dial-out codes 70, 890 899, or any 
others on your system. 

■ Create a Disallowed List or use the pre-prepared Disallowed List number 7 to disallow dialing 
0, 11, 10, 1700, 1809, 1900, and 976 or 1 (wildcard) 976. Disallowed List number 7 does not 
include 800, 1800, 411, and 1411, but Lucent Technologies recommends that you add them. 

Assign all voice mail port extensions to this Disallowed List. Lucent Technologies 
recommends assigning Disallowed List number 7. This is an added layer of security, in 
case outward restriction is inadvertently removed. (Voice messaging ports are assigned, 
by default, to Disallowed List number 7.) 



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Customer Support Information 
A-11Toll Fraud Prevention 

A

If Outcalling is required by voice messaging system extensions:

■ Program an ARS Facility Restriction Level (FRL) of 2 on voice mail port extensions used for 
Outcalling.

■ If 800 and 411 numbers are used, remove 1800, 800, 411, and 1411 from Disallowed List 
number 7.

■ If Outcalling is allowed to long-distance numbers, build an Allowed List for the voice mail port 
extensions used for Outcalling. This list should contain the area code and the first three digits 
of the local exchange telephone numbers to be allowed.

Additional general security for voice messaging systems:

■ Use a secure password for the General Mailboxes.

■ The default administration mailbox, 9997, must be reassigned to the System Manager’s 
mailbox/extension number and securely password protected.

■ All voice messaging system users must use secure passwords known only to the user.

Security Risks Associated with the Automated
Attendant Feature of Voice Messaging Systems 4

Two areas of toll fraud risk associated with the Automated Attendant feature of voice messaging 
systems are: 

■ Pooled facility (line/trunk) access codes are translated to a menu prompt to allow Remote 
Access. If a hacker finds this prompt, the hacker has immediate access. (Dial access to pools 
is initially factory-set to restrict all extensions: to allow pool access, this restriction must be 
removed by the System Manager.)

■ If the Automated Attendant prompts callers to use Remote Call Forwarding (RCF) to reach an 
outside telephone number, the system may be susceptible to toll fraud. An example of this 
application is a menu or submenu that says, “To reach our answering service, select prompt 
number 5,” and transfers a caller to an external telephone number. 

Remote Call Forwarding can be used securely only when the central office provides “reliable 
disconnect” (sometimes referred to as forward disconnect or disconnect supervision), which 
guarantees that the central office does not return a dial tone after the called party hangs up. In 
most cases, the central office facility is a loop-start line/trunk which does not provide reliable 
disconnect. When loop-start lines/trunks are used, if the calling party stays on the line, the 
central office does return a dial tone at the conclusion of the call, enabling the caller to place 
another call as if it were being placed from your company. Ground-start trunks provide reliable 
disconnect and should be used whenever possible.
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Preventive Measures

Take the following preventive measures to limit the risk of unauthorized use of the Automated 
Attendant feature by hackers:

■ Do not use Automated Attendant prompts for Automatic Route Selection (ARS) codes or 
Pooled Facility codes.

■ Assign all unused Automated Attendant selector codes to zero, so that attempts to dial these 
are routed to the system attendant. 

■ If Remote Call Forwarding (RCF) is required, MERLIN MAGIX Integrated System owners 
should coordinate with their Lucent Technologies Account Team or authorized dealer to verify 
the type of central office facility used for RCF. If it is a ground-start line/trunk, or if it is a loop-
start line/trunk and central office reliable disconnect can be ensured, then nothing else needs 
to be done.

Security Risks Associated with the Remote
Access Feature 4

Remote Access allows the MERLIN MAGIX Integrated System owner to access the system from a 
remote telephone and make an outgoing call or perform system administration using the network 
facilities (lines/trunks) connected to the MERLIN MAGIX Integrated System. Hackers, scanning 
the public switched network by randomly dialing numbers with war dialers (a device that randomly 
dials telephone numbers, including 800 numbers, until a modem or dial tone is obtained), can find 
this feature, which will return a dial tone to them. They can even employ war dialers to attempt to 
discover barrier codes.

Preventive Measures 4

Take the following preventive measures to limit the risk of unauthorized use of the MERLIN MAGIX 
Integrated System Remote Access feature:

■ The Remote Access feature can be abused by criminal toll fraud hackers if it is not properly 
administered. Therefore, this feature should not be used unless there is a strong business 
need.

In most cases, these are loop-start lines/trunks without reliable disconnect. The local 
telephone company must be involved in order to change the facilities used for RCF to 
ground-start line/trunks. Usually, a charge applies for this change. Also, hardware 
and software changes may be necessary in the MERLIN MAGIX Integrated System. 
The MERLIN Messaging Automated Attendant feature merely accesses the RCF 
feature in the MERLIN MAGIX Integrated System. Without these changes being 
made, this feature is highly susceptible to toll fraud. These same preventive 
measures must be taken if the RCF feature is active for MERLIN MAGIX Integrated 
System extensions, whether or not it is accessed by an Automated Attendant menu.
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■ It is strongly recommended that customers invest in security adjuncts, which typically use 
one-time passcode algorithms. These security adjuncts discourage hackers. Since a secure 
use of the Remote Access feature generally offers savings over credit-card calling, the break-
even period can make the investment in security adjuncts worthwhile.

■ If a customer chooses to use the Remote Access feature without a security adjunct, then 
multiple barrier codes should be employed, with one per user, if the system permits. The 
MERLIN MAGIX Integrated System permits a maximum of 16 barrier codes. 

■ The maximum length should be used for each barrier code, and should be changed 
periodically. Barrier codes, like passwords, should consist of a random, hard-to-guess 
sequence of digits. The MERLIN MAGIX Integrated System permits a barrier code of up to 11 
digits.

Other Security Hints 4

Make sure that the Automated Attendant selector codes do not permit outside line selection.

Multiple layers of security are always recommended to keep your system secure.

A number of measures and guidelines that can help you ensure the security of your system and 
voice messaging system follows:

Educating Users 4

Everyone in your company who uses the telephone system is responsible for system security. 
Users and attendants/operators need to be aware of how to recognize and react to potential 
hacker activity. Informed people are more likely to cooperate with security measures that often 
make the system less flexible and more difficult to use.

■ Never program passwords or authorization codes onto Auto Dial buttons. Display telephones 
reveal the programmed numbers and internal abusers can use the Auto Dial buttons to 
originate unauthorized calls.

■ Discourage the practice of writing down barrier codes or passwords. If a barrier code or 
password needs to be written down, keep it in a secure place and never discard it while it is 
active.

■ Instruct operators and attendants to inform tell their System Manager whenever they answer a 
series of calls where there is silence on the other end or the caller hangs up. 

■ Advise users who are assigned voice mailboxes to frequently change personal passwords and 
not to choose obvious passwords.

■ Ensure that the System Manager advises users with special telephone privileges (such as 
Remote Access, Outcalling, and Remote Call Forwarding) of the potential risks and 
responsibilities.

■ Be suspicious of any caller who claims to be with the telephone company and wants to check 
an outside line. Ask for a callback number, hang up, and confirm the caller’s identity.
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■ Never distribute the office telephone directory to anyone outside the company; be careful 
when discarding it (shred the directory).

■ Never accept collect telephone calls.

■ Never discuss your telephone system’s numbering plan with anyone outside the company.

Educating Operators 4

Operators or attendants need to be especially aware of how to recognize and react to potential 
hacker activity. To defend against toll fraud, operators should follow the guidelines below:

■ Establish procedures to counter social engineering. Social engineering is a con game that 
hackers frequently use to obtain information that may help them gain access to your system or 
voice messaging system.

■ When callers ask for assistance in placing outside or long-distance calls, ask for a callback 
extension.

■ Verify the source. Ask callers claiming to be maintenance or service personnel for a callback 
number. Never transfer to *10 without this verification. Never transfer to extension 900.

■ Remove the headset and/or handset when the console is not in use.

Detecting Toll Fraud 4

To detect toll fraud, users and operators should look for the following:

■ Lost voice mail messages, mailbox lockout, or altered greetings

■ Inability to log into voice mail

■ Inability to get an outside line

■ Foreign language callers

■ Frequent hang-ups

■ Touch-Tone sounds

■ Caller or employee complaints that the lines are busy

■ Increases in internal requests for assistance in making outbound calls (particularly 
international calls or requests for dial tone)

■ Outsiders trying to obtain sensitive information

■ Callers claiming to be the “telephone” company

■ Sudden increase in wrong numbers
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Establishing a Policy 4

As a safeguard against toll fraud, follow these guidelines for your MERLIN MAGIX Integrated 
System and voice messaging system:

■ Change passwords frequently (at least quarterly). Changing passwords routinely on a specific 
date (such as the first of the month) helps users to remember to do so.

■ Always use the longest-length password allowed.

■ Establish well-controlled procedures for resetting passwords.

■ Limit the number of invalid attempts to access a voice mailbox to five or less.

■ Monitor access to the MERLIN MAGIX Integrated System dial-up maintenance port. Change 
the access password regularly and issue it only to authorized personnel. Disconnect the 
maintenance port when not in use. (This however, eliminates Lucent Technologies’ 24-hour 
maintenance surveillance capability and may result in additional maintenance costs.)

■ Create a system management policy concerning employee turnover and include these 
suggestions:

— Delete all unused voice mailboxes in the voice mail system.

— If a terminated employee had Remote Access calling privileges and a personal 
authorization code, remove the authorization code immediately.

— If barrier codes and/or authorization codes were shared by the terminated employee, 
these should be changed immediately.

■ Regularly back up your MERLIN MAGIX Integrated System files to ensure a timely recovery 
should it be required. Schedule regular, off-site backups.

■ Keep the Remote Maintenance Device turned off when not in use by Lucent Technologies or 
your authorized dealer.

■ Limit transfers to registered subscribers only.

■ Use the Security Violations Notification options (Mailbox Lock or Warning Message) to alert 
you of any mailbox break-in attempts. Investigate all incidents.

■ Review security policies and procedures and keep them up to date.

Choosing Passwords 4

Passwords should be the maximum length allowed by the system. 
Passwords should be hard to guess and should not contain:

■ All the same numbers (for example, 1111, 666666)

■ Sequential characters (for example, 123456)

■ Numbers that can be associated with you or your business, such as your name, birthday, 
business name, business address, telephone number, or social security number

■ Words and commonly used names
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Passwords should be changed regularly—at least on a quarterly basis. Recycling old passwords is 
not recommended. Never program passwords (or authorization codes or barrier codes) onto a 
speed dial button.

Physical Security 4

You should always limit access to the system console (or attendant console) and supporting 
documentation. The following are some recommendations:

■ Keep the system console and supporting documentation in an office that is secured with a 
changeable combination lock. Provide the combination only to those individuals having a real 
need to enter the office.

■ Keep telephone wiring closets and equipment rooms locked.

■ Keep telephone logs and printed reports in locations that only authorized personnel can enter.

■ Design distributed reports so they do not reveal password or trunk access code information.

■ Keep the voice messaging system Remote Maintenance Device turned off.

Limiting Outcalling 4

When Outcalling is used to contact subscribers who are off-site, use the MERLIN MAGIX 
Integrated System Allowed Lists and Disallowed Lists or Automatic Route Selection features to 
minimize toll fraud.

If the Outcalling feature will not be used, outward restrict all voice messaging system ports. If 
Outcalling will be used, for the MERLIN Messaging System, ports to be unrestricted are port 2 on 
a 2-port system, port 4 on a 4-port system, or port 6 on a 6-port system. All other ports should be 
restricted. Use Outward Restriction, Toll Restrictions, Allowed Lists, Disallowed Lists and Facility 
Restrictions Levels, as appropriate, to minimize the possibility of toll fraud. 

Limited Warranty and Limitation of Liability 4

Lucent Technologies warrants to you, the customer, that your MERLIN MAGIX Integrated System 
will be in good working order on the date Lucent Technologies or its authorized reseller delivers or 
installs the system, whichever is later (“Warranty Date”). If Lucent Technologies determines that 
your system cannot be repaired or replaced, Lucent Technologies will remove the system and, at 
your option, refund the purchase price of your system or apply the purchase price towards the 
purchase of another Lucent Technologies system.

If you purchased your system directly from Lucent Technologies, Lucent Technologies will perform 
warranty repair in accordance with the terms and conditions of the specific type of Lucent 
Technologies maintenance coverage you selected. If you purchased your system from a Lucent 
Technologies-authorized reseller, contact your reseller for the details of the maintenance plan 
applicable to your system.
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The following will not be deemed to impair the good working order of the system, and Lucent 
Technologies will not be responsible under the limited warranty for damages resulting from:

■ Failure to follow Lucent Technologies’ installation, operation, or maintenance instructions

■ Unauthorized system modification, movement, or alteration

■ Unauthorized use of common carrier communications services accessed through the system

■ Abuse, misuse, or negligent acts or omissions of the customer and persons under the 
customer’s control

■ Acts of third parties and acts of God

■ Power surges, including power surges due to lightening

LUCENT TECHNOLOGIES’ OBLIGATION TO REPAIR, REPLACE, OR REFUND AS SET 
FORTH ABOVE IS YOUR EXCLUSIVE REMEDY.

EXCEPT AS SPECIFICALLY SET FORTH ABOVE, LUCENT TECHNOLOGIES, ITS 
AFFILIATES, SUPPLIERS, AND AUTHORIZED RESELLERS MAKE NO WARRANTIES, 
EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIM ANY WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Limitation of Liability 4

Except as provided below, the liability of Lucent Technologies and its affiliates and suppliers for 
any claims, losses, damages, or expenses from any cause whatsoever (including acts or 
omissions of third parties), regardless of the form of action, whether in contract, tort, or otherwise, 
shall not exceed the lesser of: (1) the direct damages proven; or (2) the repair cost, replacement 
cost, license fee, annual rental charge, or purchase price, as the case may be, of the equipment 
that gives rise to the claim. Except as provided below, Lucent Technologies and its affiliates and 
suppliers shall not be liable for any incidental, special, reliance, consequential, or indirect loss or 
damage incurred in connection with the equipment. As used in this paragraph, consequential 
damages include, but are not limited to, the following: lost profits, lost revenues, and losses arising 
out of unauthorized use (or charges for such use) of common carrier telecommunications services 
or facilities accessed through or connected to the equipment. For personal injury caused by 
Lucent Technologies's negligence, Lucent Technologies's liability shall be limited to proven 
damages to person. No action or proceeding against Lucent Technologies or its affiliates or 
suppliers may be commenced more than twenty-four (24) months after the cause of action 
accrues. THIS PARAGRAPH SHALL SURVIVE FAILURE OF AN EXCLUSIVE REMEDY. 
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Remote Administration and Maintenance 4

The Remote Administration and Maintenance feature of your telecommunications system, if you 
choose to use it, permits users to change the system features and capabilities from a remote 
location. 

The Remote Administration and Maintenance feature, through proper administration, can help you 
reduce the risk of unauthorized persons gaining access to the network. However, telephone 
numbers and access codes can be compromised when overheard in a public location, or lost 
through theft of a wallet or purse containing access information or through carelessness (for 
example, writing codes on a piece of paper and improperly discarding them). Additionally, hackers 
may use a computer to dial an access code and then publish the information to other hackers. 
Substantial charges can accumulate quickly. It is your responsibility to take appropriate steps to 
implement the features properly, evaluate and administer the various restriction levels, and protect 
and carefully distribute access codes.

Under applicable tariffs, you will be responsible for payment of toll charges. Lucent Technologies 
cannot be responsible for such charges and will not make any allowance or give any credit 
resulting from unauthorized access.

To reduce the risk of unauthorized access through Remote Administration and Maintenance, 
please observe the following procedures:

■ The System Administration and Maintenance capability of a Hybrid/PBX or Key system is 
protected by a password.

— Change the default password immediately

— Continue to change the password regularly

— Give the password only to people who need it and impress upon them the need to keep it 
secret

— If anyone who knows the password leaves the company, change the password 
immediately

■ If you have a special telephone line connected to your Hybrid/PBX or Key system for Remote 
Administration and Maintenance, you should do one of the following:

— Unplug the line when it is not being used

— Install a switch in the line to turn it off when it is not being used

— Keep the Remote Administration and Maintenance telephone number secret. Give it only 
to people who need to know it, and impress upon them the need to keep it a secret. Do not 
write the telephone number on the Hybrid/PBX or Key system, the connecting equipment, 
or anywhere else in the system room

If your Remote Administration and Maintenance feature requires that someone in your office 
transfer the caller to the Remote Administration and Maintenance extension, you should impress 
upon your employees the importance of transferring only authorized individuals to that extension.
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Overview 4

The system programming menu hierarchy details the sequence of menu screens that appear 
when you select the system programming options. The choice of an option on the first menu 
screen leads to either a second menu screen or a data-entry screen. A second menu screen may 
lead to still another menu screen, and so on, up to six screens, as shown on the following pages.

You can use the Inspect feature in system programming to display the telephone or line/trunk 
numbers that are programmed with a specific feature. Inspect is helpful either when you must 
assign a feature to many lines/trunks or extensions and you do not have a Direct Station Selector 
(DSS) attached to the system programming console, or when you are programming using a PC 
with the WinSPM program.

Inspect can be used with the menu options on the following pages that have an asterisk (*) next to 
them. To use Inspect in system programming, choose an eligible option, and press one of the 
following:

■ Programmed Inspect button (4400-Series telephones)

■ Fixed Inspect button (MLX telephones)

■ PgDn
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Overview 4

Table C-1 defines LED status on the 4424LD+ and MLX-20L consoles. LED status is indicated on 
the LEDs next to the 20 buttons below the display area on the system programming console. LED 
status is simulated on the computer screen when you use WinSPM.

Table C-2 defines LED status on the DSS console. LED status is indicated on the red LED next to 
the 50 extension buttons.
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Table C-1. Line or Trunk Status for 4424LD+ and MLX-20L Consoles

System 
Programmin
g Menu 
Option

LED Status1 

Green LED Red LED

Option ON OFF FLASHING ON OFF FLASHING

Lines Trunks Tie Lines

Inmode Incoming 
tie line is 
Touch-
Tone

Incoming 
tie line is 
rotary 
dial2 

Outmode Outgoing 
tie line is 
Touch-
Tone

Outgoing 
tie line is 
rotary 
dial2

Dialtone Remote 
dial 
tone2

Local 
dial tone

Lines Trunks TT/LS
Disc

Outmode Line/
Trunk is 
Touch-
Tone2 

Line/
trunk is 
rotary 
dial

Lines Trunks Pools Trunk 
is in 
pool

Trunk 
is not 
in pool

Lines Trunks Toll Type Must dial 
1 + area 
code2 

1 + 
dialing is 
not  
needed
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System 
Programmin
g Menu 
Option

LED Status1 

Green LED Red LED

Option ON OFF FLASHING ON OFF FLASHING

Lines Trunks Hold 
Disconct

Long-
450 ms2

Short-50 
ms

Lines Trunks LS-ID
Delay

LS-ID 
Delay 
is on

LS-ID 
Delay is 
off2

Extensions Lines 
Trunks

Line/
trunk or 
pool is 
assigned 
to button

Line/
trunk or 
pool is 
not 
assigned 
to button

Trunk 
is 
assign
ed to a 
pool

1 LED Status is indicated on LEDs next to the 20 buttons below the display area of the system programming console, or 
simulated on the computer screen when using WinSPM.

2 This is the factory setting.

Table C-1. Line or Trunk Status for 4424LD+ and MLX-20L Consoles — Continued
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Table C-2. Telephone Feature Status for DSS Console Only

System 
Programming 
Menu Option

Red LED Status

Option ON OFF FLASHING WINK

Extensions Account 
(FACE)

Forced 
Account Code 
Entry 
assigned

Forced 
Account Code 
Entry not 
assigned1

Extensions Call Pickup Telephone is 
assigned to 
Call Pickup 
Group

Telephone is 
not assigned 
to Call Pickup 
Group1

Extensions VoiceSignl Voice 
Announce to 
Busy assigned 

Voice 
Announce to 
Busy not 
assigned1

Extensions Ext Status Extension 
Status 
assigned

Extension 
Status not 
assigned

Extension 
Status can be 
assigned

Extensions Group 
Page

Telephone is 
in group

Telephone is 
not in group1

Extensions Group 
Cover

Telephone is 
in coverage 
group

Telephone is 
not in 
coverage 
group1

Extensions Group 
Calling 
Members

Telephone is 
assigned to 
group

Telephone is 
not assigned 
to group1

Extensions Mic Disable Telephone 
microphone is 
disabled

Telephone 
microphone is 
enabled

Extensions Remote 
Frwd

Telephone 
can transfer 
calls to remote 
telephone 
number

Telephone 
cannot 
transfer calls 
to remote 
telephone 
number1

Night Service Group 
Assign

Telephone is 
in group

Telephone not 
in group1

Night Service Exclude 
List

Telephone is 
excluded 

Telephone is 
not excluded1
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System 
Programming 
Menu Option

Red LED Status

Option ON OFF FLASHING WINK

Aux Equip Msg 
Waiting

A fax 
message-
waiting 
extension

Not a fax 
message-
waiting 
extension

Aux Equip Fax 
Extension

Extension is a 
fax machine

Extension not 
a fax machine

Tables AllowTo Allowed List 
assigned to 
telephone

Allowed List 
not assigned 
to telephone1

Tables DisallowTo Disallowed 
List assigned 

Disallowed 
List not 
assigned1

Data Voice/Data Voice/Data 
pair

Not Voice/
Data pair1

Operator Direct 
Trunk 
Queued 
Call

Operator 
position

Other Can be 
assigned as 
operator 
position

Operator Queued 
Call 
Message 
Center

Message 
Center 
position

Other Can be 
assigned as 
Message 
Center

Operator In Queue 
Alert

Position 
receives In-
Queue Alert 
for Thresh. 3

Other Position 
receives In-
Queue Alert 
for Thresh. 1

Position 
receives In-
Queue Alert 
for Thresh. 2

1 This is the factory setting.

Table C-2. Telephone Feature Status for DSS Console Only — Continued
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This appendix contains information on the general use of features for the 4400-Series, MLX, ETR, 
MLS, analog multiline, and single-line telephones. It covers telephone and operator features and 
the acceptable programming codes for each. It also describes how to program these features on 
4400-Series, MLX, ETR, and MLS telephones.

General Feature Use Information 4

The following sections provide general instructions for feature use on 4400-Series, MLX, ETR, 
MLS, and single-line telephones. Features can be used in the following ways:

■ Pressing a fixed feature button.

■ Pressing a programmed button.

■ Dialing the feature code.

Fixed Features 4

All multiline telephones have a group of fixed feature buttons that are programmed and labeled at 
the factory. The functions of these buttons, which include Conf, Transfer, and Speaker, cannot be 
changed. Press the button for the feature you want to use.

Programmed Buttons 4

Any unlabeled line button on multiline telephones can be programmed with a feature for one-touch 
activation. See Tables D-7 through D-10 for additional information about programming features 
onto line buttons.

Some features, such as Auto Dial, must be programmed onto line buttons in order to function. 
Other features, such as Privacy, are best used if programmed onto line buttons—the LED next to 
the line button provides visual indication that the feature is in use. The following features must be 
programmed onto line buttons:

■ 4400-Series Drop

■ Auto Answer Headset
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■ Auto Dial

■ Barge-In

■ Coverage

— Group Coverage

— Primary Coverage

— Secondary Coverage

— Coverage Off

— Coverage VMS Off

■ Do Not Disturb

■ Extension Status-Agent Login/Logout

■ Feature Button (multiline 4400-Series telephones only)

■ Headset/Handset Mute (MLX telephones only)

■ Headset Status

■ Headset Hang Up

■ HFAI (multiline 4400-Series telephones only)

■ Inspect (multiline 4400-Series telephones only)

■ Notify

■ Posted Message (available from display on MLX and certain 4400-Series display telephones)

■ Saved Number Dial

■ Service Observing

■ Signal

Feature Codes 4

Feature codes are 1-, 2-, and 3-digit codes that activate features. Use a feature code by doing one 
of the following:

■ Pressing a programmed Feature button on 4400-Series multiline telephones.

■ Pressing the fixed Feature button on MLX, ETR, or MLS telephones.

■ Dialing # on 4400, 4400D, or single-line telephones.

Each of these methods sends a signal to the system that a feature code is about to be dialed. 
When the code is dialed, the feature is activated.

Queued Call Console (QCC) system operators cannot use feature codes.
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The following features can be used only by dialing feature codes:

■ Pickup

■ Forward/Follow Me—Cancel One

■ Forward/Follow Me—Cancel All

■ Message Cancel

■ Personal Speed Dial

■ System Speed Dial

Telephone and Operator Features 4

Tables D-1, D-2, D-3, and D-4 list the telephone and operator features that can be assigned to 
telephones or consoles either through centralized telephone programming or by users from their 
telephones.

Pressing the Conf, Transfer, Speaker, or Feature button while activating a feature 
cancels the process. Pressing any other button (such as the Mute, HFAI, Message 
Status, DSS Page, Right and Left arrows, More, Message or Clock button) does not 
cancel the feature activating process
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Table D-1. Telephone and Operator Features for MLX Telephones

Feature Prog Code Feature Code
2-Line 
Display 7-Line Display

MLX-
5D/10D

MLX-
28D

MLX-
20L

MLX-
5/10

Account Code Entry *82 82 + code Acct AccountCode K P B K P B K P B

Alarm1 *759 Alarm Alarm K P B K P B

Alarm Clock AlClk Alarm Clock K P B K P B K P B

Authorization Code *80 80 Auth Auth Code K P B K P B K P B K P B 

Auto Dial 
Inside (ext., group, 
zone)
Outside

*22 + ext. no. 
*21 + tel. no. 

AutoD 
In 

Out 

Auto Dial 
Inside 

Outside 

K P B K P B K P B K P B 

Automatic Line 
Selection

Begin Sequence 
End Sequence

*14 
**14 

K P B K P B K P B K P B 

Barge-ln1,2 *58 Barge Barge In K P B K P B K P B K P B 

Call Waiting
On
Off

Call Waiting Pickup

*11 
**11 

87 

CWait 
On 
Off 

CallWaiting 
On 
Off 

K P B K P B K P B K P B

Callback 
Automatic

On
Off

Selective
Cancel Selective

*12 
**12 
*55 55 

*55 

CbckA 
On 
Off 
CbckS 

Cback Auto 
On 
Off 
Cback Sel 

K P B K P B K P B K P B

Caller ID Number/
Name Toggle Button

*763 763 CName CallID Name K P B K P B K P B K P B

Camp-On *57 57 Camp Camp On K P B K P B K P B K P B 
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Conference *772 772 Conf Conference B  B  B  B 

Contrast Ctrst K P B K P B K P B

Coverage
Cover inside and 
outside calls
Cover outside 
calls only

Receiver Buttons
Group
Primary
Secondary

Sender Buttons
Coverage Off
Coverage VMS 
Off

*48 

**48 

*42 + ext. no.
*40 + ext. no.
*41 + ext. no.

*49 
*46 

Cover 
CvIns, On 

CvIns, Off 

Group 
Prmry 
Secnd 

CvOff 

Coverage 
CoverInside, 
On 
CoverInside, 
Off 

Group 
Primary 
Secondary 

CoverageOff 

K P B

K P B
K P B
K P B

K P B
K P B

K P B

K P B
K P B
K P B

K P B
K P B

K P B

K P B
K P B
K P B

K P B
K P B

K P B 

K P B
K P B
K P B

K P B
K P B

Data Status *83 + ext. no. K P B K P B K P B K P B  

Direct Voice Mail *56 56 DrcVM Direct VM K P K P K P K P  

Directories 
Extension Directory 

Personal Directory 
System Directory 

(display only)
(display only)
(sys. prog.)

Dir 
ExtDir 

SysDir 

Directory 
Ext Dir 

Personal Dir
System Dir 

K P B

K P B

K P B

K P B

K P B

K P B
K P B

Do Not Disturb *47 DND DoNotDistrb K P B K P B K P B K P B

Drop *773 773 Drop Drop B  B  B  B  

Table D-1. Telephone and Operator Features for MLX Telephones — Continued

Feature Prog Code Feature Code
2-Line 
Display 7-Line Display

MLX-
5D/10D

MLX-
28D

MLX-
20L

MLX-
5/10
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Extension Status
Direct-Line 
Console1

Status Off

Status 1

Status 2

Telephones
(rooms or agents)

Status Off
Status 1 

Status 2 

*760 

*761 

*762 

*45 

*44 

760 + DSS 
button
761 + DSS 
button
762 + DSS
button

*44 
45 

44 

OpEs, 
ESOff 
OpEs, ES1 

OpEs, ES2 

ES, ES1 

ES, ES2 

OperatorES, 
ESOff 
OperatorES, 
ES1 
OperatorES, 
ES2 

ES Status, 
ES1 
ES Status, 
ES2 

K P B

K P B

K P B

K P B

K P B K P B

Feature Button *20 Feature Btn 

Table D-1. Telephone and Operator Features for MLX Telephones — Continued

Feature Prog Code Feature Code
2-Line 
Display 7-Line Display

MLX-
5D/10D

MLX-
28D

MLX-
20L

MLX-
5/10
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Forward and Follow 
Me

Activate 
Forward (inside) 
Remote Call 
Forward (outside) 
Centrex Transfer 
via Remote Call 
Forward

Follow Me

Cancel
Cancel sending 
from your 
telephone 
Cancel sending 
from one 
extension
Cancel sending 
from all 
extensions

*33 
*33 

*33 + dial-out 
code or * + 
optional 
Pauses + tel. 
no. + # 

33 + ext. no.
33 + tel no.

34 + sending 
ext. no.

33 + your ext. 
no.

*34 + ext. no.

*34* 

Forwd 
Forwd 

FlwMe 

Forward 
Forward 

Follow Me 

CanclFollow 
(QCC only) 

CanclFollow 
(QCC only)

K P B K P B K P B K P B

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Group Calling
ln-Queue Alarm 
Button

Calling Group 
Supervisor1

Enter supervisor 
mode1

Exit supervisor 
mode1

Available 
(ES Status 2)
Unavailable 
(ES Status Off)

Calling Group 
Members

Sign in (Available) 
Sign out 
(Unavailable)

*22 + Calling 
Group ext. 
no.

*762 

*760 

*44 

32 + Hold

32 + Drop

762 + DSS bt.

760 + DSS bt.

44 
*44 

GrpCl 

OpEs, ES2 

OpEs, 
ESOff 

ES 
ES,Off 

Group Call 

OperatorES, 
ES2 
OperatorES, 
ES Off 

Status, ES2 
ES Status, ES 
Off 

K P B

K P B

K P B

K P B

K P B

K P B

K P B

K P B

K P B

K P B

Group Page Auto Dial 
Button

*22 + Paging 
Group ext. 
no.

GrpPg Group Page K P B K P B K P B K P B

Headset Options
Auto Answer 
Hang Up2

Mute (Headset/
Handset) 
Status 

*780 
*781 
*783 

*782 

Hdset 
Auto 

Mute 

Stat 

Hdset 
Auto Answer 
Hang Up 
Mute 

Status 

K P B K P B K P B K P B

Hold
Hold Release

771 
** 

P B
B

P B
B

P B
B

P B
B

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Intercom Buttons
Assign Buttons2

ICOM (Default 
Ring) 
ICOM Originate 
Only 

Change Button 
Type

Ring

Voice 

*16 

*18 

**19 

*19 

Voice, 
Place, Ring 
Voice, 
Place, 
Voice 

SysAccess 

SysAcc-00 

Voice Annce, 
Place,Ring

Voice Annce, 
Place,Voice 

K B  K B K B K B  

Language Choice
English
French
Spanish

790 
791 
792 

K P B K P B K P B K P B

Messaging
Leave Message

After calling
Without calling
Cancel msg. left

Message LED Off
Posted Message
Send/Remove 
Msg1

Receiving Messages
Delete Message3

Next Message3

Return Call3

Scroll3

*25 

*54 
*751 
*38 

*26 
*28 
*27 
*29 

25 
53 + ext no.
*53 + ext no.
54 

38 + ext no.

26 
28 
27 
29 

Msgs 
LvMsg 

Post 
SdMsg 

Msgs 
Dlete 
Next 
Call 

Messages 
Msg Leave 

Posted Msg 
Send/RmvMsg 

Messages 
Delete Msg 
Next Msg 
Return Call 

K P B

K P B
K P B

K P B
K P B
K P B

K P B

K P B
K P B

K P B
K P B
K P B
K P B

K P B

K P B
K P B

K P B
K P B
K P B
K P B

K P B

K P B
K P B

Night Service1 *39 39 Night Night Srvc K P B K P B

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Notify
Send

Receive

*757 + ext. 
no.
*758 + ext. 
no.

Ntfy 
Send 

Recv 

Notify 
Send 

Receive 

K P B K P B K P B K P B

Paging
Group Paging
Loudspeaker 
Paging

GrpPg 
LdsPg 

Group Page 
Loudspkr Pg 

K P B K P B K P B K P B

Park *86 Park Park K P B K P B K P B K P B

Park Zone Auto Dial1 *22 + Park 
Zone

PrkZn Park Zone K P B K P B

Personal Speed Dial # + (01–24) +
*21 + tel no.
+ ## 

  K P B K P B

Personalized Ringing *32 + ring
(1–8)

PRing, 
Pat#1...
Pat#8 

PersonalRng,
Pattern #1...
Pattern #8 

K P B K P B K P B K P B

Pickup
General Use
Specific Extension
Specific Line
Group

*9 
*9 + ext. no.
*9 + line no.
*88 

9 + ext. no.
9 + line no.
88 

Pkup 
Genrl 
Ext 
Line 
PkupG 

Pickup 
General 
Extension 
Line 
Pickup Grp 

K P B K P B K P B K P B

Privacy
On
Off

*31 31 
*31 

Prvcy Privacy K P B K P B K P B K P B

Recall *775 775 Recll Recall K P B K P B K P B K P B

Redial *84 84 Rdial Redial K P B K P B K P B K P B 

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Reminder Service
Set4

Operator Set1,4

Cancel
Operator Cancel1

Missed1

*81 

**81 

*752 

81 + time + A 
or P 
81 + ext. no.+ 
time + A or P 
*81 
*81 + ext. no.

Rmind 
Set 

Cancl 

Missd 

Reminder 
Set 

Cancel 

Missed 

K P B K P B K P B K P B

Ringing/Idle Line 
Preference

On

Off

*343 

*344 

LnPrf, On 

LnPrf, Off 

Line Prefer, 
On 
Line Prefer, 
Off 

K P B K P B K P B K P B

Ringing Options
Individual Lines

Immediate ring
Delay ring
No ring

All Lines
Immediate ring
Delay ring
No ring

Abbreviated Ring
On
Off

Send Ring 
(Shared SA)

On
Off

*37 
*36 
*35 

*347 
*346 
*345 

*341 
*342 

*15 
**15 

RngOp 
1Line 
Immed 
Delay 
No 
AllLn 
Immed 
Delay 
No 
Abbrv 
On 
Off 
ShRng 

On 
Off 

RingOptions 
One Line 
Immed Ring 
Delay Ring 
No Ring 
All Lines 
Immed Ring 
Delay Ring 
No Ring 
Abbreviated 
On 
Off 
SharedSARng 

On 
Off 

K P B

K P B

K P B

P

K P B

K P B

K P B

P

K P B

K P B

K P B

P

K P B

K P B

K P B

P

Saved Number Dial *85 Save# SaveNumDial K P B K P B K P B K P B

Service Observing2 *59  Service Obs K P B K P B K P B K P B

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Signal (manual) *23 + ext. no. Signl Signal K P B K P B K P B K P B

System Access 
Buttons

Assign Buttons2

SA (Default Ring) 
SA Originate Only
Shared SA

Change Type (SA 
or Shared SA)

Ring 
Voice 

*16 
*18 
*17 + primary 
ext. no. 

**19 
*19 

SysAccess 
SysAcc-00 
ShareSysAcc 

 P P P P

System Speed Dial *24 + code
(600-729)

600-729 SpdDl SysSpeedDl K P B K P B K P B K P B 

Transfer *774 774 Trans Transfer B  B  B  B  

Voice Announce 
On 
Off 
VA on Idle Only

*10 
**10 
*131 

Voice 
On 
Off 
Idle 

Voice Annce 
On 
Off 
Idle 

K P B K P B K P B K P B 

1 System operator feature only.

2 Centralized telephone programming only.

3 Display telephones only.

4 U.S. English only: time is 12-hour (0100–1259) + 2 (A) or 7 (P). Canadian French and Latin American Spanish: time is 24-hour (0000–2359).

Table D-1. Telephone and Operator Features for MLX Telephones — Continued
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Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones

Feature Prog Code
Feature 
Code

2-Line 
Display 7-Line Display 4406D+1

4412D+, 
4424D+ 4424LD+

Account Code Entry *82 82 + code Acct AccountCode K P B K P B K P B

Alarm2 *759 Alarm Alarm K P B K P B

Alarm Clock AlClk Alarm Clock K P B K P B K P B

Authorization Code *80 80 Auth Auth Code K P B K P B K P B 

Auto Dial 
Inside (ext., group, 
zone)
Outside

*22 + ext. no. 

*21 + tel. no. 

AutoD 
In 

Out 

Auto Dial 
Inside 

Outside 

K P B K P B K P B

Automatic Line Selection 
Begin Sequence 
End Sequence

*14 
**14 

K P B K P B K P B

Barge-ln2,3 *58 Barge Barge In K P B K P B K P B

Call Waiting
On
Off

Call Waiting Pickup

*11 
**11 

87 

CWait 
On 
Off 

CallWaiting 
On 
Off 

K P B K P B K P B

Callback 
Automatic

On
Off

Selective
Cancel Selective

*12 
**12 
*55 55 

*55 

CbckA 
On 
Off 
CbckS 

Cback Auto 
On 
Off 
Cback Sel 

K P B K P B K P B

Caller ID Number/
Name Toggle Button

*763 763 CName CallID Name K P B K P B K P B

Camp-On *57 57 Camp Camp On K P B K P B K P B

Conference *772 772 Conf Conference B  B  B
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Coverage
Cover inside and 
outside calls
Cover outside calls 
only

Receiver Buttons
Group
Primary
Secondary

Sender Buttons
Coverage Off
Coverage VMS Off

*48 

**48 

*42 + ext. no.
*40 + ext. no.
*41 + ext. no.

*49 
*46 

Cover 
CvIns, On 

CvIns, Off 

Group 
Prmry 
Secnd 

CvOff 

Coverage 
CoverInside, 
On 
CoverInside, 
Off 

Group 
Primary 
Secondary 

CoverageOff 

K P B

K P B
K P B
K P B

K P B
K P B

K P B

K P B
K P B
K P B

K P B
K P B

K P B

K P B
K P B
K P B

K P B
K P B

Direct Voice Mail *56 56 DrcVM Direct VM K P K P K P

Directories 
Extension Directory 
Personal Directory 
System Directory 

(display only)
(display only)
(sys. prog.)

Dir 
ExtDir 

SysDir 

Directory 
Ext Dir 
Personal Dir 
System Dir 

K P B

K P B

K P B

K P B

K P B
K P B
K P B

Do Not Disturb *47 DND DoNotDistrb K P B K P B K P B

Drop
4400-Series Drop

*771 
*787 

771 
787 

Drop 
44Drp 

Drop 
4400-Series 
Drop 

B
K P B

 B
K P B

 B
K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued

Feature Prog Code
Feature 
Code

2-Line 
Display 7-Line Display 4406D+1

4412D+, 
4424D+ 4424LD+
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Extension Status
Direct-Line 
Console2

Status Off

Status 1

Status 2

Telephones
(rooms or agents)

Status Off
Status 1 
Status 2 

*760 

*761 

*762 

*45 
*44 

760 + DSS 
button
761 + DSS 
button
762 + DSS
button

*44 
45 
44 

OpEs, 
ESOff 
OpEs, ES1 

OpEs, ES2 

ES, ES1 
ES, ES2 

OperatorES, 
ESOff 
OperatorES, 
ES1 
OperatorES, 
ES2 

ES Status, ES1 
ES Status, ES2 

K P B

K P B

K P B

K P B

K P B

Feature Button *20 20 Feat Feature K P B K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued

Feature Prog Code
Feature 
Code
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Display 7-Line Display 4406D+1

4412D+, 
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Forward and Follow 
Me

Activate 
Forward (inside) 
Remote Call 
Forward (outside) 
Centrex Transfer 
via Remote Call 
Forward

Follow Me

Cancel
Cancel sending 
from your 
telephone 
Cancel sending 
from one extension
Cancel sending 
from all extensions

*33 
*33 

*33 + dial-out 
code or * + 
optional 
Pauses + tel. 
no. + # 

33 + ext. no.
33 + tel no.

34 + ext. no.

33 + your 
ext. no.

*34 + ext. 
no.
*34* 

Forwd 
Forwd 

FlwMe 

Forward 
Forward 

Follow Me 

CanclFollow 
(QCC only) 

CanclFollow 
(QCC only)

K P B K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued

Feature Prog Code
Feature 
Code
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Display 7-Line Display 4406D+1

4412D+, 
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Group Calling
ln-Queue Alarm 
Button

Calling Group 
Supervisor2

Enter supervisor 
mode2

Exit supervisor 
mode2

Available 
(ES Status 2)
Unavailable 
(ES Status Off)

Calling Group 
Members

Sign in (Available) 
Sign out 
(Unavailable) 

*22 + Calling 
Group ext. no.

*762

*760

*44

32 + Hold

32 + Drop

762 + DSS 
button
760 + DSS 
button

44 
*44 

GrpCl 

OpEs, ES2 

OpEs, 
ESOff 

ES 
ES,Off 

Group Call 

OperatorES, 
ES2 
OperatorES, ES 
Off 

Status, ES2 
ES Status, ES 
Off 

K P B

K P B

K P B

K P B

K P B

K P B

K P B

K P B

Group Page Auto Dial 
Button

*22 + Paging 
Group ext. no.

GrpPg Group Page K P B K P B K P B

Headset Options
Auto Answer 
Hang Up3

Mute (Headset/
Handset) 
Status 

*780 
*781 
*783 

*782 

Hdset 
Auto 

Mute 

Stat 

Hdset 
Auto Answer 
Hang Up 
Mute 

Status 

K P B K P B K P B

HFAI Button *779 779 HFAI HFAI K P B K P B K P B

Hold
Hold Release

771 
** 

B
B

B
B

B
B

Inspect Button *778 778 Insp Inspect K P B K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued
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Intercom Buttons
Assign Buttons3

ICOM (Default 
Ring) 
ICOM Originate 
Only 

Change Button type
Ring

Voice 

*16 

*18 

**19 

*19 

Voice, 
Place, 
Ring 
Voice, 
Place, 
Voice 

SysAccess 

SysAcc-00 

Voice Annce, 
Place,Ring 

Voice Annce, 
Place,Voice 

K B  K B K B

Language Choice
English
French
Spanish

790 
791 
792 

K P B K P B K P B

Messaging
Leave Message

After calling
Without calling
Cancel msg. left

Message LED Off
Posted Message
Send/Remove Msg2

Receiving Messages
Delete Message
Next Message
Return Call
Scroll

*25 

*54 
*751 
*38 

*26 
*28 
*27 
*29 

25 
53 + ext no.
*53 + ext 
no.
54 

38 + ext no.

26 
28 
27 
29 

Msgs 

LvMsg 

Post 
SdMsg 

Msgs 
Dlete 
Next 
Call 

Messages 

Msg Leave 

Posted Msg 
Send/RmvMsg 

Messages 
Delete Msg 
Next Msg 
Return Call 

K P B

K P B
K P B

K P B
K P B
K P B

K P B

K P B
K P B

K P B
K P B
K P B
K P B

K P B

K P B
K P B

K P B
K P B
K P B
K P B

Night Service2 *39 39 Night Night Srvc K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued
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Notify
Send

Receive

*757 + ext. 
no.
*758 + ext. 
no.

Ntfy 
Send 

Recv 

Notify 
Send 

Receive 

K P B K P B K P B

Paging
Group Paging
Loudspeaker 
Paging

GrpPg 
LdsPg 

Group Page 
Loudspkr Pg 

K P B K P B K P B

Park *86 Park Park K P B K P B K P B

Park Zone Auto Dial2 *22 + Park 
Zone 

PrkZn Park Zone K P B K P B

Personal Speed Dial # + (01–24) +
*21 + tel no.
+ ## 

  K P B

Personalized Ringing *32 + ring
(1–8)

PRing, 
Pat# 1 
...Pat#8 

PersonalRng,
Pattern # 1 
...Pattern #8 

K P B K P B K P B

Pickup
General Use
Specific Extension
Specific Line
Group

*9 
*9 + ext. no.
*9 + line no.
*88 

9 + ext. no.
9 + line no.
88 

Pkup 
Genrl 
Ext 
Line 
PkupG 

Pickup 
General 
Extension 
Line 
Pickup Grp 

K P B K P B K P B

Privacy
On
Off

*31 31 
*31 

Prvcy Privacy K P B K P B K P B

Recall *775 775 Recll Recall K P B K P B K P B

Redial *84 84 Rdial Redial K P B K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued
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Reminder Service
Set4

Operator Set2,5

Cancel
Operator Cancel2

Missed2

*81 

**81 

*752 

81 + time + 
A or P 
81 + ext. 
no.+ time + 
A or P 
*81 
*81 + ext. 
no.

Rmind 
Set 

Cancl 

Missd 

Reminder 
Set 

Cancel 

Missed 

K P B K P B K P B

Ringing/Idle Line 
Preference

On

Off

*343 

*344 

LnPrf, On 

LnPrf, Off 

Line Prefer, 
On 
Line Prefer, 
Off 

K P B K P B K P B

Ringing Options
Individual Lines

Immediate ring
Delay ring
No ring

All Lines
Immediate ring
Delay ring
No ring

Abbreviated Ring
On
Off

Send Ring 
(Shared SA)

On
Off

*37 
*36 
*35 

*347 
*346 
*345 

*341 
*342 

*15 
**15 

RngOp 
1Line 
Immed 
Delay 
No 
AllLn 
Immed 
Delay 
No 
Abbrv 
On 
Off 
ShRng 

On 
Off 

RingOptions 
One Line 
Immed Ring 
Delay Ring 
No Ring 
All Lines 
Immed Ring 
Delay Ring 
No Ring 
Abbreviated 
On 
Off 
SharedSARng 

On 
Off 

K P B

K P B

K P B

P

K P B

K P B

K P B

P

K P B

K P B

K P B

P

Saved Number Dial *85 Save# SaveNumDial K P B K P B K P B

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued

Feature Prog Code
Feature 
Code

2-Line 
Display 7-Line Display 4406D+1

4412D+, 
4424D+ 4424LD+
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Service Observing3 *59  Service Obs K P B K P B K P B

Signal (manual) *23 + ext. no. Signl Signal K P B K P B K P B

System Access 
Buttons

Assign Buttons3

SA (Default Ring) 
SA Originate Only
Shared SA

Change type (SA or 
Shared SA)

Ring 
Voice 

*16 
*18 
*17 + primary 
ext. no. 

**19 
*19 

SysAccess 
SysAcc-00 
ShareSysAcc 

 P P P

System Speed Dial *24 + code
(600-729)

600-729 SpdDl SysSpeedDl K P B K P B K P B 

Transfer *774 774 Trans Transfer B  B  B

Voice Announce 
On 
Off 

*10 
**10 

Voice 
On 
Off 

Voice Annce 
On 
Off 

K P B K P B K P B

1 You cannot select features from the display of a 4406D+ telephone.

2 System operator feature only.

3 Centralized telephone programming only.

4 U.S. English only: time is 12-hour (0100–1259) + 2 (A) or 7 (P). French and Spanish: time is 24-hour (0000–2359).

Table D-2. Telephone and Operator Features for Multiline 4400-Series Telephones — Continued

Feature Prog Code
Feature 
Code

2-Line 
Display 7-Line Display 4406D+1

4412D+, 
4424D+ 4424LD+
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Table D-3. Telephone Features for 4400, 4400D, and Single-Line Telephones

Feature Prog Code
Feature 
Code

4400, 
4400D1 Single-Line

Account Code Entry *82 82 + code K P B K P

Authorization Code *80 80 K P B K P B 

Call Waiting
On
Off

Call Waiting Pickup

*11 
**11 

87 

K P B K P B

Callback
Automatic

On
Off

Selective
Cancel Selective

*12 
**12 
*55 55 

*55 

K P B K P B

Caller ID Name2 *763 763 K P B N/A

Camp-On *57 57 K P B K P B 

Conference *772 772 B  B 

Coverage
Cover inside and 
outside calls
Cover outside calls 
only

Receiver Buttons
Group
Primary
Secondary

K P B

K P B
K P B
K P B

K P B 

K P B
K P B
K P B

Direct Voice Mail *56 56 K P K P  

Directories 
System Directory (sys. prog.) K P B K P B

Extension Status
Telephones
(rooms or agents)

Status Off
Status 1 
Status 2 

*44 
45 
44 

K P B K P B
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Forward and Follow Me
Activate 

Forward (inside) 
Remote Call 
Forward (outside) 
 Centrex Transfer   

via Remote Call
 Forward

Follow Me

Cancel
Cancel sending 
from your telephone 
Cancel sending 
from one extension
Cancel sending 
from all extensions

*33 + dial-out code 
or * + optional 
Pauses + tel. no. + 
# 

33 + ext. no.
33 + tel no.

34 + ext. no.

33 + your ext. 
no.
*34 + ext. no.

*34* 

K P B K P B

Group Calling
Calling Group 
Members

Sign in (Available) 
Sign out 
(Unavailable)

44 
*44 
45 

K P B K P B

Hold
Hold release

771 
** 

P B
P B

P B
P B

Paging
Group Paging
Loudspeaker Paging

K P B K P B

Park  4400 and single-
line: Recall or Flash 
+ your ext.
4400D: Trnsfr + 
your ext. + Trnsfr

K P B K P B

Personal Speed Dial # + (01–24) +
*21 + tel no.
+ ## 

K P B K P B

Pickup
General Use
Specific Extension
Specific Line
Group

9 + ext. no.
9 + line no.
88 

K P B K P B

Privacy
On
Off

31 
*31 

K P B K P B

Table D-3. Telephone Features for 4400, 4400D, and Single-Line Telephones — Continued

Feature Prog Code
Feature 
Code

4400, 
4400D1 Single-Line
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Recall 775 K P B K P B

Redial 84 K P B K P B 

Reminder Service
Set3

Cancel

81 + time + A 
or P 
*81 

K P B K P B

Ringing/Idle Line 
Preference

On
Off

*343 
*344 

K P B K P B

Ringing Options
Individual lines

Immediate ring
Delay ring
No ring

*37 
*36 
*35 

K P B K P B

System Speed Dial 600-729 K P B K P B 

Transfer 774 B  B  
1 You cannot select a feature from the display of a 4400D telephone.

2 4400D telephone only.

3 U.S.English only: time is 12-hour (0100–1259) + 2 (A) or 7 (P). French and Spanish: time is 24-hour (0000–2359).

Table D-3. Telephone Features for 4400, 4400D, and Single-Line Telephones — Continued

Feature Prog Code
Feature 
Code

4400, 
4400D1 Single-Line
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Table D-4. Telephone Features for ETR and MLS Telephones

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS

Account Code Entry *82 82 + code Acct: Acct? K P B K P B

Authorization Code *80 80 Auth: Auth? K P B K P B 

Auto Dial 
Inside (ext., group, zone)
Outside

*22 + ext. no.
*21 + tel. no.

Inside 
Outside 

 
Auto Dial Inside 
Outside 

K P B K P B 

Automatic Line Selection 
Begin Sequence
End Sequence

*14 
**14 

K P B K P B 

Barge-ln1 *58 Barge In K P B K P B 

Callback
Automatic

On
Off

Selective

*12 
**12 
*55 55 

Cbck Auto 
On 
Off 
Cback Sel 

AutoCallback On 
AutoCallback Off 
Callback Sel 

K P B K P B

Call Waiting
On
Off

Call Waiting Pickup

*11 
**11 

87 

CallWaiting 
On 
Off 

Call Waiting On 
Call Waiting Off 

K P B K P B

Caller ID Number/Name 
Toggle Button

*763 763 Caller’s number/
name

Caller’s number/name K P B K P B

Camp-On *57 57 Camp On Camp On K P B K P B 

Conference *772 772   B  B 

Contrast2  N/A
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Coverage
Cover Inside and 
Outside Calls
Cover Outside Calls 
only
Receiver Buttons

Group
Primary
Secondary

Sender Buttons
Coverage Off
Coverage VMS Off

*48 

**48 

*42 + ext. no.
*40 + ext. no.
*41 + ext. no.

*49 
*46 

Coverage 
On 

Off 

Group 
Primary 
Secondary 

Coverage Off
Coverage VMS 

Coverage 
Cover Inside On 

Cover Inside Off 

GroupCov 
PrmryCov 
SecndCov 

Coverage Off
Coverage VMS 

K P B

K P B
K P B
K P B

K P B
K P B

K P B 

K P B
K P B
K P B

K P B
K P B

Data Status *83 + ext. no. Data Status Data Status K P B K P B  

Direct Voice Mail *56 56 Direct VM Direct VoiceMail K P B K P B

Do Not Disturb *47 DoNotDistrb DO NOT DISTURB K P B K P B

Drop
ETR Drop Button

*773 
*777 

773 
777 

 
ETR Drop 

B
K P B

B 
K P B

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS
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Forward and Follow Me
Activate 

Forward (inside) 
Remote Call Forward 
(outside) 
 Centrex Transfer via 
Remote Call Forward

Follow Me
Cancel

Cancel sending from 
your telephone 
Cancel sending from 
one extension
Cancel sending from 
all extensions

*33 
*33 

*33 + dial-out 
code or * + 
optional Pauses 
+ tel. no. + # 

33 + ext. no.
33 + tel no.

34 + ext. no.

33 + your ext. 
no.
*34 + ext. no.

*34* 

Forward 
Forward 

Forward 
Forward 

K P B K P B

Group Calling
ln-Queue Alarm button

Calling Group 
Members

Sign in (Available) 
Sign out (Unavailable)

*22 + Calling 
Group ext. no.

*44 44 
*44 

Group Call 

ES2 
ES1 

Group Call 

ES2 
ES1 

K P B

K P B
K P B

K P B

K P B
K P B

Group Page Auto Dial 
Button

*22 + Paging 
Group ext. no.

Group Page Group Page K P B K P B

Hold
Hold Release

771 
** 

B
B

B
B

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS



M
E

R
L

IN
 M

A
G

IX
™

 Integrated S
ystem

 R
elease 1.0

S
ystem

 P
rogram

ing  
555-710-111  

Issue 1
O

ctober 1999
G

eneral F
eature U

se and T
elephone P

rogram
m

ing 
D

-28
T

elephone and O
perator F

eatures 
D

Intercom Buttons
Assign Buttons2

ICOM (Default Ring) 
ICOM Originate Only 

Change Button Type
Ring
Voice 

*16 
*18 

**19 
*19 

SysAccess 
SysAcc-00 

Place; Ring 
Place; Voice 

SysAccess 
SysAcc-00 

Place Ring Calls 
Place Voice Calls 

K P B K P B  

Language Choice
English
French
Spanish

790 
791 
792 

K P B K P B

Messaging
Leave Message

After calling
Without calling
Cancel msg. left

Message LED Off (non-
display telephones)
Message Operation 
Mode (display 
telephones)3

Posted Message
Receiving Messages

Delete Message4

Next Message4

Return Call4

Scroll4

*25 

*54 

*54

*751 

*26 
*28 
*27 

*29 

25 
53 + ext no.
*53 + ext no.
54 

54 

26 
28 
27 

29 

Msg Leave 

Msg Lamp 

Posted Msg 

Msg Delete 
Msg Next 
Msg RtnCall 

Msg Scroll 

Leave Message 
Msg Leave 

Message Lamp 

Posted Message 

Delete Message 
Next Message 
Message Return 
call 
Scroll Message 

K P B
K P B
K P B
K P B
K P B

K P B

K P B

K P B
K P B
K P B

K P B

K P B
K P B
K P B
K P B
K P B

K P B

K P B

K P B
K P B
K P B

K P B

Notify
Send
Receive

*757 + ext. no.
*758 + ext. no.

Notify 
Send 
Receive 

 
Notify Send 
Notify Recv 

K P B K P B

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS
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Paging
Group Paging
Loudspeaker Paging

Group Page 
K P B K P B

Park *86 Park K P B K P B

Personal Speed Dial # + (01–24) + 
*21 + tel no. + 
## 

PersSpeedDl PersSpeedDial K P B K P B

Personalized Ringing *32 + ring (1–8) PersonalRng Personal Ring K P B K P B

Pickup
General Use
Specific Extension
Specific Line
Group

*9 
*9 + ext. no.
*9 + line no.
*88 

9 + ext. no.
9 + line no.
88 

Pickup 
General 
Extension 
Line 
Group 

Pickup 
Pickup General 
Pickup Ext. 
Pickup Line 
Pickup Group 

K P B K P B

Privacy
On
Off

*31 31 
*31 

Privacy Privacy K P B K P B

Recall *775 775 Recall Recall K P B K P B

Redial *84 84 Rdial Redial K P B K P B 

Reminder Service
Set5

Cancel

*81 

**81 

81 + time + 
A or P 
*81 

Reminder 
Set 

Cancel 

Reminder 
Reminder Set 

Reminder Cancel 

K P B K P B

Ringing/Idle Line 
Preference

On
Off

*343 
*344 

Line Prefer 
On 
Off 

LinePreferenceOn 
LinePreferenceOff 

K P B K P B

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS
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Ringing Options
Individual Lines6

Immediate ring
Delay ring
No ring

All Lines
Immediate ring
Delay ring
No ring

Abbreviated Ring
On
Off

Send Ring 
(Shared SA)

On
Off

*37 
*36 
*35 

*347 
*346 
*345 

*341 
*342 

*15 
**15 

RingOptions 
One Line 
Immed Ring 
Delay Ring 
No Ring 
All Lines 
Immed Ring 
Delay Ring 
No Ring 
Abbreviated 
On 
Off 
SharedSARng 

On 
Off 

RingOptions 

Immed Ring 
Delay Ring 
No Ring 

All Lines - I 
All Lines - D 
All Lines - N 

AbbreviatedRngOn 
AbbreviatedRngOff 

SharedSA Rng On 
SharedSA Rng Off 

K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
P

P
P

K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
K P B
P

P
P

Saved Number Dial *85 SaveNumDial Save Number Dial K P B K P B

Signal (manual) *23 + ext. no. Signal Signal K P B K P B

System Access Buttons
Assign Buttons2

SA (Default Ring) 
SA Originate Only
Shared SA

Change Type (SA or 
Shared SA)

Ring 
Voice 

*16 
*18 
*17 + primary 
ext. no. 

**19 
*19 

SysAccess 
SysAcc-00 
ShareSysAcc 

Place; Ring 
Place; Voice 

SysAccess 
SysAcc-00 
ShareSysAcc 

Place Ring Calls 
Place Voice Calls 

P

P
P
P

K P B
K P B

P

P
P
P

K P B
K P B

System Speed Dial *24 + code
(600-729)

600-729 SysSpeedDl SysSpeedDial K P B K P B 

Transfer *774 774 Trans B B 

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS
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Voice Announce
On 
Off 

*10 
**10 

Voice Annce 
Receive; On 
Receive; Off 

Voice Annce 
RecvVoiceAnn On 
RecvVoiceAnn Off 

K P B K P B 

1 Centralized telephone programming only.

2 Press the * button and use the volume up and down key; for ETR telephones only.

3 For 4406D+, ETR, and MLS display telephone users, pressing *54 enters/exits Message operation mode. MLS telephones return to normal call handling after 15 
seconds if the user has no messages. If an MLS telephone user has messages, he or she must delete the messages or use the feature code or programmed button 
to exit Message operation. A 4406D+ or ETR telephone user must use the feature code or the programmed button to exit Message operation whether or not he or 
she has messages.

4 Display telephones only. Programming and feature codes are used with analog multiline, ETR, and MLS telephones.

5 U.S. English only: time is 12-hour (0100–1259) + 2 (A) or 7 (P). French and Spanish: time is 24-hour (0000–2359).

6 With Immediate Ring (steady red LED), incoming calls are immediately delivered. With Delay Ring (slow red LED), incoming calls are delayed (default is 2 rings). With 
No Ring (LED off), no calls are delivered.

Table D-4. Telephone Features for ETR and MLS Telephones — Continued

Feature Prog Code Feature Code ETR Display MLS Display ETR MLS
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Telephone Programming 4

The following describes how to program features on multiline 4400-Series, MLX, ETR, and MLS 
telephones. Because Personal Speed Dial is the only feature that 4400, 4400D, and single-line 
telephone users can program, general programming instructions for these telephones are not 
provided.

Programming Methods 4

Telephones can be programmed by dialing programming codes or, on 4412D+, 4424D+, and 
4424LD+ telephones and MLX display telephones, by selecting features from the display. ETR, 
MLS, and 4406D telephones cannot be programmed by selecting features from the display. 

To program a telephone, first enter programming mode:

■ On ETR and MLS telephones, press the Feature button and dial 00.

■ On MLX-10 and MLX-5 nondisplay telephones, press the Feature button and dial 00.

■ On MLX display telephones, press the Feature button and dial 00, or enter programming 
mode by pressing the menu button for Ext Program [Prog] from the menu screen on the 
display.

■ On 4406D+ telephones, go off-hook and dial #00.

■ On 4412D+, 4424D+, and 4424LD+ telephones, use the same procedure as for the 4406D+ 
telephones, or enter programming mode by pressing the menu button for Ext Program 
[Prog] from the menu screen on the display.

■ On TransTalk MDW 9000 telephones, press the imprinted Feat button and dial 00.

■ On Business Cordless 905, press SHIFT + PROG.

See the appropriate user or operator guide for more information.

Features cannot be programmed on QCCs in system operator positions. Features 
assigned to these consoles are fixed and cannot be changed.

Features can also be programmed onto individual telephones through centralized 
telephone programming. The steps for using programming codes vary, depending on the 
telephone. Tables D-7 through D-10 list the basic steps for programming each telephone 
type.
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Table D-5. Programming 4406D+ Telephones

Step Action

1 Label the button. 

➤NOTE:
Skip this step if the feature is 
not programmed on a button.

Remove the clear label cover from the telephone.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Lift the receiver, and dial #00. 

3 Select the feature or setting. Press the button you labeled.

➤NOTE:
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

Dial the programming code.

The feature is programmed. 

4 End programming. Dial #*00, or hang up.

Table D-6. Programming 4412D+, 4424D+, and 4424LD+ Telephones by Using the 
Display

Step Action

1 Label the button to be 
programmed.

➤NOTE:
Skip this step if the feature 
will not be programmed onto 
a button.

Remove the clear label cover from the telephone.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Press Menu.

Select Ext Program [Prog] from the display.

Select Start from the display.
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3 Identify the button to be 
programmed.

To delete the features currently 
programmed on the button:

Press the button you labeled.

➤NOTE:
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

The display identifies the feature currently programmed on 
the button. If no feature is programmed, the display indicates 
that the button is blank. 

Select Delete [Dlete] from the display. 

The button is now blank.

Press the button you labeled again to continue 
programming.

➤NOTE:
If the currently programmed feature was not deleted from 
the button, the new feature programmed onto it will 
replace it.

Select List Feature [List] from the display.

The screen lists feature names in alphabetical order. 

4 To display feature, select the 
feature.

If the feature name is on the 
display:

If the feature name is not on the 
display:

To move through the list of
features page by page:

To jump to the screen that 
displays the feature name:

Press the button next to or below the name of the feature to 
be programmed.

Press .

Press .

Select Find Feature [Find] from the display.

Select the range of letters from the display that corresponds 
to the first letter of the feature name (for example, it the 
feature begins with A, select ABC).

If the feature is not displayed on the page that you jumped 
to, press .

When you find the feature you want, press the button next to 
or below it.

Table D-6. Programming 4412D+, 4424D+, and 4424LD+ Telephones by Using the 
Display — Continued

Step Action
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5 Respond to any additional 
prompts on the display.

Select the appropriate prompt (for example, select On or Off 
to turn inside Coverage on or off), and/or enter required 
information (for example, dial a telephone number for Auto 
Dial).

Select Enter. 

6 End programming.

To return to the Home screen:

To return to the Menu screen:

Press Exit or lift and replace the handset.

Press Menu.

You also can program the 4412D+, 4424D+, and 4424LD+ telephones by using the 
method described for the 4406D+ telephones. For example, the programming mode can 
be entered by pressing the programmed Feature button, dialing 00, and then referring to 
the display to continue the programming process. Or you can enter programming by 
using the display and then dialing a programming code to select the feature, rather than 
selecting it from the display.

Table D-6. Programming 4412D+, 4424D+, and 4424LD+ Telephones by Using the 
Display — Continued

Step Action
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Table D-7. Programming MLX-10 and MLX-5 Nondisplay Telephones

Step Action

1 Label the button. 

➤NOTE:
Skip this step if the feature 
will not be programmed onto 
a button.

Remove the clear label cover from the telephone: pull up on 
the tab that extends from the top of the cover.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Press the Feature button, and then dial 00. 

3 Select the feature or setting. Press the button you labeled.

➤NOTE:
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

Dial the programming code.

The feature is programmed. 

4 End programming. Press the Feature button, and dial *00. 

Table D-8. Programming MLX Telephones by Using the Display

Step Action

1 Label the button to be 
programmed.

➤NOTE:
Skip this step if the feature 
will not be programmed onto 
a button.

Remove the clear label cover from the telephone by pulling 
up on the tab that extends from the top of the cover.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Press Menu.

Select Ext Program [Prog] from the display.

Select Start from the display.
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3 Identify the button to be 
programmed.

To delete the features currently 
programmed on the button:

Press the button you labeled.

➤NOTE: 
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

The display identifies the feature currently programmed on 
the button. If no feature is programmed, the display indicates 
that the button is blank. 

Select Delete [Dlete] from the display. 

The button is now blank.

Press the button you labeled again to continue programming.

➤NOTE:
If the currently programmed feature was not deleted from 
the button, the new feature programmed onto it will 
replace it.

Select List Feature [List] from the display.

The screen lists feature names in alphabetical order.

4 To display the feature, select the 
feature.

If the feature name is on the 
display:

If the feature name is not on the 
display:

To move through the list of
features page by page:

To jump to the screen that 
displays the feature name:

Press the button next to or below the name of the feature to 
be programmed.

Press More.

Press More.

Select Find Feature [Find] from the display.

Select the range of letters from the display that corresponds 
to the first letter of the feature name (for example, it the 
feature begins with A, select ABC).

If the feature is not displayed on the page that you jumped to, 
press More.

When you find the feature you want, press the button next to 
or below it.

Table D-8. Programming MLX Telephones by Using the Display — Continued

Step Action
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5 Respond to any additional 
prompts on the display.

Select the appropriate prompt (for example, select On or Off 
to turn inside Coverage on or off), and/or enter required 
information (for example, dial a telephone number for Auto 
Dial).

Select Enter. 

6 End programming.

To return to the Home screen:

To return to the Menu screen:

Press Home or lift and replace the handset.

Press Menu.

You also can program MLX display telephones by using the method described for MLX-
10 and MLX-5 non-display telephones. That is, programming mode can be entered by 
pressing the Feature button, dialing 00, and then referring to the display to continue the 
programming process. Or you can enter programming by using the display and then 
dialing a programming code to select the feature, rather than selecting it from the display.

Table D-9. Programming ETR and MLS Telephones

Step Action

1 Label the button. 

➤NOTE:
Skip this step if the feature is 
not programmed on a button.

Remove the clear label cover from the telephone.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Press the Feature button, and dial 00. 

3 Select the feature or setting. Press the button you labeled.

➤NOTE:
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

Dial the programming code.

The feature is programmed. 

4 End programming. Press the Feature button, and dial *00, or hang up.

Table D-8. Programming MLX Telephones by Using the Display — Continued

Step Action
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Table D-10. Programming TransTalk MDW 9000 Telephones

Step Action

1 Label the button to be
programmed.

➤NOTE:
Skip this step if the feature will 
not be programmed onto a 
button.

Remove the clear label cover from the telephone by pulling 
up on the tab that extends from the top of the cover.

Write the feature name on the card next to the button to be 
programmed.

Replace the cover.

2 Begin programming. Press the imprinted Feat button.

Dial 00.

3 Select the feature or setting. Press the button you labeled.

➤NOTE:
If the feature does not get programmed onto a button, 
press any line button. This does not affect the button in 
any way.

Dial the programming code.

The feature is programmed. 

4 End programming. Press the imprinted Feat button.

Dial 00.
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This appendix contains the button diagrams for Hybrid/PBX, Key, and Behind Switch systems.

4400-Series Telephones 4

Figure E-1. 4412D+, 4424D+, and 4424LD+ Telephones (Hybrid/PBX Mode)

Figure E-2. 4406D+ Telephone (Hybrid/PBX Mode)
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Figure E-3. 4412D+, 4424D+, and 4424LD+ Telephones (Key  and  Behind Switch Modes)

Figure E-4. 4406D+ Telephone (Key and Behind Switch Modes)
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MLX Telephones 4

Figure E-5. MLX-20L and MLX-28D Telephones (Hybrid/PBX Mode)

Figure E-6. MLX-16DP Telephone (Hybrid/PBX Mode)
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Figure E-7. MLX 5- and 10-Button Telephones (Hybrid/PBX Mode)

Figure E-8. MLX-20L and MLX-28D Telephones (Key and Behind Switch Modes)
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Figure E-9. MLX-16DP Telephone (Key and Behind Switch Modes)

Figure E-10. MLX 5- and 10-Button Telephones (Key and Behind Switch Modes)
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ETR and MLS Telephones 4

Figure E-11. ETR-34D Telephone (Hybrid/PBX Mode)

Figure E-12. ETR-18/18D Telephones (Hybrid/PBX Mode)
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Figure E-13. ETR-6 Telephone (Hybrid/PBX Mode)

Figure E-14. MLS-34D Telephone (Hybrid/PBX Mode)

Figure E-15. MLS-18D Telephone (Hybrid/PBX Mode)
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Figure E-16. MLS-12/12D Telephones (Hybrid/PBX Mode)

Figure E-17. MLS-6 Telephone (Hybrid/PBX Mode)
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Figure E-18. ETR-34D Telephone (Key Mode)

Figure E-19. ETR-18/18D Telephones (Key Mode)
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Figure E-20. ETR-6 Telephone (Key Mode)

Figure E-21. MLS-34D Telephone (Key Mode)

Figure E-22. MLS-18D Telephone (Key Mode)
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Figure E-23. MLS-12/12D Telephones (Key Mode)

Figure E-24. MLS-6 Telephone (Key Mode)
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Figure E-25. ETR-34D Telephone (Behind Switch Mode)

Figure E-26. ETR-18/18D Telephone (Behind Switch Mode)
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Figure E-27. ETR-6 Telephone (Behind Switch Mode)

Figure E-28. MLS-34D Telephone (Behind Switch Mode)

Figure E-29. MLS-18D Telephone (Behind Switch Mode)
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Figure E-30. MLS-12/12D (Behind Switch Mode)

Figure E-31. MLS-6 Telephone (Behind Switch Mode)
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TransTalk MDW 9031 Telephone 4

Figure E-32. TransTalk MDW 9031 Telephone (Hybrid/PBX Mode)

Figure E-33. TransTalk MDW 9031 Telephone (Key Mode)

Figure E-34. TransTalk MDW 9031 Telephone (Behind Switch Mode)
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Business Cordless 905 Telephone 4

Figure E-35. Business Cordless 905 Telephone (Hybrid/PBX Mode)

Figure E-36. Business Cordless 905 Telephone (Hybrid/PBX Mode)

Figure E-37. Business Cordless 905 Telephone (Hybrid/PBX Mode)
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This appendix includes samples of the print reports generated by the system. Table F-1 lists the 
system reports and the pages in this appendix where samples can be found.

The system’s Station Message Detail Recording (SMDR) feature reports incoming and 
outgoing call details

Table F-1. Sample Report Pages

For... See...

System Information Report F-6

Dial Plan Report F-7

Non-Local Dial Plan Report F-10

Label Information Report F-11

Tie Trunk Information Report F-12

DID Trunk Information Report F-13

GS/LS Trunk Information Report F-14

General Trunk Information Report F-15

DS1 Information Report F-16

PRI Information Report F-17

Remote Access (DISA) Information Report F-21

Operator Information Report F-22

Allowed Lists Report F-24

Access to Allowed Lists Report F-25

Disallowed Lists Report F-26

Access to Disallowed Lists Report F-27

Automatic Route Selection Report F-28
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Table F-2 lists all of the system reports and includes the print menu option used to print each 
report, the report name, and a brief description of each report.

To access the menu options in Table F-2, select the Print option on the System Programming 
menu.

Extension Directory Report F-30

System Directory Report F-31

Group Paging Report F-32

Extension Information Report F-33

Group Coverage Information Report F-35

Direct Group Calling Information Report F-36

Night Service Information Report F-37

Group Call Pickup Report F-38

Error Log Report F-39

Authorization Code Information Report F-40

BRI Information Report F-41

Switch 56 Data Information Report F-42

Table F-2. System Reports

Menu Option Report Name Description

All  Prints each of the reports available on the Print 
menu, from SysSet-up to Error Log.

➤NOTE:
With All selected, four trunk information reports 
automatically print. See Trunk Info. 

SysSet-up System Information System-wide information such as return intervals, 
system mode, system programming port, slot 
assignments, and so on.

Dial Plan Dial Plan Extensions assigned to pools, paging zones, Calling 
Groups, lines or trunks, and stations (in the report); 
labels for lines/trunks and stations.

Labels Label Information Labels assigned to stations (extensions), Posted 
Messages, and names and telephone numbers in 
MLX-20L and 4424LD+ Personal Directory.

Table F-1. Sample Report Pages — Continued

For... See...
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Trunk Info  Select to display four trunk options: Tie, DID, 
Loop/Ground, General.

TIE TIE Trunk Information Extensions assigned to and signaling attributes 
associated with Tie trunks.

DID DID Trunk Information Extensions assigned to and signaling attributes 
associated with DID trunks.

Loop/
Ground 

GS/LS Trunk Information Extensions assigned to signaling attributes for 
ground- and loop-start lines/trunks.

General General Trunk 
Information

All identified extensions and feature-related 
attributes of each extension.

T1 Info DS1 information Options (line, signal, and so on) assigned to T1 
trunks or lines.

PRI Info PRI Information PRI trunks assigned to B-channel groups.

Rmote Access Remote Access (DISA) 
Information 

Remote Access dial code, class of restriction, barrier 
code information.

Oper Info Operator Information For each system operator position: logical ID, 
extension number, label, type (DLC or QCC). All 
general system operator options—such as backup 
position, call types, and priorities.

AllowList Allowed Lists Telephone numbers included in Allowed Lists. Lists 
numbered 0–7; entries numbered 0–9.

AllowListTo Access to Allowed Lists Lists numbered 0–7. If the Allowed List is assigned to 
Remote Access users and barrier codes are used, 
barrier codes are numbered 0–16. If no barrier codes 
are used, 17 means list is assigned to tie-trunk users 
and 18 means list is assigned to non-tie-trunk users.

DisallowLst Disallowed Lists Telephone numbers included in Disallowed Lists. 
Lists are numbered 0–7, and entries are numbered 
0–9.

DisallowTo Access to Disallowed 
Lists 

Telephones to which Disallowed Lists are assigned. 
Lists are numbered 0–7. If the Disallowed List is 
assigned to Remote Access users and barrier codes 
are used, the barrier codes are numbered 0–16. If no 
barrier codes are used, 17 means the Disallowed List 
is assigned to tie-trunk users and 18 means the 
Disallowed List is assigned to non-tie-trunk users.

ARS Automatic Route 
Selection

Access code; table types with area codes and 
exchanges; routes for subpatterns A and B, FRL, 
absorb digit, delete digit, Dial 0, and N11 tables.

Table F-2. System Reports — Continued

Menu Option Report Name Description



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Sample Reports 
F-4Overview 

F

Ext Direct Extension Directory Slot/port addresses, extensions, labels, and feature-
related attributes. Column headings are printed on 
the first page only and are not carried over to 
subsequent pages. Column headings 4 through 10 
(and 14 through 20) should be read vertically. That 
is: FACE (Forced Account Code Entry); RCFW 
(Remote Call Forward); MICD (Microphone Disable); 
SIG (Voice Signal); RSTR (Calling Restrictions); 
ARSR (ARS Restriction Level); 2BDT (2B Data 
Capability).

Sys Direct System Directory System Speed Dial number, label and telephone 
number in System Directory, and whether number 
should display.

Group Page Group Paging Extension number for each group and the extension 
number of each telephone assigned to the group.

Ext Info Extension Information For each specified station (extension), type of 
equipment connected, features assigned, ESS 
supervisor status, and features assigned to each 
button. On this report, MLX-16DP telephones are 
reported as MLX-28D.

GrpCoverage Group Coverage 
Information

Extension number for each group and the extension 
number for each telephone assigned to the group. 
Information is printed only for Calling Groups with 
members and/or lines/trunks assigned.

GrpCalling Direct Group Calling 
Information

Group calling options (hunt, type, message waiting, 
station, delay announcements, alarm thresholds, and 
so on), the extension number for each telephone 
assigned to the group, and the lines or trunks 
assigned to the group.

Night 
Service 

Night Service 
Information 

The operator, password required, time-of-day, and 
Emergency Allowed List extension numbers.

NonLcl UDP Non-Local Dial Plan Ranges of extension numbers for non-local dial plan 
extensions connected to a networked external 
switch; pattern number associated with each range. 
For each pattern, shows Pool number, absorbed and 
prepended (other) digits, FRL, and call type (voice, 
data, or both).

Call Pickup Group Call Pickup Extension numbers for telephones assigned to each 
group; pickup groups numbered 
1–30.

Table F-2. System Reports — Continued

Menu Option Report Name Description
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Error Log Error Log Error message and code, time and day error 
occurred, frequency of error. See the Maintenance 
and Troubleshooting guide.

Auth Code Authorization Code 
Information

Authorization Code and permissions for extensions 
to which authorization codes are assigned.

BRI BRI Information Report Service Profile ID and Directory Number for each 
BRI line, flexible timers, and fixed timers and 
counters.

Switch 56 Switch 56 Data 
Information Report

Dial Plan Routing information and programmable 
options.

Table F-2. System Reports — Continued

Menu Option Report Name Description
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F

System Information Report 4

Print Menu Option: SysSet-up 

SYSTEM INFORMATION

Current Date:    01/04/00
Current Time:    00:21:15
System :  Mode           AutoMaintBusy   AutoBusyTie
       :  Hybrid/PBX     Disable         Disable
Language:    SystemLang       SMDR            Printer
             English          English         English
CTI Links :    19   
Direct Line Operators :    14   18   22   42
Queued Call Operators:    10
SysProg Port:    10             Password    :    craftr4
Transfer : Type      Audible       OneTouch(Complete)  ReturnTimer

: Ring      MusicOnHold   Transfer(Auto)      5 rings
VMS Transfer Return Interval    : 4
Paging System Lines             :
Music On Hold Line              : 804
Camp On Time                    : 90 sec
Call Park Return Time           : 180 sec
Auto Callback Rings             : 3
Extension Status (ESS)          : Group Call Supv
ESS Operators                   :
SMDR :   Min.CallTime        CallReport          Format

:   40 sec              In/Out              Basic
Intercom Dial Tone              :  Inside
Reminder Service Cancel         :    :
Behind Switch Code              :  Drop    Transfer   Conference
Inter-digit Timer (seconds)     :  24  24  24  10  10  10  10   5   5
Recall Timer                    :  450 msec
Second Dial-tone Timer          :  200 msec
Rotary Line Cut Through         :  Delay
Unassigned Extension            :  10
Automatic Backup                :  Weekly - 04:30 Sunday
TI/PRI/BRI Clock Synchronization:
Primary             Secondary         Tertiary
02/01 Loop          04/01 Local       04/02 Local        
Slot # 1:         008 MLX
Slot # 2:         408 GS/LS-MLX
Slot # 3:         408 GS/LS-MLX
Slot # 4:         024 TDL
Slot # 5:         800 GS/LS
Slot # 6:         008 GS/LS-MLX
Slot # 7:         800 CO-BRI
Slot # 8:         008 GS/LS-MLX
Slot # 9:         016 MLX
Slot #10:         408 GS/LS
Slot #11:         008 GS/LS
Slot #12:         412 LS-TDL
Slot #13:         800 DID
Slot #14:         400 EM
Slot #15:         016 ETR
Slot #16:         008 MLX
Slot #17:         408 GS/LS-MLX              * Not Present *
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Dial Plan Report 4

Print Menu Option: Dial Plan 
Sections: Pools; Telephone Paging Zones; Direct Group Calling Group; Lines/

Trunks; Stations; Stations and Adjuncts

DIAL PLAN FOR POOLS

POOL.#  1:    70
POOL.#  2:   890
POOL.#  3:   891
POOL.#  4:   892
POOL.#  5:   893
POOL.#  6:   894
POOL.#  4:   895
POOL.#  8:   896
POOL.#  9:   897
POOL.# 10:   898
POOL.# 11:   899

DIAL PLAN FOR TELEPHONE PAGING ZONES

TPZ #  1:     793
TPZ #  2:     794
TPZ #  3:     795
TPZ #  4:     796
TPZ #  5:     797
TPZ #  6:     798
TPZ #  7:     799

DIAL PLAN FOR DIRECT GROUP Calling Group

DGCG  #  1:   770
DGCG  #  2:   771
DGCG  #  3:   772
DGCG  #  4:   773
DGCG  #  5:   774
. .
. .
. .
DGCG  # 32:  7929

DIAL PLAN FOR LINES/TRUNKS

LINE # 1: 801 OUTSIDE LINE #  2: 802 OUTSIDE
LINE # 3: 803 OUTSIDE LINE #  4: 804 OUTSIDE
LINE # 5: 805 OUTSIDE LINE #  6: 806 OUTSIDE
LINE # 7: 807 OUTSIDE LINE #  8: 808 OUTSIDE
LINE # 9: 809 OUTSIDE LINE #  10: 810 OUTSIDE
. .
. .
. .
LINE # 79: 879 OUTSIDE LINE #  80: 880 OUTSIDE
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Dial Plan Report—Continued 4

DIAL PLAN FOR STATIONS

STN #: 1 10 OPERATR STN  #: 2 710
STN #: 3 11 STN  #: 4 711
STN #: 5 12 STN  #: 6 712
STN #: 7 13 EXT 13 STN  #: 8 713
STN #: 9 14 EXT 14 STN  #: 10 714
STN #: 11 15 STN  #: 12 715
STN #: 13 16 STN  #: 14 716
STN #: 15 17 STN  #: 16 717
STN #: 17 18 EXT 18 STN  #: 18 19
STN #: 19 20 STN  #: 20 21
STN #: 21 22 OPERATR STN  #: 22 23
STN #: 23 24 STN  #: 24 25
STN #: 25 26 STN  #: 26 21
STN #: 27 28 STN  #: 28 29
STN #: 29 30 AUDIXVP STN  #: 30 31  AUDIXVP
STN #: 31 32 AUDIXVP STN  #: 32 33  AUDIXVP
STN #: 33 34 STN  #: 34 35
STN #: 35 36 STN  #: 36 31
STN #: 37 38 STN  #: 38 39
STN #: 39 40 STN  #: 40 41
STN #: 41 42 EXT 42 STN  #: 42 742
. .
. .
. .
STN #:  121 7198 STN #:   122 7398
STN #:  123 5555 STN #:   124 7399
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Dial Plan Report—Continued 4

COMPLETE DIAL PLAN FOR STATIONS AND ADJUNCTS

ID #:  1   4000      7300        ID #:  2   4001      7301
ID #:  3   4002      7302        ID #:  4   4003      7303
ID #:  5   4004      7304        ID #:  6   4005      7305
ID #:  7   4006      7306        ID #:  8   4007      7307
ID #:  9   4008      7308        ID #: 10   4009      7309
ID #: 11   4010      3000        ID #: 12   4011      3001
ID #: 13   4012      3002        ID #: 14   4013      3003
ID #: 15   4014      3004        ID #: 16   4015      3005
ID #: 17   4016      3006        ID #: 18   4017      3007
ID #: 19   4018      3008        ID #: 20   4019      3009
ID #: 21   4020      3010        ID #: 22   4021      3011
ID #: 23   4022      3012        ID #: 24   4023      3013
ID #: 25   4024      3014        ID #: 26   4025      3015
ID #: 27   4026      3016        ID #: 28   4027      3017
ID #: 29   4028      3018        ID #: 30   4029      3019
ID #: 31   4030      3020        ID #: 32   4031      3021
ID #: 33   4032      3022        ID #: 34   4033      3023
ID #: 35   4034      3024        ID #: 36   4035      3025
ID #: 37   4036      3026        ID #: 38   4037      3027
ID #: 39   4038      3028        ID #: 40   4039      3029
ID #: 41   4040      3030        ID #: 42   4041      3031
ID #: 43   4042      3032        ID #: 44   4043      3033
ID #: 45   4044      3034        ID #: 46   4045      3035
ID #: 47   4046      3036        ID #: 48   4047      3037
ID #: 49   4048      3038        ID #: 50   4049      3039
ID #: 51   4050      3040        ID #: 52   4051      7351
ID #: 53   4052      3042        ID #: 54   4053      7353
ID #: 55   4054      7354        ID #: 56   4055      7355
ID #: 57   4056      7356        ID #: 58   4057      7357
ID #: 59   4058      7358        ID #: 60   4059      7359
ID #: 61   7160      7360        ID #: 62   7161      7361
ID #: 63   7162      7362        ID #: 64   7163      7363
ID #: 65   7164      7364        ID #: 66   7165      7365
ID #: 67   7166      7366        ID #: 68   7167      7367
ID #: 69   7168      7368        ID #: 70   7169      7369
.         .
.         .
.         .
ID #:191   5151      7490        ID #:192   5152      7491
ID #:193   5153      7492        ID #:194   5154      7493
ID #:195   5155      7494        ID #:196   5156      7495
ID #:197   5156      7496        ID #:198   5158      7497
ID #:199   5158      7498        ID #:200   5160      7499
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Non-Local Dial Plan Report 4

Print Menu Option: NonLcl UDP (Release 6.0 and later systems only)
Sections: Ranges; Patterns

Pattern 01:
Pool Absorb Other Digits FRL Call type
1)3871 00   0   BOTH
2)3892 00   0   BOTH
3)3893 00   0   BOTH 4)389400
9957   0   BOTH

Pattern 02:
Pool Absorb Other Digits FRL Call type
1)4590 00   2   BOTH
2)4592 00   2   Voice
3)3893 00   0   BOTH 4)389400
9957   0   BOTH
. . .   .   .
. . .   .   .

Pattern 20:
Pool Absorb Other Digits FRL Call type
1)4591 00   3   Data 2)459200  3  
Data
3)3894 00 9957   3   BOTH 4)387000
9957   4   BOTH

Range Ptn Range Ptn Range Ptn  Range Ptn

01) 2400-2449 01 14) 5000-5049 09 27) 7000-7049 12 39)  8050-8059 15

02) 2550-2559 02 15) 5050-5079 10 28) 7050-7050 20 40)  8060-8069 03

03) 2560-2569 03 16) 5080-5099 01 29) 7051-7059 01 41)  8070-8099 04

04) 2570-2589 04 17) 5100-5199 02 30) 7060-7099 02 42)  8100-8199 05

05) 2590-2609 04 18) 5200-5200 11 31) 7100-7119 03 43)  8200-8229 06

06) 2610-2649 05 19) 5201-5202 12 32) 7220-7449 04 44)  8230-8259 16

07) 2650-2679 06 20) 5203-5204 13 33) 7450-7549 05 45)  8260-8289 17

08) 3100-3109 07 21) 5205-5206 14 34) 7550-7589 06 46)  8290-8389 18

09) 3110-3129 07 22) 5207-5209 15 35) 7590-7609 07 47)  8390-8429 19

10) 3130-3159 02 23) 5210-5230 03 36) 7610-7709 08 48)  8430-8459 20

11) 3160-3179 06 24) 5231-5250 17 37) 7710-7809 09 49)  8460-8489 03

12) 3180-3199 08 25) 5251-5270 18 38) 7810-7899 10 50)  8490-8499 02

13) 4000-4025 08 26) 6050-6079  14
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Label Information Report 4

Print Menu Option: Labels 
Sections: Telephone Personal Directory; Posted Messages and Numbers

LABEL INFORMATION

Executive Telephone #   10:  Personal Directory

Name          Number                         Display

Executive Telephone #   14:  Personal Directory

Name          Number                         Display

Executive Telephone #   15:  Personal Directory

Name          Number                         Display
MSG #                POSTED MESSAGE

   1                    DO NOT DISTURB
   2                    OUT TO LUNCH
   3                    AT HOME
   4                    OUT SICK
   5                    IN A MEETING
   6                    IN CONFERENCE
   7                    WITH A CLIENT
   8                    WITH A CUSTOMER
   9                    AWAY FROM DESK
  10                    OUT ALL DAY
  11                    CUSTM MSG11
  12                    CUSTM MSG12
  13                    CUSTM MSG13
  14                    CUSTM MSG14
  15                    CUSTM MSG15
  16                    CUSTM MSG16
  17                    CUSTM MSG17
  18                    CUSTM MSG18
  19                    CUSTM MSG19
  20                    CUSTM MSG20
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Tie Trunk Information Report 4

Print Menu Option: Trunk Info and TIE 

TIE TRUNK INFORMATION

TRUNK     849        Slot/Port : 14/ 1       TIE-PBX
Direction: 2 Way     E&M Signal: Type1S      Dialtone  : Remote
InType   : Wink      InMode    : Rotary      AnsSupvr  : 300  ms
OutType  : Wink      OutMode   : Rotary      Disconnect: 300  ms

TRUNK     850        Slot/Port : I4/ 2       TIE-PBX
Direction: 2 Way     E&M Signal: Type1S      Dialtone  : Remote
InType   : Wink      InMode    : Rotary      AnsSupvr  : 300  ms
OutType  : Wink      OutMode   : Rotary      Disconnect: 300  ms

TRUNK     851        Slot/Port : 14/ 3       TIE-PBX
Direction: 2 Way     E&M Signal: Type1S      Dialtone  : Remote
InType   : Wink      InMode    : Rotary      AnsSupvr  : 300  ms
OutType  : Wink      OutMode   : Rotary      Disconnect: 300  ms

TRUNK     852        Slot/Part : 14/ 4       TIE-PBX
Direction: 2 Way     E&M Signal: Type1S      Dialtone  : Remote
InType   : Wink      InMode    : Rotary      AnsSupvr  : 300  ms
OutType  : Wink      OutMode   : Rotary      Disconnect: 300  ms
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DID Trunk Information Report 4

Print Menu Option: Trunk Info and DID 

DID TRUNK INFORMATION

Trk SS/PP Blk DiscTime Type ExpDig DelDig AddDig    Signal  InvDest
841 13/ 1  1    500ms  Wink    4      3       1   TouchTone BkupExt
842 13/ 2  1    500ms  Wink    4      3       1   TouchTone BkupExt
843 13/ 3  2    500ms  Wink    3      0              Rotary BkupExt
844 13/ 4  2    500ms  Wink    3      0              Rotary BkupExt
845 13/ 5  1    500ms  Wink    4      3       1   TouchTone BkupExt
846 13/ 6  1    500ms  Wink    4      3       1   TouchTone BkupExt
847 13/ 7  2    500ms  Wink    3      0              Rotary BkupExt
848 13/ 8  1    500ms  Wink    4      3       1   TouchTone BkupExt
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GS/LS Trunk Information Report 4

Print Menu Option: Trunk Info and Loop/Ground 

GS/LS TRUNK INFORMATION

Trk SS/PP Type OutMode RelDisc ChannelUnit LS-ID Delay

801 2/ 1 Loop TouchTone Yes N/A N/A

802 2/ 2 Loop TouchTone Yes N/A N/A

803 2/ 3 Loop TouchTone Yes N/A N/A

804 2/ 4 Loop TouchTone Yes N/A N/A

805 4/ 1 Loop Rotary Yes N/A N/A

806 4/ 2 Loop Rotary Yes N/A N/A

807 4/ 3 Loop Rotary Yes N/A N/A

808 4/ 4 Loop Rotary Yes N/A N/A

809 5/ 1 Ground TouchTone N/A N/A N/A

810 5/ 2 Ground TouchTone N/A N/A N/A

811 5/ 3 Loop Rotary Yes N/A N/A

812 5/ 4 Loop Rotary Yes N/A N/A

813 5/ 5 Loop Rotary Yes N/A N/A

814 5/ 6 Loop Rotary Yes N/A N/A

815 5/ 7 Loop TouchTone Yes N/A N/A

816 5/ 8 Loop Rotary Yes N/A N/A

817 6/ 1 Ground Rotary N/A N/A N/A

 .

 .

879 15/ 7 LS-ID Rotary Yes N/A Yes

880 15/ 8 LS-ID Rotary Yes N/A No
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General Trunk Information Report 4

Print Menu Option: Trunk Info and General 

GENERAL TRUNK INFORMATION

Trk SS/PP RemAccess Pool TlPrfx HldDisc Principal QCC
Prty

QCC
Oper

Extern
Switch

801 2/1 No Remote 70 Yes Long 4 60

802 2/2 No Remote 70 Yes Long 4 02

803 2/3 No Remote 70 Yes Long 4 21

804 2/4 No Remote Yes Long

805 4/1 No Remote Yes Long

806 4/2 No Remote Yes Long 4

807 4/3 No Remote Yes Long 4

808 4/4 No Remote Yes Long 4

809 5/1 No Remote Yes Long 4 10

810 5/2 No Remote 890 Yes Long 4

811 5/3 No Remote Yes Long 4

812 5/4 No Remote Yes Long 4

813 5/5 No Remote Yes Long 4

814 5/6 No Remote Yes Long 4

815 5/7 No Remote Yes Long 4

816 5/8 No Remote Yes Long 4

817 6/1 Dedicated Yes Long 42 4

. . . . . . . . .

. . . . . . . . .

912 10/1 No Remote  Yes Long 4 12

913 10/2 No Remote  Yes Long 4 13
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DS1 Information Report 4

Print Menu Option: T1 Info 

DS1 SLOT ATTRIBUTES

Slot Type Format Supp Signal LineComp ClkSync Src Active

2 T1 D4 ZCS Rob Bit 1 Prim Loop Yes

3 T1 D4 ZCS Rob Bit 1 None Local Yes
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PRI Information Report 4

Print Menu Option: PRI Info 
Sections: Network Selection, Special Service, Call-by-Call and Dial Plan Routing 

Tables; PRI Information 

Slot 5 Switch: DMS-100 

Slot 11 Switch: MERLIN-PBX 

Slot 12 Switch: MERLIN-Ntwk 

System: By line                            

Line    PhoneNumber     NumberToSend
801                    
802                    
803                    
804                    
805                    
806                    
807                    
808                    
809                    
810                    
811                    
812                    
813                    
814                    
815                    
816                    
817                    
818                    
819                    
820                    
821                    
822                    
823                    

BcchnlGrp #: Slot: TestTelNum: NtwkServ: Incoming Routing:

5 5 CallbyCall By Dial Plan 

Channel ID: 23 22 21 20 19 18 17 16 15 14

13 12 11 10 9 8 7 6 5 4

3 2 1
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PRI Information Report—Continued 4

    BchnlGrp #: Slot: TestTelNum: NtwkServ:   Incoming Routing:
    79          12                 ElecTandNtwkRoute Directly to UDP

    Channel ID: 1  2  3  4  5  6  7  8  9 10 
                11 12 13 14 15 16 17 18 19 20 
                21 22 23 

    Line    PhoneNumber     NumberToSend
     849                    
     850                    
     851                    
     852                    
     853                    
     854                    
     855                    
     856                    
     857                    
     858                    
     859                    
     860                    
     861                    
     862                    
     863                    
     864                    
     865                    
     866                    
     867                    
     868                    
     869                    
     870                    
     871                    

    BchnlGrp #: Slot: TestTelNum: NtwkServ:   Incoming Routing:
    80          11                ElecTandNtwk Route Directly to UDP

    Channel ID:  1  2  3  4  5  6  7  8  9 10 
                11 12 13 14 15 16 17 18 19 20 
                21 22 23 

    Line    PhoneNumber     NumberToSend
     825                    
     826                    
     827                    
     828                    
     829                    
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PRI Information Report—Continued 4

     830                    
     831                    
     832                    
     833                    
     834                    
     835                    
     836                    
     837                    
     838                    
     839                    
     840                    
     841                    
     842                    
     843                    
     844                    
     845                    
     846                    
     847                    

    Network Selection Table

    Entry Number:     0          1          2          3
    Pattern to Match: 101****    10***                            

    Special Service Table

    Call-By-Call Service Table

    Entry Number: 0           1           2           3           4           
    Pattern    0: 957         7                                               
    Pattern    1:             1                                               
    Pattern    2:             2                                               
    Pattern    3:             3                                               
    Pattern    4:             4                                               
    Pattern    5:             5                                               
    Pattern    6:             6                                               
    Pattern    7:             7                                               
    Pattern    8:             8                                               

Entry Number: 0 1 2 3 4 5 6 7 

Pattern to Match: 011 010 01 00 0 1 

Operator: none OP OP OP/P none none none none 

Type of Number: I I I N N N N N 

Digits to Delete: 3 3 2 2 1 0 0 0 
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PRI Information Report—Continued 4

    Pattern    9:             9                                               
    Call Type:    BOTH        BOTH        BOTH        BOTH      BOTH        
    NtwkServ:     DMS-Private DMS-Private                                     
    DeleteDigits: 0           0           0           0           0           

    Entry Number: 5           6           7           8           9           
    Call Type:    BOTH        BOTH        BOTH        BOTH      BOTH        
    NtwkServ:                                                                 
    DeleteDigits: 0           0           0           0           0           

    Dial Plan Routing Table

    Entry Number:      0           1           2           3          
    NtwkServ:         Any service Any service Any service             
    Expected Digits:   4           7          10           0          
    Pattern to Match:                                                 
    Digits to Delete:  0           7          10           0          
    Digits to Add:                13          13                      

    Entry Number:      4           5           6           7          
    NtwkServ:                                                         
    Expected Digits:   0           0           0           0          
    Pattern to Match:                                                 
    Digits to Delete:  0           0           0           0          
    Digits to Add:                                                    

    Entry Number:      8           9          10          11          
    NtwkServ:                                                         
    Expected Digits:   0           0           0           0          
    Pattern to Match:                                                 
    Digits to Delete:  0           0           0           0          
    Digits to Add:                                                    

    Entry Number:     12          13          14          15          
    NtwkServ:                                                         
    Expected Digits:   0           0           0           0          
    Pattern to Match:                                                 
   

    Digits to Delete:  0           0           0           0          
    Digits to Add:                                                    
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Remote Access (DISA) Information Report 4

Print Menu Option: Rmote Access 
Sections: General Options; System Default Class of Restrictions (Non-TIE); System 

Default Class of Restrictions (TIE); Barrier Code Administration

GENERAL OPTIONS (ACCESS CODE 889)

Barrier Code required for Non-TIE DISA lines     :  Yes
Barrier Code required for TIE DISA lines    :No
Automatic Queuing enabled for DISA lines    :Yes
System Wide Barrier Code Length: 07
Date And Time of Last Barrier Code Length Change: 09:23:94, 09:45 PM

SYSTEM DEFAULT CLASS OF RESTRICTIONS (NON-TIE)

Restriction          :  UNRESTRICTED
ARS Restriction Level:  3
Allowed Lists        :
Disallowed Lists     :

SYSTEM DEFAULT CLASS OF RESTRICTIONS (TIE)

Restriction          :  UNRESTRICTED
ARS Restriction Level:  3
Allowed Lists        :
Disallowed Lists     :

BARRIER CODE ADMINISTRATION

Barrier Code number  :  1
Barrier Digits       :  2468345
Restriction          :  OUTWARD RESTRICTED
ARS Restriction Level:  3
Allowed Lists        :
Disallowed Lists     :

Barrier Code number  :  2
Barrier Digits       :  1234693
Restriction          :  UNRESTRICTED
ARS Restriction Level:  3
Allowed Lists        :
Disallowed Lists     :
.
.
Barrier Code number  :  16
Barrier Digits       :  9876115
Restriction          :  OUTWARD RESTRICTED
ARS Restriction Level:  0
Allowed Lists        :
Disallowed Lists     :
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Operator Information Report 4

Print Menu Option: Oper Info 
Sections: Operator Positions; General Options; DSS Options; QCC Operator 

Options: QCC Call Types

OPERATOR POSITIONS

PORT          CALL ALERT
ADDR. EXT # LABEL TYPE (QCC ONLY)
==== ===== ======= ====  ==========
1/ 1 10 OPERATR  QCC No
1/ 5 14 EXT 14  DLC N/A
2/ 1 18 EXT 18  DLC N/A
2/ 5 22 OPERATR  DLC N/A
6/ 1 42 EXT 42  DLC N/A

GENERAL OPTIONS

Length of hold reminder timer: 60 sec
DLC Automatic hold enabled   : No

DIRECT STATION SELECTOR (DSS) OPTIONS

BUTTON  FIRST
NUMBER  DIAL CODE
======  =========

1 0
2 50
3 100

Operator Call Park codes:  881  882  883  884  885  886  884  888

QCC OPERATOR OPTIONS

Listed Directory Number for queue : 800
Held calls return to queue        : No
Automatic hold enabled            : No
Calls-in-queue alarm threshold    : 0
Time until priorities are elevated: 0 sec
Message Center Operators          :
One Touch Extend                  : AUTOMATIC
Rings before extended calls return: 4
Backup operator station           :
Voice Announce on Call 5 button   : Disable
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Operator Information Report—Continued 4

QCC CALL TYPES:
        CALL TYPE           PRIORITY    OPERATORS
=======================     ========    ===================
Dial 0 Operator                4          10
Follow Forward                 4          N/A
Unassigned DID                 4          10
Listed Directory Number        4          10
Operator’s Extension           4          N/A
Returning                      4           0
Group Coverage
     Group #    1              4
     Group #    2              4
     Group #    3              4
     Group #    4              4
     Group #    5              4
     Group #    6              4
     Group #    7              4
     Group #    8              4
     Group #    9              4
     Group #   10              4
     Group #   11              4
     Group #   12              4
     Group #   13              4
     Group #   14              4
     Group #   15              4
     Group #   16              4
     Group #   17              4
     Group #   18              4
     Group #   19              4
     Group #   20              4
     Group #   21              4
     Group #   22              4
     Group #   23              4
     Group #   24              4
     Group #   25              4
     Group #   26              4
     Group #   27              4
     Group #   28              4
     Group #   29              4
     Group #   30              4



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Sample Reports 
F-24Allowed Lists Report 

F

Allowed Lists Report 4

Print Menu Option: AllowList 
Sections:   Lists 1 through 7

ALLOWED LISTS

List : 0

Entry 0: ------
Entry 1: ------
Entry 2: ------
Entry 3: ------
Entry 4: ------
Entry 5: ------
Entry 6: ------
Entry 7: ------
Entry 8: ------
Entry 9: ------
   .
   .
   .
List : 7

Entry 0: ------
Entry 1: ------
Entry 2: ------
Entry 3: ------
Entry 4: ------
Entry 5: ------
Entry 6: ------
Entry 7: ------
Entry 8: ------
Entry 9: ------
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Sample Reports 
F-25Access to Allowed Lists Report 

F

Access to Allowed Lists Report 4

Print Menu Option: AllowListTo 

ACCESS TO ALLOWED LISTS

FOR Remote Access 17 & 18 MEAN TIE & NON-TIE RESTRICTIONS

List 1 STNS 10

RACC 1 17 18

List 3 STNS 33

RACC
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Sample Reports 
F-26Disallowed Lists Report 

F

Disallowed Lists Report 4

Print Menu Option: DisallowLst 
Sections: Lists 1 through 7

DISALLOWED LISTS

List : 0

Entry 0:  ------------
Entry 1:  ------------
Entry 2:  ------------
Entry 3:  ------------
Entry 4:  ------------
Entry 5:  ------------
Entry 6:  ------------
Entry 7:  ------------
Entry 8:  ------------
Entry 9:  ------------
   .
   .
   .
List : 7

Entry 0:  ------------
Entry 1:  ------------
Entry 2:  ------------
Entry 3:  ------------
Entry 4:  ------------
Entry 5:  ------------
Entry 6:  ------------
Entry 7:  ------------
Entry 8:  ------------
Entry 9:  ------------
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Sample Reports 
F-27Access to Disallowed Lists Report 

F

Access to Disallowed Lists Report 4

Print Menu Option: DisallowTo 

ACCESS TO DISALLOWED LISTS

FOR Remote Access 17 & 18 MEAN TIE & NON-TIE RESTRICTIONS

List 1 STNS 33

RACC 9

List 3 STNS 33

RACC
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Sample Reports 
F-28Automatic Route Selection Report 

F

Automatic Route Selection Report 4

Print Menu Option: ARS 
Sections: Tables

AUTOMATIC ROUTE SELECTION

ARS IS: ACTIVE ACCESS CODE: 9

TABLE 17: Default Toll Output Table

TABLE 18: Default Local Output Table

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00 ----------------- 3 BOTH --:-- A

2)---- -- ----------------- - ----- --:-- A 

3)---- -- ----------------- - ----- --:-- A

4)---- -- ----------------- - ----- --:-- A

5)---- -- ----------------- - ----- --:-- B

6)---- -- ----------------- - ----- --:-- B

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00 ----------------- 3 BOTH --:-- B

2)---- -- ----------------- - ----- --:-- B

3)---- -- ----------------- - ----- --:-- B

4)---- -- ----------------- - ----- --:-- B

5)---- -- ----------------- - ----- --:-- B

6)---- -- ----------------- - ----- --:-- B

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00 ----------------- 3 BOTH --:-- A

2)---- -- ----------------- - ----- --:-- A 

3)---- -- ----------------- - ----- --:-- A

4)---- -- ----------------- - ----- --:-- A

5)---- -- ----------------- - ----- --:-- B

6)---- -- ----------------- - ----- --:-- B
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Sample Reports 
F-29Automatic Route Selection Report 

F

Automatic Route Selection Report—
Continued 4

TABLE 19: Dial 0 Output Table

TABLE 20: N11 Output Table
01)411 02)611 03)811 04)911

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00 ----------------- 3 BOTH --:-- B

2)---- -- ----------------- - ----- --:-- B

3)---- -- ----------------- - ----- --:-- B

4)---- -- ----------------- - ----- --:-- B

5)---- -- ----------------- - ----- --:-- B

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00  ---------------- 3 BOTH  --:-- A

Pool Absorb Other Digits FRL Call type Start Pattern

1)70-- 00  ---------------- 3 BOTH  --:-- A
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Sample Reports 
F-30Extension Directory Report 

F

Extension Directory Report 4

Print Menu Option: Ext Direct 

EXTENSION DIRECTORY

Port Ext # Label F H R M V R A 2 Port Ext # Label F H R M V R A 2

Addr A B C I S S R B Addr  A B C I S S R B

C I F C I T S D  C I F C I T S D

E S W D G R R T  E S W D G R R T

1/ 1 10 OPERATR N N N N   U 3 N 1/21 710  N N N N   U 3 N

1/ 2 11 N N N N   O 3 Y 1/22 711  N N N N   U 3 N

1/ 3 12 N N N N   U 3 Y 1/23 712  N N N N   U 3 N

1/ 4 13 EXT 13 N N N N   U 3 N 1/24 713  N N N N   U 3 N

1/ 5 14 EXT 14 N N N N   U 3 N 1/25 714 N N N N   U 3 N

1/ 6 15 N N N N   U 3 N 1/26 715 N N N N   U 3 N

1/ 7 16 N N N N   U 3 N 1/27 716 N N N N   U 3 N

1/ 8 17 N N N N   U 3 N 1/28 717 N N N N   U 3 N

2/ 1 18 EXT 18 N N N N   U 3 N 2/ 2 19 N N N N   U 3 N

2/ 3 20 N N N N   U 3 N 2/ 4 21 N N N N   U 3 N

2/ 5 22 OPERATR N N N N   U 3 N 2/ 6 23 N N N N   U 3 N

2/ 7 24 N N N N   U 3 N 2/ 8 25 N N N N   U 3 N

3/ 1 26 N N N N   U 3 N 3/ 2 27 N N N N   U 3 N

3/ 3 28 N Y N N   U 3 N 3/ 4 29 N N N N   U 3 N

3/ 5 30 AUDIXVP N N N N   U 3 N 3/ 6 31 N N N N   U 3 N

3/ 7 32 AUDIXVP N N N N   U 3 N 3/ 8 33 N N N N   U 3 N

4/ 1 34 N N N N   U 3 N 4/ 2 35 AUDIXVP N N N N   U 3 N

4/ 3 36 AUDIXVP N N N N   U 3 N 4/ 4 37 N N N N   U 3 N

4/ 5 38 N N N N   U 3 N 4/ 6 39 N N N N   U 3 N

4/ 7 40 N N N N   U 3 N 4/ 8 41 N N N N   U 3 N

6/ 1 42 EXT 42 N N N N   U 3 N 6/21 742 N N N N   U 3 N

  .  

  .  

  .  

7/ 1 54 EXT 54 N N N N   U 3 N 7/2 754 N N N N   U 3 N
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Sample Reports 
F-31System Directory Report 

F

System Directory Report 4

Print Menu Option: Sys Direct 

SYSTEM DIRECTORY

Code Name Number Display

600 ABC Company 555-9999 YES

601 Jacques Smith 5551212 YES

605 Travel Agency 912015556677 YES
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Sample Reports 
F-32Group Paging Report 

F

Group Paging Report 4

Print Menu Option: Group Page 

GROUP PAGING

Group #   793   STNS   :   20   21   22   23   24   25

Group #   794   STNS   :   15   16   17   18   19
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Sample Reports 
F-33Extension Information Report 

F

Extension Information Report 4

Print Menu Option: Ext Info plus extension number 

EXTENSION INFORMATION
Extn SS/PP Type
  10  1/ 1 MLX-20L + 1 DSS

CTI Link : NO  Alarms:  ACTIVE  (SUSPENDED)
Pool Access : 70  890  891  892  893  894  895  896  897  898  899
Page Group :
Primary Coverage :
Secondary Coverage :
Coverage Group : 5
Group Coverers    : 773
NS Groups       : 10
Group Calling Member:
Pickup Groups   : 
Allowed Lists   : 
Disallowed Lists   : 
Restrictions : UNRESTRICTED
ESS Sup. Status : ESS-0 -NO RESTRICTION
ESS Restrictions : ON
Auto Callback : OFF
Call Waiting      : ON
Abbreviated Ring : ON
Line Preference  : ON
Shared SA Ring    : ON
Receive Voice Calls : ON
Coverage Inside   : OFF
Forwarding to   : 
Delay Forwarding  : 0
ARS Restriction   : 3
Forced Account Code : No
Microphone Disable : No
Rotary Enable : No
Remote Forward Allow : No
Trunk Transfer Allow : No
NS Exclusion     : No
Voice Announce Pair : No
Voice/Data Pair    : No
BIS/HFAI         : No
Language        : English
Authorization Code : 3134
2B Data Port  : No
Primary Ring Delay : 2
Secondary Ring Delay : 2
Group Cover Delay : 3
HotLine Extension : No
Networking and ISDN Display Preference: Name 
Service Observer :
Service Observing Group :
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Sample Reports 
F-34Extension Information Report—Continued 

F

Extension Information Report—Continued 4

EXTENSION INFORMATION

Extn  SS/PP Type
  10    1/ 1 MLX-20L + 1 DSS

Button 34 Blank Status None
Button 33 Blank Status None
Button 32 Blank Status None
Button 31 Blank Status None
Button 30 Blank Status None
Button 29 Blank Status None
Button 28 Blank Status None
Button 27 Blank Status None
Button 26 Blank Status None
Button 25 Blank Status None
Button 24 Blank Status None
Button 23 Blank Status None
Button 22 Blank Status None
Button 21 Blank Status None
Button 20 Forced Release Status None
Button 19 Pool Inspect Status None
Button 18 Headset Auto Answer Status Off
Button 17 Join Status None
Button 16 Cancel Status None
Button 15 Alarm Status Status Off
Button 14 Night Service  Status Off
Button 13 Headset Status   Status Off
Button 12 Destination    Status None
Button 11 Release Status None
Button 10 Position Busy  Status Off
Button 9 Send/Remove Message Status None
Button 8 Handset/Headset Mute Status Off
Button 7 Source Status None
Button 6 Start Status None
Button 5 Call 5 Status None
Button 4 Call 4 Status None
Button 3 Call 3 Status None
Button 2 Call 2 Status None
Button 1 Call 1 Status None
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Sample Reports 
F-35Group Coverage Information Report 

F

Group Coverage Information Report 4

Print Menu Option: GrpCoverage 

GROUP COVERAGE INFORMATION

Group # 2 Senders : 6802 6804

Group # 5 Senders : 10 11 12 13 14 18 19 20 42

44 45 47 681
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Sample Reports 
F-36Direct Group Calling Information Report 

F

Direct Group Calling Information Report 4

Print Menu Option: Grp Calling 
Sections: Each programmed group

DIRECT GROUP CALLING INFORMATION

Group #  : 782         Group Type : AutoLogout
Call Distribution Type   : CIRCULAR

PryAnn No.     Ext #       LABEL
       1        27         ANN1
       2        28         ANN2

Secondary Announcement Ext # : 29
Time Between Delay Announcements : 0
Repeat Secondary Announcement: NO
Message Waiting Station  : NONE
Queue Control Limit: 99
Calls-in-queue Threshold 1: 1
Calls-in-queue Threshold 2: 1
Calls-in-queue Threshold 3: 1
External Alert ext #     : NONE
Overflow Threshold (#)   : 1
Overflow Threshold (Time): 0
Prompt-Based Overflow Option: No
Overflow to DGC group #  : NONE

Group Coverage :   1

Member No.    EXT #         LABEL
        1     12
        2     13
        3
        4
        5
        6
        7
        8
        9
       10
       11
       12
       13
       14
       15
       16
       17
       18
       19
       20
LINES:
DIRECT GROUP CALLING INFORMATION

Group Priority:16
Support Group:

Home Group(s)/Priority:
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Sample Reports 
F-37Night Service Information Report 

F

Night Service Information Report 4

Print Menu Option: Night Service 

NIGHT SERVICE INFORMATION

OPERATOR 10 DGCG #:
STNS  :  10
LINES  :  801

OPERATOR 14 DGCG #:
STNS  :  14
LINES  :  804

OPERATOR 18 DGCG #:
STNS  :  18
LINES  :  808

OPERATOR 22 DGCG #:
STNS  :  22
LINES  :  822

OPERATOR 42 DGCG #:
STNS  :  42
LINES  :  842

Password  :
Current Day : OFF

Turn off at: Turn on at:
  Sunday : :
  Monday : :
  Tuesday : :
  Wednesday : :
  Thursday : :
  Friday : :
  Saturday : :
Emergency Allowed List:
 0)
 1)
 2)
 3)
 4)
 5)
 6)
 7)
 8)
 9)
NS Excluded STNS:
  61   62   63   64   65
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Sample Reports 
F-38Group Call Pickup Report 

F

Group Call Pickup Report 4

Print Menu Option: Call Pickup 

GROUP CALL PICKUP

Group #  1  STNS  :  10  11  12  13  I4  15  16
Group #  2  STNS  :  17  18  19  20
Group #  3  STNS  :  21  22  23  24  25  26  27  28  29  30
Group #  4  STNS  :  31
Group #  5  STNS  :  32
Group #  6  STNS  :  33
Group #  7  STNS  :  34
Group #  8  STNS  :  35
Group #  9  STNS  :  36
Group # 10  STNS  :  37
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Sample Reports 
F-39Error Log Report 

F

Error Log Report 4

Print Menu Option: Error Log 

ERROR LOG

Last 30 System Errors:

Message                   ss/pp    Cnt  First        Last       Code
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/08 00:00:53  7001
TIMEOUT COLD START        00/00     -     -     01/11 00:04:08  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/11 00:04:14  7001
TIMEOUT COLD START        00/00     -     -     01/21 00:22:14  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/03 00:22:14  7001
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/04 00:22:14  7001
SOFTWARE COLD START       00/00     -     -     01/04 00:21:14  0003
SOFTWARE COLD START       00/00     -     -     01/04 00:21:14  0003
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/04 00:21:14  7001
SOFTWARE COLD START       00/00     -     -     01/04 00:22:11  0003
PRI SVC AUDIT TIMEOUT     00/00     -     -     01/08 00:00:53  7001
TIMEOUT COLD START        00/00     -     -     02/11 00:04:08  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     02/11 00:04:14  7001
TIMEOUT COLD START        00/00     -     -     02/21 00:22:14  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     02/03 00:22:14  7001
PRI SVC AUDIT TIMEOUT     00/00     -     -     02/04 00:22:14  7001
SOFTWARE COLD START       00/00     -     -     02/04 00:21:14  0003
SOFTWARE COLD START       00/00     -     -     02/04 00:21:14  0003
PRI SVC AUDIT TIMEOUT     00/00     -     -     02/04 00:21:14  7001
SOFTWARE COLD START       00/00     -     -     02/04 00:22:11  0003
PRI SVC AUDIT TIMEOUT     00/00     -     -     02/08 00:00:53  7001
TIMEOUT COLD START        00/00     -     -     03/11 00:04:08  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     03/11 00:04:14  7001
TIMEOUT COLD START        00/00     -     -     03/21 00:22:14  0001
PRI SVC AUDIT TIMEOUT     00/00     -     -     03/03 00:22:14  7001
PRI SVC AUDIT TIMEOUT     00/00     -     -     03/04 00:22:14  7001
SOFTWARE COLD START       00/00     -     -     03/04 00:21:14  0003
SOFTWARE COLD START       00/00     -     -     03/04 00:21:14  0003
PRI SVC AUDIT TIMEOUT     00/00     -     -     03/04 00:21:14  7001
SOFTWARE COLD START       00/00     -     -     03/04 00:22:11  0003
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Sample Reports 
F-40Authorization Code Information Report 

F

Authorization Code Information Report 4

Print Menu Option: Auth Code 

SMDR Option for the Account Code Field is Home Extension

Extension         Authorization Code   
10                3124                 
15                1357921              
20                6578                 
23                443796   
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Sample Reports 
F-41BRI Information Report 

F

BRI Information Report 4

Print Menu Option: BRI 

BRI INFORMATION

Flexible Timers:
T200 = 1000 ms   T203 = 33 sec   T303 = 4 sec T305 = 30 sec T308 = 4 sec

Fixed Timers and Counters:
T202 = 2 sec   T309 = 90 sec   T310 = 60 sec   T313 = 4 sec
K Cntr = 1     N200 = 3        N201 = 260      N202 = 3

       Line    Service Profile ID       Directory Number
       801     908555100001             9085551000
       802     908555100101             9085551001
       803     908555100201             9085551002
       804     908555100301             9085551003
       805     908555100401             9085551004
       806     908555100501             9085551005
       807     908555100601             9085551006
       808     908555100701             9085551007
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Sample Reports 
F-42Switch 56 Data Information Report 

F

Switch 56 Data Information Report 4

Print Menu Option: Switch 56 

Dial Plan Routing for Network Service

      Expected Digits:  3
       Digits to Delete: 0
       Digits to Add:    0

Trk ss/pp Dirction InType OutType AnsSup Discnt Inmode Outmode Service

801 02/01 2 Way Wink Wink 120 180 T-Tone T-Tone TIE

802 02/02 Outgoing Delay Delay 160 180 Rotary T-Tone S56

803 02/03 Incoming Auto Auto 100 140 Rotary Rotary S56

.

.

.

808 02/08 2 Way Wink Wink 120 180 Rotary Rotary TIE



General System Programming Sequence 
G-1Basic System Operating Conditions 

G
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GGeneral System Programming 
Sequence G

        

This appendix lists the basic procedures, in the order in which they must be performed, to program 
a new system. In some instances, you may need to rearrange the system planning forms to match 
this order.

Basic System Operating Conditions 4

■ Select the system programming position:

System→SProg Port 

■ Select the system language:

More→Language→SystemLang 

■ Select the system mode:

System→Mode 

■ Enable Automatic Maintenance Busy:

System→MaintenBusy 

■ Set the system time:

System→Time Set the system date:

System→Date 

■ Schedule automatic backups:

System→Backup/Restore→Auto Backup 

If your MERLIN MAGIX system is part of a private network, contact the Network 
Engineering Group for assistance. Refer to the Network Reference for additional 
programming that is required.
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G-2System Renumbering 

G

System Renumbering 4

■ Select the system numbering plan:

SysRenumber→Default Numbering 

■ Single renumbering:

SysRenumber→Single 

■ Block renumbering:

SysRenumber→Block 

■ DSS console page buttons:

SysRenumber→Single→More→DSS buttons

Identify System Operator Positions 4

■ Identify QCC system operator positions:

Operator→Positions→Queued Call 

■ Identify DLC system operator positions:

Operator→Positions→Direct Line 

Lines and Trunks 4

■ Specify type of trunk on 400 or 800 GL/LS module:

LinesTrunks →LS/GS/DS1 

■ Identify dial signaling for loop-start/ground-start trunks:

LinesTrunks→TT/LS Disc→Outmode 

■ Classify disconnect signaling reliability for loop-start trunks:

LinesTrunks→TT/LS Disc→LS Disconnect 

■ Specify toll prefix requirements:

LinesTrunks→Toll Type 

■ Specify Hold Disconnect interval:

LinesTrunks→More→HoldDiscnct 

■ Assign the QCC queue priority:

LinesTrunks→More→QCC Prior 

■ Identify QCC operator to receive calls:

LinesTrunks→More→QCC Oper 

■ Assign trunks to pools:

LinesTrunks→Pools 
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General System Programming Sequence 
G-3Complex Lines 

G

Complex Lines 4

■ Program DS1 trunks:

LinesTrunks→LS/GS/DS1 

■ Program tie lines:

LinesTrunks→TIE Lines 

■ Program DID trunks:

LinesTrunks→DID 

■ Program PRI trunks:

LinesTrunks→PRI 

■ Program BRI trunks:

LinesTrunks→BRI 

Telephones 4

Many System Managers prefer to program auxiliary equipment before programming telephones.

■ Assign trunks to telephones:

Extensions→LinesTrunks 

■ Copy trunk assignments:

Extensions→Line Copy 

■ Identify principal user for Personal Line:

LinesTrunks→More→PrncipalUsr 

■ Assign ring, voice, outgoing only, shared buttons:

More→Cntr Prg 

■ Copy telephone button assignments:

More→Cntr Prg 
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General System Programming Sequence 
G-4Auxiliary Equipment 

G

Auxiliary Equipment 4

■ Program Music-On-Hold:

AuxEquip→MusicOnHold 

■ Program loudspeaker paging:

AuxEquip→Ldspkr Pg 

■ Program a fax port:

AuxEquip→Fax 

■ Identify the jack used for maintenance alarms:

AuxEquip→MaintAlarms 

■ Program voice mail and Automated Attendant:

AuxEquip→VMS/AA→TransferRtn 

Print Reports 4

■ Print system reports to simplify checking your work and to provide a paper copy of system 
configuration:

More→Print 



Programming Special Characters 
H-14400 and Single-Line Telephones 

H
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HProgramming Special Characters H

This appendix provides the special characters used in dialing sequences for numbers dialed 
automatically, such as on Auto Dial buttons. The characters allowed depend on the type of 
telephone.

4400 and Single-Line Telephones 4

Some dialing sequences need special characters. For example, the user presses and releases 
either the Recall or Flash button or the switchhook to insert a Pause character in a dialing 
sequence after a dial out code to allow the system to seize an outside line/trunk before dialing the 
number.

Table H-1. Special Characters for 4400 and Single-Line Telephones

Press... Means...

Recall, Flash, 
or switchhook1 

1 On single-line telephones with positive or timed disconnect (such as the 2500YMGL), the Recall or Flash button, instead 
of the switchhook, must be used.

Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple consecutive 
pauses are allowed.

# End of Dialing. Used to signal the end of the dialing sequence or to separate one 
group of dialed digits from another, such as an account code from a telephone 
number.
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Programming Special Characters 
H-24400D and Multiline 4400-Series Telephones 

H

4400D and Multiline 4400-Series Telephones 4

Some dialing sequences need special characters—for example, the user presses Hold to insert a 
Pause character after the dial-out code in a dialing sequence to allow the system to seize an 
outside line before dialing the number. A Pause character can also be used to separate a 
telephone number from an extension number.

Table H-2. Special Characters for 4400D and Multiline 4400-Series Telephones

Press... See... Means...

Trnsfr s Stop. Inserts a Stop within a sequence of automatically dialed numbers—
for example, an outside Auto Dial button may be programmed with a 
password, then a Stop, then a telephone number. To use Auto Dial with a 
Stop in the sequence, the user presses the button to dial the password, 
listens for the dialing and connection, and presses the button again to dial 
the number.

Hold p Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple 
consecutive pauses are allowed.

Conference f Flash. Sends a switchhook flash. Must be the first entry in the dialing 
sequence.

## # End of Dialing for Auto Dial buttons. Used at the end of a dialing 
sequence to indicate that the user has finished dialing or to separate one 
group of dialed digits from another.

# # End of Dialing. Used at the end of a dialing sequence to indicate that the 
user has finished dialing or to separate one group of dialed digits from 
another.
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Programming Special Characters 
H-3MLX-10 and MLX-5 Non-Display Telephones 

H

MLX-10 and MLX-5 Non-Display Telephones 4

Some dialing sequences need special characters—for example, the user presses Hold to insert a 
Pause character after the dial-out code in a dialing sequence to allow the system to seize an 
outside line before dialing the number. A Pause character can also be used to separate a 
telephone number from an extension number.

Table H-3. Special Characters for MLX-10 and MLX-5 Non-Display Telephones

Press... Means...

Drop Stop. Halts the dialing sequence to allow for system response.

Hold Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple consecutive pauses 
are allowed.

Conf Flash. Sends a switchhook flash. Must be the first entry in the dialing sequence.

# End of Dialing for extension programming only. Used at the end of a dialing 
sequence to indicate that the user has finished dialing or to separate one group of dialed 
digits from another.

## End of Dialing. Used to signal the end of the dialing sequence or to separate one group 
of dialed digits from another.
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MLX Display Telephones 4

Some dialing sequences need special characters—for example, the user presses Hold to insert a 
Pause character in a dialing sequence after a dial-out code to allow the system to seize an outside 
line before dialing the number. A Pause character can also be used to separate a telephone 
number from an extension number.

Table H-4. Special Characters for MLX Display Telephones

Press... See... Means...

Drop s Stop. Halts the dialing sequence to allow for system response.

Hold p Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple 
consecutive pauses are allowed.

Conf f Flash. Sends a switchhook flash. Must be the first entry in the dialing 
sequence.

# # End of Dialing for extension programming only. Used at the end of a dialing 
sequence to indicate that the user has finished dialing or to separate one group 
of dialed digits from another.

## # End of Dialing. Used to signal the end of the dialing sequence or to separate 
one group of dialed digits from another.
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H

ETR and MLS Non-Display Telephones 4

Some dialing sequences need special characters—for example, the user presses Hold to insert a 
Pause character after the dial-out code in a dialing sequence to allow the system to seize an 
outside line before dialing the number. A Pause character can also be used to separate a 
telephone number from an extension number.

Table H-5. Special Characters for ETR and MLS Non-Display Telephones

Press... Means...

Trnsfr Stop. Halts the dialing sequence to allow for system response.

Hold Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple consecutive pauses 
are allowed.

Conf Flash. Sends a switchhook flash. Must be the first entry in the dialing sequence.

# End of Dialing for extension programming only. Used at the end of a dialing 
sequence to indicate that the user has finished dialing or to separate one group of dialed 
digits from another.

## End of Dialing. Used to signal the end of the dialing sequence or to separate one group 
of dialed digits from another.
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H

ETR and MLS Display Telephones 4

Some dialing sequences need special characters—for example, the user presses Hold to insert a 
Pause character in a dialing sequence after a dial-out code to allow the system to seize an outside 
line before dialing the number. A Pause character can also be used to separate a telephone 
number from an extension number.

Table H-6. Special Characters for ETR and MLS Display Telephones

Press... See... Means...

Trnsfr s Stop. Halts the dialing sequence to allow for system response.

Hold p Pause. Inserts a 1.5-second pause in the dialing sequence. Multiple 
consecutive pauses are allowed.

Conf f Flash. Sends a switchhook flash. Must be the first entry in the dialing sequence.

# # End of Dialing for extension programming only. Used at the end of a dialing 
sequence to indicate that the user has finished dialing or to separate one group 
of dialed digits from another.

## # End of Dialing. Used to signal the end of the dialing sequence or to separate 
one group of dialed digits from another.
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Numerics

2B Data 

Digital information carried by two B-channels for better performance and quality; 
the bit rate is twice that of one B-channel used alone.

4400-Series Telephones

A family of digital multiline and digital single-line telephones.

A Account Code 

Code used to associate incoming and outgoing calls with corresponding 
accounts, employees, projects, and clients.

ACCUNET

AT&T’s switched digital service for 56-kbps, 64-kbps restricted, and 64-kbps clear 
circuit-switched data calls.

Address

Coded representation of the destination of data or of the data’s originating 
terminal, such as the dialed extension number assigned to the data terminal. 
Multiple terminals on one communications line each must have a unique address.

ADDS

Automated Document Delivery System. Computer-based application that stores 
documents in a database and automatically faxes them on request.

Adjunct 

Optional equipment used with the communications system, such as an alerting 
device or modem that connects to a multiline telephone or to an extension jack.

ALS 

Automatic Line Selection. Programmed order in which the system makes outside 
lines available to a user.
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Ambiguous Numbering

Numbering of extension ranges, remote access codes, or other system 
components that causes conflicts in network operations. These numbers can be 
unique and still be ambiguous. For example, Extension 441 is different from 
Extension 4410; for UDP routing purposes, however, the two numbers are 
ambiguous and a call intended for Extension 4410 would be misrouted, on the 
first three digits sent, to Extension 441. See also Unambiguous Numbering.

AMI 

Alternate Mark Inversion. Line coding format in which a binary one is represented 
by a positive or negative pulse, a binary zero is represented by no line signal, and 
subsequent binary ones must alternate in polarity; otherwise, a bipolar violation 
occurs. AMI is used in the DS1 interface.

Analog Data Station

See Modem Data Station.

Analog Transmission 

Mode of transmission in which information is represented in continuously variable 
physical quantities, such as amplitude, frequency, phase, or resistance. See also 
Digital Transmission.

ANI 

Automatic Number Identification. Process of automatically identifying a caller’s 
billing number and transmitting that number from the caller’s local central office to 
another point on or off the public network.

Application 

Software and/or hardware that adds functional capabilities to the system. For 
example, MERLIN MAGIX Reporter is an application that provides call 
management information (if available in the local area or jurisdiction).

ARS 

Automatic Route Selection. System feature that routes calls on outside facilities 
according to the number dialed and line/trunk availability. To initiate ARS, the 
user dials a dial-out code, also called an “ARS access code.”

ASCAP 

American Society of Composers, Artists, and Producers.

Ascend Pipeline

ISDN-BRI bridge/router that enables high-speed Internet access over a digital 
facility. It makes outgoing calls only.
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ASN 

AT&T Switched Network. AT&T telecommunications services provided through 
an Integrated Digital Services Network Primary Rate Interface (ISDN-PRI) trunk, 
ACCUNET switched digital service, MEGACOM, MEGACOM 800, Software 
Defined Network (SDN), Multiquest, and Shared Access for Switch Services 
(SASS).

Asynchronous Data Transmission

Method of transmitting a short bitstream of digital data, such as printable 
characters represented by a 7- or 8-bit ASCII code. Each string of data bits is 
preceded by a start bit and followed by a stop bit, thus permitting data to be 
transmitted at irregular intervals. See also Synchronous Data Transmission.

AT&T Attendant 

Application with equipment that connects to one or more tip/ring extension jacks 
and automatically answers incoming calls with a recorded announcement; directs 
calls in response to touch tones.

AT&T Switched Network

See ASN.

Automated Attendant

An application that automatically answers incoming calls with a recorded 
announcement and directs callers to a department, an extension, or the system 
operator.

Automated Document Delivery System

See ADDS.

Automatic Immediate Cycling

Process that occurs in a private network when all available routes for a call 
specify systems with matching switch identifiers. The call is routed from the 
originating system to the destination system and back to the originating system in 
a continuous loop. Switch identifier labeling systems must be unique across a 
network.

Automatic Line Selection

See ALS.

Automatic Number Identification

See ANI.

Automatic Ringdown Tie-Trunk

See Automatic-Start Tie Trunk.
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Automatic Route Selection

See ARS.

Automatic-Start Tie Trunk 

Tie trunk on which incoming calls are routed to an operator or other designated 
destination without a start signal, as soon as the trunk is seized; the destination is 
specified during programming. Also called “Automatic Ringdown” or “Auto-In” Tie 
Trunk.

B B8ZS

Bipolar 8 Zero Substitution. Line-coding format that encodes a string of eight 
zeros in a unique binary sequence to detect bipolar violations.

Backup

Procedure for saving a copy of system programming onto a floppy disk or 
memory card. See also Restore.

Bandwidth 

Difference, expressed in hertz, between the highest and lowest frequencies in a 
range that determines channel capacity.

Barrier Code 

Password used to limit access to the Remote Access feature of the system. In a 
private network, it is especially important that barrier codes be required for all 
types of remote access.

Basic Carrier 

Hardware that holds and connects the processor module, power supply module, 
and up to five other modules in the system. See also Expansion Carrier.

Baud Rate 

Strictly speaking, a measurement of transmission speed equal to the number of 
signal level changes per second. In practice, often used synonymously with bit 
rate and bps.

B-Channel 

Bearer-Channel. 64- or 56-kbps channel that carries a variety of digital 
information streams, such as voice at 64 kbps, data at up to 64 kbps, wideband 
voice encoded at 64 kbps, and voice at less than 64 kbps, alone or combined.

Basic Rate Interface

See BRI.

Bearer-Channel

See B-Channel.
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Behind Switch Mode

One of three modes of system operation in which the control unit is connected to 
(behind) another telephone switching system, such as Centrex or DEFINITY, 
which provides features and services to telephone users. See also Hybrid/PBX 
Mode and Key Mode.

Binary Code 

Electrical representation of quantities or symbols expressed in the base-2 number 
system, which includes zeros and ones.

Bipolar 8 Zero Substitution

See B8ZS.

Bipolar Signal 

Digital signal in which pulses (ones) alternate between positive and negative. See 
also AMI, B8ZS, and Bipolar Violation.

Bipolar Violation 

Condition occurring when two positive or two negative pulses are received in 
succession. See also AMI and B8ZS.

Bit

Binary Digit. One unit of information in binary notation; it can have one of two 
values—zero or one.

Bit Rate

Speed at which bits are transmitted, usually expressed in bps. Also called “data 
rate.” 

Blocking

Condition in which end-to-end connections cannot be made on calls because of a 
full load on all possible services and facilities. See also Glare.

BMI

Broadcast Music Incorporated.

Board

Module—for example, 100D or 408 MLX GS/LS—that allows you to connect 
lines/trunks and extensions to the communications system.

Board Assignment

System Programming and Maintenance (SPM) procedure for assigning line/trunk 
and extension modules to slots on the control unit.
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Board Renumbering

System programming procedure for renumbering boards that have already been 
assigned to specific slots on the control unit.

bps

Bits per second.

BRI

Basic Rate Interface. Standard protocol for accessing Integrated Service Digital 
Network (ISDN) services.

Broadband

Transmission path having a bandwidth greater than a voice-grade channel.

Bus

Multiconductor electrical path used to transfer information over a common 
connection from any of several sources to any of several destinations.

Button 

Key on the face of a telephone that is used to access a line, activate a feature, or 
enter a code on a communications system.

Byte 

Sequence of eight bits processed together. Also called “octet.” 

C Call Accounting System

See CAS.

Call Accounting Terminal

See CAT.

Caller ID

Service provided by some local telephone companies (if local regulations allow) 
that supplies the calling party telephone number and name. An 800 GS/LS-ID, 
408 GS/LS-ID-MLX, or 412 LS-ID-TDL module can capture both the number and 
name of the calling party and display them on the screens of 44xx, MLX, ETR, 
and MLS telephones. See also ANI.

Calling Group 

Team of individuals who answer the same types of calls.

Calling Party Name on Caller ID

This central office service allows a subscriber to view the name of the calling 
party on a 44xx, MLX, ETR, or MLS display telephone. 
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Calling Party Number on Caller ID

This central office service allows a subscriber to view the number of the calling 
party on a 44xx, MLX, ETR, or MLS display telephone. 

CAS 

Call Accounting System. DOS- or UNIX System-based application that monitors 
and manages telecommunications costs.

CAT 

Call Accounting Terminal. Stand-alone unit with a built-in microprocessor and 
data buffer that provides simple call accounting at a low cost.

CCITT 

International Telegraph and Telephone Consultative Committee.

CCS 

Common-Channel Signaling. Signaling in which one channel of a group of 
channels carries signaling information for each of the remaining channels, 
permitting each of the remaining channels to be used to nearly full capacity. In the 
system’s 100D module, channel 24 can be designated as the signaling channel 
for channels 1–23.

Centralized Telephone Programming

Programming of features on individual telephones; performed at a central location 
by the system manager. See also System Programming and Extension 
Programming.

Centralized Voice Messaging

Sharing of a voice messaging system by two or more directly connected MERLIN 
MAGIX, MERLIN LEGEND (Release 6.1 or higher), DEFINITY ECS, DEFINITY 
BCS, or DEFINITY ProLogix Solutions systems in a private network.

Central Office 

See CO.

Centrex 

Set of system features to which a user can subscribe on telephone trunks from 
the local telephone company.

Channel 

Telecommunications transmission path for voice and/or data.

Channel Service Unit

See CSU.
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Checksum 

Sum of ones in a sequence of ones and zeros, used to detect or correct errors in 
data transmission.

Circuit-Switched Data Call 

Data call made through an exclusively established and maintained connection 
between data stations.

Class of Restriction

See COR.

Clear Data Channel

Clear data channels (also called unrestricted data channels) allow the 
transmission of occurrences of more than seven contiguous zero bits. If a clear 
data channel is requested and only restricted channels are available, the call will 
be rejected. See also Restricted Data Channel.

Clock Synchronization

When digital signals are transmitted over a communications link, the receiving 
end must be synchronized with the transmitting end to receive the digital signals 
without errors using clock synchronization. A system synchronizes itself by 
extracting a timing signal from an incoming digital stream. All the digital facilities 
in a network operate from a single common clock—preferably a port connected to 
a digital PSTN facility on a hub system or a system that connects two network 
systems. In this case, all digital facilities specify a loop clock source. One system 
in a network may be specified as a local clock source when no functioning digital 
facility in the network is connected to the PSTN. All other digital facilities then use 
this clock and specify their clock sources as loop. Primary, secondary, and 
tertiary clock sources are specified to allow backup synchronization in the event 
that the primary source is out of service. 

CO

Central Office. Location of telephone switching equipment that provides local 
telephone service and access to toll facilities for long-distance calling.

Coaxial Cable

Cable consisting of one conductor, usually a small copper tube or wire within, and 
insulated from, another conductor of larger diameter—usually copper tubing or 
copper braid.

Codec

Coder-Decoder. Device used to convert analog signals— such as speech, music, 
or television—to digital form for transmission over a digital medium and back to 
the original analog form.

Collected Digits

Digits that a caller dials in response to an integrated voice response application’s 
menus; collected digits may be used to initiate a screen pop at a system 
extension. See also CTI Link and Enhanced Customer Care Solution.
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Combination Configuration

Private network arrangement that combines characteristics of Virtual Private 
Network (VPN), a series configuration, and a star configuration.

Common Channel Signaling 

See CCS.

Control Unit 

Processor module, power supply module, other modules, carriers, and housing of 
the system.

Console

Telephone and adjuncts (if any) at an operator or system programmer extension.

CONVERSANT

Entry-level voice response application that automatically answers and routes calls 
and executes telephone transactions.

Conversion Resource

See Modem Pool.

Coordinating System Manager

In a private network that includes more than two systems, the system manager 
who acts as a clearinghouse for any changes made on local systems that affect 
the network, assuring that all system managers work together and that local 
system changes do not have undesirable effects on the network as a whole.

COR

Class of Restriction. Various types of restrictions that can be assigned to remote 
access trunks or barrier codes. These restrictions consist of calling restrictions, 
ARS Facility Restriction Levels (FRLs), Allowed Lists, Disallowed Lists, and 
Automatic Callback queuing.

Coverage

Set of system features that can determine how an extension’s calls are covered 
when the person at the extension is busy or not available.

CRC

Cyclic Redundancy Check. Error-detection code used on DS1 facilities with the 
extended superframe format (ESF).

CSU

Channel Service Unit. Equipment used on customer premises to provide DS1 
facility terminations and signaling compatibility.
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CTI Link

Computer Telephony Integration. Hardware/software feature that is part of the 
PassageWay Telephony Services application. It allows the use of Lucent 
Technologies-certified software applications on a LAN running Novell NetWare or 
Windows NT software in a Hybrid/PBX mode system. These applications may 
provide special features for client control of such calling activities as power 
dialing. See also Screen Pop.

Cyclic Redundancy Check

See CRC.

D D4 Framing Format

Framing format consisting of a sequence of individual frames of 24 eight-bit slots 
and one signal bit (193 bits) in a 12-frame superframe. See also ESF.

Data-Channel 

See D-Channel.

Data Communications Equipment

See DCE.

Data Module

Type of ISDN terminal adapter that acts as the DCE at a data workstation that 
communicates over high-speed digital facilities. 

Data Rate 

See bps.

Data Station

Special type of extension where data communications take place; includes DTE 
and DCE; sometimes a telephone is also part of a data station.

Data Terminal 

Input/output device (often a personal computer) that can be connected to the 
control unit via an interface.

Data Terminal Equipment

See DTE and Data Terminal.

Data Workstation

Special type of extension where data communications take place; includes DTE 
and DCE; sometimes a telephone is also part of a data workstation.
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DCE

Data Communications Equipment. Equipment, such as modems or ISDN terminal 
adapters, used to establish, maintain, and terminate a connection between the 
system and data terminal equipment (DTE)—such as printers, personal 
computers, host computers, or network workstations.

DCP

Digital Communications Protocol. AT&T proprietary protocol to transmit digitized 
voice and data over the same communications link.

D-Channel

Data-Channel. 16- or 64-kbps channel that carries signaling information or data 
on a PRI or BRI.

Dedicated Feature Buttons

The imprinted feature buttons on a telephone: for example, Conf or Conference, 
Drop, Feature, HFAI (Hands-Free Answer on Intercom), Hold, Message, Mute or 
Microphone, Recall, Speakerphone or Spkrphone, and Transfer.

Delay-Start Tie Trunk

Tie trunk or tandem tie trunk on which the originating end of the tie trunk transmits 
an off-hook signal to the receiving end and waits for the receiving end to send an 
off-hook signal followed by an on-hook signal. Also called “dial-repeating tie 
trunk.”

Desktop Videoconferencing System 

System application that allows face-to-face, simultaneous video and voice 
communications between individuals and requires high-speed data transmission 
facilities. See also Group Videoconferencing System.

DFT 

Direct Facility Termination. See Personal Line.

DHG

Data Hunt Group. Group of analog or digital data stations that share a common 
access code. Calls are connected in a round-robin fashion to the first available 
data station in the group.

Dial Access 

See Feature Code.

Dialed Number Identification Service

See DNIS.

Dial-Out Code 

Digit (usually a 9) or digits dialed by telephone users to get an outside line.
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Dial Plan

Numbering scheme for system extensions, lines, and trunks.

Dial-Repeating Tie Trunk

Tie trunk on which the originating end of the tie trunk transmits an off-hook signal 
to the receiving end and waits for the receiving end to send an off-hook signal 
followed by an on-hook signal.

DID

Direct Inward Dial. Service that transmits from the telephone company central 
office and routes incoming calls directly to the called extension, calling group, or 
outgoing line/trunk pool, bypassing the system operator.

DID Trunk

Incoming trunk that receives dialed digits from the local exchange, allowing the 
system to connect directly to an extension without assistance from the system 
operator.

Digital

Representation of information in discrete elements—such as off and on or zero 
and one. See also Analog Transmission.

Digital Communications Protocol

See DCP.

Digital Data Station

See ISDN Terminal Adapter Data Station.

Digital Signal 0 

See DS0.

Digital Signal 1 

See DS1.

Digital Subscriber Line

See DSL.

Digital Transmission

Mode of transmission in which the information to be transmitted is first converted 
to digital form and then transmitted as a serial stream of pulses. See also Analog 
Transmission.

DIP Switch 

Dual In-line Package. Switch on a 400EM module used to select the signaling 
format for tie-line transmission. Also used on other equipment for setting 
hardware options.
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Direct Facility Termination

DFT. See Personal Line.

Direct Inward Dial

See DID.

Direct-Line Console

See DLC.

Direct Station Selector

See DSS.

Display Buttons 

Buttons on a 4412D+, 4424D+, 4424LD+, or MLX display telephone used to 
access the telephone’s display.

DLC 

Direct-Line Console. Telephone used by a system operator to answer outside 
calls (not directed to an individual or a group) and inside calls, to transfer calls, to 
make outside calls for users with outward calling restrictions, to set up conference 
calls, and to monitor system operation.

DNIS 

Dialed Number Identification Service. Service provided by AT&T and MCI to route 
incoming 800 or 900 calls according to customer-selected parameters, such as 
area code, state, or time of call.

Door Answering Unit

Device connected to a tip/ring jack and used at an unattended extension or front 
desk.

DOS

Disk Operating System.

Drop-and-Insert Equipment

Device that can be installed between systems connected by tandem PRI trunks or 
T1-Emulated tandem tie trunks to allow fractional use of the facility—that is, use 
of fewer than 23 of the PRI B-channels or fewer than 24 of the T1 channels. In a 
PRI facility, the equipment must never drop Channel 24, the D-channel. All 
channels must still be programmed and all count towards the system maximum of 
80 lines.

DS0

Digital Signal 0. Single 64-kbps voice or data channel.
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DS1

Digital Signal 1. Bit-oriented signaling interface that multiplexes twenty-four 64-
kbps channels into a single 1.544-mbps stream.

DSL

Digital Subscriber Line. Digital Subscriber Line provides full-duplex service on a 
single twisted metallic pair (2-wire) at a rate sufficient to support ISDN Basic Rate 
Access. 

DSS

Direct Station Selector. Fifty-button adjunct that enhances the call-handling 
capabilities of a 4424D+, 4424LD+, MLX-20L, or MLX-28D telephone used as an 
operator console.

DTE

Data Terminal Equipment. Equipment that makes the endpoints in a connection 
over a data connection—for example, a data terminal, personal computer, host 
computer, or printer.

DTMF signaling

Dual-Tone Multifrequency Signaling. Touch-tone signaling from telephones using 
the voice transmission path. DTMF signaling provides 12 distinct signals, each 
representing a dialed digit or character, and each composed of two voiceband 
frequencies.

E E&M Signaling 

Trunk supervisory signaling, used between two communications systems, in 
which signaling information is transferred through two-state voltage conditions (on 
the Ear and Mouth leads) for analog applications and through two bits for digital 
applications. See also Tie Trunk.

EIA 

Electronic Industries Association.

EIA-232-D

Physical interface, specified by the EIA, that transmits and receives 
asynchronous data at speeds of up to 19.2-kbps over cable distances of 50 feet 
(15 meters).

Electronic Switching System

See ESS.

Endpoint

Final destination in the path of an electrical or telecommunications signal.
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Enhanced Customer Care Solution

Application that sends calls to available agents in a calling group. The Enhanced 
Customer Care Solution places calls in queue, plays announcements, tracks 
agent activity and availability, and provides real-time reports.

ESF

Extended Superframe Format. PRI framing format consisting of individual frames 
of 24 eight-bit slots and one signal bit (193 bits) in a 24-frame extended 
superframe.

ESS 

Electronic Switching System. Class of central office (CO) switching systems 
developed by Lucent Technologies in which the control functions are performed 
principally by electronic data processors operating under the direction of a stored 
program.

ETR Telephone

Enhanced tip/ring telephone (Series 4). 

Expansion Carrier

Carrier added to the control unit when the basic carrier cannot house all of the 
required modules. Houses a power supply module and up to six additional 
modules.

Extended Superframe Format

See ESF.

Extension

Endpoint on the internal side of the communications system. An extension can be 
a telephone with or without an adjunct. Also called “station.” See also Data 
Workstation.

Extension Jack

An analog, digital, or tip/ring physical interface on a module in the control unit for 
connecting a telephone or other device to the system. Also called “station jack.”

Extension Programming

Programming performed at an extension to customize telephones for personal 
needs; users can program features on buttons, set the telephone ringing pattern, 
and so on. See also Centralized Telephone Programming and System 
Programming.
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F Facility 

Equipment (often a line/trunk) constituting a telecommunications path between 
the system and the telephone company central office (CO).

Facility Restriction Level

See FRL.

Factory Setting 

Default state of a device or feature when an optional setting is not programmed 
by the user or system manager.

Fax 

Facsimile. Scanning and transmission of a graphic image over a 
telecommunications facility, or the resulting reproduced image, or the machine 
that does the scanning and transmitting.

FCC

Federal Communications Commission.

Feature 

Function or service provided by the system.

Feature Code 

Code entered on a dialpad to activate a feature. 

Feature Screen 

Display screen on 4412D+, 4424D+, 4424LD+, and MLX display telephones; 
provides quick access to commonly used features.

Flash ROM

Type of read-only memory provided on the processor module, used to supply 
system features.

Foil Shield 

Copper foil sheet (for power units), used to prevent excessive noise on the 
module.

Forced Idle

Condition of the system during certain programming or maintenance procedures; 
system prevents initiation of new calls.

Foreign Exchange

See FX.
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Fractional-T1

A digital transmission facility consisting of at least one, and fewer than 24, DS0 
channels using robbed-bit signaling, and connecting a PBX and a central office or 
toll office.

Frame 

One of several segments of an analog or digital signal that has a repetitive 
characteristic. For example, a DS1 frame consists of a framing bit and 24 bytes, 
which equals 193 bits.

Framing Format

Pattern of frames used in transmissions.

FRL 

Facility Restriction Level. Calling restriction type that restricts calls to certain 
specified ARS and UDP routes.

FX 

Foreign Exchange. Central office other than the one that is providing local access 
to the public telephone network.

G Glare 

Condition that occurs when a user tries to call out on a loop-start line at the same 
time that another call arrives on the same line.

Ground-Start Trunk

Trunk on which the communications system, after verifying that the trunk is idle 
(no ground on tip lead), transmits a request for service (puts ground on ring lead) 
to the telephone company central office.

Group IV (G4) Fax Machine

Fax unit, offering 400 by 100 dots per inch (DPI) in fine mode, that can operate at 
any speed for communication with a Group III (G3) fax machine or another Group 
IV (G4) fax machine.

Group Videoconferencing System 

System application that allows face-to-face, simultaneous video and voice 
communications between groups and requires high-speed data transmission 
facilities. See also Desktop Videoconferencing System.

H Hands-Free Answer Intercom

See HFAI.

Headset

Lightweight earpiece and microphone used for hands-free telephone operation.
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HFAI 

Hands-Free Answer Intercom. Feature that allows a user to answer a voice-
announced call. 

Home Screen 

Display normally shown on a 44xx or MLX display telephone; shows time, date, 
and call information, as well as when some features are in use.

Host 

Telephone company or other switch providing features and services to the 
system users, usually when the system is operating in Behind Switch mode.

Hub System

In a private network that is arranged in a star configuration, the communications 
system through which all calls across the network pass.

Hybrid/PBX Mode

One of three modes of system operation in which the system uses line/trunk 
pools and ARS in addition to personal lines. Provides a single interface (SA 
buttons) to users for both internal and external calling. See also Behind Switch 
Mode and Key Mode.

I ICLID

Incoming Call Line Identification. See Caller ID.

ICOM Buttons

Intercom Buttons. Telephone buttons that provide access to inside system lines 
for calling other extensions or receiving calls from them.

Immediate-Start Tie Trunk

Tie trunk on which no start signal is necessary; dialing can begin immediately 
after the trunk is seized.

In-Band Signaling

See Robbed-Bit Signaling.

Inside Dial Tone

Tone users hear when they are off-hook on an SA or ICOM button.

Inspect Screen

Display screen on a multiline 44xx or MLX display telephone that allows the user 
to preview incoming calls and view a list of the features programmed on line 
buttons.
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Integrated Services Digital Network

See ISDN.

Integrated Solution III

See IS III.

Integrated System

Software-controlled processor complex that interprets dialing pulses, tones, and/
or keyboard characters and makes the proper interconnections—both inside and 
outside. Consists of a computer, software, a storage device, and carriers with 
special hardware to perform the actual connections. Provides voice and/or data 
communications services, including access to public and private networks, for 
telephones and other equipment. Also referred to in this guide as “system,” short 
for MERLIN MAGIX Integrated System.

Intercom Buttons

See ICOM Buttons.

Interface

Hardware and/or software that links systems, programs, or devices.

Intersystem Calls

In a private network, calls between a local extension and a local or non-local dial 
plan extension.

Intuity

Set of integrated applications that provides voice mail, fax messaging, Automated 
Attendant, call accounting, and system programming.

Intuity CONVERSANT

Voice response application that automatically answers and routes calls and 
executes telephone transactions.

I/O Device

Input/Output Device. Equipment that can be attached to a computer internally or 
externally for managing a computer system’s input and output of information.

IROB Protector 

In-Range Out-of-Building protector. Surge-protection device for off-premises 
telephones at a location within 1000 feet (305 meters) of cable distance from the 
control unit.

IS III 

Integrated Solution III. Set of UNIX System-based applications that augments and 
provides additional services using the system. IS III is no longer available.
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ISDN 

Integrated Services Digital Network. Public or private network that provides end-
to-end digital connectivity for all services to which users have access by a limited 
set of standard multipurpose user and network interfaces; provides digital circuit-
switched or packet-switched connections within the network and to other 
networks for national and international digital connectivity.

ISDN Terminal Adapter

Integrated Services Digital Network Terminal Adapter. A device that connects the 
communications system with data terminal equipment (DTE).

ISDN Terminal Adapter Data Station

Type of data station that includes an ISDN terminal adapter as its DCE. It may 
also include an MLX telephone for simultaneous voice and data (ISDN terminal 
adapter data-only station). These data stations connect to MLX extension jack 
modules for digital transmission of data over a DS1 facility.

J Jack 

Physical connection point to the system for a telephone, line/trunk, or other 
device. Also called “port.”

K kbps 

kilobits per second.

Key Mode 

One of three modes of system operation, in which the system uses personal lines 
on line buttons for outside calls, with a separate interface (ICOM buttons) for 
inside calling. See also Behind Switch Mode and Hybrid/PBX Mode.

L LAN

Local Area Network. Arrangement of interconnected personal computers or 
terminals, which sometimes access a host computer, and sometimes sharing 
resources such as files and printers.

LDN

Listed Directory Number.

LED 

Light-Emitting Diode. Semiconductor device that produces light when voltage is 
applied; light on a telephone.

Line

Connection between extensions within the communications system; often, 
however, used synonymously with trunk.
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Line and Trunk Assignment

Assignment of lines and trunks connected to the system control unit to specific 
buttons on each telephone.

Line Coding 

Pattern that data assumes as it is transmitted over a communications channel.

Line Compensation

Adjustment for the amount of cable loss in decibels (dB), based on the length of 
cable between a 100D module and a channel service unit (CSU) or other far-end 
connection point.

Line/Trunk

Refers to inside system lines and outside lines/trunks in general terms. See also 
Line and Trunk.

Line/Trunk Jack 

Physical interface on a module in the control unit for connecting an outside line/
trunk to the communications system. Also called “trunk jack.”

Line/Trunk and Extension Module

Module on which the jacks for connecting central office lines/trunks and/or the 
jacks for connecting the extensions are located.

Local Dial Plan

In a system that is part of a private network, list of extension ranges that the local 
system refers to in order to route local intersystem calls via UDP.

Local Extension

In a system that is part of a private network, extension that is listed in the 
system’s local dial plan.

Local Host Computer Access

Method for connecting an extension jack to an on-site computer for data-only 
calls through a modem or ISDN terminal adapter.

Local Loop

The two-way connection between a customer’s premises and the central office.

Local User

In a private network, person whose extension is connected to the local control 
unit.
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Logical ID

Unique numeric identifier for each extension and line/trunk jack in the system 
control unit.

Loop-Start Line

Line on which a closure between the tip and ring leads is used to originate or 
answer a call. High-voltage 20-Hz AC ringing current from the central office 
signals an incoming call.

M Magic On Hold

Lucent Technologies Music-On-Hold enhancement that promotes a company’s 
products or services.

mbps

megabits per second.

Megacom

AT&T tariffed digital WATS offering for outward calling.

Megacom 800

AT&T tariffed digital 800 offering for inward calling.

Memory Card

Storage medium, similar in function to a floppy disk, that allows information to be 
added to, or obtained from, the communications system through the PCMCIA 
interface slot on the processor module.

MERLIN Messaging System

Voice-messaging system that provides Automated Attendant, call answering, and 
voice-mail services. It is housed in its own module.

Messaging 2000

See Octel 100.

MFM

Multi-Function Module. Adapter that has a tip/ring mode for answering machines, 
modems, fax machines, and tip/ring alerts, and an SAA mode for -48 VDC alerts. 
It is installed inside an MLX telephone and is used to connect optional equipment 
to the telephone. The optional equipment and the telephone operate 
simultaneously and independently.

MLS Telephone

An enhanced tip/ring (Series 3) telephone. No longer available.
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MLX Telephone

Multiline button telephone that transmits and receives digital signals.

Mode Codes 

Streams of touch-tone codes used by voice messaging applications to 
communicate with the system’s control unit.

Modem 

Device that converts digital data signals to analog signals for transmission over a 
telephone line, and analog signals received on a telephone line to digital signals.

Modem Data Station

Type of data station that includes a modem as its DCE. It may also include an 
MLX telephone for simultaneous voice and data (MLX voice and modem data 
station), an analog multiline telephone (analog voice and modem data station), or 
a single-line telephone for dialing only (modem data-only station). These data 
stations connect respectively to MLX, analog, or tip/ring extension jack modules. 
They provide analog transmission of data.

Modem Pool 

Pair, or group of pairs, of modems and data modules with interconnected RS-232 
interfaces that converts digital signals to analog, or analog signals to digital, 
thereby allowing users with ISDN terminal adapter data stations to communicate 
with users who have analog modem data stations.

Module 

Circuit pack in the control unit that provides the physical jacks for connecting 
telephones and/or outside lines/trunks to the communications system. In the 
name of a module, the first digit indicates the number of line/trunk jacks it 
contains; the last digit indicates the number of extension jacks it contains. If no 
letters appear after the number, a line/trunk module provides loop-start lines or an 
extension jack module provides analog or tip/ring jacks. For example, a 408 GS/
LS-MLX module contains four line/trunk jacks and eight digital (MLX) extension 
jacks, and provides either loop-start (LS) or ground-start (GS) trunks. 

Monitored Extension

Extension for which one or more CTI applications is receiving call information. 
The CTI application does not have to be directly attached to the equipment at the 
extension in order to monitor calls. The call information may appear on the PC 
screen of another extension that has been programmed to receive it. See also 
CTI Link and Unmonitored Extension.

Multi-Function Module

See MFM.

Multiline Telephone

Telephone that provides multiple line buttons for making or receiving calls or 
programming features.
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Multiplexing 

Division of a transmission channel into two or more independent channels—either 
by splitting the frequency band into a number of narrower bands or by dividing the 
channel into successive time slots.

Music-On-Hold 

Customer-provided music source or Magic On Hold connected to the system 
through a loop-start jack.

N Network 

Configuration of communications devices and software connected for information 
interchange.

Network Interface 

Hardware, software, or both that links two systems in an interconnected group of 
systems—for example, between the local telephone company and a PBX.

NI-1 BRI

National Integrated Services Digital Network 1 Basic Rate Interface. Type of 
digital facility that carries the equivalent of three lines. Two are called B-channels 
and provide voice and data communications services. A third D-channel controls 
signaling and maintains operations on the B-channels.

Non-Local Dial Plan

In a system that is part of a private network, list of extension ranges that the local 
system references in order to route non-local intersystem calls via UDP.

Non-Local Extension

In a system that is part of a private network, extension that is in the non-local dial 
plan.

Non-Local User

In a private network, user who is connected to another system in the network and 
not to the local system.

Non-Satellite System

In a private network, communications system that is directly connected to and 
located more than 200 miles from the local system.

O Octel 100 Messaging

Voice-messaging system housed in a PC that connects to tip/ring ports on the 
system’s modules. Messaging 2000 provides voice mail, Automated Attendant, 
call answering, and fax messaging services.
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Off-Hook 

Telephone is said to be off-hook when the user has lifted the handset, pressed 
the speakerphone button to turn on the speakerphone, or used a headset to 
connect to the communications system or the telephone network.

Off-Premises Telephone

See OPT.

Ones Density 

Requirement for channelized DS1 service to the public network that prohibits 
eight consecutive zeros in a digital data stream.

On-Hook 

Telephone is said to be on-hook when the handset is hung up, the speakerphone 
is turned off, and the user is not using a headset to connect to the 
communications system or the telephone network.

OPT 

Off-Premises Telephone. Single-line telephone or other tip/ring device connected 
to the system via a 008 OPT module in the control unit. Appears as an inside 
extension to the system, but may be physically located away from the system.

OPX

Off-Premises Extension.

Out-of-Band Signaling

Signaling that uses the same path as voice-frequency transmission and in which 
the signaling is outside the band used for voice frequencies.

P Parity 

Addition of a bit to a bit string so that the total number of ones is odd or even; 
used to detect and correct transmission errors.

PassageWay Direct Connection Solution

Set of software applications that provides an interface between a personal 
computer and an MLX telephone.

PBX 

Private Branch Exchange. Local electronic telephone switch that serves local 
stations (for example, extensions within a business) and provides them with 
access to the public network.

PC

Personal Computer.
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PCMCIA Memory Card

Personal Computer Memory Card International Association Memory Card. See 
Memory Card.

Peripheral System

In a private network, system that does not connect to more than one other 
system, sometimes called an “end node.”

Personal Line 

Central office line/trunk that terminates directly at one or more extensions. In 
Hybrid/PBX mode, a personal line cannot be part of a line/trunk pool. Also called 
“DFT” (Direct Facility Termination).

PFT 

Power Failure Transfer. Feature that provides continuity of telephone service 
during a commercial power failure by switching some of the system’s line/trunk 
connections to telephones connected to specially designated extension jacks.

Phantom Extension

Extension that is not actually plugged into the system, but is used, for example, 
as a calling group member covered by a voice messaging system.

Pool 

In Hybrid/PBX mode, a group of outside lines/trunks that users can access with a 
Pool button or by dialing an access code on an SA button. Also used by the ARS 
feature when choosing the least expensive route for a call.

Point-to-Point Facility

In a private network, a line/trunk that passes through the PSTN without using the 
switching capabilities of the PSTN.

Port 

See Jack. Also, refers to extension or line/trunk jacks before these are numbered 
according to the dial plan during programming. The lowest jack on a module is 
always Port 1.

Power Failure Transfer

See PFT.

Power Supply Module

Device that directs electricity to modules and telephones on the system. One 
power supply module is needed for each carrier.
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PRI 

Primary Rate Interface. Standard interface that specifies the protocol used 
between two or more communications systems. As used in North America, it 
provides twenty-three 64-kbps B-channels for voice and/or data and one 16-kbps 
D-channel, which carries multiplexed signaling information for the other 23 
channels.

Primary System Operator Position

First extension jack on the first TDL or MLX module in the control unit—that is, 
the extension jack with the lowest logical ID in the system.

Prime Line 

Individual extension number assigned to a telephone in a system operating in 
Behind Switch mode. Each telephone user has his or her own prime line and is 
automatically connected to that line when he or she lifts the handset.

Priority Call Queuing

System function that prioritizes calling groups, thereby allowing certain incoming 
calls to be answered before others.

Private Communications Network 

See Private Network.

Private Network

Interconnected group of communications systems, which may consist of MERLIN 
MAGIX Integrated Systems, MERLIN LEGEND Communications Systems, 
DEFINITY Enterprise Communications Servers (ECS), DEFINITY Business 
Communications Servers (BCS),and/or DEFINITY ProLogix Solutions.

Reviewers: Is this the correct name for BCS?

Private Network Trunks

Facilities that connect communications systems in a private network. See also 
Tandem Tie Trunk and Tandem PRI Trunk.

Processor Module

Module in the second slot of the control unit (Slot 0, to the right of the power 
supply module). Includes the software and memory that runs the system.

Programming Port Reassignment

Reassignment of the system programming jack position to any of the first five 
extension jacks on the first TDL or MLX module in the control unit.

Protocol 

Set of conventions governing the format and timing of message exchanges 
between devices, such as an MLX telephone and the control unit.
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PSTN

Public Switched Telephone Network. Network that is commonly accessible for 
local or long-distance calling. Also called “public network” or “public switched 
network.”

PSTN Trunk

In a private network, facility that connects a networked system to the public 
switched telephone network.

Public switched Telephone Network 

See PSTN.

Q QCC 

Queued Call Console. A 4424LD+ or MLX-20L telephone used by a system 
operator in Hybrid/PBX mode only. Used to answer outside calls (directed to a 
system operator position) and inside calls, to direct inside and outside calls to an 
extension or to an outside telephone number, to serve as a message center, to 
make outside calls for users with outward calling restrictions, to set up conference 
calls, and to monitor system operation.

R RAM 

Random-Access Memory. Computer memory in which an individual byte or range 
of bytes can be addressed and read or changed without affecting other parts of 
memory.

Read-Only Memory

See ROM.

Remote Access

System feature that allows an outside caller to gain access to the system, almost 
as if at a system extension. In a private network, remote access settings are used 
to control calls routed via ARS or UDP routing across the network.

Restore

Procedure whereby saved and archived system programming is reinstated on the 
system, from a floppy disk or memory card. See also Backup.

Restricted Data Channel

Channels that do not allow the transmission of occurrences of more than seven 
contiguous zero bits. See also Unrestricted Data Channels.

Rotary Dial Enable

Through centralized programming, T/R ports (including the T/R ports on the new 
ETR modules) can be programmed to accept rotary-dial and touch-tone digits or 
just touch-tone digits.
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Riser Cable 

Cable that runs between floors in a multi-story building and connects wiring 
closets.

RS-232 

Physical interface, specified by the Electronics Industries Association (EIA), that 
transmits and receives asynchronous data at distances of up to 50 feet 
(15 meters).

Robbed-Bit Signaling 

Signaling in which the least significant bit of every sixth frame per channel is used 
for signaling in that channel.

ROM 

Read-Only Memory. Computer memory that can be read, but cannot be changed.

S SA buttons

Telephone buttons that provide access to both inside and outside calls.

Satellite System

In a private network, a communications system that is directly connected to, and 
located within 200 miles of the local system.

Screen Pop

Refers to a computer-telephony software application that takes caller information 
(for example, the calling party number provided by Caller ID service), queries a 
database, and displays a screen with information about the caller onto a user’s 
PC screen. Screen pop requires that an identifying number or code be available 
to identify the calling party. See also CTI Link.

SDN 

Software Defined Network. AT&T private networking service created by 
specialized software within the public network.

Series Configuration

Private network arrangement whereby either two or four or more communications 
systems are connected in a line, with no particular system acting as the hub 
system. See also Star Configuration. 

Service Observing

Feature that allows one extension to listen in (observe) on calls that arrive at 
another extension.

SID 

Station (Extension) Identification.
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Signaling 

Sending of information between devices to set up, maintain, or cease a 
connection, such as a telephone call.

Simplex Signaling

Transmission of signals in one direction only, across a telecommunications 
channel.

Single-Line Telephone

Industry-standard touch-tone or rotary dial telephone that handles one call at a 
time. It is connected to the system via an extension jack on a 016 (T/R) or 008 
OPT module, or via a port on an 016 ETR module programmed for tip/ring 
operation.

Slot

Position in a carrier for a module; numbered from 0.

SMDR 

Station Message Detail Recording. Feature that captures usage information on 
incoming and outgoing calls.

SMDR Printer 

Printer used to produce SMDR reports. Connected to the system via an RS-232 
jack on the processor module.

Software Defined Network

See SDN.

Special Character

Pause, Stop, or End-of-Dialing signal in a programmed dialing sequence, such as 
a speed dial number.

Square Key 

Configuration in Key mode operation in which all outside lines appear on all 
telephones.

Star Configuration

Private network arrangement whereby either three or more communications 
systems are connected with one system acting as the hub system. See also 
Series Configuration. 

Station 

See Extension.
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Station Jack 

See Extension Jack.

Station Message Detail Recording

See SMDR.

Switch

See Integrated System.

Switched 56 Service

DS1 Switched 56 service is an end-to-end digital, 56-kbps, full-duplex, 
synchronous, circuit-switched service offering. The service is offered by network 
service providers and by some Local Exchange Carriers (LECs) as circuit-
switched, 56-kbps service. T1-emulated tandem tie trunks in a private network 
can be programmed for data.

Switchhook Flash

Momentary (320 ms to 1 sec) on-hook signal used as a control; may be directed 
to the control unit or to a host switch outside the system. Also called “Recall” or 
“timed flash.”

Switch Identifier

Number assigned to a tandem trunk in a private network. It identifies the system 
connected to the far end of the trunk. A switch identifier is based on the type of 
system and its distance from the system where the identifier is assigned. See 
also Satellite System and Non-Satellite System.

Synchronous Data Transmission

Method of transmitting a continuous digital data stream in which the transmission 
of each binary bit is synchronized with a master clock. See also Asynchronous 
Data Transmission.

System Acceptance Test

Test of all trunks, telephones, data terminals, and features after installation to 
ensure that they are working correctly.

System Access Buttons

See SA buttons.

System Date and Time 

Date and time that appear on 44xx, MLX, and ETR display telephones and SMDR 
reports.
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System Programming

Programming of system functions and features that affect most users, performed 
from a 4424LD+ or MLX-20L telephone or a computer using WinSPM. See also 
Extension Programming and Centralized Telephone Programming. 

System Programming and Maintenance

See WinSPM.

System Renumbering

Procedure used to change the numbers assigned to telephones, adjuncts, calling 
groups, paging groups, park zones, Remote Access, and lines/trunks.

T T1 

Type of digital transmission facility that, in North America, transmits at the DS1 
rate of 1.544 mbps.

T1-Emulated Data

A T1 tie trunk programmed for S56DATA for use by data calls at speeds up to 56 
kbps. These trunks may be used for tandem and non-tandem operation.

T1-Emulated Voice

A T1 tie trunk programmed for Tie-PBX or Tie-Toll for use by voice calls.

T1 Switched 56 Service

T1 digital data transmission over the public network or over a private network at 
56 kbps. See Switched 56 Service.

Tandem Switching

Capability of private network communications systems that allows them to direct 
outside calls from one facility to another, rather than just to an extension. Calls 
may be sent, for example, from a PSTN facility to a tandem trunk, or vice versa.

Tandem Trunk

Private outside facility (as opposed to an inside system line) that connects two 
communications systems in a private network and can carry calls to another 
outside facility through tandem switching. The trunk is not connected to the 
PSTN.

Tandem Tie Trunk

Tandem trunk that is an analog delay-start tie trunk, providing a single line/trunk 
per facility and allowing analog transmission of voice and low-speed data; or a T1 
facility offering 24 channels on emulated tie trunks and programmed for voice or 
data.
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Tandem PRI Trunk

Tandem Primary Rate Interface Trunk. Private network trunk.

TAPI

Telephony Application Programming Interface. Application programming interface 
that allows computer telephony applications to be used with MLX telephones. 
See also Passageway Direct Connection Solution.

Telephone Power Supply Unit

Equipment that provides power to an individual telephone.

Terminal Adapter

See ISDN Terminal Adapter.

Tie Trunk 

Private trunk directly connecting two telephone switches. 

Timed Flash 

See Switchhook Flash.

Tip/Ring 

Contacts and associated conductors of a single-line telephone plug or jack.

Touch-Tone Receiver

See TTR.

T/R 

See Tip/Ring.

Trunk

Telecommunications path between the communications system and the 
telephone company central office or another switch. Often used synonymously 
with line.

Trunk Jack 

See Line/Trunk Jack.

Trunk Pool

See Pool.

TSAPI

Telephony Services Application Programming Interface. Application programming 
interface that allows computer telephony applications to be used. See also TAPI 
and CTI Link.
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TTR 

Touch-Tone Receiver. Device used to decode DTMF touch-tones dialed from 
single-line or Remote Access telephones.

U UDP

Uniform Dial Plan. Composed of the local dial plan and non-local dial plan. A dial 
plan that allows a caller at any extension in a private network to dial the same 
number of digits to reach any other extension in the private network, even if the 
originating extension is physically connected to one communications system and 
the terminating extension is physically connected to a different communications 
system.

Unambiguous Numbering

Practice of numbering of extension ranges, remote access codes, or other 
system components to avoid routing conflicts in network or local calling. For 
example, Extension 441 is unique when compared to Extension 4410; however, 
this is ambiguous, because the system routes as soon as it matches the digits 
sent for a call with the digits in a local dial plan or in a non-local dial plan 
extension range. When a caller dials 4410, therefore, the system routes the call 
to Extension 441 without considering the last dialed digit.

Uniform Dial Plan

See UDP.

Uninterruptible Power Supply

See UPS.

Unit Load 

Measure of the power load drain of a module, telephone, or adjunct.

Unmonitored Extension

Extension for which no CTI application is receiving call information. See also CTI 
Link and Monitored Extension.

Unrestricted Data Channels

Also called Clear Data Channels. Allow the transmission of occurrences of more 
than seven contiguous zero bits. If an unrestricted data channel is requested and 
only restricted channels are available, the call will be rejected. See also 
Restricted Data Channel.

UPS 

Uninterruptible Power Supply. Device that connects to the system to provide 117 
VAC to the equipment when the commercial power source fails.
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V VAC 

Alternating Current Voltage.

VDC 

Direct Current Voltage.

VMI 

Voice Messaging Interface. Enhanced tip/ring port.

VideoconferencingSystem

System application that allows face-to-face meetings, with voice and video, 
between individuals or groups. This application requires high-speed data 
transmission facilities. See also Desktop Videoconferencing System and Group 
Videoconferencing System.

Virtual Private Network

See VPN.

VPN

Virtual Private Network. Type of private network that uses the switching 
capabilities of the PSTN, rather than tandem switching, to direct calls between 
connected communications systems. A VPN may constitute a part of a private 
network.

Voice Announce

System feature that allows users to receive voice announcements on their 
telephones. In Release 7.0 and later systems, the VA On Idle Only option (only 
for MLX telephones) allows voice announcement calls to go through only when 
the telephone is idle. 

Voice-Band Channel

Transmission channel, generally in the 300–3400-Hz frequency band.

Voice Mail

Application that allows users to send messages to other system extensions, to 
forward messages received with comments, and to reply to messages.

Voice Messaging Interface

See VMI.
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W WATS 

Wide Area Telecommunications Service. Service that allows calls to certain areas 
for a flat-rate charge based on expected usage.

Wink-Start Tie Trunk

Tie trunk on which the originating end transmits an off-hook signal and waits for 
the remote end to send back a signal (a wink) that it is ready for transmission.

WinSPM 

Windows System Programming and Maintenance. Windows-based application for 
programming the system. 
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Numerics

008 MLX module, 1-4
016 ETR

assign T/R or ETR functionality, 3-92
016 T/R module

ringing frequency, 3-26
024 TDL module, 1-4
1 + 7-digit dialing requirements, 3-177
100D module

clock synchronization, 3-34
2B Data option, 3-205
2-digit numbering plan, 3-9
355A modular adapter, 2-2
408 GS/LS-MLX module, 1-4
412 LS-ID-TDL module, 1-4
4ESS, 3-62
5ESS, 3-62
7 x 24 display, 2-26
800 CO-BRI

clock synchronization, 3-34

A

Account Code
SMDR format, 3-157

Adapter
355A, 2-2

Add digits, 3-59
Alarms

maintenance, 3-96
threshold, 3-139

Allowed Lists
assign to telephones, 3-163
creating or changing, 3-163

Arrow keys, 2-28
Assigning

Allowed Lists, 3-163
Disallowed Lists, 3-164
Intercom buttons, 3-87
System Access (SA) buttons, 3-87, 3-136
trunks or pools, 3-84

Authorization Codes, 3-110, 3-157
Automated Attendant, 3-97
Automatic Backup, 3-212
Automatic Callback, 3-169
Automatic hold or release, 3-121
Automatic maintenance busy, 3-6

Automatic Route Selection (ARS)
dial 0 table, 3-185
digit absorption, 3-182, 3-189
extension restriction level, 3-107
Facility Restriction Level, 3-180, 3-188, 3-189
N11 special numbers table, 3-184
other digits, 3-183
overview, 3-175
Pool routing, 3-179
start and stop times for subpatterns, 3-178
tables, 3-177
voice and/or data routing, 3-185, 3-191

Auxiliary equipment
loudspeaker paging, 3-94
maintenance alarms, 3-96
Music-On-Hold, 3-93
voice messaging systems (VMSs), 3-97

B

Backing up the system
description, 2-29
directory, 2-29
menu option, 2-29
to memory card, 3-211

Barrier codes
changing codes, 3-172
changing length, 3-172
establishing requirements, 3-170, 3-172

Basic Rate Interface (BRI), 3-81
clock synchronization, 3-34
Directory Number, 3-81
Service Profile Identifier, 3-81

B-Channel Groups, 3-64
Behind Switch mode

dial codes, 3-161
Block assignment, DID trunks, 3-55, 3-56
Block renumbering, 3-9, 3-14
Board renumbering, 2-31, 3-4
Boards, 2-31

inspect, 2-32
null, 2-31
phantom, 2-31
programming in surrogate mode, 2-31
types, 2-32



MERLIN MAGIX™ Integrated System Release 1.0
System Programing  555-710-111  

Issue 1
October 1999

Index 
IN-2 

IN

C

Call
extended completion, 3-128
remote forwarding, 3-111
restrictions, 3-105

Call Forwarding
Delayed, 3-113

Call Pickup groups, 3-132
Call types

queue priority level, 3-127
Callback

automatic interval, 3-153
Call-by-Call Service Table, 3-79
Caller ID, 3-33
Calling Groups

supportive relationship, 3-136
Calls-in-Queue alert, 3-125
Camp-On

return time, 3-152
Channel service unit (CSU), 3-49
Circular Hunting Pattern, 3-138
Clock synchronization, 3-34
COM1, 2-3
COM2, 2-3
Compressed files, 2-30
Computer Telephony Integration (CTI), 3-98

programming errors, 3-100
Configuration

attributes, 2-36
Console

MLX-20L, 2-26
system programming, 2-26
window language, 2-36

Copy
call restrictions, 3-107
line/trunk assignments, 3-86
options for lines/trunks, 3-37

Counters, Primary Rate Interface (PRI), 3-70

D

D8W modular cord, 2-2
Data

2B Data, 3-205
features, 3-204

Date, 3-7
Default

password, 2-40
Delete digits, 3-58
DEX600E, 3-62
Dial 0 table, 3-185
Dial mode, 3-52
Dial plan routing, 3-73
Dial-out code, 3-104

Dialtone
inside, 3-159
outside, 3-159

DID Trunks, 3-55, 3-56
Digit absorption, 3-182, 3-189
Digital Signal 1 (DS1) facilities

channel service unit (CSU), 3-49
clock synchronization, 3-34
frame format, 3-40, 3-46
line compensation, 3-48
signaling mode, 3-47
zero code suppression, 3-47

Digits
add, 3-59
delete, 3-58
expected, 3-57

Direct Inward Dial (DID) trunks
add digits, 3-59
block assignment, 3-55, 3-56
delete digits, 3-58
disconnect time, 3-57
expected digits, 3-57
invalid destination, 3-60
signaling, 3-59
type, 3-56

Direct Station Selector (DSS)
page buttons, 3-18

Direct-Line Console (DLC)
operator positions, 3-19

Directory
extension, 3-196
personal, 3-196
System Speed Dial, 3-199

Directory Number (DN), 3-81
Disallowed Lists

assign lists to telephones, 3-165
creating or changing lists, 3-164

Disconnect
interval, 3-29
time (DID), 3-57
time (tie trunk), 3-54

DMS-100 services, 3-62
DMS-250, 3-62

E

E&M Signal, 3-51
End key, 2-27
Enter key, 2-28
Expected digits, 3-57
Extended call completion, 3-128
Extensions

Automatic Route Selection (ARS) restriction 
level, 3-107

directory, 3-196
forced idle, 2-45
status, 3-153
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F

Facility Restriction Levels (FRLs), 3-180, 3-188
Fax machines

assigning an extension, 3-95
Features

data, 3-204
group, 3-55, 3-56, 3-84, 3-131, 3-148
Group Calling, 3-137
operator, 3-120
Queued Call Console (QCC), 3-121
Remote Access, 3-165
system, 3-148
telephone, 3-103

Flash, 2-27
Follow Me

Delayed Call Forwarding, 3-113
Forced Account Code Entry, 3-109
Forced idle

extensions, 2-45, 2-46
general, 2-45
lines/trunks, 2-46
reminder tones, 2-46

Frame format, 3-40, 3-46
Frigid start, 2-43

G

Ground-start trunks
Outmode signaling, 3-25
toll type, 3-28

Group Calling
Announcement Interval, 3-139
Calls-in-Queue Alarm Thresholds, 3-143
delay announcement, 3-138
external alert for Calls-in-Queue alarm, 3-144
features, 3-137
labeling, 3-198
line/trunk or Pool assignments, 3-136
member assignments, 3-134
Message-waiting indicator, 3-142
number-based overflow, 3-141
overflow and thresholds, 3-141
Repeatable Announcement, 3-140
time-based overflow, 3-141
type, 3-145

Group Coverage
member assignments, 3-133
receiver, 3-140
ring delay, 3-116

Group paging, 3-132
Groups

call pickup, 3-132
Night Service, 3-192

H

Help, 2-25
Helpline, Lucent Technologies, xxi
Hold

automatic, 3-123
automatic, Direct-Line Console (DLC), 3-121
disconnect interval, 3-29
one-touch, 3-149
return, 3-120
timer, 3-120

Host system dial codes, 3-161
Hunt type, 3-138

I

I/O address, 2-3
Idle states, 2-45
Incoming routing, 3-68
Inside dial tone, 3-159
Inspect

boards, 2-32
key, 2-34

Installation procedure, 2-3
Intercom buttons

assigning, 3-87, 3-136
Inter-digit timers, 3-162
Interrupt, 2-3
Intuity, GL-19
Invalid destination, 3-60

K

Keys
arrow, 2-28
function, 2-27
sequences, 2-27

L

Labeling, 3-196
extension directory, 3-196
group calling, 3-198
lines/trunks, 3-197
posted message, 3-198
system speed dial directory, 3-199
using SPM, 3-196
using system programming console, 3-196

Language
console window, 2-36
menu option, 2-29
overview, 2-36
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Language, (continued)
PC, 2-36
procedure, 2-36
report, 3-200
Station Message Detail Recording (SMDR) 

report, 3-154
Legend-NTWK, 3-62
Legend-PBX, 3-62
Line buttons, 2-27
Line Compensation, 3-48
Linear Hunting Pattern, 3-138
Lines/trunks

assigning to Pools, 3-35
assigning to telephones, 3-84
copy options, 3-37
copying assignments, 3-86
forced idle, 2-46
group calling assignments, 3-136
labeling, 3-197
programming, 3-23
tie, 3-49
type, 3-23

Loop-Start trunks
disconnect signaling reliability, 3-27
hold disconnect interval, 3-29
Loop-Start identification (LS-ID) delay, 3-33
outmode signaling, 3-24
toll type, 3-28

Loudspeaker Paging, 3-94

M

Main menu
return to, 2-27

Maintenance, 2-29
Maintenance alarms, 3-96
Memory card, 3-206

automatic backup, 3-212
backup, 3-211
backup error messages, 3-214
formatting, 3-209
inserting, 3-208
restore, 3-216
restore error messages, 3-217
types, 3-206

Message Center, 3-128
Message-waiting indicator, 3-142

fax, 3-95
Messaging systems, 3-97
Microphone operation, 3-110
MLX-20L console, 2-26
Mode of operation, 3-5
Modem

speed, 2-2, 2-27
Modem connection, local, 2-14
Modular adapter

355A, 2-2
355AF, 2-2

Modular cord, D8W, 2-2

Monitor, 2-29
Most Idle Hunting Pattern, 3-138
Music-On-Hold, 3-93

N

N11 special numbers table, 3-184
Network selection tables, 3-76
Network service, 3-66
Night Service, 3-191

Coverage Control, 3-195
Emergency Allowed List, 3-193
Exclusion List, 3-193
Group Assignment, 3-192
Outward Restriction, 3-193
overview, 3-191
setting system time, 3-8
time set, 3-194

Novell NetWare, 3-98
Null boards, 2-31
Numbering, 3-9

2-digit, 3-9
set up space, 3-9

O

One-Touch Transfer/One-Touch Hold, 3-149
Operation mode, 3-5
Operator

assigning Direct-Line Console (DLC) 
positions, 3-22

assigning Queued Call Console (QCC) 
positions, 3-20

features, 3-120
hold timer, 3-120
optional features, 3-120
positions, 3-19
primary position, 3-20

Other (extra) digits, 3-183
Other digits, 3-190
Outgoing tables, 3-76
Outmode signaling, 3-24
Outside dial tone, 3-159

P

Page buttons
Direct Station Selector (DSS), 3-18

Page Down key, 2-27
Page Up key, 2-27
Paging

group, 3-132
loudspeaker, 3-94
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Park
return time, 3-152

Pass-thru
connection, 2-37
menu option, 2-29
overview, 2-37
procedure, 2-38

Password
menu options, 2-29
overview, 2-40
procedure, 2-40

PC keys, 2-27
PC Keys in SPM

Function of, 2-27
Personal Line

principal user, 3-30
Pools

assigning to telephones, 3-84
dial-out code, 3-104
Group Calling assignments, 3-136
routing, (ARS), 3-179
trunk assignment, 3-35

Position-Busy Backup, 3-130
Posted message, 3-198
Primary Cover Ring Delay, 3-115
Primary Rate Interface (PRI)

B-channel groups, 3-64
Call-by-Call services table, 3-79
counters, 3-70
Dial Plan routing, 3-73
Network Selection tables, 3-76
network service, 3-66
Outgoing tables, 3-76
Special Services table, 3-77
switch type, 3-62

4ESS, 3-62
5ESS, 3-62
DEX600E, 3-62
DMS-100, 3-62
DMS-250, 3-62
Legend-NTWK, 3-62
Legend-PBX, 3-62

telephone number to send, 3-69
terminal equipment identifier, 3-73
test telephone number, 3-70
timers and counters, 3-70

Principal user
Personal Line, 3-30

Print
options, 2-41
report language, 3-200
SMDR Call Report format, 3-155

Priority
elevate, 3-124
QCC Queue, 3-31

Priority Call Queuing, 3-136

Q

Queue Over Threshold, 3-123
Queued Call Console (QCC)

operator positions, 3-19
operator to receive calls, 3-32
optional features, 3-120
queue priority level, 3-31

R

Recall timer, 3-162
Redirect outside calls to unassigned

extension numbers, 3-160
Release, automatic, 3-123
Reminder service

cancel, 3-159
Remote Access

Automatic Callback, 3-169
barrier codes, 3-172
features, 3-165
without barrier codes, 3-170

Remote Call Forwarding
Delayed Call Forwarding, 3-113

Remote modem connection, 2-15
Renumbering, 3-9

block, 3-9, 3-14
single, 3-9, 3-13

Reports, 3-201
language, 3-200
printing, 2-48
Station Message Detail Recording (SMDR) 

Call, 3-156
Station Message Detail Recording (SMDR) 

format, 3-155
Station Message Detail Recording

(SMDR) UDP Call, 3-158
Requirements, system, 2-2
Reset

communications port, 2-27
factory defaults, 2-42

Restart, 3-2
cold start, 2-42

Restore
from memory card, 3-216

Restrictions
Automatic Route Selection (ARS) restriction level 

for extensions, 3-107
call, 3-105
copy call restrictions, 3-107
Night Service, 3-193

Return ring, 3-129
Ring

delay interval, 3-153
return, 3-129
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Ringing Frequency (016 module), 3-26
Rotary Trunk Digit Transfer, 3-25
Routing

voice and data, 3-185, 3-191
Routing by dial plan, 3-73

S

Second dial tone, 3-26
Secondary Cover Ring Delay, 3-115
Security

system, 3-166
Select system numbering plan, 3-9
Service Observing, 3-118, D-11, D-21
Service Profile Identifier (SPID), 3-81
Set system date, 3-7
Set system time, 3-8
Set up space numbering, 3-9
Signaling, 3-59

mode, 3-47, 3-48
outmode, 3-25
reliability, 3-27

Single renumbering, 3-9, 3-13
SMDR

Talk Time, 3-157
Speakerphone operation, 3-110
Special services table, 3-77
Speed dial

directory, labeling, 3-199
Star Codes

second dial tone, 3-26
Start and stop times for subpatterns, 3-178
Station Message Detail Recording (SMDR)

account code format, 3-157
call length, 3-155
call report format, 3-155
calls recorded, 3-156
language, 3-154
UDP calls recorded, 3-158

Surrogate mode programming, 2-49
Switched 56

data services, 3-42
dial plan routing, 3-40, 3-45

Switched 56 Data Services, 3-42
Switchhook flash, 2-27
System

backing up programming to a memory 
card, 3-211

date, 3-7
language, 3-3
mode, 3-5
numbering, 3-9
operating conditions, 3-1
operator positions, 3-19
renumbering, 3-9
reports, 3-201
requirements, SPM, 2-2
restart, 3-2

System, (continued)
security, 3-166
Speed Dial Directory, 3-199
time, 3-8

System Access (SA) buttons
assigning, 3-87, 3-136

System Erase (frigid start), 2-43
System features, 3-148
System operating conditions

basic, 3-1
System programming

console, 2-1, 2-26
jack, 2-38
menu, 2-44
position assignment, 3-3
procedure, 2-47

System Programming and Maintenance
(SPM) software

additional functionality, 2-1
command, 2-26
display screen, 2-26
help, 2-27

System programming console, 1-8
System restart, 3-2

T

T1
Switched 56 Dial Plan Routing, 3-45

Tables
Automatic Route Selection (ARS), 3-177
Call-by-Call service, 3-79
dial 0, 3-185
N11 special numbers, 3-184
network selection, 3-76
outgoing, 3-76
special services, 3-77

TAPI, GL-33
Telephone number to send, 3-69
Telephones, 3-84

programming, 3-83
Terminal emulation type, 2-39
Terminal equipment identifier, 3-73
Test telephone number, 3-70
Tie trunks

answer supervision time, 3-54
dial tone, 3-53
direction, 3-50
Switched 56 Data Services, 3-42
type, 3-50

Time, 3-8
Time set

Night Service, 3-194
Timers

Basic Rate Interface (BRI), 3-82
Primary Rate Interface (PRI), 3-70
recall, 3-162
second dial tone, 3-26
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Tip/Ring functionality on 016 ETR module, 3-92
Toll

fraud prevention, 3-166
type, 3-28

Touch-Tone/rotary signaling on tip/ring ports, 3-91
Transfer

audible, 3-150
One-Touch, 3-149
return time, 3-149
trunk-to-trunk, 3-114
type, 3-151

TSAPI, 3-99, GL-33

U

Uniform Dial Plan (UDP)
digit absorption, 3-189
facility restriction level, 3-188
other digits, 3-190
routing, 3-186
voice and/or data routing, 3-191

V

Voice and/or data routing, 3-185, 3-191
Voice announce

when idle for MLX telephones, 4-40
Voice messaging systems (VMSs)

programming ports, 3-97

W

Windows System Programming and Maintenance 
(WinSPM) software, 1-3

Z

Zero code suppression, 3-40, 3-47
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